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Purpose

INTRODUCTION

Purpose

This manual covers procedures of installing “SV9300 PC Programming” (hereinafter “PCPro”), as appli-
cation tool for installing and servicing UNIVERGE SV9300 (hereinafter “SV9300”) and configuring its
communication with the SV9300, along with helpful tips on configuring the system office data. 
This manual is intended for use as PCPro online help. Click the [Help] button or [F1] key on the Main
Menu to browse through this manual.
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Outline of This Manual

Outline of This Manual

This manual consists of nine chapters and four appendixes. The following paragraphs summarize chapters
1 through 9 and Appendixes A, B, C and D.

CHAPTER 1 PCPro Overview
Provides introductory information about PCPro and proceeds to describe its system
configuration, operating environment, working conditions and more.

CHAPTER 2 Setting Up the PCPro
Explains how to connect the SV9300 and PCPro, how to install, launch and exit the
application, establish a communication link between the SV9300 and the PCPro.

CHAPTER 3 PCPro Window Layout
Explains the PCPro window layout, submenus on the screen and the function of the
work window, etc.

CHAPTER 4 Standard Mode
Explains the functions that can be configured in Standard Mode and how to operate
them.

CHAPTER 5 Wizard Mode
Explains the functions that can be configured in Wizard Mode and how to operate
them.

CHAPTER 6 System Data Mode
Explains how to use System Data Mode.

CHAPTER 7 Command Mode
Explains how to use Command Mode and the operational screens.

CHAPTER 8 Reporting
Explains how to view fault information, system configuration information, the
check result of the system, the result of read system data and a log of system data
upgrades stored on the SV9300 from PCPro in a report format.
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Outline of This Manual

CHAPTER 9 Settings
Explains how to configure PCPro to communicate between the SV9300 and PCPro,
set System Data Off-line Readout/Edit, and use the NEC System Data Conversion
Tool and configure the environment.

NOTE: In this manual, “Virtual PBX” is designated as the system data file when 
using System Data Off-line Readout/Edit.

APPENDIX A Main Menu and Toolbar Correspondence
List of menu bar functions, toolbar functions and the associated shortcut keys.

APPENDIX B List Command
Provides lists of the List Commands and explains how to use the List Commands.

APPENDIX C PCPro Maintenance Interface
Explains the PCPro Maintenance Interface (PMI) features and how to use the PMI.

APPENDIX D Troubleshooting
Explains the probable reasons for failure as they occur and the remedial actions.
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UNIVERGE SV9300
PC Programming Manual

Chapter

1

PCPro Overview

This chapter provides overview of PCPro and PCPro’s system con-
dition.

• What is PCPro?
• Operating Environments and Conditions
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What Is PCPro?

What Is PCPro?

PCPro is an application tool that installs and services the SV9300 system. PCPro supports four modes of
operation designed to simplify the work of initially setting up the system (system data registration):

• Standard Mode : This mode is suited for completing complex of setup.
– Streamlines the complexities of setup and verification work.
– Achieves functionality beyond reach of command entry.
– Displays the status of blade mounted on the SV9300 and fault information in

an easy-to-view format.
– Minimum operation needed to enter massive data simultaneously.

• Wizard Mode : This mode provides screens, which are the equivalent of system data settings of
the Programming Manual.
– By entering system data in order according to the screen, settings of the ser-

vice feature will be completed.
– Because supplemental remarks of the system data and recommended value to

implement the service are displayed on the screen, the system data for the ser-
vice can be set easily.

• System Data Mode : Suited for proceeding with setup work while verifying command details.
• Command Mode : Suited for quick entry on the command line for expert.
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What Is PCPro?

The general configuration of SV9300 maintenance activity and the position of PCPro are illustrated below.

 

Multiline Terminal
(CAT mode)

SV9300

Supervisory
Service

Remote
Maintenance

Internet
(ISP)

Switching 
HUB Router

PCPro
(RS-232C

Connection)

Program Download
by FTP
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(IP Connection)
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Connection)
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(SNMP Manager)

On-Site Connection
Maintenance

MA4000

PSTN

SV8500/SV9500



Chapter 1 PCPro Overview

1-4 NWA-088656-001 Rev.8.0

What Is PCPro?

Operating Environments and Conditions

Operating Environment of PC

<Common Operating Environment>

<OS-Specific Operating Environments>

Continued on next page

Item Specification

Recommended CPU • Refer to <OS-Specific Operating Environments>
Page 1-4

Hard disk • 1GB of free disk space minimum

Monitor • 1,024  768 dots or more, 16-bit colors (65,536) at least

CD-ROM drive • Required to install the program.

Hardware connection to the Main 
Unit

• IP connection / RS-232C direct connection / Modem Con-
nection 

Mouse • Mouse, or equivalent pointing device

Item Minimum Specification
Recommended 
Specification

Windows 8.1
• Windows 8.1 Pro
• Windows 8.1 Enterprise
* Including Windows 8.1 

Update.

CPU • Processor (1 GHz) or higher 

RAM • 1 GB minimum • 4 GB minimum

Windows 8.1 (x64)
• Windows 8.1 Pro
• Windows 8.1 Enterprise
* Including Windows 8.1 

Update.

CPU • Processor (1 GHz) or higher 

RAM • 2 GB minimum • 4 GB minimum
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What Is PCPro?

<OS-Specific Operating Environments>

NOTE: Windows 8.1 and Windows 10 support only a Desktop Mode.

<Required Software>

NOTE 1: Install the latest release of service pack for the OS, or necessary software to be used. In addi-
tion, install the security patches and the virus scan program.

NOTE 2: The abnormal conditions of PCPro caused by Windows malfunction are subject to the indem-
nity. Therefore, it is recommended to apply the security patches on a regular basis.

Item Minimum Specification
Recommended 
Specification

Windows 10 (x86)
• Windows 10 Home
• Windows 10 Pro
• Windows 10 Enterprise

CPU • Processor (1 GHz) or higher , or SoC

RAM • 1 GB minimum • 2 GB minimum

Windows 10 (x64)
• Windows 10 Home
• Windows 10 Pro
• Windows 10 Enterprise

CPU • Processor (1 GHz) or higher , or SoC

RAM • 2 GB minimum • 4 GB minimum

Microsoft Windows Server 
2012 (x64)

CPU • Pentium4 processor equivalent (1.4 GHz) or higher

RAM • 512 MB minimum • 4 GB minimum

Microsoft Windows Server 
2016 (x64)

CPU • Pentium4 processor equivalent (1.4 GHz) or higher

RAM • 512 MB minimum • 4 GB minimum

Microsoft Windows Server 
2019 (x64)

CPU • Pentium4 processor equivalent (1.4 GHz) or higher

RAM • 512 MB minimum • 4 GB minimum

Item Specification

Microsoft Excel 2010 or later Excel is used to create maintenance reports or script files.
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What Is PCPro?

Operating Conditions

• Internet access is required to connect to the Software License Authentication Center (Web Server).
• Before using PCPro, please confirm that the date and time of your PC are correctly set.
• PBX that can be connected to SV9300 PCPro is only UNIVERGE SV9300. It is not possible to con-

nect to other devices.
• SV9300 PCPro and SV8300 PCPro can be installed in a same PC. When you install the both software

in a same PC, specify the installation folder respectively (different folders are set by default).
• To use PCPro, Microsoft .NET Framework 4.5.2 (hereafter .NET Framework 4.5.2) must be installed

to your PC. If .NET Framework in your PC is older than .NET Framework 4.5.2, the installer of PC-
Pro automatically installs .NET Framework 4.5.2 in your PC.

• To install .NET Framework 4.5.2, the following amount of free space on HDD is required depending
on the OS currently used is 32 bit OS or 64 bit OS.

• If .NET Framework 4.5.2 is accidentally uninstalled, or not properly installed for some reason, PC-
Pro does not launch.
* In this case, install .NET Framework 4.5.2 from a CD of PCPro.

• If .NET Framework 4.5.2 is not properly installed, an error message will appear at the start up of PC-
Pro. Install .NET Framework 4.5.2 again.

• It takes about twenty minutes to install .NET Framework 4.5.2.
* The time required for .NET Framework 4.5.2 installation differs depending on the PC specifica-

tion. For details, refer to the web page of Microsoft.
• Depending on the PC environment currently used, applying security patches is required after the in-

stallation of .NET Framework 4.5.2. For details, refer to the web page of Microsoft Windows Update.
• Adobe Reader must be installed to view the PC Programming Manual from PCPro as help informa-

tion.
• A phenomenon such as the missing of characters may occur depending on the type of PC and setting

conditions of installed OS/applications. In such cases, use the PC with Classic mode.
• Program Upgrade (On-line/Off-line) may not work correctly if any functionality of FTP is controlled

by a virus check program or the like. Be sure to disable such control beforehand.
• There are the following constrains when launching PCPro from RMAT.

– Connectable only to the office selected by RMAT.
– [Tools] > [Connection Account...] of the Main Menu is not available.

.NET Framework
Amount of Free Space on HDD

32 bit OS 64 bit OS

.NET Framework 4.5.2 850 MB 2.0 GB
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• To use HTTP server functions requires any of the following OS: 
– Windows 8.1
– Windows 10
– Windows Server 2012
– Windows Server 2016
– Windows Server 2019

NOTE: Be sure to use the OS with the recommended specifications and environment. For the details, 
refer to <OS-Specific Operating Environments>. 

• PCPro uses the following functions. Set the following functions by a Microsoft browser.
– Play animations in web pages
– Show pictures
– Run scripts in web pages

The details of the setting method are as follows.
• Select the [Control Panel] > [Internet Options] > [Advance] tab in this order and enable the fol-

lowing functions.
– Play animations
– Show pictures

• Select the [Control Panel] > [Internet Options] > [Security] > tab in this order, then click the Cus-
tom Level button, and enable the following functions.
– Active scripting

• The FTP/HTTP server facility of PCPro may not work correctly as it is blocked by the Windows Fire-
wall. In this case, Windows Firewall override instructions are below:

<Overriding the Widows Defender Firewall in the [Windows Security Alert] screen>

If the [Windows Security Alert] screen appears while running, click [Allow access].
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<Overriding the Widows Defender Firewall in the [Windows Firewall] setup screen>

(1) On the Windows, click [Start]> [Windows System] > [Control Panel] > [System and Security]
> [Windows Defender Firewall] in order to display the [Windows Defender Firewall] screen
and confirm the connected network.
* The following is the case which is connected to the Domain networks.

(2) Click [Turn Windows Defender Firewall on or off] to display the [Customize Settings] screen.

Connected
network
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(3) Uncheck the “Block all incoming connections, including those on the list of allowed apps”
check box of the setting for connected network checked by Step (1), then click the [OK] button.

The [Windows Defender Firewalls] screen is displayed.
(4) Click the [Allow an app or feature through Windows Defender Firewall] to display the

[Allowed Apps] screen.
(5) Select “PCPro FTP Server” (or MatFtps.exe) or “PCPro HTTP Server” (or HttpServer.exe)

from the “Allowed apps and features:”, then click the [OK] button.
* If “PCPro FTP Server” or “PCPro HTTP Server” is not found on the list, click [Allow another

app...] and then click the [Browse…] button to select MatFtps.exe or HttpServer.exe.

• When providing the IP connection, enable the “Internet Protocol Version 4 (TCP/IPv4)” by the net-
work settings of PC.

<Enabling Internet Protocol Version 4 (TCP/IPv4) setup>

(1) Click [Start]> [Windows System] > [Control Panel] in order.
(2) Click the “View network status and tasks” in the [Control Panel] screen.

The [Network and Sharing Center] screen is displayed.

“Block all incoming connections,
including those in the list of

allowed apps” check box

[OK] button
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(3) Click the “Ethernet”* in the [Network and Sharing Center] screen.
* If several networks exist, a different name such as “Ethernet 2” may be displayed.

The [Ethernet Status] screen is displayed.
(4) Click the [Properties] button in the [Ethernet Status] screen.

The [Ethernet Properties] screen is displayed.

Ethernet

[Properties] button
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(5) Check the “Internet Protocol Version 4 (TCP/IPv4)” in the [Ethernet Properties] screen, then
click the [OK] button.

• To create the maintenance report and Terminal Phonebook, it is necessary for Excel to make the mac-
ro settings effective. To make the macro settings effective for Excel, do the following settings using
an example of Excel 2010.

<Enabling Macro in Excel>

(1) Launch Excel 2010.
(2) Click the [Option] from the [File] menu.

The [Excel Options] screen is displayed.
(3) On the [Excel Options] screen, click [Trust Center] > [Trust Center Settings...] button in this

order. 

The [Trust Center] screen is displayed.

[OK] button

Internet Protocol
Version 4 (TCP/IPv4)

[Trust Center]

[Trust Center Settings...] 
button
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(4) On the [Trust Center] screen, click [Macro Settings] > [Disable all macros with notification]
radio button in this order.

(5) Click the [OK] button.

The macro settings in Excel has now been completed.

NOTE: Handling of Alert Messages
When the alert message is displayed by the macro settings in Excel, do the following operations
using an example of Excel 2010.
1. Click the [Enable Content] button of the “Security Warning Macros have been disabled.”

displayed on the message bar.

[Macro Settings]

[OK] button

[Disable all macros with 
notificaton] radio button

[Enable Content] button
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Setting Up PCPro

This chapter explains how to set up and launch PCPro. 

• Installing PCPro
• PCPro Folder Configuration
• Launching PCPro 
• Connecting PCPro to the SV9300
• Communication Link with the SV9300
• System Data Backup
• Copy System Data to Remote Units
• Exiting PCPro
• Uninstalling PCPro
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Installing PCPro

PCPro can be installed in following steps:

NOTE: Install PCPro by a user who has administrator authority of Windows.

STEP1: Mount the PCPro CD-ROM on the CD/DVD-ROM drive on the PC running Windows operat-
ing system.

STEP2: Double click the Setup.exe included in the installation CD.
The [Welcome] dialog box is displayed when double clicking the Setup.exe.

NOTE: When the PCPro installer launches, it displays the dialog box shown below. Click the [Yes] but-
ton to continue with the installation.

STEP3: Proceed as directed by onscreen guidance.
STEP4: Click the [Yes] button. 

A shortcut icon for PCPro is created in the Desktop on your PC.

PCPro has now been installed.

[Yes] button
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PCPro Folder Configuration

The table below lists the files that are created in the folders specified by the user when PCPro was installed.

Created File/Folder Description

Executable files (*.exe, *.dll) Program files

ftproot (Default) root folder of the SV9300 PCPro built-in FTP server
* This folder is generated when PCPro launches.

httproot (Default) root folder of the SV9300 PCPro built-in HTTP server
* This folder is generated when PCPro launches.

reports Report file folder (system report, Fault Display report and more)
* This folder is generated when PCPro launches.

logfiles System communication log folder (trace results, MP-FP command 
output results, and more)
* This folder is generated when PCPro launches.

pbxfiles File folder created by the program (which contains a software authen-
tication PBX creation file, system data files created by Quick Setup, 
SLV verification logs and so on).
* This folder is generated when PCPro launches.

sample Sample files folder 
* The following sample files are automatically generated.

• A Directory data file (Excel)
• Script/scenario files
• PMI files
• A root certificate file of the HTTP server

database Data base folder used by the program

help A help file for PCPro

html

images

maintenancereport System data change history data files for maintenance reports

userdb

conversion A programming and a data base folder for system data conversion tool
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Launching PCPro

To launch PCPro, follow these steps:

NOTE: After installing PCPro, launch PCPro by a user who has administrator authority of Windows 
because of the privilege settings.

STEP1: Launch PCPro in any of the following operations:
• Double-click the PCPro icon in the Desktop.
• Choose [Start] > [NEC SV9300 PCPro] > [NEC SV9300 PCPro] in Windows OS. 

The [Logon] dialog box is displayed.

NOTE: When the PCPro launches, it displays the dialog box shown below. Click the [Yes] button to 
continue with the launching.

[Yes] button
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STEP2: Type the User Name and Password and then click the [OK] button.
If a login password is default, or does not meet the password setting conditions, the [Change 
Password] screen is displayed. For information about the User Name, the Password defaults, 
see “The Kinds of PCPro Account”. Page 9-10  For information about changing your 
password, see “Changing Password of PCPro Account”. Page 9-12

If a password change is not required, click the [OK] button. you can log in to the PCPro when
the password is authenticated to the system.

NOTE 1: For setting up PCPro, log in to PCPro with an admin account. In other cases, you can use a 
manager account for end users management. For details of PCPro account, see “The Kinds of 
PCPro Account.” Page 9-10

NOTE 2: If you fail to log in five times, the following Dialog box appears and terminates PCPro. Also, a 
log for the login failure is output to the “pcpro.log”.

Password field

[OK] button

User Name field
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STEP3: To prevent the unauthorized access, change the password. Enter the new password in the New 
password field and the Confirm new password field.
For details of a password change, see “Changing Password of PCPro Account”.

Page 9-12

NOTE: The passwords that can be set for an “admin” account and a “manager” account are as 
follows.
- Input length: Eight or more digits (up to sixteen digits)
- Input characters: 0 to 9, A to Z, a to z

Tips: Password Change in the Login Authentication
The [Change Password] screen appears for the following cases.
- When logged in for the first time after a PCPro installation
- After an upgrade of previous version’s PCPro, when logged in with the password that does

not meet the setting conditions 

STEP4: Click the [OK] button.
The [PCPro] window is displayed.

PCPro has launched.

Confirm new password field

[OK] button

New password field



Chapter 2 Setting Up PCPro

2-7 NWA-088656-001 Rev.8.0

Connecting PCPro to the SV9300

Connecting PCPro to the SV9300

Three ways are available for connecting the SV9300 to the PC (PCPro is installed). Choose one of these
methods to suit your particular needs.

• IP Connection Page 2-9
• RS-232C Connection (Direct Connection) Page 2-13
• Modem Connection Page 2-14

NOTE 1: Up to four instances of PCPro can be connected to the CPU blade with SV9300. The number of 
connections allowed per connection mode is as follows (When the remote unite is in survival 
mode, the PCPro can connect to the CPU of each unit.):
- IP connection :Up to 2
- RS-232C connection (direct connection) :Up to 2 (on a modem connection, 1)
- Modem connection :1
* When connecting two or more PCPro, note that system data is overwritten if you set, change,

or clear system data at the same time because SV9300 does not perform exclusive control.
* When PCPro is connected with Virtual PBX, the connection cannot be counted to the num-

ber of PCPro connected with the CPU blade with SV9300 because Virtual PBX is not actual. 
NOTE 2: A communication link can be established between the SV9300 and the PC (at a baud rate of 

9600 bps) by default when PCPro launches for the first time. Once a communication link is in 
place, follow these steps to change the baud rate:
(1) Change the baud rate of the CPU with CM40 Y=08.
(2) Change the setting to meet the baud rate of the CPU in the PCPro [Connection Account]

screen. Page 9-2
(3) Log off PCPro once, then log it on again.

NOTE 3: By the PCPro IP connection to SV9300 using 9300V4 software or later, the overall communi-
cation speed of PCPro is improved approximately 10 times faster, and the processing time such 
as the System Data Save/Load/Verify menu and the System Check and Report menu is short-
ened. However, the processing time of the following menus is not shortened.
- Program Upgrade (Off-line)
- Program Upgrade (On-line) (including Speech Synthesis Data Upgrade)
- Firmware Upgrade (Line/Trunk Blade)

Continued on next page



Chapter 2 Setting Up PCPro

2-8 NWA-088656-001 Rev.8.0

Connecting PCPro to the SV9300

NOTE 4: The communication speed between PCPro and SV9300 also changes by the network condition 
and the ability of PC side.
The following table shows the comparison of processing time for the System Data Save/Load/
Verify menu by this improvement.

* The above is the index in the idle state (in a state with no call).

NOTE 5: The speed of displaying the User Web Portal pages is accelerated approximately 3 times.

Item

Processing Time for System Data Save/
Load/Verify

9300V4 software 
or later

9300V3 STEP2 
or before

Time for Saving System Data Approx. 2 minutes Approx. 25 minutes

Time for Loading System 
Data

Approx. 2 minutes Approx. 25 minutes

Bandwidth to be used for 
System Data Save/Load/
Verify

Approx. 1.2 Mbps Approx. 80 kbps
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IP Connection 

Hardware Requirements

* Customer purchases

Description Quantity Remarks

Required for the SV9300 LAN cable* Up to 2 <When using ETHERNET port>
• 10BASE-T/100BASE-TX LAN cable 

(STP category 5 [cross/straight cable])

<When using VOIP port>
• 10BASE-T/100BASE-TX LAN cable 

(STP category 5 [cross/straight cable]) 
or 1000BASE-T LAN cable (STP cat-
egory 5e [cross/straight cable])

Required for the PC 
(PCPro)

LAN cable* Up to 2 • 10BASE-T/100BASE-TX LAN cable 
(STP category 5 [cross/straight cable])

PC* Up to 2 • For the specifications of the PC 
required, see “Operating Environ-
ments and Conditions”. Page 1-4



Chapter 2 Setting Up PCPro

2-10 NWA-088656-001 Rev.8.0

Connecting PCPro to the SV9300

Connection Method

NOTE 1:  When providing the IP connection with the PCPro, enable the “Internet Protocol Version 4 
(TCP/IPv4)” by the network settings of PC. For details of the setting method, refer to the 
<Enabling Internet Protocol Version 4 (TCP/IPv4) setup>. Page 1-9

NOTE 2: To establish the IP connection with SV9300, a NIC driver of PC must be operated properly. 
Confirm that the NIC driver has been updated or re-installed, and the driver has been au-
thenticated.

STEP1: Using PCPro (IP connection), set the following system data on the SV9300:
• Ethernet Port IP Address:

CM0B Y=0XX>00: aaa.bbb.ccc.ddd
(XX: 01-50 [Unit No.]) (aaa.bbb.ccc.ddd: IP Address Example: 10.20.30.100)

• Ethernet Port Subnet Mask:
CM0B Y=0XX>01: aaa.bbb.ccc.ddd
(XX: 01-50 [Unit No.]) (aaa.bbb.ccc.ddd: Subnet Mask Example: 255.255.255.0)

• Ethernet Port Default Gateway:
CM0B Y=0XX>02: aaa.bbb.ccc.ddd
(XX: 01-50 [Unit No.]) aaa.bbb.ccc.ddd: Default Gateway Example: 10.20.30.1)

• VOIP Port IP Address:
CM0B Y=1XX>00: aaa.bbb.ccc.ddd
(XX: 01-50 [Unit No.]) (aaa.bbb.ccc.ddd: IP Address Example: 10.20.30.100)

• VOIP Port Subnet Mask:
CM0B Y=1XX>01: aaa.bbb.ccc.ddd
(XX: 01-50 [Unit No.]) (aaa.bbb.ccc.ddd: Subnet Mask Example: 255.255.255.0)

• VOIP Port Default Gateway:
CM0B Y=1XX>02: aaa.bbb.ccc.ddd
(XX: 01-50 [Unit No.]) (aaa.bbb.ccc.ddd: Default Gateway Example: 10.20.30.1)

NOTE 1: Ethernet and VOIP port IP addresses cannot be in the same subnet. Different subnets must 
be used for when assigning both the Ethernet and VOIP ports.

NOTE 2: There are the following conditions when setting the Default Gateway Address by this 
command.
- Only one Default Gateway Address can be set for each unit.
- Set the Default Gateway Address to the Maintenance port (Y=0XX) when not using 

VoIPDB.
- Set the Default Gateway Address to the VOIP port (Y=1XX) when using VoIPDB.

NOTE 3: Period (.) is required when an IP address, Subnet mask and Default gateway are assigned 
by CM0B (Example: 10.40.221.9).
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Tips: SV9300 IP Address
When system data on the SV9300 is all cleared in an off-line state (SENSE switch of the CPU
blade is set to “E”), or SV9300 is launched with standard system data, the following IP ad-
dress and subnet mask are set as defaults: STEP1 can be bypassed as long as these IP ad-
dresses are used.

• When system data of SV9300 is all cleared or SV9300 is in an off-line state (SENSE switch of the
CPU blade is set to “E”)

• When SV9300 has launched with standard system data

STEP2: Connect LAN cable between the Ethernet port on the front of the CPU blade mounted in the 
SV9300 and the Switching HUB/Router.

Item ETHERNET Port VOIP Port (TCP)

Communication speed Auto negotiation Auto negotiation

IP Address Unit01-50: 192.168.1.1 No data

Subnet mask 255.255.255.0

Default gateway No data

TCP port 60000 60000

Item ETHERNET Port VOIP Port (TCP)

Communication speed Auto negotiation Auto negotiation

IP address Unit01: 192.168.1.1
Unit02: 192.168.1.2
Unit03: 192.168.1.3
Unit04: 192.168.1.4

Unit01: 172.16.1.1
Unit02: 172.16.2.1
Unit03: 172.16.3.1
Unit04: 172.16.4.1

Subnet mask 255.255.255.0 255.255.0.0

Default gateway No data No data

TCP port 60000 60000



Chapter 2 Setting Up PCPro

2-12 NWA-088656-001 Rev.8.0

Connecting PCPro to the SV9300

STEP3: Connect LAN cable between the PC LAN port and the Switching HUB/Router.

PC (PCPro) CPU

SV9300

LAN cable
LAN cable

(10BASE-T/100BASE-TX/1000BASE-T*)Switching HUB
/Router

LAN

ETHERNET
/VOIP

* The communication by 1000BASE-T standard
is available only when connecting to VOIP port.
For the connection by 1000BASE-T standard,
please use the STP cable higher than Cat5e 
standard.
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RS-232C Connection (Direct Connection)

Hardware Requirements

* Customer purchases

Connection Method

STEP1: Interconnect the RS1/RS2 port on the front of the CPU blade mounted in the SV9300 and 
the RS-232C port on the PC with the PCPro cable.

STEP2: Launch PCPro and configure its connectivity with the SV9300 in the [Connection Account] 
screen.
For more details, see “Communication Link with the SV9300”. Page 2-16

Description Quantity Remarks

PC* Up to 2 • For the specifications of the PC required, see “Oper-
ating Environments and Conditions”. Page 1-4

PCPro cable Up to 2 • RS CONSOLE CA-A

CPU

SV9300

PC (PCPro)

PCPro cable (RS CONSOLE CA-A : 2m)
RS1/RS2
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Modem Connection

Hardware Requirements

* Customer purchases

Connection Method

STEP1: Using CAT or PCPro (RS-232C connection), set the following system data on the SV9300:
• CM40 Y=10

First data : 1
Second data : X - XXXXXXXX (Built-in modem No.)

• CM13 Y=07
First data : X - XXXXXXXX (Built-in modem No.)
Second data : 0 (Data station) 

• CM13 Y=18
First data : X - XXXXXXXX (Built-in modem No.)
Second data : 0 (To send) 

• CM15 Y=044 NOTE
First data : 00 - 15 (Service restriction class A)
Second data : 0 (Restricted)

NOTE: Using the CPU built-in modem when the second data of CM15 Y=044 (Call Waiting 
Answer-Called Side) is set to 1 (Allow) affects the communication. Therefore, be sure to set 
the second data to 0 (restricted).

Description Quantity Remarks

Required for the SV9300 COT/PRI/BRI 
blade

1 • Used to interface the SV9300 to a 
public network. 

Required for the remote 
unit

PC* 1 unit • For the specifications of the PC 
required, see “Operating Environ-
ments and Conditions”. Page 1-4

Modem* 1 unit • Modem supporting AT commands
• 28.8 Kbps or faster modem recom-

mended

RS-232C 
straight cable

1 • Used to connect the modem and PC to 
each other.
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STEP2: Connect the modem as shown below.

STEP3: Launch PCPro and configure its connectivity (modem connection) with the SV9300 in the 
[Connection Account] screen. For more details, see “Establishing a Link”. Page 2-16

PC (PCPro)

SV9300

RS-232C
straight
cable

ModemCOT PSTN

Built-in Modem

CPU

Using CPU built-in modem
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Communication Link with the SV9300

Establishing a Link

To establish a communication link between PCPro and the SV9300, follow these steps:

STEP1: Launch PCPro. Page 2-4
STEP2: On the Main Menu, click [System] > [Connect].

The [Connect] screen is displayed. 
STEP3: Select a connection account.

The default connection account is registered once the system data all clear/standard system data 
entry is completed. If you wish to use any other account, create a new connection account. For 
instructions on how to create a connection account, see “Connection Account”. Page 9-2
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STEP4: Enter the system password.
Perform this procedure only if a system password is registered on the SV9300.

No. Item Description

(1) Connection 
Account

Select a preset default account, or an account that has been set in “Connection 
Account”.
• IP (LAN, Default)

Connection Type : IP
An IP connection to the SV9300 which system data all clear/standard system 
data has been loaded. 
Select IP (LAN, Default) when IP connection (ETHERNET port) is used.

• IP (VoIP, Default)
Connection Type : IP
An IP connection to the SV9300 which system data all clear/standard system 
data has been loaded. 
Select IP (VoIP, Default) when IP connection (VOIP port) is used.

• RS-232C (9600 bps)
Connection Type : Direct (RS-232C)
Select Direct connection when RS-232C connection (direct connection) is used.

• Virtual PBX (Default)
Connection Type : Virtual PBX
Select Virtual PBX (Default) when using the System Data Off-line Readout/Edit 
feature with the arbitrary system data file.

* PCPro displays the connection account previously connected to the system.

(2) System 
Password

Type the system password that is preregistered with the SV9300.

(1)

[Connect] button

(2)
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STEP5: Click the [Connect] button.
If you successfully log on to the system, a dialog appears saying “Successfully connected to the 
System.”.

The [Connect] screen closes. The following list of information is displayed on the status bar in 
the [PCPro] window:
•Connection Account (account in which PCPro is connected to the SV9300)
•System Account (version number of the CPU software installed on the SV9300)
•BIOS version of SV9300
•Unit No. of SV9300
•Dual CPU (CPU0/1) of SV9300

If you fail log on to the system, a dialog appears saying “Cannot connect to the System.”. Take
remedial action as recommended in “Troubleshooting a Connect Failure”. Page D-2

NOTE: SV9300 PCPro cannot be connected to SV8300. The following dialog box appears when 
attempting to connect to SV8300.

A communication link has now been established between PCPro and the SV9300.
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Clearing the Communication Link

To clear the communication link between PCPro and the SV9300, follow these steps:

STEP1: On the Main Menu, click [System] > [Disconnect] in this order.
[Disconnect] dialog box is displayed.

STEP2: Click the [Save and Disconnect] button or [Disconnect] button. 

The [Disconnect] dialog box closes. The connection information displayed on the status bar in the [PCPro]
window disappears.

The communication link to the SV9300 has now been cleared.

No. Item Description

(1) [Save and Dis-
connect] button

Click to save the system data to flash memory in the SV9300 and clear the 
communication link to the SV9300.

(2) [Disconnect] 
button

Click to clear the communication link to the SV9300 without saving system 
data.

(1)

(2)
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System Data Backup

With the SV9300, if any of the operations listed below is carried out without backing up the system data
following the entry of system data or service memory settings (such as abbreviated phone dialing and ab-
sent transfer), the data settings would be lost. Before performing any of these operations, you need to back
up system data. System data backup may be executed at an appointed time, which is specified by CM43
Y=5>00 (by default, at 3.a.m.)

• Power OFF
• System reset (CPU blade reset)
• Switching to off-line mode
• Switching to on-line mode following the setting of system data in off-line mode

NOTE 1: The SYSD lamp on the CPU blade blinks while the system data backup is in progress. Do not 
reset the system while the SYSD lamp is blinking red.

NOTE 2: The system data backup takes about 5 minutes both in on-line mode and in off-line mode to com-
plete.

NOTE 3: When voice data in a VRS is recorded or changed, the backup of voice data is required.

To backup system data, follow these steps:

STEP1: Launch PCPro. Page 2-4
STEP2: On the Toolbar, click the [System data backup] button.

[System data backup] dialog box is displayed.

STEP3: Click the [Yes] button.
The system data backup begins.
When System Data Backup is executed, voice data is also backed up at the same time.

[Yes] button
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STEP4: Click the [OK] button.

The system data backup has now been complete.

[OK] button
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Copy System Data to Remote Units

When copying system data set to a Main Unit to Remote Units such as installing additional Remote Units,
do the following settings. Copy system data to Remote Units may be executed at an appointed time, which
is specified by CM43 Y=7>00 (by default, at 2.a.m.)

NOTE 1: Time required for copy system data to Remote Units differs depending on the number of man-
aged Units and set system data.

NOTE 2: [Copy System Data to Remote Units] cannot be executed during accessing a flash ROM such 
as during system data backup. In that case, click the [Copy System Data to Remote Units] but-
ton again after system data backup has completed.

NOTE 3: System data backup is started automatically in each Remote Unit after system data backup is 
completed.
Do not execute the system reset and do not turn the power off the CPU blade while “SYSD” 
LED on the CPU blade is flashing during system data backup.

To copy system data to Remote Units, follow these steps:

STEP1: Launch PCPro. Page 2-4
STEP2: On the Toolbar, click the [Copy System Data to Remote Units] button.

[Copy System Data to Remote Units] dialog box is displayed.

STEP3: Click the [Yes] button.
The copy system data to Remote Units begins.

NOTE: If the [Yes] button is clicked, the system data is copied to all remote units after backup. Click 
the [No] button when copying system data to all remote units without backup.

[Yes] button
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Copy System Data to Remote Units

STEP4: Click the [OK] button.

The copy system data to Remote Units has now been completed.

[OK] button
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Exiting PCPro

To exit PCPro, follow these steps:

STEP1: Clear the communication Link to the SV9300.
For information on clearing the communication link, see “Clearing the Communication Link”.

Page 2-19
STEP2: Perform either of the following procedures:

• Click [x] (Close) in the upper right corner of the [PCPro] window.
• On the Main Menu, click [File] > [Exit] in this order.

The [PCPro] window closes. If a communication link to the SV9300 is in existence, the [Dis-
connect] dialog box is displayed. Clear the connection.

Now you have exited PCPro.

[Close] button
[Exit] button
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Uninstalling PCPro

To uninstall PCPro, follow these steps:

STEP1: Click [Start] > [Windows System] > [Control Panel] in this order in Windows OS.
The [Control Panel] screen is displayed.

STEP2: Click the “Uninstall a program”.
The [Programs and Features] screen is displayed.

STEP3: Right-click the SV9300 PCPro, then click the “Uninstall” on a pop-up window.
STEP4: Click the [Yes] button.

PCPro has been removed from your computer.
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PCPro Window Layout

This chapter describes the layout of the [PCPro] window layout and
the functions of its components.

• PCPro Window Component Names and Functions
• Main Menu
• Toolbar
• Submenu
• Work Window
• Mode selector tabs
• Status bar
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PCPro Window Component Names and Functions

PCPro Window Component Names and Functions

The PCPro main window is organized into the items listed in the table below. System data set on the
SV9300 can be configured or viewed by manipulating a variety of menu choices available from the main
window.

Continued on next page

No. Item Description
Reference 

Page

(1) Main Menu Displays a menu pertaining to the operations of PCPro as a whole. Page 3-4

(2) Toolbar Displays shortcut icons of the commonly used menu choices. Page 3-11

(3) Submenu Displays the submenu associated with the mode selector tab 
being selected.

Page 3-18

(4) Work 
Window

Displays screen for configuring the functions selected from the 
main menu, toolbar and submenus. Data is selected and entered, 
and processing executed in this window.

Page 3-20

(5) Mode 
Selector Tabs

Switches the submenu view to one of the following modes:
• Standard Mode
• Wizard Mode
• System Data Mode
• Command Mode

Page 3-21

(1)

(4)

(2)

(3)

(5)
(6)
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No. Item Description
Reference 

Page

(6) Status bar Displays the status of PCPro operation and that of connection 
with the SV9300.

Page 3-22
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Main Menu

The Main Menu displays a complete repertoire of menus pertaining to the PCPro operations. Click a menu
choice on the Main Menu to gain access to the functions listed in the table below. Different menus are dis-
played according to the user class of the user who has logged in to PCPro.

Continued on next page

No. 
 Menu 

Category
 Menu Choice Function

Reference 
Page

(1) File Exit Exits PCPro. Page 2-24

(2) View Toolbars Standard 
Buttons

Shows or hides the toolbar. –

Customize... Enable to change the toolbar buttons 
displayed on the toolbar.

–

Sub menu Standard Shows or hides the [Standard] tab 
among the mode selector tabs.

–

Wizard Shows or hides the [Wizard] tab 
among the mode selector tabs.

–

System Data Shows or hides the [System Data] tab 
among the mode selector tabs.

–

Command Shows or hides the [Command] tab 
among the mode selector tabs.

–

Status bar Shows or hides the status bar. –

Tooltips Shows or hides the tooltips that are dis-
played by pointing to onscreen buttons 
or entry fields.

–

(1) (2) (3) (4) (5) (6) (7)
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Main Menu

Continued on next page

No. 
 Menu 

Category
 Menu Choice Function

Reference 
Page

(3) System Connect... Displays the [Connect] screen. Estab-
lishes a communication link with the 
SV9300.

Page 2-7

Disconnect... Displays the [Disconnect] screen. 
Clears a communication link with the 
SV9300.

Page 2-19

System Data Backup Displays the [System Data Backup] 
screen. Executes system data backup 
of the SV9300.

Page 2-20

Copy System Data to 
Remote Units

Displays the [Copy System Data to 
Remote Units] screen. Executes copy 
system data to the Remote Units.

Page 2-22

System Data Save/Load/
Verify 

Displays the [System Data Save/Load/
Verify] screen. Performs any of the fol-
lowing operations:
• Save system data resisted on the 

SV9300 to PCPro.
• Load system data stored on PCPro 

into the SV9300.
• Compare the system data registered 

on the SV9300 and system data 
saved on PCPro.

Page 4-270

Reset Displays the [Reset] screen. Resets the 
CPU, Line/Trunk Blades, and IP Trunk 
(P2P CCIS).

Page 4-282

Software License 
Authentication

Displays the [Software License 
Authentication] screen. Registers/
deletes software licenses.

Page 4-42

Mainte-
nance

Fault Dis-
play

Displays the [Fault Display] screen. 
Enable to confirm information about 
errors present on the SV9300.

Page 4-268
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Main Menu

Continued on next page

No. 
 Menu 

Category
 Menu Choice Function

Reference 
Page

(3) System Mainte-
nance

System 
Check and 
Report

Displays the [System Check and 
Report] screen. Displays the check 
result of system, system configuration 
of the SV9300, details of line/trunk 
blades and port information in the 
HTML format. Also checks whether 
the duplicate IP addresses exist or not, 
and detects line/trunk blades requiring 
the firmware upgrade.

Page 4-251

Mainte-
nance 
Report

Displays the [Maintenance Report] 
screen. Edits and creates the mainte-
nance report.

Page 4-287

Port Status/
Lamp Status

Displays the [Port Status/Lamp Status] 
screen. Enable to confirm the status of 
each busy trunk, list of busy stations, 
LED indication of a selected blade and 
busy status of a selected trunk number 
(idle/busy/etc.).

Page 4-256

Program 
Upgrade 
(On-line)

Displays the [Program Upgrade (On-
line)] screen. Upgrades the CPU soft-
ware in On-line.

Page 4-61

Program 
Upgrade 
(Off-line)

Displays the [Program Upgrade (Off-
line)] screen. Upgrades the CPU soft-
ware in Off-line.

Page 4-73

Firmware 
Upgrade 
(Line/Trunk 
Blade)

Displays the [Firmware Upgrade 
(Line/Trunk Blade)] screen. Extracts 
line/trunk blades requiring the firm-
ware upgrade and upgrades the firm-
wares for all blades at once.

Page 4-77
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Main Menu

Continued on next page

No. 
 Menu 

Category
 Menu Choice Function

Reference 
Page

(3) System Mainte-
nance

Trace Infor-
mation...

Displays the [Trace Information] 
screen. Enable to confirm trace infor-
mation transmitted from the SV9300 
randomly. 
* This menu is reserved for NEC tech-

nicians and need not be used in most 
situations.

Page 7-12

(4) Edit Standard Switches the submenu view to Stan-
dard Mode.

Page 4-2

Wizard Switches the submenu view to Wizard 
Mode.

Page 5-2

System Data Switches the submenu view to System 
Data Mode.

Page 6-2

Command Switches the submenu view to Com-
mand Mode.

Page 7-2

Quick Setup Displays the [Quick Setup] screen. 
Provides initial settings to the SV9300 
(Unit01).

Page 4-6

Blade Configuration Displays the [Blade Configuration] 
screen. Registers blades on the 
SV9300.

Page 4-29

Speed Dialing Displays the [Speed Dialing] screen.
Displays a list of Speed Dialing usage 
and sets the Station Speed Dialing and 
the System Speed Dialing.

Page 4-125

Call Pickup Group Displays the [Call Pickup Group] 
screen. Adds, edits and deletes the Call 
Pickup Group.

Page 4-170

UCD Group Displays the [UCD Group] screen. 
Adds, edits and deletes the UCD 
Group.

Page 4-183
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Continued on next page

No. 
 Menu 

Category
 Menu Choice Function

Reference 
Page

(4) Edit Station Hunting Group Displays the [Station Hunting Group] 
screen. Adds, edits and deletes the Sta-
tion Hunting Group.

Page 4-197

User Web Portal Man-
agement

Performs required settings to manage 
the User Web Portal and collects logs.

Page 4-210

Terminal Phonebook Displays the [Terminal Phonebook] 
screen. Assigns the directory data 
made by Excel to PCPro, and then 
changes the data into a directory for-
mat which is available for download-
ing on DT900 Series.

Page 4-230

(5) Tools Connection Accounts... Displays the [Connection Accounts] 
screen. Creates and verifies a connec-
tion count.

Page 9-2

 PCPro 
Accounts

Change 
Password...

Displays the [Change Password] 
screen. Changes the password associ-
ated with the user name of the user 
who has currently logged in.

Page 9-12

Script Displays the [Script] screen. Runs the 
system data scripts.

Page 4-90

Station Copy/Key Copy Displays the [Station Copy/Key Copy] 
screen. Copies key data (station data), 
copies/assigns new stations and 
moves/swaps stations.

Page 4-103

Reports Fault 
Display...

Display a fault information report. Page 8-2

System 
Check and 
Report...

Displays a system report. Page 8-3

System 
Data...

Displays the results of system data 
read out by System Data Mode.

Page 8-24
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Continued on next page

No. 
 Menu 

Category
 Menu Choice Function

Reference 
Page

(5) Tools Reports Log 
Viewer...

Displays a history of upgrade to the 
system data.

Page 8-26

Settings Options Displays the [Options] screen. Set the 
maximum number of the displays of 
System Data, monitors the status of the 
IP connection and message displays, 
and selects the Chinese character.

Page 9-39

Settings FTP Server 
Settings...

Displays the [FTP Server Settings] 
screen. Displays and configures FTP 
server information.

Page 9-43

HTTP 
Server Set-
tings...

Displays the [HTTP Server Settings] 
screen. Displays and configures HTTP 
server information.

Page 9-47

System Data Conver-
sion Tool...

Displays the [System Data Conversion 
Tool] screen. Converts the system data 
of SV8300 to that of SV9300.

Page 9-24

Communication Log... Displays a log of real-time communi-
cations sessions between PCPro and 
the SV9300.
* This menu is reserved for NEC tech-

nicians and need not be used in most 
situations.

–

(6) Window Close All Closes all open windows in the work 
window. 

–
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No. 
 Menu 

Category
 Menu Choice Function

Reference 
Page

(7) Help Help Displays “PC Programming Manual” 
for this user class.
* Adobe Reader is required to view the 

guide.

–

License Displays the end user license agree-
ment of PCPro.

–

About SV9300 PCPro... Displays version information about 
PCPro.

–
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Toolbar

In the toolbar, there are “Standard Buttons” which display the shortcut icons (hereinafter “toolbar 
buttons”) of the preset menus and “Customize Settings” which enable to change the toolbar buttons 
displayed on the toolbar in accordance with the intended use.

Standard Buttons

When “Standard Buttons” is selected from the Toolbars in View menu, toolbar buttons of the commonly 
used menus are always displayed on the toolbar. Click an icon to gain access to the functions listed in the 
table below.

Continued on next page

No. 
 Menu 

Category
Item Function

Reference 
Page

 (1) System Connect Displays the [Connect] screen. Estab-
lishes a communication link with the 
SV9300.

Page 2-7

 (2) Disconnect Displays the [Disconnect] screen. Clears a 
communication link with the SV9300.

Page 2-19

 (3) Tools Connection 
Accounts

Displays the [Connection Accounts] 
screen. Creates and verifies a connection 
account.

Page 9-2

 (4) Edit Quick Setup Displays the [Quick Setup] screen. Page 4-6

 (5) Command Displays the [Command] screen. Page 7-3

 (6) Tools Script Displays the [Script] screen. Page 4-90

(3)(1) (2) (4) (5) (6) (7) (9) (10)(8)

(Standard Buttons)
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Toolbar

No. 
 Menu 

Category
Item Function

Reference 
Page

 (7) System System Data 
Backup

Displays the [System data Backup] 
screen.

Page 2-20

 (8) Copy System 
Data to Remote 
Units

Displays the [Copy System Data to 
Remote Units] screen.

Page 2-22

 (9) Maintenance 
Report

Displays the [Maintenance Report] 
screen. Edits and creates the maintenance 
report.

Page 4-287

 (10) Help Help Displays the PC Programming Manual for 
this user class.
* Adobe Reader is required to view the 

guide.

–
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Customize Settings

When you want to edit (add/remove) the toolbar buttons displayed on the toolbar in accordance with the
intended use, you can edit them on the [Customize Settings] screen.
To display the [Customize] screen, click [View] > [Toolbars] > [Customize...] in this order on the Main
Menu.

No. Item Description

(1) [Add >>] button Click to add the toolbar button selected in the Available toolbar 
buttons area.

(2) [<< Remove] button Click to remove the toolbar button selected in the Current toolbar 
buttons area.

(3) [Move Up] button Click to move up the toolbar button selected in the Current toolbar 
buttons area.

(4) [Move Down] button Click to move down the toolbar button selected in the Current 
toolbar buttons area.

(5) Available toolbar buttons 
area

Displays the list of toolbar buttons available for the toolbar.

(6) Current toolbar buttons 
area

Displays the list of toolbar buttons currently used.

(7) [Reset] button Click to return the setting of Current toolbar buttons area to the 
default setting (Standard Buttons).

(1)

(5)

(2)

(3)

[Cancel] button
[OK] button

(4)

(6)

(7)
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Toolbar

In the [Customize] screen, you can edit (add/remove) the toolbar buttons as shown the table below.

Continued on next page

 Menu 
Category

Item Icon Function
Reference 

Page

System Connect Displays the [Connect] screen. Estab-
lishes a communication link with the 
SV9300.

Page 2-7

Disconnect Displays the [Disconnect] screen. Clears 
a communication link with the SV9300.

Page 2-19

System Data 
Backup

Displays the [System Data Backup] 
screen.

Page 2-20

Copy System Data 
to Remote Units

Displays the [Copy System Data to 
Remote Units] screen.

Page 2-22

System Data Save/
Load/Verify

Displays the [System Data Save/Load/
Verify] screen.

Page 4-270

Reset Displays the [Reset] screen. Page 4-282

Software License 
Authentication

Displays the [Software License Authen-
tication] screen.

Page 4-42

Fault Display Displays the [Fault Display] screen. Page 4-268

System Check and 
Report

Displays the [System Check and Report] 
screen.

Page 4-251

Maintenance 
Report

Displays the [Maintenance Report] 
screen. Edits and creates the mainte-
nance report.

Page 4-287

Port Status/
Lamp Status

Displays the [Port Status/Lamp Status] 
screen.

Page 4-256

Program Upgrade 
(On-line)

Displays the [Program Upgrade (On-
line)] screen.

Page 4-61

Program Upgrade 
(Off-line)

Displays the [Program Upgrade (Off-
line)] screen.

Page 4-73

Firmware Upgrade
(Line/Trunk 
Blade)

Displays the [Firmware Upgrade (Line/
Trunk Blade)] screen.

Page 4-77
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Continued on next page

 Menu 
Category

Item Icon Function
Reference 

Page

System Trace 
Information...

Displays the [Trace Information] screen. 
Enable to confirm trace information 
transmitted from the SV9300 randomly.
* This menu is reserved for NEC techni-

cians and need not be used in most 
situations.

Page 7-12

Edit Command Displays the [Command] screen. Page 7-3

Quick Setup Displays the [Quick Setup] screen. Page 4-6

Blade 
Configuration

Displays the [Blade Configuration] 
screen.

Page 4-29

Speed Dialing Displays the [Speed Dialing] screen. Page 4-125

Call Pickup Group Displays the [Call Pickup Group] screen. Page 4-170

UCD Group Displays the [UCD Group] screen. Page 4-183

Station Hunting 
Group

Displays the [Station Hunting Group] 
screen.

Page 4-197

User Web Portal 
Management

Displays the [Web Server Settings] 
screen.

Page 4-210

Terminal 
Phonebook

Displays the [Terminal Phonebook] 
screen.

Page 4-230

Tools Connection 
Accounts...

Displays the [Connection Accounts] 
screen. Creates and verifies a connection 
account.

Page 9-2

Change 
Password...

Displays the [Change Password] screen. Page 9-12

Script Displays the [Script] screen. Page 4-90

Station Copy/
Key Copy

Displays the [Station Copy/Key Copy] 
screen.

Page 4-103

Options Displays the [Options] screen. Page 9-39
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Toolbar

To edit (add/remove) the toolbar buttons, do the following procedures.

Adding Toolbar Buttons

STEP1: Select the toolbar button to add from the Available toolbar buttons area.

NOTE: You cannot select more than one toolbar button at a time.

STEP2: Click the [Add] button.
The selected toolbar button is added in the Current toolbar buttons area.

Tips: When Resetting to the Default Setting
Click the [Reset] button if you want to reset the toolbar indication to the default setting
(Standard Buttons).

STEP3: Repeat the operations from STEP1 to STEP2, if necessary.

STEP4: Change the order of the toolbar using the [Move Up] button or the [Move Down] button, if 
necessary.

STEP5: Click the [OK] button.
The selected toolbar button is added on the toolbar.

 Menu 
Category

Item Icon Function
Reference 

Page

Tools FTP Server 
Settings...

Displays the [FTP Server Settings] 
screen.

Page 9-43

HTTP Server 
Settings...

Displays the [HTTP Server Settings] 
screen.

Page 9-47

Communication 
Log...

Displays a log of real-time communica-
tions sessions between PCPro and the 
SV9300.
* This menu is reserved for NEC techni-

cians and need not be used in most 
situations.

–

Help Help Displays the PC Programming Manual 
for this user class.
* Adobe Reader is required to view the 

guide.

–
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Removing Toolbar Buttons

STEP1: Select the toolbar button to remove from the Current toolbar buttons area.

NOTE: You cannot select more than one toolbar button at a time.

STEP2: Click the [Remove] button.
The selected toolbar button returns in the Current toolbar buttons area.

Tips: When Resetting to the Default Setting
Click the [Reset] button if you want to reset the toolbar indication to the default setting
(Standard Buttons).

STEP3: Repeat the operations from STEP1 to STEP2, if necessary.

STEP4: Change the order of the toolbar using the [Move Up] button or the [Move Down] button, if 
necessary.

STEP5: Click the [OK] button.
The selected toolbar button is removed from the toolbar.

The toolbar editing has now been completed.
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Submenu

Submenu

Displays the submenu associated with the mode selector tab being selected.

<Mode: ST--Standard Mode, WZ--Wizard Mode, SD--System Data Mode, CM--Command Mode>

Continued on next page

No. Item Description

Mode:
: Applicable

–: Not applicable
Reference 

Page

ST WZ SD CM

(1) Search Charac-
ter entry field

Type part of the name of the func-
tion you want to search for.

– –  – Page 6-6

(2) [Start] button Click to launch a search. – –  –

(3) View Search 
Results field

Displays search results. Click a 
search result to open a setup screen 
in the work window.

– –  –

(4) “Within com-
mand parame-
ters” check box

Specify whether command parame-
ters are included as search objects or 
not. 

– –  –

(6)

(4)
(2)

(6)

(5)

(8)

(7)

(6)

(7)
(8)

(6)

(1)
(3)

<Standard Mode> <Wizard Mode> <System Data Mode> <Command Mode>
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Submenu

<Mode: ST--Standard Mode, WZ--Wizard Mode, SD--System Data Mode, CM--Command Mode>

No. Item Description

Mode:
:Applicable

–:Not applicable
Reference 

Page

ST WZ SD CM

(5) Search Status 
Display field

Displays a search status and the 
number of search results.

– –  –

(6) Submenu display Displays mode-specific submenus. 
Click a menu choice to open a setup 
screen in the work window.
For mode details, see the chapters 
suggested at right. 

    Standard 
Mode 
Page 4-2

Wizard 
Mode 
Page 5-2

System Data 
Mode 
Page 6-2

Command 
Mode 
Page 7-2

(7) [Expand All] 
button

Click to expand the entire submenu 
tree.

–   – –

(8) [Collapse All] 
button

Click to collapse the entire tree 
view.

–   – –
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Work Window

Displays a screen for configuring the functions selected from the main menu, toolbar and submenus.

No. Item Description

(1) Screen selector tab Displays the title of the screen that is on display on the tab. Click the tab to 
change screen. 
To close the screen, right-click on the tab and click “Close” or place the 
mouse pointer over the tab and click the [Close] button.

(2) Setup screen Select and enter data, execute processing and verify settings all through this 
window.

(1)

(2)
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Mode Selector Tabs

Mode Selector Tabs

No. Item Description
Reference 

Page

(1) [Standard] tab Switches the submenu view to Standard Mode. Page 4-2

(2) [Wizard] tab Switches the submenu view to Wizard Mode. Page 5-2

(3) [System Data] tab Switches the submenu view to System Data Mode. Page 6-2

(4) [Command] tab Switches the submenu view to Command Mode. Page 7-2

(1) (2) (3) (4)
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Status bar

No. Item Description

(1) User Name Displays the name of the user who has logged in to PCPro.

(2) Connection 
Account

Displays the connection account of the SV9300 or Virtual PBX with which 
PCPro has established a communication link.
* Displays only when connecting with the SV9300 or Virtual PBX.

(3) BIOS Version 
Information

Displays the BIOS version of the SV9300 with which PCPro has estab-
lished a communication link.
• When not connected to the SV9300 

or connected to Virtual PBX: BIOS:
• When connected to the SV9300: BIOS: xx

(4) Version 
Information

Displays the version number of the CPU software installed on the SV9300 
or Virtual PBX with which PCPro has established a communication link.
* Displays only when connecting with the SV9300 or Virtual PBX. For Vir-

tual PBX, the virtual software version is displayed.

(5) Unit No. 
Information

Displays the Unit No.of the SV9300 with which PCPro has established a 
communication link.
• 01 to 50
* Displays only when connecting with the SV9300.

(6) Dual CPU 
Information

Displays the ACT CPU of the SV9300 with which PCPro has established a 
communication link.
• Dual CPU (CPU0)/Dual CPU (CPU1)
*1 Displays only for Dual CPU (Unit01-04).
*2 Displays only when connecting with the SV9300.

(5) (6)(4)(2)(1) (3)
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Standard Mode

Standard Mode is suited for completing complex of setup.

• Streamlines the complexities of setup and verification work.
• Achieves functionality beyond reach of command entry.
• Minimum operational effort needed to enter massive data simultaneously.

This chapter explains how to switch to Standard Mode, use Stan-
dard Mode and to set each menu items. 

• Switching to Standard Mode
• Using Standard Mode
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Switching to Standard Mode

You can switch the submenu display to Standard Mode in one of the following operations:
• Click mode selector tab [  Standard].
• On the Main Menu, click [Edit] > [Standard] in this order.

On the Main Menu,
[Edit] > [Standard]

Mode selector tab
 [    Standard]
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Using Standard Mode

Click a menu choice appearing on a submenu to open a setup screen in the work window. Work with the
setup screen as instructed in the page shown in the Refer column.

Continued on next page

Submenu 
Category

Menu Choice Description
Reference 

Page

Implement Quick Setup Displays the [Quick Setup] screen. Pro-
vides initial settings to the SV9300 
(Unit01).

Page 4-6

Blade Configuration Displays the [Blade Configuration] screen. 
Registers blades on the SV9300.

Page 4-29

Upgrade Software License 
Authentication

Displays the [Software License Authenti-
cation] screen. Registers/deletes software 
licenses.

Page 4-42

Program Upgrade 
(On-line)

Displays the [Program Upgrade (On-line)] 
screen. Upgrades the CPU software in On-
line.

Page 4-61

Program Upgrade 
(Off-line) 

Displays the [Program Upgrade (Off-line)] 
screen. Upgrades the CPU software in Off-
line.

Page 4-73

Standard Mode
submenu
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Continued on next page

Submenu 
Category

Menu Choice Description
Reference 

Page

Upgrade Firmware Upgrade 
(Line/Trunk Blade)

Displays the [Firmware Upgrade (Line/
Trunk Blade)] screen. Extracts line/trunk 
blades requiring the firmware upgrade and 
upgrades the firmwares for all blades at 
once.

Page 4-77

Tools Script Displays the [Script] screen. Runs the sys-
tem data scripts.

Page 4-90

Station Copy/Key 
Copy

Displays the [Station Copy/Key Copy] 
screen. Copies key data (station data), 
copies/assigns new stations and moves/
swaps stations.

Page 4-103

Service Speed Dialing Displays the [Speed Dialing] screen.
Displays a list of Speed Dialing usage and 
sets the Station Speed Dialing and the 
System Speed Dialing.

Page 4-125

Call Pickup Group Displays the [Call Pickup Group] screen. 
Adds, edits and deletes the Call Pickup 
Group.

Page 4-170

UCD Group Displays the [UCD Group] screen. Adds, 
edits and deletes the UCD Group.

Page 4-183

Station Hunting 
Group

Displays the [Station Hunting Group] 
screen. Adds, edits and deletes the Station 
Hunting Group.

Page 4-197

User Web Portal 
Management

Displays the [Web Server Settings] screen. 
Performs required settings to manage the 
User Web Portal and collects logs.

Page 4-210

Terminal Phonebook Displays the [Terminal Phonebook] screen. 
Assigns the Terminal Phonebook data 
made by Excel to PCPro, and then changes 
the data into a zip file which is possible to 
download onto the DT900 Series.

Page 4-230
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Submenu 
Category

Menu Choice Description
Reference 

Page

Maintenance System Check and 
Report

Displays the [System Check and Report] 
screen. Displays the check result of system, 
system configuration of the SV9300, 
details of line/trunk blades and port infor-
mation in the HTML format. Also checks 
whether the duplicate IP addresses exist or 
not, and detects line/trunk blades requiring 
the firmware upgrade.

Page 4-251

Port Status/Lamp 
Status

Displays the [Port Status/Lamp Status] 
screen. Enable to confirm the status of each 
busy trunk, list of busy stations, LED indi-
cation of a selected blade and busy status 
of a selected trunk number (idle/busy/etc.).

Page 4-256

Fault Display Displays the [Fault Display] screen. Enable 
to confirm information about errors present 
on the SV9300.

Page 4-268

System Data Save/
Load/Verify

Displays the [System Data Save/Load/Ver-
ify] screen. Performs any of the following 
operations:
• Save registered system data on the 

SV9300 to PCPro.
• Loads the system data saved on the 

PCPro into the SV9300.
• Compares the system data saved on the 

SV9300 and that saved on PCPro and 
checks for differences between the two 
copies of the data.

Page 4-270

Reset Displays the [Reset] screen. Resets the 
CPU, Line/Trunk Blades, and IP Trunk 
(P2P CCIS).

Page 4-282

Maintenance Report Displays the [Maintenance Report] screen. 
Edits and creates the maintenance report.

Page 4-287
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[Implement] Category

The [Implement] category is organized into two submenus as followings:
• Quick Setup
• Blade Configuration Page 4-29

Quick Setup

The [Quick Setup] menu lets you complete default setting, the system clock, IP address, station and trunk
on the SV9300 (unit number 01) in easy procedures based on onscreen guidance. Follow these steps:

STEP1: Take one of these actions:
• Click submenu [Quick Setup] in Standard Mode.
• On the Main Menu, click [Edit] > [Quick Setup] in order.
• Click  on the toolbar.
Displays [Quick Setup] screen in the work window.

STEP2: Proceed with each default setting in the order of buttons.
For subsequent operations, refer to the detailed explanations of the individual buttons.

[1] button

[2] button

[3] button

[4] button

[5] button

[6] button

[7] button

[Completion]
 button

[Quick Setup]
Menu
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NOTE 1: System data that has been configured through the button [2] to [7] button screens is not applied 
to the SV9300 until a write operation is performed in the screen invoked by clicking the [Com-
pletion] button.

NOTE 2: For a detailed description of item settings, refer to the “Command Manual”.

Button 
Name

Setup Item Description Refer

[1] Clear all System Data/
SRAM (CM00/CMEC)

Clears all system data/SRAM on the 
SV9300.

Page 4-8

[2] Date/Time and 
Language Settings
(CM02/CM04/CM0B)

Sets the Date & Time and the language used 
on the SV9300.

Page 4-10

[3] System Network 
Settings (CM0B)

Sets the IP addresses of the SV9300 and the 
RTP port (VoIPDB).

Page 4-11

[4] Setting of Numbering 
Plan (CM20)

Sets a numbering plan for the station and the 
trunk route access.

Page 4-14

[5] Station Setup (CM05/
CM10/CM12/CM77)

Registers a LC/DLC blade and sets a station 
number and relevant data.

Page 4-15

[6] IP Station Setup 
(CM10/CM12/CM77) 

Configures IP Station. Page 4-18

[7] Trunk Setup (CM05/
CM10/CM30/CM35)

Registers a trunk blade and sets trunk data. Page 4-21

[Completion] Upload configuration to 
the System

Writes the system data configured through 
the screen to the SV9300. Also, creates the 
script files of the system data.

Page 4-26
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Clear all System Data/SRAM (CM00/CMEC) 

Clear all System Data/SRAM on the SV9300 in the following steps:

STEP1: Click the [1] button in the [Quick Setup] screen.
The [1.Clear all System Data/SRAM] screen is displayed in the work window.

STEP2: Set the [SENSE] switch to “E” (OFF-line) on the CPU blade mounted in the SV9300.
STEP3: Press the [RESET] button on the CPU blade to reset.

Press the CPU blade [RESET] button and the lamps will change in their states as described
below.

* Either S1 or S2 becomes blinking green fast or off state.

STEP4: Check that the SV9300 has restarted.
Check that the RUN lump on the CPU blade indicates a normal state (blinking blue slowly). 

STEP5: Reconnect the communication link with the SV9300
Clear the communication link: click [System] > [Disconnect] ( Page 2-19 ), then estab-
lish the link: click [System] > [Connect] ( Page 2-16 ).
Connect the Connection Account by default accounts.

Change
Lamp States

RUN SYSD S1 S2

Press the [RESET] 
button

Off Off Off Off

 Lighting blue Off Blinking green 
fast/Off*

Blinking green 
fast/off*

 Off Blinking red 
fast

Off Off

 Off Off Off Blinking green 
fast

Normal state Blinking blue 
slowly

Off Off Off
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STEP6: Click [Clear All System Data/SRAM] button.

A dialog box is displayed to confirm the execution of System Data/SRAM All Clear.

STEP7: Confirm the [SENSE] switch on the CPU blade is set on “E” (OFF-line) and click the [Yes] 
button.

After a while, the SYSD lamp of CPU blade will turn from blinking red to light off at the
completion of Clear All System Data/SRAM, accompanied by the appearance of a dialog
box indicating its completion.

STEP8: Click the [OK] button.

You are directed back to the [Quick Setup] dialog box. Checked mark appears to the right of
button [1].

[Clear All System Data/
SRAM] button

[Yes] button

[OK] button
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STEP9: Return the [SENSE] switch to “1” (On-line) on the CPU blade.
The SV9300 is automatically reset when the [SENSE] switch of the CPU blade is set to “1” 
(On-line).

All system data previously assigned to SV9300 is cleared.

Date/Time and Language Settings (CM02/CM04/CM0B) 

Set the Date/Time and the language used on the SV9300 in these steps:

STEP1: Click the [2] button in the [Quick Setup] screen.
[2. Date/Time and Language Settings] screen is displayed in the work window.

STEP2: Set items (1) to (3).

(1)

(3)

(2)

[OK] button
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STEP3: Click the [OK] button.
You are directed back to the [Quick Setup] screen. Checked mark appears to the right of but-
ton [2].

The Date/Time and the language have now been set.

System Network Settings (CM0B) 

Set the IP addresses of the SV9300 (CPU blade) and the RTP port (VoIPDB) in these steps:

STEP1: Click the [3] button in the [Quick Setup] screen.
The [3. System Network Settings] screen is displayed in the work window.

No. Item Description

(1) Set Time by PC 
Clock (CM02) 
check box

Mark the check box to adjust the setting of the SV9300 to the Date/
Time of the PC displayed on the screen (default: checked).

(2) Set Time by SNTP 
(CM0B/CM02) 
check box

Mark the check box to adjust the following setting of the SNTP
Server (default: unchecked).
• SNTP Server Address (IPv4) : 0.0.0.1 to 255.255.255.254 

(default: blank)
• UTC Time Zone Offset : No Time Difference/UTC +23:45 to 

UTC -23:45 (default: UTC -06:00)

(3) Multiline Terminal 
Display Language 
(CM04) field

Choose the language displayed in the LCD of Multiline Terminal.

- Japanese
- English
- French (Canadian 

French)
- Spanish (Latin 

Spanish)
- Portuguese (Brazil-

ian Portuguese)
- German

- Italian
- Netherlandish
- French (Europe)
- Spanish (Europe)
- Portuguese 

(Europe)
- Swedish
- Danish
- Catalan

- Japanese Kanji
- Russian
- Turkish
- Simplified Chinese 
- Traditional Chinese 
- English (Default)
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STEP2: Set items (1) to (8) for the SV9300 (CPU blade) and RTP (VoIPDB blade).
 

Continued on next page

No. Item Description

(1) IP Address field Enter the IP addresses of the SV9300 maintenance port and VOIP port 
(UDP/TCP).
• 0.0.0.1 to 255.255.255.254

(default: see “SV9300 IP Address” Page 2-11)

(2) Subnet Mask field Enter the subnet masks of the SV9300 maintenance port and VOIP 
port.
• 255.0.0.0 to 255.255.255.252

(default: see “SV9300 IP Address” Page 2-11) 
• Make sure that subnet mask of the maintenance port and VOIP port 

are not the same. 

(3) Default Gateway 
field

Enter the default gateways of the SV9300 maintenance port and VOIP 
port.
• 0.0.0.1 to 255.255.255.254 (default: blank)
• There are the following conditions when setting the Default Gateway 

Address by this command.
- Only one Default Gateway Address can be set for each unit.
- Set the Default Gateway Address to the Maintenance port (Y=0XX) 

when not using VoIPDB.
- Set the Default Gateway Address to the VOIP port (Y=1XX) when 

using VoIPDB.

[OK] button

(1)

(6)

(8)

(1)

(5)

(2)

(2)
(9)

(3)

(3)

(7)

(4)
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STEP3: Click the [OK] button.
You are directed back to the [Quick Setup] screen. Checked mark appears to the right of but-
ton [3].

The IP addresses of maintenance port and VOIP port have now been set.

No. Item Description

(4) RTP Channel Count 
selection field

Select the number of RTP channels used on the VoIPDB from a drop-
down list for display.
• Selection range: 16 to 128 (in groups of 16 channels)

(default: all channels on the mounted blade 64/128)

(5) IP Address field Enter the IP address (RTP) of the VOIP port.
• 0.0.0.1 to 255.255.255.254
* By the Units to be set, the default of the IP addresses for VOIP 

(RTP) port when the SV9300 has launched with standard system 
data are as follows (no data is set when system data/SRAM of the 
SV9300 is all cleared or the SV9300 is in an off-line state [SENSE 
switch of the CPU blade is set to “E/F”]).
- Unit01: 172.16.1.2
- Unit02: 172.16.2.2
- Unit03: 172.16.3.2
- Unit04: 172.16.4.2

(6) IP Address field Enter the IP Address (Primary) of the DNS Server (Option (IPv4)).
• 0.0.0.1 to 255.255.255.254 (default: blank)

(7) Enter the IP Address (Secondary) of the DNS Server (Option (IPv4)).
• 0.0.0.1 to 255.255.255.254 (default: blank)

(8) Enter the Global IP Address of the NAT (Option (IPv4)).
• 0.0.0.1 to 255.255.255.254 (default: blank)

(9) [Clear] button Click to reset the complete set of data to the defaults.
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Setting of Numbering Plan (CM20) 

Set a station and trunk route numbering plan in these steps:

STEP1: Click the [4] button in the [Quick Setup] screen.
The [4. Setting of Numbering Plan] screen is displayed in the work window.

STEP2: Set items (1) to (4).
Along with the station and trunk route, you can set two patterns of access number.

STEP3: Click the [OK] button.
You are directed back to the [Quick Setup] screen. Checked mark appears to the right of but-
ton [4].

The numbering plan has now been configured.

No. Item Description

(1) Station Station Number 
(Digits) field

Select a station number length.
• 1 to 8 digits (default: 4 digits)

(2) Access Code field Select a station number access code.
• Up to 4 digits [0 to 9, *, #, blank field] (default: upper...4, 

lower... 3) 

(3) Trunk 
Route

Trunk Route 
(Route Number) 
field

Select a trunk route number.
• 00 to 63 (default: upper...01, lower...02) 

(4) Access Code field Select a trunk route access code.
• Up to 4 digits [0 to 9, *, #,blank field] (default: blank field 

= not set) 

[OK] button

(1)
(2)
(1)
(2)
(3)
(4)
(3)
(4)
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Station Setup (CM05/CM10/CM12/CM77) 

Register LC/DLC blades, and set the station number of a Single Line Telephone or Digital Multiline
Terminal and relevant data in these steps:

STEP1: Click the [5] button in the [Quick Setup] screen.
The [5. Station Setup] screen is displayed in the work window.

STEP2: Right-click on the slot in which you are about to register the LC/DLC blade in Blade Display 
Area.
Right-click menu is displayed.

No. Item Description

(1) [Zoom In] button Right click to register the selected blade in the Blade Display Area.

(2) Blade Display Area Displays the slot configuration of SV9300. Registers the LC/DLC 
blades on the SV9300.

(1)

(2)

[OK] button

Right-click menu
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STEP3: Click the LC/DLC blade mounted in the slot in the right-click menu. 
The blade name is displayed on the blade in the Blade Display Area.

STEP4: Click the [Zoom In] button.
The [5. Station Setup > Zoom In] screen is displayed in the work window.

STEP5: Set item (3).

Right-Click Menu Description

Telephone (LC) Choose one of the following combination of LC blades mounted:
• LC(8+8): GCD-8LCF + GPZ-8LCF/CD-8LCA + PZ-8LCE
• LC(8) : GCD-8LCF/CD-8LCA
• LC(4+4): GCD-4LCF + GPZ-4LCF/CD-4LCA + PZ-4LCA
• LC(4) : GCD-4LCF/CD-4LCA
• LC(4+8): GCD-4LCF + GPZ-8LCF/CD-4LCA + PZ-8LCE
• LC(8+4): GCD-8LCF + GPZ-4LCF/CD-8LCA + PZ-4LCA

Telephone (DLC) Choose one of the following combination of DLC blade mounted:
• DLCA(16) : GCD-16DLCA/GCD-16DLCA-A/CD-16DLCA
• DLCA(8+8): GCD-8DLCA + GPZ-8DLCB/CD-8DLCA + PZ-8DLCB
• DLCA(8) : GCD-8DLCA/GCD-8DLCA-A/CD-8DLCA

Delete Blade Click to delete the information about the blade mounted in the slot.

(1) (2)

(3)

[OK] button
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No. Item Description

(1) [Fill In] button Click to apply the settings entered on the first line to other 
lines as well.
• STN No. field

Station numbers are assigned in sequential numbering 
from the first line. 
* Numbers containing * or # cannot be set.
Automatic entry stops before first digit of a station number 
change (example: 3999). 

• TN No., RFC (Day)/(Night), SFC (A)/(B)/(C) fields:
The same values as the first line are set.

• Port No. and Name Display fields:
Out of the scope of continuous entry.

(2) [Clear] button Click to initialize the settings to their defaults.

(3) System Data 
Setup Area

Port No. field Displays the Port number (unit number + slot number + line 
number) of the line that houses a Single Line Telephone or 
Digital Multiline Terminal.

STN No. field Enter a station number associated with the port number. 
Up to 8 digits [0 to 9, *, #, blank field] (default: A station 
number is entered automatically when it is entered accord-
ing to the numbering plan setting.) 

TN No. field Select a station tenant number.
• 00 to 63 (default: 01) 

RSC (Day)/
(Night) field

Select the trunk restriction class of each station: 
• Unrestricted (RCA)/Non-Restricted 1 (RCB)/Non-

Restricted 2 (RCC)/Semi-Restricted 1 (RCD)/Semi-
Restricted 2 (RCE)/Restricted 1 (RCF)/Restricted 2 
(RCG)/Fully-Restricted (RCH) (default: Unrestricted 
(RCA))

SFC (A)/(B)/
(C) field

Select the service restriction class A, B or C of each station.
• 00 to 15 (default: 15) 

Name Dis-
play field

Enter a station name displayed on LCD of the Digital Multi-
line Terminal. (default: blank)
• Up to 16 characters
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STEP6: Click the [OK] button.
You are directed back to the [5. Setting of Station] screen.

STEP7: Click the [OK] button.
You are directed back to the [Quick Setup] screen. Checked mark appears to the right of but-
ton [5].

The Station has now been configured.

IP Station Setup (CM10/CM12/CM77) 

Configure the basic settings of the IP Station.

STEP1: Click button [6] in the [Quick Setup] screen.
The [6. IP Station Setup] screen appears in the work window.

STEP2: Set the items listed in (3).

(1) (2)

(3)

[OK] button
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No. Item Description

(1) [Fill In] button Click to apply the settings entered on the selected line to other 
lines as well. For the operating instructions, see “Using the [Fill 
In] Button”. Page 4-20
• STN No. field

Station numbers are assigned in sequence starting from the one 
on the selected line. In all cases duplicate station numbers are 
assigned in sequence.
*  Numbers containing * or # cannot be set. Before the starting 

digit of a station number changes, automatic entry stops with 
the preceding station number (example: 3999).

 * “F” is automatically added even if the station number that “F” 
is not added to the lead of station number is entered.

• TN No, RSC (Day)/(Night) and SFC (A)/(B)/(C) fields
The same values as appearing on the first line are set.

• Port No. and Name Display fields
Out of the scope of continuous entry.

(2) [Clear] button Click to initialize the settings to their defaults.

(3) System 
Data Setup 
Area

Port No. 
field

Displays the number of the port that houses the IP Station.

STN No. 
field

Enter a station number associated with the port number (0000 to 
1023) according to the numbering plan setting.
• Up to 8 digits [0 to 9, *, #, blank field] 

TN No. 
field

Select a station tenant number.
• 00 to 63 (default: 01)

RSC 
(Day)/
(Night) 
field

Select the trunk restriction class of each station: 
• Unrestricted (RCA)/Non-Restricted 1 (RCB)/Non-Restricted 2 

(RCC)/Semi-Restricted 1 (RCD)/Semi-Restricted 2 (RCE)/
Restricted 1 (RCF)/Restricted 2 (RCG)/Fully-Restricted (RCH) 
(default: Unrestricted (RCA))

SFC (A)/
(B)/(C) 
field

Select the service restriction class A, B or C of each station.
• 00 to 15 (default: 15) 

Name Dis-
play field

Enter a station name displayed on LCD of the IP Station. (default: 
blank)
• Up to 16 characters
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Tips: Using the [Fill In] Button
Click the [Fill In] button to display the dialog box shown below. Enter the number of lines
into which station numbers are to be entered continuously into the Line Input field and click
the [OK] button.

You are directed back to the [6. Setting of IP Station] screen, and station numbers and rel-
evant data are entered into the second and subsequent lines automatically.

STEP3: Click the [OK] button.
The [Quick Setup] screen appears again, with a check mark to the right of button [6].

The IP Station has now been configured.

[OK] button
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Trunk Setup (CM05/CM10/CM30/CM35) 

Register a trunk blade and configure relevant trunk data.

STEP1: Click the [7] button in the [Quick Setup] screen.
The [7. Trunk Setup] screen is displayed in the work window.

STEP2: (2) Right-click the slot of the trunk blade to be registered in the Blade Display Area.
Right-click menu is displayed.

No. Item Description

(1) [Zoom In] button Click to display a preferences screen for the blade selected in the Blade 
Display Area.

(2) Blade Display Area Displays slot configuration of the SV9300. Registers the trunk blades 
to the SV9300.

(1)

(2)

[OK] button

Right-click menu
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STEP3: On the right-click menu, click the trunk blade mounted in the slot.
The blade name is displayed on the slot in the Blade Display Area.

STEP4: Click the [Zoom In] button.
The [7. Trunk Setup > Zoom In] screen is displayed in the work window.

Right-Click Menu Description

Trunk (COT) Choose one of the following combination of COT blade (Central office 
trunk) mounted:
• COT(4) : GCD-4COTC/GCD-4COTC-A/GCD-4COTB/

GCD-4COTB-A/GCD-4COTA/CD-4COTC/CD-4COTB/
CD-4COTA

• COT(4+4): GCD-4COTC + GPZ-4COTG/GPZ-4COTG-A
GCD-4COTC-A + GPZ-4COTE/GPZ-4COTG/
GPZ-4COTG-A
GCD-4COTB + GPZ-4COTF/GPZ-4COTF-A
GCD-4COTB-A + GPZ-4COTF/GPZ-4COTF-A
GCD-4COTA + GPZ-4COTE/GPZ-4COTG-A
CD-4COTC + PZ-4COTG/CD-4COTB + PZ-4COTF/
CD-4COTA + PZ-4COTE

Trunk (BRT) Choose one of the following combination of BRT blade (BRI trunk) 
mounted:
• BRI(4) : GCD-2BRIA/CD-2BRIA
• BRI(4+4) : GCD-2BRIA + GPZ-2BRIA/CD-2BRIA + PZ-2BRIA

Trunk (PRT) Choose the PRT blade (PRI trunk):
• PRT: GCD-PRTA/CD-PRTA

Delete Blade Click to delete the blade information setting in the slot.
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STEP5: Set item (4).

(2)

(4)

(3)

(1)

[OK] button
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Continued on next page

No. Item Description

(1) Trunk Blade No. field Select the trunk blade number.
• 000-127

* Unassigned trunk blade number is automatically dis-
played in the Trunk Blade No. field.

(2) [Fill In] button Click to apply the settings entered on the first line to other 
lines as well.
• Trunk No. field

Trunk numbers are assigned in sequence starting from the 
one on the first line.
* Duplicate trunk numbers will be set unconditionally. 

Correct those numbers to avoid duplication.
Entry will stop automatically when the trunk number 
equals the maximum (511).

• RT No. field
The same value as that appearing on line 1 is set.
* For blades that require a voice channel and a control 

channel to be routed separately, route numbers are 
assigned automatically.

• TN No./Trunk Type/Incoming Connection Signaling/Ter-
minating System (Day)/(Night) field
The same value as that appearing on line 1 is set.

• Port No./DIT Destination (Day)/(Night) field
Out of the scope of continuous entry.

(3) [Clear] button Click to initialize the settings to their defaults.
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No. Item Description

(4) System 
Data Setup 
Area

Port No. field Displays the number of the Port number (unit number + slot 
number + line number) that houses the trunk.

Trunk No. field Enter a trunk number associated with the Port number with 
three digits.
• 4 digits [“D” + 000 to 511, blank field] (default: “D” + 000 

to 511) 
* If a number is entered without being prefixed by “D”, it 

is automatically prefixed with “D”.
If a number is entered with one or two digits, it is also 
automatically padded with “D00” or “D0”. If a four-digit 
number is entered, it is prefixed with “D” automatically, 
with the last digit being removed.

RT No. field Select a trunk route number according to the numbering plan 
setting.
• 00 to 63 (default: 01)

TN No. field Select a trunk tenant number.
• 00 to 63 (default: 01)

Trunk Type field Select a trunk type.
• DDD (C.O., DID, ISDN, SIP) trunk/FX trunk [North 

America Only]/WATS trunk [North America Only]/
CCSA trunk [North America Only]/TIE (Tie line) 
trunk/Paging Trunk/Not used

Incoming Con-
nection Signaling 
field

Select an Incoming Connection Signaling.

Terminating Sys-
tem (Day)/
(Night) field

Select a Terminating System of each station.

DIT Destination 
(Day Mode/Night 
Mode) field

DIT Destination (Day Mode/Night Mode) can be set only 
when Direct-In Termination is selected at the Terminating 
System (Day)/(Night) field.
• Up to 8 digits [A to F, 0 to 9, blank field] (default: blank 

field)
* Displays only when selecting COT blade.
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STEP6: Click the [OK] button.
You are directed back to the [7. Setting of Trunk] screen.

STEP7: Click the [OK] button.
You are directed back to the [Quick Setup] screen. Checked mark appears to the right of but-
ton [7].

Trunks have now been configured.

Finish

Write the system data that has been configured in the [2] to [7] screens to the SV9300 in these steps:

STEP1: Click the [Completion] button in the [Quick Setup] screen.
The [Upload configuration to the System] screen is displayed in the work window.

[Confirm the System Data
 and output the Script

 file] button
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STEP2: Click the [Confirm the System Data and output the Script file] button.
A listing of the settings completed by Quick Setup is saved to a file in the HTML format.
You can open the “Quick-Setup-confirm.html” to verify the setting, which displays a save
destination on the screen. As for the details of setting data, refer to the “Command Manual”.

STEP3: Click the [Write] button.
A confirm dialog box is displayed, asking confirmation to write system data to the SV9300.

STEP4: Click the [Yes] button.

After the system data has been written to the SV9300, it is saved in flash ROM and the
[Quick Setup > Upload configuration to the System > Write] screen appears.

[Write] button

[Yes] button
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STEP5: Click the [<< Back] button.

You are directed back to the [Quick Setup] screen. 
Checked mark appears to the left of [Completion] button. 

The system data has now been written to the SV9300. Quick Setup is complete.

[<< Back] button
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Blade Configuration

The [Blade Configuration] menu lets you register additional blades, update data on pre-registered data, de-
lete blade information and so on for each Unit. One of the following action will display the [Blade Con-
figuration] screen in the work window:
• Click submenu [Blade Configuration] in Standard Mode.
• On the Main Menu, click [Edit] > [Blade Configuration] in this order.

Continued on next page

No. Item Description

(1) Unit No. field Select the unit number of the SV9300 from which you want to read infor-
mation.
• 01 to 50 (default: 01) 

(2) [Change Unit Num-
ber] buttons

Click to change the number entered in the Unit No. field.
• [Previous] button: Decrement the number by one.
• [Next] button: Increment the number by one.

(1)

(3)

(2)
(6)

(5)

(4)

[Blade
 Configuration]

 menu
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No. Item Description

(3) Blade Display Area View this area to confirm blade mounted in the individual slots in the 
SV9300 or register new blade. Blade names marked in different colors by 
blade type and a clock source status are displayed.
<Blade Name>
• Station blade : Light blue
• Trunk blade : Light yellow
• Other blades : Light red
• Blade without set system data : White
* As for the indication on the Blade Display Area when blades for 

SV8300 are mounted, refer to the “Indication When Blades for SV8300 
Are Mounted”. Page 4-32

<Clock Source Status>
• Sync.(1st) : The blade is set to the first priority blade to 

receive the synchronization signal.
• Sync.(1st) Synchronized : The blade is set to the first priority blade to 

receive the synchronization signal and the 
blade is synchronized.

• Sync.(2nd) : The blade is set to the second priority blade 
to receive the synchronization signal.

• Sync.(2nd) Synchronized: The blade is set to the second priority blade 
to receive the synchronization signal and the 
blade is synchronized.

* The clock source supports only for BRT/PRT/CCT/DTI blade.

(4) [Read] button Click to read blade information from the SV9300 having its unit number 
specified in the Unit No. field.

(5) [Apply] button Click to write edited data to the SV9300.

(6) [Zoom In] button Click to display a preferences screen for the blade selected in the Blade 
Display Area.
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Tips 1: When Confirming the Operation Status for Each Blade
You can confirm the operation status for each blade by the [Blade LED Status] screen of the
Port Status/Lamp Status menu. Page 4-262
To display the [Blade LED Status] screen, do the following operation.
1. Right-click the slot for the appropriate blade in the Blade Display Area.
2. Click [Properties...] on the right-click menu.

The [Blade LED Status] screen is displayed.

NOTE: When connecting with Virtual PBX, the Port Status/Lamp Status menu is not dis-
played. For this reason, [Delete Blade] is displayed on the right-click menu, how-
ever, [Properties...] is not. 

Tips 2: Concerning Displayed Blade Information
• When the blade names are displayed as follows, they mean that the appropriate blades are

mounted in slots and also system data is correctly assigned.
Example: COT(4), LC(8+8), DIOP(LD), PRT and others
* Numeric values such as (4) and (8+8) displayed with the blade name mean the number of

available ports of the mounted blade. For example, LC(8+8) means that the LC blade with
capacity of 16 ports is mounted.

• When the blade name is displayed in brackets or “!” mark is displayed in front of the blade
name, they mean the following states.
- When displayed in brackets : The system data for the appropriate blade has been 

assigned. However, the blade is not mounted in the Slot.
Example: (DLC), (COT), (DIOP(LD))

- When displayed with “!” mark: The system data for the appropriate blade has been 
assigned. However, the blade which differs from the 
assigned system data is mounted in the Slot.
Example: ! DLC, ! COT, ! DIOP(LD)

[Properties...]
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Tips 3: Indication When Blades for SV8300 Are Mounted
When blades for SV8300 are mounted, a blue line on the left side of the blade display and
“*NV” at the end of the blade name appear as follows.

Registering Additional Blades

To register an additional blade, follow these steps:

STEP1: Select a unit number in Unit No. field.
STEP2: Click [Read] button.

A screen is displayed to notify the completion of the data read process.
Blade information is read from the SV9300 having the unit number specified in the Unit No.
field, and information about the blades mounted in the SV9300 is displayed in the Blade Dis-
play Area of the [Blade Configuration] screen.

STEP3: Click the [OK] button.

“*NV”
indication

A blue line

[OK] button
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STEP4: Right-click on the vacant slot on which you want to register an additional blade in Blade Dis-
play Area.
Right-click menu is displayed.

STEP5: On the right-click menu, click the blade mounted in the slot in the SV9300.
The blade name is displayed on the corresponding slot in the Blade Display Area.

Right-Click Menu Description

Telephone (LC) Choose one of the following combination of LC blade mounted:
• LC(4+4) : GCD-4LCF + GPZ-4LCF/CD-4LCA + PZ-4LCA
• LC(4) : GCD-4LCF/CD-4LCA
• LC(4+8) : GCD-4LCF + GPZ-8LCF/CD-4LCA + PZ-8LCE
• LC(8+4) : GCD-8LCF + GPZ-4LCF/CD-8LCA + PZ-4LCA
• LC(8+8) : GCD-8LCF + GPZ-8LCF/CD-8LCA + PZ-8LCE
• LC(8) : GCD-8LCF/CD-8LCA
• DIOP(LLC): GCD-4DIOPA/GCD-4DIOPB/CD-4DIOPA/CD-4DIOPB

Telephone (DLC/
DESKCON) 

Choose one of the following combination of DLC blade mounted:
• DLCA(16) : GCD-16DLCA/GCD-16DLCA-A/CD-16DLCA
• DLCA(8+8) : GCD-8DLCA + GPZ-8DLCB/CD-8DLCA + PZ-8DLCB
• DLCA(8) : GCD-8DLCA/GCD-8DLCA-A/CD-8DLCA

Telephone (ILC) Choose one of the following combination of BRT blade (ILC):
• ILC(2+2) : GCD-2BRIA + GPZ-2BRIA/CD-2BRIA + PZ-2BRIA
• ILC(2) : GCD-2BRIA/CD-2BRIA

Continued on next page

Right-click Menu
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Right-Click Menu Description

Trunk (COT/DID/LD/
OD)

Choose one of the following combination of COT blade (Central office 
trunk) or DIOP/ODT blade (analog leased line trunk) mounted:
• COT(4+4) : GCD-4COTC + GPZ-4COTG/GPZ-4COTG-A

GCD-4COTC-A + GPZ-4COTE/GPZ-4COTG/
GPZ-4COTG-A
GCD-4COTB + GPZ-4COTF/GPZ-4COTF-A
GCD-4COTB-A + GPZ-4COTF/GPZ-4COTF-A
GCD-4COTA + GPZ-4COTE/GPZ-4COTG-A
CD-4COTC + PZ-4COTG/CD-4COTB + PZ-4COTF/
CD-4COTA + PZ-4COTE

• COT(4) : GCD-4COTC/GCD-4COTC-A/GCD-4COTB/
GCD-4COTB-A/GCD-4COTA/CD-4COTC/CD-4COTB/
CD-4COTA

• ODT(4) : GCD-4ODTA/GCD-4ODTB/CD-4ODTA
• DIOP(DID): GCD-4DIOPA/GCD-4DIOPB/CD-4DIOPA/CD-4DIOPB
• DIOP(LD) : GCD-4DIOPA/GCD-4DIOPB/CD-4DIOPA/CD-4DIOPB

Trunk (BRT) Choose one of the following combination of BRT blade (BRI trunk) 
mounted:
• BRI(4+4) : GCD-2BRIA + GPZ-2BRIA/CD-2BRIA + PZ-2BRIA
• BRI(4) : GCD-2BRIA/CD-2BRIA

Trunk (PRT/DTI/CCT/
QSIG) 

Choose one of the following combination of PRT blade (PRI trunk) or DTI/
CCT blade (digital leased line /No.7 common signaling network trunk):
• PRT : GCD-PRTA/CD-PRTA
• CCT : GCD-CCTA/CD-CCTA
• CCT(E1): GCD-CCTA/CD-CCTA
• DTI (T1): GCD-PRTA/CD-PRTA
• QSIG : GCD-PRTA/CD-PRTA
• DTI(E1) : GCD-PRTA/CD-PRTA

CSI Choose the CSI blade mounted:
• CSIB *NV: CD-4CSIB/CD-4CSIB-A

Others Choose the VM00 blade or PVA blade mounted:
• VM00: GCD-VM00/CD-VM00
• PVA : GCD-PVAA/CD-PVAA
• RGA : GCD-RGA/CD-RGA
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STEP6: Click the [Apply] button.
A dialog box appears to let you know the blade reset when selecting a blade required the
blade reset.

STEP7: Click the [Yes] button.

STEP8: Select a registered blade and click the [Zoom In] button or double-click the slot.
A dialog box appears to let you know when the data read is complete. PCPro reads detailed
information from the SV9300 and displays a [Blade Configuration] screen in the work win-
dow.

STEP9: Click the [OK] button.
STEP10: Set item (2).

Click the [Fill In] button after entering the data on the first line, it is useful to set the neces-
sary items.

Continued on next page

No. Item Description

(1) Blade information display 
area

Displays the name of the blade which detailed data is config-
ured, the blade number and the number of the slot in which it is 
mounted.

[Yes] button

(1)

(2)

(7)
(6)

(4)

(3)

(5)
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Continued on next page

No. Item Description

(2) System 
data setup 
area (for 
station 
blades)

Port No. Displays the number of port that houses a Single Line Tele-
phone or Multiline Terminal (unit number + slot number + line 
number).

CKT No. field Displays the line number on the blade.

Station Num-
ber field

Enter an station number associated with the Port number and 
line number according to the numbering plan setting.
• Up to 8 digits [0 to 9, *, #, blank field] (default: blank field)

Name Display 
field

Enter a station name displayed on LCD of the Multiline Termi-
nal. (default: blank)
• Up to 16 characters

Tenant No. 
field

Select a station tenant number.
• 00 to 63 (default: 01)

RSC (Day)/
(Night) field

Select the trunk restriction class of each station:
• Unrestricted (RCA)/Non-Restricted 1 (RCB)/Non-Restricted 

2 (RCC)/Semi-Restricted 1 (RCD)/Semi-Restricted 2 (RCE)/
Restricted 1 (RCF)/Restricted 2 (RCG)/Fully-Restricted 
(RCH) (default: Unrestricted (RCA))

SFC (A)/(B)/
(C) field

Select the service restriction class A, B or C of each station.
• 00 to 15 (default: 15)

System 
data setup 
area (for 
trunk 
blades)

Port No. Displays the number of port that houses the trunk.

CKT No. field Displays the line number on the blade.

Trunk 
Number field

Enter a trunk number associated with the port numbers with 
three digits.
• 4 digits [“D” + 000 to 511, blank field] (default: blank field)

Trunk Route 
field

Select a trunk route number according to the numbering plan 
setting.
• 00 to 63 (default: 01)

Tenant No. 
field

Select a trunk tenant number.
• 00 to 63 (default: 01)
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Continued on next page

No. Item Description

(2) System 
data setup 
area (for 
trunk 
blades)

Trunk Type 
field

Select a trunk kind.
• DDD (C.O., DID, ISDN, SIP) trunk/FX trunk [North 

America Only]/WATS trunk [North America Only]/
CCSA trunk [North America Only]/TIE (Tie line) trunk/
Paging Trunk/Not used

Incoming Con-
nection Signal-
ing field

Select an Incoming Connection Signaling.

Terminating 
System (Day)/
(Night) field

Select a Terminating System of each station.

DIT Destina-
tion (Day)/
(Night) field

DIT Destination (Day Mode/Night Mode) can be set only 
when Direct-In Termination is selected at the Terminating Sys-
tem (Day)/(Night) field.
• Up to 8 digits [A to F, 0 to 9, blank field] (default: blank 

field)
* Displays only when selecting COT blade.

(3) Trunk Blade No. field Select the trunk blade number.
• 000 to 127, NONE (No data) (default: NONE)

(4) [Apply] button Click to write the detailed data settings to the SV9300.

(5) [Cancel] button Click to return to the [Blade Configuration] screen without 
writing the detailed data settings to the SV9300.
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STEP11: Click the [Apply] button.
The settings are written to the SV9300, and you are directed back to the [Blade Configura-
tion] screen. The slots in which additional blades are mounted are checked.
The following dialog boxes are displayed in accordance with the assigned blade after click-
ing the [Apply] button.

No. Item Description

(6) [Fill In] button (for station 
blades) 

Click to apply the settings entered on the first line to other 
lines as well.
• Station number field

Numbers are assigned in sequence starting from the one on 
the first line.
* Numbers containing * or # cannot be set.

Automatic entry stops before the first digit of a station 
number change (example: 3999).

• Tenant No./RSC (Day)/(Night)/SFC (A)/(B)/(C) fields
The same value as that appearing on line 1 is set.

• Port No./CKT No./Name Display fields
Out of the scope of continuous entry.

[Fill In] button (for trunk 
blades)

Click to apply the settings entered on the first line to other 
lines as well.
• Trunk number field

Numbers are assigned in sequence starting from the one on 
the first line.
* Entry will stop automatically when the trunk number 

equals the maximum (511).
• Trunk Route/Tenant No./Trunk Type/Incoming Connection 

Signaling/Terminating System (Day)/(Night) fields
The same value as that appearing on line 1 is set.

• Port No./CKT No./DIT Destination (Day Mode/Night Mode) 
fields
Out of the scope of continuous entry.

(7) [Clear] button Click to initialize the settings to their defaults.
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• LC/LLC/DLC/DESKCON/COT/DID/LD/OD/CSI/VM00/PVA

• PRT/DTI/CCT/QSIG/RGA

• BRT/ILC

STEP12: Click the [Yes] button.
* For PRT/DTI/CCT/QSIG, the following dialog box is displayed after clicking the [Yes]

button. Then click the [Yes] button.

Additional blades have now been registered.

[Yes] button

[Yes] button

[Yes] button

[Yes] button
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Deleting Blade Information

To delete information about a blade registered in the SV9300, follow these steps:

STEP1: Select a unit number in Unit No. field.
STEP2: Click the [Read] button.

A screen is displayed to notify the completion of the data read process.
Blade information is read from the SV9300 having the unit number specified in the Unit
Number field, and information about the blades mounted in the SV9300 is displayed in the
Blade Display Area of the [Blade Configuration] screen.

STEP3: Click the [OK] button.

STEP4: Right-click the slot you want to delete blade information from in Blade Display Area.
[Delete Blade] menu is displayed.

STEP5: Click [Delete Blade] on the right-click menu.
A dialog box is displayed to confirm the deletion of the blade information.

[OK] button

[Delete Blade] menu
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STEP6: Click the [Yes] button.

When the deletion of the blade information for the appropriate slot is completed, a dialog box
is displayed to notify the completion of the process.

STEP7: Click the [OK] button.

NOTE: By now, all blade information has been deleted, including the information registered in the 
[Blade Configuration] screen.

Blade information has now been deleted.

[Yes] button

[OK] button
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[Upgrade] Category

The [Upgrade] Category has three submenus:
• Software License Authentication
• Program Upgrade (On-line) Page 4-61
• Program Upgrade (Off-line) Page 4-73
• Firmware Upgrade (Line/Trunk Blade) Page 4-77

Software License Authentication

The SV9300 requires you to complete a software license authentication procedure using PCPro before you
can use its functions. Follow these steps:

(1) Access the License Management Server (Web server) to download a license data file (*.lic2: all
Software Key Codes and Activation Codes are included) on the basis of the Software Key Code
found in the license sheet supplied with the product.

(2) Register the downloaded license data file from PCPro onto the SV9300.

NOTE: When registering a license data by One-Step Registration, delete the all registered license data 
before registering the license data.

SV9300

Maintenance 
PC (PCPro)

The License 
Management Server 

(Web server)

Using PCPro

IP Network

(2) Register the license data
Using Web browser

(1) Download a license data
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Software license authentication is carried out on the [Software License Authentication] menu. This menu
allows you to register and unregistered software licenses. You can also view the license data registered in
the SV9300.

• Registering a Software License by One-Step Registration Page 4-45
• Verifying a Software License Page 4-49
• Deleting a Software License Page 4-52

Tips: Register a Temporary Activation Code
When replacing the CPU blade due to the breakdown of current CPU blade and others, register 
a temporary Activation Code of the current CPU blade to run the SV9300 temporarily until an 
Activation Code of the new CPU blade is obtained from the License Management Server.

Page 4-55

NOTE 1: Perform software license authentication on the SV9300 with unit number 01.
NOTE 2: Be sure to carry out the software license authentication procedure. Running the system without 

first performing the software license authentication procedure might result in the occurrence of 
alarms, disable functions of key importance to the system or other otherwise the successful 
system operations unpredictable.

NOTE 3: Establish a communication link with the SV9300 before proceeding with software license 
authentication.
For how to establish a communication link, refer “Establishing a Link”. Page 2-16
If the communication link with the SV9300 is cleared, only the following functions are operable:
- License data verification
- Access to the Software License Authentication Center 

NOTE 4: Internet access is required to download a license data file (*.lic2).
NOTE 5: When using the SV9300 with Dual CPU, the Software License Authentication must be executed 

to the Dual CPU (CPU0). When the Dual CPU (CPU1) is in a ACT state, be sure to switch to 
the Dual CPU (CPU0) before doing the this procedures.
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NOTE 6: In software license registrations (the software license registration or the Activation Code 
registration), there are licenses requiring the system reset after license registrations.
The system reset is not required when registering the following software licenses. In this case,
connect the appropriate device to SV9300 after the software license registration. The system
reset is required when registering other software licenses. In this case, set the appropriate 
system data before executing the system reset.
• PORT Capacity
• DtermIP/DT700/DT800 Series
• Soft Phone (DtermSP30/SP350)
• Soft Phone ACD (DtermSP30/SP350)
• Remote Unit
• Standard SIP Terminal
• Embedded Conference
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Registering a Software License by One-Step Registration

When registering a software license by “One-Step Registration”, register the software license according
to the following procedures.

<Registering License Data File>

STEP1: Take one of these actions:
• Click submenu [Software License Authentication] in Standard Mode.
• On the Main Menu, click [System] > [Software License Authentication] in this order.
The [Registration] screen is displayed in the work window.

STEP2: Select the [One-Step Registration] radio button and click the [Next >>] button.
 

The [Selection of License Data File] screen is displayed.

1. Obtain license data file

Access the License Management Server to download a license 
data file (*.lic2: all Software Key Codes and Activation Codes 
are included) on the basis of the Software Key Code found in the 
license sheet supplied with the product.

2. Register license data file
Register the downloaded license data file from PCPro onto the 
SV9300.  Page 4-45

[Software License
 Authentication]

Menu

[Next >>] button

[One-Step
Registration]
radio button
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STEP3: Click the [Select File] button.

A dialog box is displayed to specify the file name and folder.
STEP4: Specify the folder of the file name where the downloaded license data file is saved, and click 

the [Open] button.

You are directed back to the [Select of License Data File] screen, showing where the license
data is stored and the file name in the License Data File Name field.

[License Data File Name]
 display field

[Next >>] button

[Select File] button

[Open] button

Save in field

File name field
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STEP5: Click the [Next >>] button.

The [Confirmation and Registration License Data] screen is displayed.
STEP6: Verify information (1) to (3).

Continued on next page

No. Item Description

(1) License Information Displays the following codes of the SV9300 to which 
PCPro is connected.
• Hardware Key Code
• Activation Code

[Next>>] button

(1)

(2)

(3)

[Register] button
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STEP7: Click the [Register] button.
A dialog box is displayed to notify the completion of the license data registration.

STEP8: Click the [OK] button.
 

The license data is registered onto the SV9300 and the [Confirmation of License Data]
screen is displayed.

No. Item Description

(2) System Version License Infor-
mation

Displays information included-in the license data.
• License data name
• Software key code
• Time and Date of File Preparation
• Order number
• Name/Comment

(3) Capacity/Function/Terminal 
License

Displays information included-in the license data.
• License data name
• Software key code
• Time and Date of File Preparation
• Order number
• Name/Comment

[OK] button
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STEP9: Click the [Complete] button.

You are directed back to the [Registration Type Select] screen.

The software license registration process is completed.

Verifying a Software License

To verify the license data registered in the SV9300, follow these steps:

NOTE: When the Dual CPU (CPU1) is in a ACT state, any license information is not displayed on 
the [Confirmation of License Data] screen (switch to the Dual CPU (CPU0) to confirm the 
license information).

STEP1: Take one of these actions:
• Click submenu [Software License Authentication] in Standard Mode.
• On the Main Menu, click [System] > [Software License Authentication] in this order.
The [Software License Authentication] screen is displayed in the work window.

[Complete] button
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STEP2: Select the [Display Hardware Key Code and Current License Data / Manual Registration] 
radio button and click the [Next >>] button.

The [Software License Authentication] screen is displayed.

STEP3: Select the [1. Confirmation and Registration of License Data (Preparation of PBX Generator 
File)] radio button and click the [Next >>] button.

The [Selection of License Data] screen is displayed.

[Software License
 Authentication]

menu

[Display Hardware
 Key Code and

 Current License
 Data / Manual

 Registration]
 radio button

[Next >>] button

[1. Confirmation and

Registration of License

Data (Preparation of

 PBX Generator File)]

 radio button
[Next >>] button
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STEP4: Click the [Next >>] button.

The [Verification of License Data] screen is displayed.
STEP5: Verify the pre-registered license data displayed in the System Information field.

STEP6: Click the [Complete] button.
You are directed back to the [Software License Authentication] screen.

The license data has now been verified in the SV9300.

[Next>>] button
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Deleting a Software License 

To delete the license data registered in the SV9300, follow these steps:

NOTE: All license data is deleted at once, it cannot be selectively deleted.

STEP1: Click the submenu [Software License Authentication] in Standard Mode.
The [Registration] screen is displayed in the work window.

STEP2: Select the [Display Hardware Key Code and Current License Data / Manual Registration] 
radio button and click the [Next >>] button.

The [Software License Authentication] screen is displayed.

[Software License
 Authentication]

menu

[Display Hardware
 Key Code and

 Current License
 Data / Manual

 Registration]
 radio button

[Next >>] button
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STEP3: Check the [1. Deletion of Software License] radio button and click the [Next >>] button.

The [Deletion of Software License] screen is displayed.

STEP4: Click the [Delete] button.

A dialog box is displayed, verifying deletion of all license data.

[1. Delection of Software

License] radio button
[Next >>] button

[Delete] button
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STEP5: Click the [yes] button

A dialog box is displayed verifying the completion of the license data deletion process.

STEP6: Click the [OK] button.

You are directed back to the [Software License Authentication] screen.

License data has now been deleted.

[Yes] button

[OK] button
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Register a Temporary Activation Code 

When replacing the CPU blade due to the breakdown of current CPU blade and others, register a tem-
porary Activation Code of the current CPU blade to run the SV9300 temporarily until an Activation
Code of the new CPU blade is obtained from the License Management Server. Follow these steps to
register a temporary Activation Code.

NOTE 1: Use the current CPU’s license data file (*.lic2) to register license data and to activate li-
cense temporarily to the new CPU.

NOTE 2: Switch to the off-line mode when activating the license temporarily by “One-Step Registra-
tion” of PCPro.

NOTE 3: Temporary license is effective for five days (in 120 hours).
NOTE 4: SV9300 stores the fault information (FK=17) after five days in case of temporary license 

activation.
NOTE 5: The following limitations occur after five days in case of temporary license activation.

- CM10 registration is restricted.
- No limitation for end users.
- Temporary activation becomes ineffective when the system is reset (both Power-On reset

and system reset by PCPro).
NOTE 6: Temporary activation becomes ineffective when the system is reset by Power-On reset even 

if it is in five days.

1. Connect the system via 
Off-line mode

Connect PCPro to the system in off-line mode (set the SENSE 
switch of the CPU blade to “E/F”).

2. Register license data file 
to activate license tem-
porary

Register the current CPU’s license data file (*.lic2: all Software 
Key Codes and Activation Codes are included) and activate 
license temporary onto the SV9300 by PCPro. Page 4-56

3. Return to On-line mode
Return the system to on-line mode (set the SENSE switch of the 
CPU blade to “1”).
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<Registering License Data File to Activate License Temporarily>

STEP1: Take one of these actions:
• Click submenu [Software License Authentication] in Standard Mode.
• On the Main Menu, click [System] > [Software License Authentication] in this order.
The [Registration] screen is displayed in the work window.

STEP2: Select the [One-Step Registration] radio button and click the [Next >>] button.
 

The [Selection of License Data File] screen is displayed.

[Software License
 Authentication]

Menu

[Next >>] button

[One-Step
Registration]
radio button



Chapter 4 Standard Mode

4-57 NWA-088656-001 Rev.8.0

[Upgrade] Category

STEP3: Click the [Select File] button.

A dialog box is displayed to specify the file name and folder.
STEP4: Specify the folder of the file name where the current CPU’s license data file is saved, and 

click the [Open] button.

You are directed back to the [Select of License Data File] screen, showing where the 
license data is stored and the file name in the License Data File Name field.

[License Data File Name]

 display field

[Next >>] button

[Select File] button

[Open] button

Save in field

File name field
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STEP5: Click the [Next >>] button.

The [Confirmation and Registration License Data] screen is displayed.
STEP6: Verify information (1) to (3).

Continued on next page

No. Item Description

(1) License Information Displays the following codes of the SV9300 to which 
PCPro is connected.
• Hardware Key Code
• Activation Code

[Next>>] button

(1)

(2)

(3)

[Register] button
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STEP7: Click the [Register] button.
A dialog box is displayed to notify that the Hardware Key Code of the system is different
from the license files.

STEP8: Click the [Yes] button.
 

NOTE: When PCPro connects to the system via on-line mode, the following dialog box is displayed. 
Click the [OK] button to cancel the procedure.

A dialog box is displayed to notify the term of validity of the license.

No. Item Description

(2) System Version License Infor-
mation

Displays information included-in the license data.
• License data name
• Software key code
• Time and Date of File Preparation
• Order number
• Name/Comment

(3) Capacity/Function/Terminal 
License

Displays information included-in the license data.
• License data name
• Software key code
• Time and Date of File Preparation
• Order number
• Name/Comment

[Yes] button

[OK] button
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STEP9: Click the [Yes] button.

The license data is registered onto the SV9300 and a dialog box is displayed to notify the
completion of temporary license activation.

STEP10: Click the [OK] button.
 

You are directed back to the [Confirmation of License Data] screen.
STEP11: Click the [Complete] button.

The temporary license activation process is completed.

[Yes] button

[OK] button

[Complete] button
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Program Upgrade (On-line)

You can download an upgrade program for the FTP server installed on a LAN onto the SV9300 as directed
by PCPro and upgrade the CPU program on-line. You may choose to use PCPro as a FTP server or con-
figure a separate FTP server for each unit. For information on specifying a FTP server, see “FTP Server
Settings”. Page 9-43

This menu allows you to set a CPU program upgrade schedule, view results and verify the CPU program.
• Set a Schedule Page 4-62
• Display of Results Page 4-69
• Confirmation of Program Page 4-71

One of the following action will display the [Program Upgrade (On-line)] screen in the work window:
• Click submenu [Program Upgrade (On-line)] in Standard Mode.
• On the Main Menu, click [System] > [Maintenance] > [Program Upgrade (On-line)] in this order.

Tips 1: Firmware Upgrade
While line/trunk blade and VoIPDB firmware are included as part of the CPU program, simply
upgrading the CPU program will not upgrade the firmware. To upgrade firmware, finish up-
grading the CPU program first and upgrade the firmware. For more details, refer to the “Firm-
ware Upgrade (Line/Trunk Blade)”. Page 4-77

Tips 2: Speech Synthesis Data Upgrade
When using the new tone sources for Wake Up Call announcements with the SV9300 upgraded
from 9300V2 to 9300V3 software, Speech Synthesis data upgrade is required (if Speech Synthe-
sis data is not upgraded, the announcements as with current 9300V2 are sent). For details, refer
to the “Speech Synthesis Data Upgrade (For Upgrading from 9300V2 to 9300V3 Software)”.

Page 4-88

SV9300 (Remote Unit)

PCPro
(FTP Server)

Download direct

SV9300 (Main Unit)LAN

Upgrade Program
(CD-ROM)

Program download 
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NOTE 1: Establish a connection link with the SV9300 before executing Program Upgrade (On-line).
NOTE 2: For the baud rate, see “Establishing a Link”. Page 2-16
NOTE 3: To use the FTP server facility of PCPro, keep PCPro running and keep FTP server starting.
NOTE 4: You can confirm the status of program upgrade by the S1 lamp of CPU blade.

NOTE 5: If a proxy server exists between SV9300 and PC using User Web Portal, User Web Portal may 
not be used temporary after the program upgrade of SV9300. In such a case, clear the cache in 
the proxy server (as for the method of cache clear, ask an administrator).

Set a Schedule

You can enter and read FTP server information, the upgrade date and time and change over date and
time for each unit on which the CPU program is upgraded.

STEP1: Click the [Scheduling] tab.
The [Scheduling] screen is displayed.

Upgrade Status
S1 Lamp Status 

(Green)

Under Upgrading Flash quickly

Program upgrade is completed Remain Lit

Program changeover is completed Disappear

Upgrade fails/Upgrade is interrupted Flash normally

(1)

(7)

(4)

(6)

(2)

(3)

(5)
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Continued on next page

No. Item Description

(1) [Scheduling] tab Click to set a schedule.

(2) [Read] button Click to read the FTP server information, upgrade date and 
time, and change over date and time on each unit registered 
on the SV9300. 

(3) [Apply] button Click to set FTP server information, upgrade date and time, 
and change over date and time on each unit registered on the 
SV9300.
If the FTP server information on unit number 02 is modi-
fied, the system data is automatically copied to units with 
the subsequent unit numbers.

(4) “ACT Unit and STBY Unit 
have each settings separately” 
check box

Check to have each setting for ACT Unit and STBY Unit 
separately. When this check box is checked, you can enter to 
the Upgrade Date field and the Change over Date field for 
Unit01-04 (STBY).
* This check box appears when connecting to the Dual CPU

system and clicking the [Read] button.

(5) FTP 
Server 
Informa-
tion dis-
play Area

Unit No. Displays the unit number registered to the SV9300.
• For Single CPU: Unit01 to 50
• For Dual CPU : Unit01 to 04 (CPU0/1: ACT/STBY)

FTP Server Infor-
mation field

Displays FTP server information read from the SV9300.

Upgrade Date 
field

Displays the upgrade date and time of the CPU program 
read from the SV9300.

Change over Date 
field

Displays the change over date and time of the CPU program 
read from the SV9300.

Folder field If the PCPro FTP server is used, displays the name of the 
folder in which the program file is stored.

(6) [Fill In] button Click to enter FTP server information, the upgrade date and 
time, and change over date and time continuously on unit 
number 02 in (5).
Select the items you want to enter continuously in (7).
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NOTE: Schedule Setting with Dual CPU
- In a Dual CPU system, the “FTP Server Information” of STBY-CPU in Unit01-04 is the

same setting as that of ACT-CPU in Unit01-04.
- When the “ACT Unit and STBY Unit have each settings separately” check box is 

unselected, you cannot enter to the line of Unit01-04 (STBY) (because of the gray out sta-
tus). In that case, the same value as Unit01-04 (CPU0/1: ACT) is set to the Unit01-04
(CPU0/1: STBY).

STEP2: Click the [Read] button.
Reading of the current schedule settings starts.

STEP3: Click the [OK] button.
The result of reading is displayed.

No. Item Description

(7) Continu-
ous Item 
Entry

“FTP Server Infor-
mation” check box

Select to enter FTP server information on unit number 01 in 
(5) continuously.

“Upgrade Date” 
check box

Select to enter upgrade dates and times at fixed intervals 
continuously starting from Unit01 in (5).

Time field Enter the number of minutes at intervals of which the date 
and time are upgraded.
• Entry range: 0 to 59 (default: 5)

“Change over 
Date” check box

Select to enter change over dates and time continuously 
from Unit01 in (5).

[OK] button
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STEP4: Click the cell of FTP Server Information for the unit number to be set.
A […] button appears.

NOTE: For Dual CPU system, you cannot edit the FTP Server Information field on Unit01-04 
(STBY-CPU).

STEP5: Click the […] button.
A detailed setup screen appears.

To choose not to use the FTP server facility of PCPro (that is, install an FTP server separate-
ly), clear the “Use the FTP Server of PCPro” check box, enter relevant information and click
the [OK] button.

[...] button

[OK] button
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To use the FTP server facility of PCPro, select the “Use the FTP server of PCPro” check box
and the name of the user who uses it, and click the [OK] button.

NOTE: For instructions on how to add or edit users, see “FTP Server Settings”. Page 9-43

STEP6: Click the cell of Upgrade Date for the unit number to be set.
A […] button appears.

STEP7: Click the […] button.
A detailed setup screen appears.

[OK] button

[...] button
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STEP8: Set upgrade date and time, then click the [OK] button.
Click the [OK] button to return to the original screen. Changed cells appears in green. Click
the [Cancel] button to abandon the changes.

Tips: When Executing CPU Program Upgrade (On-Line) Immediately
To execute the CPU program upgrade (on-line) immediately, check the “Immediately Exe-
cution” radio button, then click the [OK] button. PCPro starts CPU program upgrade (on-
line) immediately.

No. Item Description

(1) Unit No. field Displays the Unit No. to upgrade the CPU program.

(2) Upgrade Date 
Area

[Executed 
Immediately] 
radio button

Check to execute the CPU program upgrade (on-line) 
immediately.

[Date/Time] 
radio button

Check to set the date/time for CPU program upgrade 
(on-line).
• Upgrade Date/Time: YYYY/MM/DD HH:MM

[Clear] radio 
button

Check to delete the registered upgrade date/time.

[OK] button [Cancel] button

(1)

(2)
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STEP9: Click the cell of Change over Date for the unit number to be set.
A […] button appears.

STEP10: Click the […] button.
A detailed setup screen appears.

STEP11: Set change over date and time, then click the [OK] button.
Click the [OK] button to return to the original dialog box. Changed cells appears in green.
Click the [Cancel] button to abandon the changes.

No. Item Description

(1) Unit No. field Displays the Unit No. to change over the CPU program.

(2) Change over 
Date Area

[Date/Time] 
radio button

Check to set the change over date/time of the CPU pro-
gram.
• Change over Date/Time: YYYY/MM/DD HH:MM

[Clear] radio 
button

Check to delete the registered change over date/time.

[...] button

[OK] button

(1)

(2)

[Cancel] button
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NOTE: Program changeover involves the automatic reset of CPU blade. Therefore, when executing 
Program Upgrade to the multiple Units, as for the program changeover of the Main Unit 
(Unit 01), set the change over date so that the program changeover can be executed after the 
completion of program download of all Units.

STEP12: Click the [Apply] button.
The settings are written to the SV9300.
When the writing of data is completed, a dialog box is displayed to notify the completion of
the process.

STEP13: Click the [OK] button.

The schedule have now been set.

Display of Results

You can view and confirm a results of program upgrade on each individual unit.

STEP1: Click the [Display of Results] tab.
The [Display of Results] screen is displayed.

[OK] button

(1)
(2)

(3)
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No. Item Description

(1) [Display of Results] tab Click to display of results.

(2) [Read] button Click to read a results of program upgrade.

(3) Result 
display 
Area

Unit No. field Displays the unit numbers registered to the SV9300.
• For Single CPU: Unit01 to 50
• For Dual CPU : Unit01 to 04 (CPU0/1: ACT/STBY)

Kind field Displays the type of the following results.
Change over/Automatic rollback/Upgrade/Version Match-
ing

Executive Date/
Time field

Displays the date and time at which an event occurred.

Result field Displays the result of the event that occurred.
• Messages that may be displayed and their explanations.

Success : Program Upgrade has been succeeded
Canceled: Program Upgrade has been canceled
Start : Program Upgrade has been started
Failure : FTP Server logon failure/missing files 

(Failed to log on to the FTP server, or there 
were no upgrade files on the server)

Page D-32
Failure : Data transfer error

(An error occurred transferring a file)
Failure : - (any other error)
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STEP2: Click the [Read] button:
The latest results are displayed.

Confirmation of Program

You can confirm the description and version number of the CPU program installed on each unit.

STEP1: Click the [Confirmation of Program] tab.
The [Confirmation of Program] screen is displayed.

(1)

(3)

(2)
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STEP2: Click the [Read] button.
Reading of the CPU program setting starts.

The CPU program has now been verified.

No. Item Description

(1) [Confirmation of Program] tab Click to check the CPU program.

(2) [Read] button Click to read the CPU program version number. 

(3) Program 
Display 
Area

Unit No. field Displays the unit numbers registered to the SV9300.
• For Single CPU: Unit01 to 50
• For Dual CPU : Unit01 to 04 (CPU0/1: ACT/STBY)

Active Program 
field

Displays the version number of the ACT CPU program.

Upgraded field Displays the version number of the STANDBY (upgrade) 
CPU program.

Outdated field Displays the version number of the STANDBY (outdated) 
CPU program.
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Program Upgrade (Off-line)

Allows you to upgrade the software on the CPU program off-line mounted in the SV9300 by using a Up-
grade program downloaded onto PCPro.
For information on specifying a FTP server, see “FTP Server Settings” Page 9-43

The [Program Upgrade (Off-line)] menu allows you to upgrade Program Upgrade (Off-line).

Tips 1: Firmware Upgrade
While line/trunk blade and VoIPDB firmware are included as part of the CPU program, simply
upgrading the CPU program will not upgrade the firmware. To upgrade firmware, finish up-
grading the CPU program first and upgrade the firmware. For more details, refer to the “Firm-
ware Upgrade (Line/Trunk Blade)”. Page 4-77

Tips 2: Speech Synthesis Data Upgrade
When using the new tone sources for Wake Up Call announcements with the SV9300 upgraded
from 9300V2 to 9300V3 software, Speech Synthesis data upgrade is required (if Speech Synthe-
sis data is not upgraded, the announcements as with current 9300V2 are sent). For details, refer
to the “Speech Synthesis Data Upgrade (For Upgrading from 9300V2 to 9300V3 Software)”.

Page 4-88

NOTE 1: Be sure to insert the LAN cable into the ETHERNET port of the CPU blade.
NOTE 2: You can confirm the status of program upgrade by the S1 lamp and ALM lamp of CPU blade.

Upgrade Status
S1 Lamp Status 

(Green)
ALM Lamp Status 

(Red)

Under Upgrading Disappear Disappear

Program upgrade is completed Remain lit Disappear

Upgrade fails/Upgrade is interrupted Disappear Remain lit

SV9300 (FTP Client) PCPro
(FTP Server)

(2) File Transfer demand

LAN cable (cross/straight cable)

Upgrade Program
(CD-ROM)

(3) File Transfer

(1) Set the SENSE switch on the CPU blade to 8
     (Program Upgrade Mode: Off-line) and then
     reset the system to start updating the program.
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STEP1: Connect the ETHERNET port of the CPU blade mounted on the SV9300 and the LAN Port of 
PCPro directly with a LAN cable.

STEP2: Check that the communication link with the SV9300 is cleared.
STEP3: Do either of the following:

• Click [Program Upgrade (Off-line)] on the standard mode submenu.
• On the Main Menu, click [System] > [Maintenance] > [Program Upgrade (Off-line)] in this

order.
A dialog box appears for you to confirm the change to the PC IP address.

STEP4: Click the [Yes] button.

The IP address is changed to 192.168.1.250 and the [Program Upgrade (Off-line)] screen 
appears in the work window.

NOTE: If an IP address is assigned for two ETHERNET ports or the setting of IPv6 is “Enable”, the 
dialog box appears asking you to change the IP address manually. 

STEP5: Set the [SENSE] switch on the CPU blade mounted on the SV9300 to 8.
STEP6: Click the [Select Folder] button.

A dialog box appears for selecting a folder.

[Yes] button

[Select Folder] button

[Next>>] button
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STEP7: Select the folder containing the program that needs to be upgraded and click the [OK] button.

You are directed back to the [Program Upgrade (Off-line)] screen.
STEP8: Click the [Next >>] button.
STEP9: Press the [RESET] button on the CPU blade to reset.

The program update process starts. When the process completes, a dialog box appears for you
to confirm the illumination of the LED.

STEP10: Check that the S1 LED on the CPU blade lights to green.
STEP11: Return the [SENSE] switch to the original setting (0 to 4).
STEP12: Click the [OK] button.

STEP13: Close the work window of Program Update (Off-line).
A dialog box appears for you to confirm that the IP address of PC has been returned to default.

[OK] button

[OK] button[OK] button
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STEP14: Click the [OK] button.

A dialog box is displayed to notify the IP address has been changed.
STEP15: Click the [OK] button.

The program has now been updated.

[OK] button

[OK] button
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Firmware Upgrade (Line/Trunk Blade)

The line/trunk blades and VoIPDB to be used in SV9300 are shipped with firmware programs (hereinafter
“firmware”) already written to them. Furthermore, the latest firmwares of the all line/trunk blades and
VoIPDB are included in a CPU program. Therefore, for the case (1) or (2) as shown below, the firmwares
in a CPU program must be downloaded to the all appropriate line/trunk blades and VoIPDB.

(1) When Upgrading Firmware: Page 4-79
Upgrades firmwares using the [Firmware Upgrade (Line/Trunk Blade)] menu when the firmware
versions of the line/trunk blades or VoIPDB to be used are older than that in a CPU program.

*: The download is not required when the firmware version of the line/trunk blade or VoIPDB is new-
er than that in a CPU program.

(2) When Changing Firmware: Page 4-86
Changes a firmware by the command setting (CME8 Y=0) when a PRT blade is used for Digital
Trunk Interface (DTI) for the first time.

*: A PRT blade (GCD-PRTA) is available for as an either PRT Interface or Digital Trunk Interface
(DTI), a firmware for a PRT Interface is written to it in shipping. Therefore, if a PRT blade is used
for DTI for the first time, the firmware must be changed for DTI.

NOTE 1: The firmware upgrade is not available by the [Firmware Upgrade (Line/Trunk Blade)] menu 
while the firmware is upgrading by CME8 Y=0, 3.

NOTE 2: The system data backup and the firmware upgrade cannot be executed at the same time.
NOTE 3: Execute the firmware upgrade from the PCPro connected to the Unit01.
NOTE 4: Although firmwares are included in a CPU program, the firmwares cannot be upgraded/

changed by just upgrading a CPU program. Be sure to upgrade/change the firmwares accord-
ing to the procedures.

NOTE 5: Execute the firmware upgrade to the all VoIPDBs or appropriate line/trunk blades.
NOTE 6: The firmware change can be executed on only one blade at a time. The firmware change can-

not be executed on multiple blades simultaneously.
NOTE 7: Execute the firmware change for all the appropriate line/trunk blades.

Firmware download

Line/Trunk blade

CPU blade
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NOTE 8: The firmware upgrade can be executed for the multiple Units and the blades at the same time.
NOTE 9: While the firmware upgrade/change is in progress, do not execute the system reset and do not 

unplug the blade or turn SV9300 off.
NOTE 10: The firmware upgrade/change is available only when a CPU blade is during an online oper-

ation.
NOTE 11: The firmware upgrading time for per blade of each blade type is as follows.

NOTE 12: A call will be disconnected when executing the firmware upgrade/change during a call. There-
fore, do not execute the firmware upgrade/change during a call with an appropriate blade.

NOTE 13: For a VM00 blade, the firmware upgrade is not available by this procedures (the firmware 
upgrade is available by replacing to a CF blade).

NOTE 14: A Remote Unit is not changed to survival mode even if the firmware upgrade of the VoIPDB 
blade is executed.

NOTE 15: When the setting of CM0B Y=1XX>80 is extremely short (such as second data 01, 02), Cau-
tion is required for the setting of CM0B Y=1XX>80 because the CPU in Remote Unit is reset 
during the firmware upgrade of VoIPDB (usually, follow the default setting (NONE)).

Blade Type Firmware Upgrading Time

VoIPDB Approx. 8 minutes

LC (CD-4LCA/CD-8LCA)/DLC/COT/
ODT/DIOP

Approx. 2 minutes

LC (GCD-4LCF/GCD-8LCF) Approx. 12 minutes

BRI Approx. 5 minutes

PRI/DTI Approx. 6 minutes

CCT Approx. 10 minutes

CSI Approx. 7 minutes



Chapter 4 Standard Mode

4-79 NWA-088656-001 Rev.8.0

[Upgrade] Category

When Upgrading Firmware

When comparing the firmware version of the line/trunk blades or VoIPDB to be used and that in a CPU
program, and upgrading the firmwares, follow these steps:

Tips: Before downloading
• Be sure to read the NOTES before downloading. Page 4-77
• If the CPU program upgrade is required, complete the CPU program upgrade before ex-

ecuting the firmware upgrade.
• Set the blade type of the line/trunk blades (CM05 Y=0) in advance. For details of the blade

type, refer to the “Command Manual”.
• When using a PRT blade or a BRT blade for ISDN or ISDN Telephone, be sure to set the

trunk blade number (CM05 Y=1).
• Accommodate the line/trunk blades to the appropriate slots (slots set by CM05 Y=0) in ad-

vance.

STEP1: Take one of these actions:
• Click submenu [Firmware Upgrade (Line/Trunk Blade)] in Standard Mode.
• On the Main Menu, click [System] > [Maintenance] > [Firmware Upgrade (Line/Trunk

Blade)] in this order.
• Click the link of the system check result in the [System Check and Report] menu (only

when mismatches in firmware version are detected).

[Firmware Upgrade
 (Line/Trunk Blade)] menu
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Continued on next page

No. Item Description

(1) [Read] button Click to read the line/trunk blades or VoIPDB requiring the 
firmware upgrade from SV9300.

(2) [Apply] button Click to upgrade the firmware to the line/trunk blades or 
VoIPDB requiring the firmware upgrade.

(3) [Select All] button Click to check the all “Select” check boxes of the line/trunk 
blades or VoIPDB requiring the firmware upgrade.

(4) [Release All] button Click to uncheck the all “Select” check boxes of the selected 
line/trunk blades or VoIPDB.

(5) Firmware 
Information 
Display Area

“Select” 
check box

Check to execute the firmware upgrade for the line/trunk 
blades or VoIPDB requiring the firmware upgrade (default: 
checked).
• The status and meaning of the “Select” check box after the 

firmware upgrade are as follows.
Unchecked: Firmware upgrade has been succeeded
Checked : Firmware upgrade has been failed
* As for the lines during upgrading the firmware by the 

other process are exempt. 

Unit No. field Displays the Unit No. of the line/trunk blades or VoIPDB 
requiring the firmware upgrade.
• 01 to 50

* For Dual CPU (Unit01-04), (ACT) or (STBY) is dis-
played only for VoIPDB after the Unit number.

Slot No. field Displays the Slot No. of the line/trunk blades or VoIPDB 
requiring the firmware upgrade.
• 01 to 18

Blade Type 
field

Displays the blade type of the line/trunk blades or VoIPDB 
requiring the firmware upgrade.
• Blade Type: DLC/LC/LLC/COT/OD/DID/LD/BRT(BRI)/

PRT/CCT/CCT(E1)/DTI(T1)/QSIG/DTI(E1)/
ILC

• VoIPDB : GPZ-64IPLD/GPZ-128IPLD/PZ-64IPLC-A/
PZ-128IPLC-A 
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No. Item Description

(5) Firmware 
Information 
Display Area

Version field Displays the firmware version.
• When reading the firmware version

Displays the firmware version of the line/trunk blades or 
VoIPDB requiring the firmware upgrade and the firmware 
version after the firmware upgrade (firmware version in a 
CPU program) (for example: 20-> 23).

• After the firmware upgrade
- When the firmware upgrade has been succeeded: 

displays only the firmware version after the firmware 
upgrade.

- When the firmware upgrade has been failed: 
still displays each firmware version when reading.

Result field Displays the result of the firmware upgrade.
• Messages that may be displayed and their explanations.

OK : Firmware upgrade has been succeeded
Failed : Firmware upgrade has been failed
Upgrading... : During upgrade of the firmware.
Blank field : Other than the above
* The Result fields become blanks when reading the firm-

ware version by the [Read] button.

(6) Link to the [System Check and 
Report] menu

Click to confirm the details of the firmware for the line/
trunk blades or VoIPDB read by the [Read] button.
*1 Click the link (underline part) of “For more details of 

firmware versions of blades, click here.” to launch the 
[System Check and Report] screen.

*2 The screen display is switched if the [System Check and 
Report] screen is already launched.
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STEP2: Click the [Read] button.
• When the line/trunk blades or VoIPDB requiring the firmware upgrade are detected: 

When the following dialog box is displayed, go to step 3 to click the [OK] button.

• When no line/trunk blade or VoIPDB requiring the firmware upgrade exist:
When the following dialog box is displayed, click the [OK] button. the firmware upgrade
is not needed.

Tips: Details of Firmware Version
• The details of the firmware version of each blade displayed on the Firmware 

Information Display Area can be confirmed by the [System Check and Report] menu.
Page 4-251, Page 8-3

• Click the link (underline part) of “For more details of firmware versions of blades, click
here.” to launch the [System Check and Report] screen.

NOTE: The line/trunk blades requiring the firmware upgrade are displayed when satisfying the fol-
lowing conditions.
- When the blade type accommodated in the SV9300 corresponds with the blade type as-

signed by system data (CM05 Y=0).
- When the firmware version in a CPU program is newer than that of the line/trunk blades.

[OK] button

[OK] button
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STEP3: Check the “Select” check box of the line/trunk blades or VoIPDB requiring the firmware up-
grade.

Tips: Selecting Blades
If the [Select All] button or the [Release All] button is clicked, the “Select” check boxes on
the Firmware Information Display Area can be selected or released all at once.

STEP4: Click the [Apply] button.
The following dialog box is displayed.

STEP5: Click the [Yes] button.
The firmware upgrade is executed to the selected line/trunk blades or VoIPDB.
When the firmware upgrade has been completed normally, the following dialog box is dis-
played.

“Select” check box“Select” check box

[Yes] button

[OK] button
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NOTE 1: If this operation is executed, appropriate line/trunk blades are reset, then start downloading
of the firmware. BUSY LED (Red) of the blade flashes by 0.5 sec. ON/OFF (LIVE LED
(Green) flashes at this time).

NOTE 2: A download takes about 2 to 10 minutes per blade (depending on the file size). If the down-
load is completed, LIVE LED (Green) of the blade flashes by 0.5 sec. ON/OFF.

NOTE 3: S2 lamp on CPU flashes at intervals of 1 sec. ON/OFF during the firmware upgrade of 
VoIPDB. Time for upgrade is about 8 minutes.

NOTE 4: When you click the [Cancel] button displayed during a firmware upgrade, the confirmation 
of firmware upgrade by PCPro is interrupted. However, the firmware upgrade of SV9300 is 
continued. After the cancelation, click the [Read] button as in STEP2 above and confirm the 
necessity of the firmware upgrade.

STEP6: Click the [OK] button.
“OK” is displayed on the Result fields of the line/trunk blades or VoIPDB for which the firm-
ware upgrade is executed.

NOTE 1: If the line/trunk blades or VoIPDB requiring the firmware upgrade still remains, confirm 
that the “Select” check box is checked, then retry from STEP3. 
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NOTE 2: If the firmware upgrade has been failed, the error message and “Failed” are displayed on 
the result fields of the line/trunk blades or VoIPDB for which the firmware upgrade has been 
failed. Either one of possible causes as shown table below is considered, take remedial 
actions in order of “a” to “b”.

The Firmware Upgrade (Line/Trunk Blade) has now been completed.

Cause Remedial Action

a. Firmware check sum error in a CPU 
program.

Upgrade the CPU program, then retry from 
STEP2.

b. Flash-ROM malfunction of the blade 
(malfunction caused by a repeat of 
writing or a deterioration).

Replace the blade, then retry from STEP2.
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When Changing Firmware

When changing a firmware to use a PRT blade as a Digital Trunk Interface (DTI), follow these steps:

Tips: Before downloading
• Be sure to read the NOTES before downloading. Page 4-77
• If the CPU program upgrade is required, complete the CPU program upgrade before ex-

ecuting the firmware upgrade.
• When changing a firmware for DTI(T1), set the blade type (CM05 Y=0) of PRT blade to

“43” (DTI[T1]) in advance. When changing a firmware for DTI(E1), set the blade type
(CM05 Y=0) of PRT blade to “47” (DTI[E1]) in advance.

• Accommodate the PRT blade to the appropriate slot (slot set by CM05 Y=0) in advance.

STEP1: With the [System Check and Report] menu, read the accommodated line/trunk blades infor-
mation and figure out the PRT blades to be changed.
A list of including accommodation locations of line/trunk blades (Unit No. and Slot No.),
firmware version and firmware type (blade type) are displayed. Page 4-251

STEP2: Specify the accommodation location (Unit No. and Slot No.) of the PRT blade read by
STEP1 by CME8 Y=0, then download the firmware.

• CME8 Y=0

First Data : XX ZZ:
XX: 01-50: Unit No.
ZZ : 01-18: Slot No.

Second Data: 43: DTI(T1)
or

: 47: DTI(E1)

NOTE 1: If this command is executed, the appropriate PRT blade is reset, then start downloading of 
the firmware. BUSY LED (Red) of the blade flashes by 0.5 sec. ON/OFF (LIVE LED (Green) 
flashes at this time) during download.

NOTE 2: A download takes about 3 minutes per blade. If the download is completed, LIVE LED
(Green) of the blade flashes by 0.5 sec. ON/OFF.



Chapter 4 Standard Mode

4-87 NWA-088656-001 Rev.8.0

[Upgrade] Category

STEP3: Confirm that the firmware version of the PRT blade and that of the blades in a CPU program 
match.

• CME8 Y=0

First Data : XX ZZ:
XX: 01-50: Unit No.
ZZ : 01-18: Slot No.

Second Data: 43 XX ZZ:
XX: Firmware version on the blade
ZZ : Firmware version in a CPU program

*1: If the firmware version matches, go to STEP4.
*2: If the firmware version does not match, either one of possible causes as shown table

below is considered, take remedial actions in order of “a” to “c”.

STEP4: If any other PRT blades which require the firmware upgrade exist, do the STEP2 to STEP3 
to the appropriate blades.

This is the end of the procedure for firmware change.

Cause Remedial Action

a. Blade type set by CM05 Y=0 and 
accommodated blade does not 
match.

Set the correct firmware type by CM05 
Y=0, then try from STEP2 again.

b. Firmware check sum error in a CPU 
program.

Upgrade the CPU program, then try from 
STEP1 again.

c. Flash-ROM malfunction of the blade 
(malfunction caused by a repeat of 
writing or a deterioration).

Replace the blade, then try from STEP1.
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Speech Synthesis Data Upgrade (For Upgrading from 9300V2 to 9300V3 
Software)

In Speech Synthesis announcements when setting or answering Wake Up call, for 9300V3 software or lat-
er, the announcements which are easier to understand for user than those of current 9300V2 can be sent.
When using those announcements with the SV9300 upgraded from 9300V2 to 9300V3 software, upgrade
the Speech Synthesis data according to the following steps (when newly installing SV9300 with 9300V3
software or later, Speech Synthesis data upgrade is not required because new Speech Synthesis data is al-
ready written to the CPU).

NOTE 1: Upgrade the Speech Synthesis data after upgrading from 9300V2 to 9300V3 software.
NOTE 2: For the Speech Synthesis data upgrade, be sure to use the Program Upgrade (On-line).
NOTE 3: If Speech Synthesis data is not upgraded, the announcements as with current 9300V2 are sent.

Continued on next page

1. CPU Program Upgrade

Using Program Upgrade (On-line/Off-line), upgrade the SV9300 
software from 9300V2 to 9300V3.
• Program Upgrade (On-line) Page 4-61
• Program Upgrade (Off-line) Page 4-73

2. Obtaining Speech Syn-
thesis Data for 9300V3 
Software or Later

Obtains the Speech Synthesis data (SC-4409 LYRA VOICE PROG-
B1) for 9300V3 software or later from the local site.

3. Speech Synthesis Data 
Upgrade

Upgrade the Speech Synthesis data by the following steps.
Make Unit01 into the on-line status.
Using “Program Upgrade (On-line)”, upgrade the Speech Synthe-
sis data of Unit01 of CPU. Page 4-61
(Upgrading time: about 5 minutes per unit)
*1 When using a Dual CPU system, upgrade STBY-CPU of 

Unit01 in the same way as for ACT-CPU of Unit01.
*2 When using a failover system, upgrade the CPU of a second-

ary unit in the same way as for the CPU of a primary unit.
Execute the System Reset after the completion of Speech Synthe-
sis upgrade.

1

2

3
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The Speech Synthesis data has now been upgraded.

4. Verifying the Upgrade

Refer to the Speech Synthesis information by CMFB Y=03, verify 
that the Speech Synthesis data is upgraded.
* When using a Dual CPU system, refer to the Speech Synthesis 

information by CMFB Y=11, verify that the Speech Synthesis data 
of STBY-CPU is upgraded.
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[Tools] Category

The [Tools] Category is organized into the following two submenus:
• Script
• Station Copy/Key Copy Page 4-103

Script

The [Script] menu allows you to run a system data script. Create a system data script as a CSV file or an
Excel file (xlsx) and load it into the Main Menu via the [Script] menu.
In addition, a scenario file (LIST file) of the system data for SV9300 that is output by the System Data
Conversion Tool can be loaded into SV9300. For details, see “Run a Scenario File”. Page 4-98
Do either of the following to see the [Script] screen in the work window:

• Click [Script] on the standard mode submenu.
• On the Main Menu, click [Tools] > [Script] in this order.
• Click  on the toolbar. 

NOTE: - Establish an Establishing a Link before running the Error Info function. For more details, 
see “Establishing a Link”. Page 2-16

- There is no need to establish a link when writing a script.
- An index of script lines that can be run simultaneously is 10,000 lines (depending on the spec-

ifications of the PC and memory installed).
- SV8300 script files cannot be used. To use the system data of SV8300 as that of SV9300, the

system data conversion is required by the System Data Conversion Tool. For details, see
“System Data Conversion Tool”. Page 9-24

- When using a script file made by an older Excel file format (xls), change the XLS file format
into the XLSX file format by using some tools (such as Microsoft Excel) before using it on
PCPro.
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Continued on next page

No. Item Description

(1) [Save as...] (  ) button Click to create (export to) a script file from the contents of 
the script shown in the Script Entry area.

(2) [Save] (  ) button Click to save (export) the contents of the script shown in the 
screen to the current script file.

(3) [Open] (  ) button Click to open (import) a script file.

(4) [New] (  ) button Click to create a new script file.

(5) [Find] ( ) button Displays the [Find and Replace] screen (for finding). Click to 
search a character string from the contents of the script.

(6) [Replace] ( ) button Displays the [Find and Replace] screen (for replacing). Click 
to replace a character string from the contents of the script.

(7) [Scenario Open] ( ) button Click to open (import) a scenario file (a file that runs the 
multiple script files by one operation).

(11)

(15)

(1)
(2)
(3)
(4)

(12)
(14) (13)

(9)

(7)
(6)
(5)

(8)

(10)

(16)
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Continued on next page

No. Item Description

(8) [Listup All CMD] ( ) button Click to list the all office data in the office data file. 
* This button is effective when “Virtual PBX (office data 

file)” is chosen in Connection Type of Connection 
Account. For details of Connection Account, see “Con-
nection Account” in Chapter 9.

(9) [Apply] button Click to apply the contents of the script shown in the Script 
Entry area as system data on the SV9300.

(10) [Read] button Click to read the contents of the script shown in the Script 
Entry area as system data on the SV9300.

(11) Script File Name field Displays the drive, path and file names of a script file 
imported or exported.

(12) Title field Displays and/or edits the title of the script file specified in the 
Script File field.

(13) [Clear] button Click to clear the data shown in the Script Entry Area.

(14) [Auto Fill] button This button functions as entry auxiliaries. Each time clicking 
the enter key, +1 value or a copied value are entered to the 
next line. The using mode can be switched by the [Auto Fill] 
button.
• Mode: OFF/0-9/0-B/0-F/COPY
*1 When specifying “0-B”, +1 value is entered in order of 

0-9, A, B.
*2 When specifying “0-B”, +1 value is entered in order of 

0-9, A-F.
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No. Item Description

(15) Script Entry 
Area

CMD field Displays and/or edits the command code and YY number.
• Input characters: 0 to 9, A through F, a through f (a through 

f are converted to uppercase automatically)
• Input length: Up to six characters

FD field Displays and/or edits the first data portion of the command 
code.
• Input characters: 0 to 9, A through F, a through f (a through 

f are converted to uppercase automatically) and comma (,)
• Input length: Up to 16 characters

SD field Displays and/or edits the second data portion of the com-
mand code.
• Input characters: No limitation
• Input length: Up to 256 characters

ED field Displays command code-specific SV9300 response data.
• Input characters: Other than CCC
• Input length: Up to 24 characters

MESSAGE 
field

Displays or edits a command code comment.
• Input characters: Unlimited
• Input length: Up to 256 characters

(16) [Clear Cache] button Click to clear the read data stored in the memory when the 
List Command such as @STN or LSTN is executed.
*1 Clear Cache must be executed by the [Clear Cache] 

button when a station is added or deleted after @STN is 
executed.

*2 For details of the List Command, refer to the “Appendix 
B List Command”. Page B-1
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Create a Script File

There are three ways to create a script file as described below. Here, method 1 and 2 are highlighted.
1. Write a system data script in Microsoft Excel and save it to a CSV file or an Excel file (xlsx) (using

the [Open] (  ) button).
2. Enter a system data script directly in the [Script] menu (using the [New] (  ) button).
3. Read system data from the SV9300 to the Script Entry Area and edit it (using the [Read] button).

<When Entering a Script to Excel>

STEP1: Launch Microsoft Excel.
STEP2: Specify Columns A to E in an Excel sheet and click [Format (O)] > [Cell (E)] to set the dis-

play format a character string.
Delete Excel sheets except Excel sheet 1.

STEP3: Fill out the Excel sheet with the command code, first data and second data as system data, 
left-justified, to create an Excel file.
Sample setting: Set station numbers 3000, 3001 and 3002 for the Digital Multiline Terminal.

Command code

First data

Second data

You may enter a comment
in column E.
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STEP4: When you have finished entering all the system data, name the Excel file and save it as a 
script file of a CSV file or an Excel file (xlsx).
If you see the message shown below when you save the script file, click the [Yes] button.

<When Entering a Script by the [Script] Menu>

STEP1: Click the [New] ( ) button on the [Script] screen.
STEP2: Enter the command code, first data and second data to the CMD field, FD field and SD field 

in the Script Entry Area.
Sample setting: Set station numbers 3000, 3001 and 3002 for the Digital Multiline Terminal.
* You can enter a comment in the Message field.

STEP3: When you have finished entering all the system data, Click the [Save as...] button.
The [Script] dialog box is displayed.

STEP4: Specify the File name field and the Save as type field, then click the [Save] button.

[Yes] button

[Save] button
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Tips: File Format When Saving a Script File
• For the file format when saving a script file, you can select the file format as shown the

table below.

• The file format previously saved is displayed for a default value in the Save as type field.
• To save a script file as a CSV format, use the OS or Excel corresponding to the character

code.
• When a script file is saved by Excel format (xlsx), regardless of the language of the OS or

Excel currently used, you can save the data even including character codes of any lan-
guages.

The creation of a script file is now completed.

File Format Description

Script file - ANSI (*.csv) A comma-delimited file format generally used for 
script set by default.
* The number of script lines that can be saved is

100,000 lines.

Script file - Unicode (*.csv) A comma-delimited file format that the character
code is Unicode.
*1 Usually, this file format is not used. Select when

the character code is different from the language
of the OS or Excel currently used.

*2 The number of script lines that can be saved is
100,000 lines.

Microsoft Excel worksheet 
(*.xlsx)

A file format for Excel.
*1 Up to 100,000 lines can be saved in a Excel for-

mat (xlsx).
*2 You cannot edit script files using a editor in a

text format.
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Run a Script

STEP1: Click the [Open] button.
The [Script] dialog box appears.
The [Script] screen appears in the work window.

STEP2: Select the script file you have saved in “  Create a script file” and click the [Open] button.
The script is loaded into the Script Entry Area.

STEP3: Click the [Read] or [Apply] button.

A script file has now been run.
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Run a Scenario File

When running the scenario file (a file that runs the multiple script files by one operation) output by the
System Data Conversion Tool, do the following operations.
For details of the System Data Conversion Tool, see “System Data Conversion Tool”. Page 9-24

STEP1: Click the [Scenario Open] button.
The [Script] dialog box appears.

STEP2: Select the scenario file (LIST file) output by the System Data Conversion Tool, and click the 
[Open] button.
The scenario file output by the System Data Conversion Tool is loaded into the Script Entry
Area.

Continued on next page

No. Item Description

(1) [Read] button Click to read the contents of the scenario file shown in the Script 
Entry area as system data on the SV9300.

(2) [Apply] button Click to apply the contents of the scenario file shown in the Script 
Entry area as system data on the SV9300.

(3) File Name field Displays the drive name, path name and file name of the selected 
scenario file.

(4) Title field Displays the title area of the scenario file selected in File Name 
field.

[Scenario Open]
 button

(4)

(5)

(2)
(1)

(3)

(6)
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STEP3: Click the [Read] or [Apply] button.
When clicking the [Read] button, the office data is listed by reading sequentially the script
files.
When clicking the [Apply] button, the office data is sequentially read from script files and
are written in the system.

After the office data readout is completed, the results are displayed on the RESULT field. 

No. Item Description

(5) Script 
Entry Area

FILE 
NAME 
field

Displays the file name of the scenario file.
*  If no file exists to load, the file name is indicated by Red-letter.

RESULT 
field

Displays the result or the status of the loaded scenario file. 
Messages that may be displayed and their explanations.
• When reading the scenario file

Blank field : A file exists
FILE NOT FOUND: No file exists

• When operating by the [Read] button or the [Apply] button
Blank field : Not executed
PROCESSING : During execution
OK : Normally completed
FILE NOT FOUND : No file exists
USER CANCEL : Cancel by a user
FILE FORMAT ERROR: An format error of the file
OUTPUT FILE ERROR : An output error of the CSV file
ERROR : Other errors

[RESULT] field
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The read office data files are output to the following folders by each script file: 
<install folder>\pbxfiles\script\ScenarioResult_yyyyMMddhhmm

yyyyMMddhhmm: Date and time of saved file 

A scenario file has now been run.
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Listing the All Office Data in the Office Data File

While connecting with Virtual PBX, the all office data in the office data file can be listed. If you save
the listed data to script files (csv format), you can reuse the data on the [Script] menu. 
To list the all office data, do the following steps:

STEP1: Click the [Listup All CMD] button. 

When clicking the [Listup All CMD] button, the following confirmation message for readout
a scenario file appears. 

STEP2: Click the [Yes] button. 
Script files in the scenario file are listed in the [FILE NAME] field. 

[All Command List]
 button

[FILE NAME] field
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STEP3: Click the [Read] button. 
The office data in the script files are read out. After the office data readout is completed, the
results are displayed on the RESULT field. 

NOTE: The execution of the script files takes twenty to thirty minutes.

The read office data files are output to the following folders by each script file: 
<install folder>\pbxfiles\script\ScenarioResult_yyyyMMddhhmm

yyyyMMddhhmm: Date and time of saved file 

The all office data in the office data file have now been listed.

[RESULT] field
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Station Copy/Key Copy

The [Station Copy/Key Copy] menu makes it possible to:

The target system data and related system data on the [Station Copy/Key Copy] menu are as follows.

<Target System Data>

- CM12: Station Class-1
- CM13: Station Class-2
- CM73: Memory Allocation for Station Speed Dialing
- CM90 Y=00-05, 14: Multiline Terminal Key Assignment
- CM94: Multiline Terminal One-Touch Memory
- CME6: Call Forwarding Set*

- CMEF: Service Memory for User Web Portal
* The following system data is not included.

CME6 Y=50 (Trunk number link up with a Mobility Access station number)
CME6 Y=51 (Destination of ISDN Alternative Routing in Remote Unit survival mode)

<Related System Data>

- CM16 Y=0: Next station number in Call Pickup Group
- CM17 Y=0, 2: Next station number in UCD group/UCD Group number
- CM18 Y=0: Next station number in Station Hunting Group

• Key Copy
(Station Data Copy)

Page 4-108

: Overwrites station data (such as key data) of an existing station to the 
other station. You can specify multiple destinations at a time (destinations 
are specified by a station number).

• Copy Station
Page 4-114

: Copies/assigns a station newly using an existing station. You can specify 
multiple destinations at a time (destinations are specified by a station 
number and a port number to be accommodated).

• Move Station
Page 4-120

: Changes a station port of an existing station. You can specify multiple 
destinations at a time (destinations are specified by a port number to be 
accommodated).

• Swap Stations
Page 4-122

: Swaps the station ports of the two existing stations. You can specify mul-
tiple destinations at a time (the two existing stations to be swapped are 
specified by a station number).
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NOTE 1: The [Station Copy/Key Copy] menus can be executed even if the terminal is not connected to 
the system or the SV9300 is in an off-line state.

NOTE 2: When station data is copied, the key settings (CM90 Y=00-05, 14) assigned to My Line of the 
original terminal will be replaced by those assigned to My Line of the destination.

NOTE 3: If the station is assigned to any one of a Call Pickup Group/UCD Group/Station Hunting 
Group, the Move Station/Swap Station are not available. For the details of Call Pickup Group/
UCD Group/Station Hunting Group, see “[Service] Category”. Page 4-125

NOTE 4: When the station is moved or swapped, the assigned data of “Authorization Code Per Station” 
(CM2B Y=00-04) will be returned to default.

NOTE 5: When the station is moved or swapped, the assigned data of “Login password for User Web 
Portal” (set by CM2B Y=12) will be returned to default (a station number is applied as a 
default). Notify the station user to change the password immediately. The password can be 
changed by using User Web Portal.

NOTE 6: The verification whether the station to be handled by the [Station Copy/Key Copy] menu is 
during a telephone conversation, is not performed. If the operation by the [Station Copy/Key 
Copy] is performed for the stations which is during a telephone conversation, the writing of sys-
tem data to the SV9300 may be failed.

NOTE 7: The Station Copy/Key Copy is available only between the same kind of terminals. However, the 
Station Copy is available between Digital Multiline Terminal and IP Station.
* For the supported feature for each terminal and available system data, see the “Supported

Features for Each Terminal” Page 4-105 and “System Data That Can Be Assigned for
Each Terminal” Page 4-106.

NOTE 8: The [Station Copy/Key Copy] menus are not available for name display in Russian and Turkish.
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Tips 1: Supported Features for Each Terminal
The table below shows the supported features for each terminal by the [Station Copy/Key Copy]
menu.

: Available  –: Not Available

Kind of 
Terminal

Key Copy 
(Station Data 

Copy)
Copy Station Move Station Swap Station

Single Line 
Telephone

   

Digital Multiline 
Terminal

   

IP Station   – –

Standard SIP 
Station

  – –

Virtual Station  – – –

PS Station   – –

ISDN Terminal  – – –

Modem Station – – – –

Attendant Console – – – –
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Tips 2: System Data That Can Be Assigned for Each Terminal
The table below shows the system data that can be assigned for each terminal by the [Station
Copy/Key Copy] menu.

: Available  –: Not Available

*1 The setting of CM90 cannot be edited.
*2 The service memory for User Web Portal Management can be set only for Move Station and Swap

Station.

Kind of 
Terminal

Station 
Class-1 
(CM12)

Station 
Class-2 
(CM13)

Station 
Speed 
Dialing 
(CM73)

Key 
Assign-

ment
(CM90)

One-
Touch 
Key 

(CM94)

Call 
Forward-
ing Set 
(CME6)

Service
Memory 
for User 

Web 
Portal

(CMEF)

Single Line 
Telephone

   – –  

Digital 
Multiline 
Terminal

      

IP Station       –

Standard 
SIP Station

   – –  –

Virtual 
Station

  – – –  –

PS Station    – –  –

ISDN 
Terminal

  – – –  –

Modem 
Station

– – – – – – –

Attendant 
Console

– – – – – – –
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One of the following action will display the [Station Copy/Key Copy] screen in the work window:
• Click submenu [Station Copy/Key Copy] in Standard Mode.
• On the Main Menu, click [Tools] > [Station Copy/Key Copy] in this order.

No. Item Description

(1) [Key Copy (Station 
Data Copy)] button

Click to copy the station data. The [Key Copy (Station Data Copy)] 
screen is displayed.

(2) [Copy Station] but-
ton

Click to copy/assign stations from a specified station. The [Copy Station] 
screen is displayed.

(3) [Move Station] but-
ton

Click to change a station port. The [Move Station] screen is displayed.

(4) [Swap Stations] but-
ton

Click to swap ports of two stations. The [Swap Stations] screen is dis-
played.

(1)

(2)

(4)

(3)

[Station Copy/Key
 Copy] Menu
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Key Copy (Station Data Copy)

To copy station data such as key data to a existing station, follow these steps:

NOTE: The Key Copy (Station Data Copy) is applied only to existing stations. This feature cannot 
be used for a new station.

STEP1: Click the [Key Copy (Station Data Copy)] button on the [Station Copy/Key Copy] screen.
The [Key Copy (Station Data Copy)] screen for system data selection is displayed.

STEP2: Set the items (1) and (2).

Continued on next page

No. Item Description

(1) Basis Station No. 
fields

Enter the basis station number.
• Input characters: 0 to 9, *, #, blank field (A, B are automatically 

converted to *, #)
• Input length: Up to 8 digits (default: blank field)

(1)

(2)

(3) [Next>>] button
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STEP3: Click the [Next >>] button.
The [Key Copy (Station Data Copy)] screen for system data editing is displayed.

No. Item Description

(2) “Selection of System 
Data to be copied” 
check box

Among the system data to which the station number entered in Basic Sta-
tion No. field is assigned, check the system data to be copied.
The selectable system data and default setting are as follows.
• Checked

- Station Class-1 (CM12)
- Station Class-2 (CM13)
- Multiline Terminal Key Assignment (CM90 Y=00, 01, 02, 03, 04, 

05, 14)
• Unchecked

- Memory Allocation For Station Speed Dialing (CM73):
The memory area is shared between basis station and target stations

- Multiline Terminal One-Touch Memory (CM94):
The memory area is shared between basis station and target stations

- Call Forwarding Set/Reset from PCPro (CME6)
*1 The setting as described above returns to default after a restart of the 

[Station Copy/Key Copy] menu.
*2 The unselected system data remain default. 

(3) [<< Menu] button Click to return to the [Station Copy/Key Copy] screen.
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STEP4: Edit the SD field for each system data tab if necessary.

Continued on next page

No. Item Description

(1) Basis Station No.field Displays the basis station number.

(2) Kind of Terminal field Displays the kind of terminal of the basis station number. 
The kind of terminals to be displayed are as follows.
• Single Line Telephone
• Digital Multiline Terminal
• IP Station
• Standard SIP Station/PS Terminal
• ISDN Terminal

(3) Port No. field Displays the port number of the basis station.

(4) [Select All] button Click to check the check boxes of all lines in a selected sys-
tem data tab.

(5) [Release All] button Click to uncheck the check boxes of all lines in a selected 
system data tab.
* The [Release All] button is not effective when the [KEY 

DATA (CM90)] tab is selected.

(6) [System Data] tab Reads the system data selected in the “Selection of System 
Data to be copied” check box of the [Key Copy (Station 
Data Copy)] screen for system data selection and displays 
them for each system data.

[<<Back] button [Next>>] button

(1)
(2)
(3)

(6)

(7)

(4)

(5)
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STEP5: Click the [Next >>] button.
The [Key Copy (Station Data Copy)] screen for copy execution is displayed.

No. Item Description

(7) List of 
Read Sys-
tem Data 
Grids

“Select” check 
box

Check the check box of the line to be copied in a selected 
system data tab (Default: checked).
* The “checked” mark appears only when the system data 

read is succeeded.

CMD field Displays the command code and Y number.

FD field Displays the first data of the command code.

SD field Displays and/or edits the second data of the command code.
• Input characters:

- CM12/CM13: 0 to 9, alphabet
- CM73/CM94: 0-9
- CM90: Display only (unavailable to edit)

• Input length: Up to 256 digits

ED field Displays command code-specific SV9300 response data.
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STEP6: Set the items (3).

NOTE: If the Name Display field is not specified in the Target Station’s Settings Area, the system 
data remain a existing setting.

No. Item Description

(1) System data to be copied field Displays the list of system data to be copied.

(2) Remarks field Displays the supplemental remarks for the Target Station’s 
Settings Area.

(3) Target 
Station’s 
Settings 
Area

Station No. field Enter the copy source station number.
• Input characters: 0 to 9, *, # (A, B are automatically con-

verted to *, #)
• Input length: Up to 8 digits

Name Display 
field

Enter the name display information (assigned by CM77 
Y=1).
• Input characters: Alphabet, blank field
• Input length: Up to 16 characters

Result field Displays the result of copy.

(4) [<< Menu] button Click to return to the [Station Copy/Key Copy] screen.

(5) [Execute Copy] button Copy the basis station data specified on the [Key Copy (Sta-
tion Data Copy)] screen for system data selection to the sta-
tion specified in the Target Station’s Settings Area.

(2)

(3)

(5)(4)

[<<Back] button

(1)
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STEP7: Click the [Execute Copy] button.
The Key Copy (Station Data Copy) is started from a lead line of the station specified in the
Target Station’s Settings Area. The lines for which the writing of system data is completed,
“Success” is displayed on the Result fields of the lines.

NOTE: Once the copy is started, the operation is continued to the last line even if an error occurred 
at writing system data to each station. 

The Key Data (Station Data) has now been copied.
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Copy Station

To copy/assign stations newly from a specified station, follow these steps:

NOTE: The Copy Station newly assigns stations. You cannot overwrite the system data to an existing 
station.

STEP1: Click the [Copy Station] button on the [Station Copy/Key Copy] screen.
The [Copy Station] screen for system data selection is displayed.

STEP2: Set the items (1) and (2).

Continued on next page

No. Item Description

(1) Basis Station No. 
fields

Enter the basis station number.
• Input characters: 0 to 9, *, # (A, B are automatically converted to *, #)
• Input length: Up to 8 digits (default: blank field)

(1)

(2)

(3) [Next>>] button
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STEP3: Click the [Next >>] button.
The [Copy Station] screen for system data editing is displayed.

No. Item Description

(2) “Selection of System 
Data to be copied” 
check box

Among the system data to which the station number entered in Basis Sta-
tion No. field is assigned, check the system data to be copied.
The selectable system data and default setting are as follows.
• Checked

- Station Class-1 (CM12)
- Station Class-2 (CM13)
- Multiline Terminal Key Assignment (CM90 Y=00, 01, 02, 03, 04, 

05, 14)
• Unchecked

- Memory Allocation For Station Speed Dialing (CM73):
The memory area is shared between basis station and target stations.

- Multiline Terminal One-Touch Memory (CM94):
The memory area is shared between basis station and target stations.

- Call Forwarding Set/Reset from PCPro (CME6)
*1 The setting as described above returns to default after a restart of the 

[Station Copy/Key Copy] menu.
*2 The unselected system data remain default. 

(3) [<< Menu] button Click to return to the [Station Copy/Key Copy] screen.
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STEP4:  Edit the SD field for each system data tab if necessary.

Continued on next page

No. Item Description

(1) Basis Station No. field Displays the basis station number.

(2) Kind of Terminal field Displays the kind of terminal of the basis station number. 
The kind of terminals to be displayed are as follows.
• Single Line Telephone
• Digital Multiline Terminal
• IP Station
• Standard SIP Station/PS Terminal
• ISDN Terminal

(3) Port No. field Displays the port number of the basis station number.

(4) [Select All] button Click to check the check boxes of all lines in a selected sys-
tem data tab.

(5) [Release All] button Click to uncheck the check boxes of all lines in a selected 
system data tab.
* The [Release All] button is not effective when the [KEY 

DATA (CM90)] tab is selected.

(6) [System Data] tab Reads the system data selected by the “Selection of System 
Data to be copied” check box of the [Copy Station] screen 
for system data selection and displays them for each system 
data.

(1)
(2)
(3)

(6)

(7)

[Next>>] button[<<Back] button

(4)

(5)
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STEP5: Click the [Next >>] button.
The [Copy Station] screen for copy execution is displayed.

No. Item Description

(7) List of 
Read Sys-
tem Data 
Grids

“Select” check 
box

Check the check box of the line to be copied in a selected 
system data tab (Default: checked).
* The “checked” mark appears only when the system data 

read is succeeded.

CMD field Displays the command code and Y number.

FD field Displays the first data of the command code.

SD field Displays and/or edits the second data of the command code.
• Input characters:

- CM12/CM13: 0 to 9, alphabet
- CM73/CM94: 0-9
- CM90: Display only (unavailable to edit)

• Input length: Up to 256 digits

ED field Displays command code-specific SV9300 response data.
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STEP6: Set the item (3).

No. Item Description

(1) System Data to be copied field Displays the list of system data to be copied.

(2) Remarks of Port field Displays the range of available port numbers.

(3) Target 
Station’s 
Settings 
Area

Port No. field Enter the port number of the target station.
• Input characters: 0 to 9
• Input length: 4 digits (IP Terminal), 6 digits (TDM Termi-

nal)

Station No. field Enter the station number of the target station.
• Input characters: 0 to 9, *, #, blank field (A, B are auto-

matically converted to *, #)
• Input length: Up to 8 digits

Name Display 
field

Enter the name display information (assigned by CM77 
Y=1).
• Input characters: Alphabet, blank field
• Input length: Up to 16 characters

Result field Displays the result of copy.

(4) [<< Menu] button Click to return to the [Station Copy/Key Copy] screen.

(5) [Execute Copy] button Copy the basis station data specified in the [Copy Station] 
screen for system data selection to the station specified in 
the Target Station’s Settings Area.

(3)

(5)(4)

[<<Back] button     

(1)

(2)
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STEP7: Click the [Execute Copy] button.
The copy of station data is started from a lead line of the station specified in the Target Sta-
tion’s Settings Area. The lines for which the writing of system data is completed, “Success”
is displayed on the Result fields of the lines.

NOTE: Once the copy is started, the operation is continued to the last line even if an error occurred 
at writing of system data to each station. 

The Station has now been copied.
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Move Station

To change the station port, follow these steps:

NOTE 1: The Move Station takes over the basis station data (CM12/CM13/CM73/CM90/CM94/
CME6/CMEF).

NOTE 2: The Move Station to the port which is in use is not available.
NOTE 3: The Move Station by selecting specific system data is not available.

STEP1: Click the [Move Station] button on the [Station Copy/Key Copy] screen.
The [Move Station] screen is displayed.

STEP2: Set the item (1).

Continued on next page

No. Item Description

(1) Data Set-
tings Area 
(Maxi-
mum of 
500 lines)

Station No. field Enter the basis station number.
• Input characters: 0 to 9, *, # (A, B are automatically con-

verted to *, #)
• Input length: Up to 8 digits

Destination Port 
No. field

Enter the destination port number.
• Input characters: 0 to 9
• Input length: 6 digits

Result field Displays the result of moved station.

(2) [<< Menu] button Click to return to the [Station Copy/Key Copy] screen.

(1)

(3)(2)
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STEP3: Click the [Execute Move] button.
After clicking the [Execute Move] button, the following dialog box is displayed.

STEP4: Click the [Yes] button.
The station data of the port number specified in the Destination Port No. field is changed to
the station data specified in the Station No. field. The lines for which the writing of system
data is completed, “Success” is displayed on the Result fields of the lines.

NOTE 1: Click the [No] button if the stations to be moved are busy.
NOTE 2: If the writing error is occurred in the middle of line after the start of the Move Station, the 

process of Move Station will be stopped on the line.

The Station Data has now been moved.

No. Item Description

(3) [Execute Move] button Click to move the station data specified in the Station No. 
field to the port number specified in the Destination Port 
No. field.

[Yes] button
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Swap Stations

To swap the ports of the two stations, follow these steps:

NOTE 1: The Swap Station takes over the basis station data (CM12/CM13/CM73/CM90/CM94/
CME6/CMEF).

NOTE 2: The Swap Station by selecting specific system data is not available.

STEP1: Click the [Swap Stations] button on the [Station Copy/Key Copy] screen.
The [Swap Stations] screen is displayed.

STEP2: Set the item (1).

(1)

(3)(2)
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STEP3: Click the [Execute Swap] button.
After clicking the [Execute Swap] button, the following dialog box is displayed.

No. Item Description

(1) Data Set-
tings Area 
(Maxi-
mum of 
500 lines)

“Select” check 
box

Check the check box of the line to swap the stations 
(Default: all checked).
* The check box of the line for which the Swap Stations was 

executed would be unchecked.

Station No. 1 field Enter the basis station number.
• Input characters: 0 to 9, *, # (A, B are automatically con-

verted to *, #)
• Input length: Up to 8 digits

Station No. 2 field Enter the destination station number.
• Input characters: 0 to 9, *, # (A, B are automatically con-

verted to *, #)
• Input length: Up to 8 digits

Result field Displays the result of swapped station.

(2) [<< Menu] button Click to return to the [Station Copy/Key Copy] screen.

(3) [Execute Swap] button Swaps the station data specified in the Station No. 1 field 
and the station data specified in the Station No. 2 field.

[Yes] button
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STEP4: Click the [Yes] button.
The station data specified in the Station No. 1 field is swapped to the station data specified
in the Station No. 2 field. The lines for which the writing of system data is completed, “Suc-
cess” is displayed on the Result fields of the lines.

NOTE 1: Click the [No] button if the both stations to be swapped are busy.
NOTE 2: If the writing error is occurred in the middle of line after the start of the Swap Station, the 

process of Swap Station will be stopped on the line.

The Station Data has now been swapped.
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[Service] Category

The [Service] Category is organized into the following four submenus:
• Speed Dialing
• Call Pickup Group Page 4-170
• UCD Group Page 4-183
• Station Hunting Group Page 4-197
• User Web Portal Management Page 4-210
• Terminal Phonebook Page 4-230

Speed Dialing

The [Speed Dialing] menu allows you to set the service (such as Station Speed Dialing/One-Touch Dial-
ing, System Speed Dialing (2-4 digits)) used for each 1000-Slot Memory block number, allocate memory
areas used for each service and set the called party number/station number, station name, illumination 
color and others for each block number.
In the Station Speed Dialing/One Touch-Dialing, System Speed Dialing (2-4 digits) settings, you can con-
firm memory areas which can be assigned by displaying the list of memory area usage (allocated/none) for
each block number on the [Memory Area Allocation] screen. In addition, by editing the memory area for
each block number, you can set the Speed Dialing easily. In the [Speed Dialing] menu, you can use the
features as shown the table below.

<Uses of Speed Dialing>

Setting 
Screen

Features Summary
Reference 

Page

Speed Dialing > 
Usage of 1000-
Slot Memory 
Block Number

Usage settings 
of Speed Dial-
ing

Assign the services to be used for each 1000-
Slot Memory Block number (00-99). Enable to 
assign the following services.
• System Speed Dialing (Tenant)/Calling 

Name Display
• System Speed Dialing (for all Tenants)/

Calling Name Display
• Station Speed Dialing/One-Touch Dialing

Page 4-133
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<System Speed Dialing (Calling Name Display)>

Setting 
Screen

Features Summary
Reference 

Page

Speed Dialing > 
Memory Alloca-
tion for System 
Speed Dialing

Range Settings Enable to set the memory area (1000-Slot 
Memory Block number, Starting 10-Slot 
Memory Block number, the number of 10-Slot 
Memory Blocks, settings for all tenants) for 
each tenant number.

Page 4-135

Release 
Memory Area

Enable to clear the allocated memory area for 
each tenant number.

Page 4-138

Speed Dialing > 
Directory Number
Assignment for 
System Speed 
Dialing

Settings of 
Access Code, 
Called Party 
Number/
Station Num-
ber, Station 
Name, Illumi-
nation Color 
and Depart-
ment

By specifying a tenant number, enable to set/
change the Access Code, called party number/
station number, Station Name, Illumination 
Color and Department for each block number.

Page 4-139
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<Station Speed Dialing/One-Touch Dialing>

Continued on next page

Setting 
Screen

Features Summary
Reference 

Page

Speed Dialing > 
Memory Alloca-
tion for Station 
Speed/One-Touch 
Dialing

Range Settings Enable to set memory areas used for each 
station number (1000-Slot Memory Block 
number, Starting 10-Slot Memory Block num-
ber, facility for programming, the number of 
10-Slot Memory Blocks).
* You can also assign memory areas by 

specifying two or more station numbers at a 
time.

Page 4-143

Release 
Memory Area

Enable to clear the allocated memory area for 
each station number.
* You can also release memory areas by 

specifying two or more station numbers at a 
time.

Page 4-145

Speed Dialing > 
Directory Num-
ber Assignment 
for Station Speed 
Dialing

Settings of 
Access Code, 
Called Party 
Number/Sta-
tion Number, 
Station Name, 
Illumination 
Color and 
Department

By specifying a station number, enable to set/
change the Access Code, called party number/
station number, Station Name, Illumination 
Color and Department for each block number.

Page 4-147
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Continued on next page

Setting 
Screen

Features Summary
Reference 

Page

Memory Area 
Allocation

Verifying 
Memory Area 
Usage

Enable to confirm the memory area usage 
(allocated/none) for each 10-Slot Memory 
Block number (00-99) (confirmed by 10-Slot 
Memory Block).

Page 4-158

Verifying 
Setting Status 
of Allocated 
Memory Area

Enable to confirm the following setting 
statuses for the allocated memory area.
•  Block numbers to be used and the setting 

status
• Services in use (Station Speed Dialing/One-

Touch Dialing)
• Station Number
• The number of 10-Slot Memory Block to be 

used and the setting status

Page 4-159

Memory Area 
Allocation by 
Block Number 
Specification

Enable to assign memory areas by specifying 
the un-allocated memory block number.

Page 4-160

Editing 10-Slot 
Memory Block

Enable to set/change the Access Code, called 
party number/station number, Station Name 
for each allocated/un-allocated memory block 
number.

Page 4-161

Clearing Data 
in the 10-Slot 
Memory

Enable to clear the data for 10-Slot Memory 
Block which is left in un-allocated memory 
area.

Page 4-162
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Setting 
Screen 

Features Summary
Reference 

Page

Memory Area 
Allocation

Changing the 
Number of 
Memory 
Blocks for Use

Enable to change the number of memory 
blocks in an allocated memory area for each 
block number.

Page 4-163

Moving 
Memory Area

Enable to move the setting of allocated 
memory area to the un-allocated memory area.

Page 4-164

Releasing 
Memory 
Blocks for Use

Enable to clear the allocated memory area for 
each block number.

Page 4-166

Adding Sta-
tions (Station 
Speed Dialing)

Enable to add stations to the allocated memory 
area set to Station Speed Dialing.

Page 4-167

Searching 
Memory Area 
that the Station 
Uses

Enable to search the memory area being used 
for each station number (appropriate memory 
areas are displayed in a different color).

Page 4-169
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<Settings for Each 1000-Slot Memory Block Number>

Setting 
Screen

Features Summary
Reference 

Page

Speed Dialing > 
Called Party 
Number (Calling 
Party Number)/
Station Name for 
1000-Slot 
Memory Block 
Number

Speed Dialing 
> Called Party 
Number (Call-
ing Party Num-
ber)/Station 
Name/Illumi-
nation Color/
Department 
settings for 
1000-Slot 
Memory Block 
Number

Provides, for the specified block number 
range, the following functions.
• Setting or changing: 

- Called/Calling party number
- Station name (in Latin alphabet/simplified 

Chinese/traditional Chinese)
- Illumination color
- Department

Also provides the following search functions.
• Search through the entire speed dialing data 

set (up to 100,000 records)
• Editing the resulting data
Specify search fields and criteria such as 
called party number, name or specific key 
words.

Page 4-151
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Do either of the following to see the [Speed Dialing] screen in the work window:
• Click [Speed Dialing] on the standard mode submenu.
• On the Main Menu, click [Edit] > [Speed Dialing] in this order.

Continued on next page

No. Item Description

(1) [Usage of 1000-Slot Memory Block 
Number] button

Click to assign any of the following services for 1000-
Slot Memory Block numbers.
• System Speed Dialing (Tenant)/Calling Name Display
• System Speed Dialing (for All Tenants)/Calling Name 

Display
• Station Speed Dialing/One-Touch Dialing

(1) (2)

(4)

[Speed Dialing]
Menu

(6)

(3)

(5)
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No. Item Description

(2) [The State of Memory Area] button Click to display the following statuses of memory area 
use by the 10-Slot Memory Block.
• Setting statuses of called party numbers in each 10-Slot 

Memory Block.
• Memory allocation statuses of Station Speed Dialing/ 

One-Touch Dialing
• 10-Slot Memory Block allocation for stations and 

modification of the number of allocated 10-Slot 
Memory Block

• Search of the 10-Slot Memory Block allocated to 
stations

(3) System Speed 
Dialing (Calling 
Name Display)

[Memory 
Allocation] 
button

For tenants, click to allocate the 10-Slot Memory Block 
to be used for System Speed Dialing.

[Called Party 
Number (Calling
Party Number)/ 
Station Name] 
button

Click to assign the called party number (calling party 
number), station name, illumination color and department 
to Block numbers for System Speed Dialing.

(4) Station Speed 
Dialing/One-
Touch Dialing

[Memory
Allocation] 
button

For station numbers, click to assign the 10-Slot Memory 
Block to be used for Station Speed Dialing/One-Touch 
Dialing.

[Called Party 
Number/Station 
Name] button

Click to assign the called party number, station name, 
illumination color and department to Block numbers for 
Station Speed Dialing/One-Touch Dialing.

(5) 1000-Slot 
Memory Block 
Number

[Called Party 
Number (Calling
Party Number)/ 
Station Name] 
button

Click to assign the called party number (calling party 
number), station name, illumination color and department 
to Block numbers.

(6) “Available option: Clear the cache 
and read the all Speed Dialing data 
again” check box

Click to clear the cache and read the all Speed Dialing 
data again.
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Tips 1: When system data settings related to Speed Dialing is changed using other features such as the 
System Data Mode, the latest setting status and the indication on the [Speed Dialing] screen 
may not be corresponded. To obtain the latest cache data, check the “Available option: Clear 
the cache and read the all Speed Dialing data again” check box before reading data.

Tips 2: Reading Speed Dialing data when “Available option: Clear the cache and read the all Speed 
Dialing data again” check box is checked, the following dialog box is displayed.

To clear the cache and read the all Speed Dialing data, click the [Yes] button. To read the cache
stored up to now, click the [No] button.

Usage of 1000-Slot Memory Block Number

To assign a service to be used for each 1000-Slot Memory Block number, follow these steps:

STEP1: Click the [Usage of 1000-Slot Memory Block Number] button on the [Speed Dialing] 
screen. 
The [Usage of 1000-Slot Memory Block Number] screen is displayed.

(4)

(3)

[<<Back] button

(1)
(2)
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STEP2: Click the [Read] button.
PCPro starts reading the services assigned for 1000-Slot Memory Block numbers.

STEP3: Verify the contents displayed on the setting area.
STEP4: Select the Setting Status field for each 1000-Slot Memory Block number. Then, select the 

service to be used from the dropdown list. 
The [Number of un-allocated 10-Slot memory blocks] screen is displayed.

STEP5: Click the [Apply] button.

Services to be used for 1000-Slot Memory Block numbers have now been assigned.

No. Item Description

(1) [Read] button Click to read the setting status of 1000-Slot Memory 
Block number.

(2) [Apply] button Click to write the set contents to the SV9300.

(3) Display area for status of 1000-
Slot Memory Block Allocation

Displays the status of memory area allocation using 
different colors for each 1000-Slot Memory Block 
number (00-99).
• Blue : System Speed Dialing (Tenant)/Calling Name 

Display
• Orange: System Speed Dialing (for All Tenants)/Calling 

Name Display
• Green : Station Speed Dialing/One-Touch Dialing
• Pink : Other Service

(4) Setting Area 1000-Slot 
Memory Block 
Number field

Displays the 1000-Slot Memory Block number
• 1000-Slot Memory Block Number: 00-99

Function field Select the service to be used from the dropdown list.
The following services can be selected.
• System Speed Dialing (Tenant)/Calling Name Display
• System Speed Dialing (for All Tenants)/Calling Name 

Display
• Station Speed Dialing/One-Touch Dialing
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Memory Allocation for System Speed Dialing

In the memory allocation for System Speed Dialing, you can assign or release the memory area to be
used for each tenant.

<Range Settings>

To assign the memory area to be used for System Speed Dialing, follow these steps:

STEP1: Click the [Memory Allocation] button of System Speed Dialing (Calling Name Display) on 
the [Speed Dialing] screen.
The [Memory Allocation for System Speed Dialing] screen is displayed.

Continued on next page

No. Item Description

(1) [Read] button Click to read the setting status for each tenant number.

(2) Display area for the status of 
1000-Slot Memory Block 
allocation

Displays the setting status of 1000-Slot Memory Blocks 
by different colors for each 1000-Slot Memory Block 
number.
• Orange: System Speed Dialing (for All Tenants)
• Blue : System Speed Dialing (Tenant)

(3) [Range Settings] button Click to assign 10-Slot Memory Blocks to be used for 
tenants. The [Memory Allocation for Tenant] screen is 
displayed when you click this button.

(4)

(2)

[<<Back] button

(1)

(3)
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STEP2: Click the [Read] button. 
PCPro starts reading the services assigned for Tenants numbers.

STEP3: Verify the contents displayed on the setting area.

No. Item Description

(4) Setting Area Tenant No. 
field

Displays the Tenant numbers. 
• Tenant Number: 00-63
* Tenant numbers can be set on the [Memory Allocation 

for Tenant] screen.

1000-Slot 
Memory Block 
Number field

Displays the 1000-Slot Memory Block numbers.
• 1000-Slot Memory Block number: 00-99
* 1000-Slot Memory Block numbers can be set on the 

[Memory Allocation for Tenant] screen.

Starting 10-
Slot Memory 
Block Number 
field

Displays the Starting 10-Slot Memory Block numbers.
• Starting 10-Slot Memory Block Number: 00-99
* Starting 10-Slot Memory Block numbers can be set on 

the [Memory Allocation for Tenant] screen.

Number of 10-
Slot Memory 
Blocks field

Displays the number of 10-Slot Memory Blocks.
• Number of 10-Slot Memory Blocks: 1-1000

For All 
Tenants field

Displays the status of All Tenants area use.
• For All Tenants: Use/Not use
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STEP4: Select the Tenant number and click the [Range Setting] button. 
The [Memory Allocation for Tenant] screen is displayed.
* The [Memory Allocation for Tenant] screen can also be displayed by double clicking

an appropriate line.

Continued on next page

No. Item Description

(1) Tenant No. field Displays the Tenant number selected on the [Memory 
Allocation for System Speed Dialing] screen.
• Tenant Number: 00-63

(2) [Apply] button Click to write the set contents to the SV9300.

(3) [Release] button Click to release the assigned 10-Slot Memory Blocks.

(4) Memory Area to be used for 
Tenants

Select the memory area to be used for tenants by the 
following radio buttons.
• [Use Tenant area] radio button
• [Use Tenant area + All Tenants area] radio button
• [Use All Tenants area] radio button

(5)

(4)

(1)

(2)
(3)
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STEP5: Specify the memory area to be used for Tenants using radio buttons.
STEP6: Specify the number of 10-Slot Memory Block field, the 1000-Slot Memory Block Number 

field and the Starting 10-Slot Memory Block Number field.
STEP7: Click the [Apply] button.

Memory areas for System Speed Dialing have now been allocated.

<Release Memory Area>

To release the memory area to be used for System Speed Dialing, follow these steps:

STEP1: Repeat the operations from STEP1 to STEP4 of <Range Settings>.
STEP2: Click the [Release] button on the [Memory Allocation for Tenant] screen.

Memory areas for System Speed Dialing have now been released.

No. Item Description

(5) Tenant Area Number of 10-
Slot Memory 
Blocks field

Specify the number of 10-Slot Memory Blocks.
• Number of 10-Slot Memory Blocks:1-1000
* The number of 10-Slot Memory Blocks assigned for 

Tenant area differs depending on the setting status of 
System Speed Dialing. The range of allocatable 10-Slot 
Memory Blocks numbers is displayed on the right side 
of the number of 10-Slot Memory Blocks field with 
“Range X-XXXX”. Therefore, assign the number of 10-
Slot Memory Blocks within the range.

[Search 
allocable 
block] button

If you click this button, PCPro searches the available 
1000-Slot Memory Block numbers and 10-Slot Memory 
Block numbers. Then displays the searched numbers on 
the 1000-Slot Memory Block Number field and the Start-
ing 10-Slot Memory Block Number field.

1000-Slot 
Memory Block 
Number field

Specify the 1000-Slot Memory Block number.
• 1000-Slot Memory Block number: 00-99

Starting 10-
Slot Memory 
Block Number 
field

Specify the Starting 10-Slot Memory Block number.
• Starting 10-Slot Memory Block number: 00-99
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Directory Number Assignment for System Speed Dialing

To assign the Called Party number (Calling Party number)/Station number and Station Name for 
System Speed Dialing for each tenant, follow these steps:

STEP1: Click the [Called Party Number (Calling Party Number/Station Name] button of System 
Speed Dialing (Calling Name Display) on the [Speed Dialing] screen.
The [Directory Number Assignment for System Speed Dialing] screen is displayed.

Continued on next page

No. Item Description

(1) [Read] button Click to read the called party number/station number and 
called party name registered to the Memory Slot No.

(2) [Apply] button Click to write the set contents to the SV9300.

(3) [Tenant] tab Tenant No. 
field

Specify the Tenant number from the dropdown list.
• Tenant Number: 00-63

1000-Slot 
Memory Block 
Number field

Displays the 1000-Slot Memory Block number assigned 
to the Tenant number.

Memory Slot 
No. field

Displays the Memory Slot number assigned to the Tenant 
number.

Number of 
Slots field

Displays the number of slots assigned to the Tenant num-
ber.

(4)

[<<Back] button

(3) (2)

(1)
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Continued on next page

No. Item Description

(3) [Tenant] tab [Display per 
100 blocks] 
radio button

Check to display Block number by 100 blocks.
Select the number of blocks to be displayed from the 
dropdown list.
• Number of blocks to be displayed: 0-/100-
* The dropdown list can be selected only when the 

[Display per 100 blocks] radio button is checked.

[Display per 
1000 blocks] 
radio button

Check to display Block number by 1000 blocks.
Select the number of blocks to be displayed from the 
dropdown list.
• Number of blocks to be displayed: 0-/1000-
* The dropdown list can be selected only when the 

[Display per 1000 blocks] radio button is checked.

(4) Setting Area Memory Slot 
No. field

Displays the Memory Slot number.

Tenant No. 
field

Displays the Tenant number.

Abbreviated 
Code field

Displays the Abbreviated Code for System Speed Dialing.

Access Code 
field

Assign the Access Code.
• Access Code: 0-9, *, # (up to 4 digits) (however, A, B 

are automatically converted to *, #)

Called Party 
Number 
(Calling Party 
Number)/
Station No. 
field

Assign the Called Party number (Calling Party number)/
Station number.
• Called Party Number (Calling Party Number)/Station 

No.: 0-9, C, D, *, # (up to 26 digits) (however, A, B are 
automatically converted to *, #)

Station Name 
field

Assign the Station name of Called Party (up to 16 charac-
ters).

Illumination 
Color field

Select an illumination color for each calling party 
assigned to the Block number when an incoming call is 
terminated.
• Illumination Color: Red, Green, Blue, Yellow, Purple, 

Light Blue, White, Rotation.
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STEP2: Click the [Read] button. 
PCPro starts reading the 10-Slot Memory Blocks assigned for Tenants numbers.

STEP3: Verify the contents displayed on the setting area.
STEP4: Set the Access Code field, Called Party Number (Calling Party Number)/Station No. field, 

Station Name field, Illumination Color field and Department field, then click the [Apply] 
button.

The directory number for System Speed Dialing has now been assigned.

Memory Allocation for Station Speed/One-Touch Dialing

In the [Memory Allocation for Station Speed/One-Touch Dialing] settings, you can assign or release
memory areas to be used for each station at a time.

Tips: In Memory Allocation for Station Speed/One-Touch Dialing, approximately 200 lines of 
data can be read in about 5 minutes.

When you click the [Memory Allocation] button for Station Speed/One-Touch Dialing on the [Speed
Dialing] screen, the [Memory Allocation for Station Speed/One-Touch Dialing] screen is displayed.

No. Item Description

(4) Setting Area Department 
field

Select the Department from the dropdown list.
• Department: 00-99/NONE
* When Department Name is registered, the [00: Depart-

ment Name] is displayed.

(5)

(7)

(3)

(6)

[<<Back] button

(4)

(1)
(2)
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Continued on next page

No. Item Description

(1) [Read] button Click to read the memory area setting status for each 
station number.

(2) [Apply] button Click to write the set contents to SV9300.

(3) Feature Selec-
tion Area

[Station Speed 
Dialing] radio 
button

Check to assign the memory area to be used for Station 
Speed Dialing.

[One-Touch 
Dialing] radio 
button

Check to assign the memory area to be used for One-
Touch Dialing.

(4) [Memory Area Allocation] 
button

Click to verify the memory area usage for each block 
number on the [Memory Area Allocation] screen and 
specify the block number to edit the memory area.

(5) [Range Settings] button Click to assign the memory area for the two or more sta-
tions at a time on the [Memory Allocation] screen.

(6) [Release Memory Area] button Click to delete the memory area assigned to the stations at 
a time on the [Memory Allocation] screen.

(7) Setting Area Station No. 
field

Displays the station numbers which are registered to the 
system.
Kinds of station to be displayed are as follows.
• For Station Speed Dialing

Single Line Station
Multiline Terminal
IP Multiline Terminal
PHS/SIP Station

• For One-Touch Dialing
Multiline Terminal
IP Multiline Terminal

Memory Area 
field

Displays the setting status of memory areas for station 
numbers.
• Memory Area: Allocated/None
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<Range Settings>

To assign memory areas to be used for each station number at a time, follow these steps:

STEP1: Check the [Station Speed Dialing] radio button or the [One-Touch Dialing] radio button, then 
click the [Read] button.
PCPro starts reading the memory area setting status for the registered station numbers.

STEP2: Verify the contents displayed on the Setting Area.

No. Item Description

(7) Setting Area Number of 10-
Slot Memory 
Blocks field

Displays the number of 10-Slot Memory Blocks in the 
assigned memory areas.
• For Station Speed Dialing: 1-100
• For One-Touch Dialing : 1-4

Programming 
from the Sta-
tion field

Select the facility for programming the dialed number 
from the station from a dropdown list.
• Programming from the Station: Allowed/Not allowed

1000-Slot 
Memory Block 
Number field

Displays the 1000-Slot Memory Block number of the 
Block number.
• 1000-Slot Memory Block number: 00-99

Starting 10-
Slot Memory 
Block Number 
field

Displays the Starting 10-Slot Memory Block number of 
the Block number.
• 10-Slot Memory Block number: 00-99
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Tips: Verifying Memory Area Usage and Editing Memory Area
When you click the [Memory Area Allocation] button, the [Memory Area Allocation] screen
is displayed. In the [Memory Area Allocation] screen, you can verify the memory area usage
for each block number and edit the memory area such as the memory area allocation by the
block number specification.
For the details, refer to the “Verifying Memory Area Usage and Editing Memory Area”.

Page 4-156

STEP3: Select the station number (multiple selections are available) to assign the memory area, then 
click the [Range Settings] button.
The [Memory Allocation] screen is displayed.
* To set the number of 10-Slot Memory Blocks and the facility for programming by one 

station, double-click the appropriate line to assign the memory area.
STEP4: Set the items (2) and (3), then click the [OK] button.

If you click the [OK] button, the indication in the Memory Area field changes to
 “(Changing)”.

No. Item Description

(1) Station No. field Displays the selected station number.

(2) Allow or restrict the programming 
speed dial entry from the station 
field

Select whether the programming speed dial entry from 
the station is allowed or restricted from a dropdown list.
• Allow or restrict the programming speed dial entry 

from the station: Allowed/Not allowed

(3) Number of 10-Slot Memory 
Blocks field

Enter the number of 10-Slot Memory Blocks.
• For Station Speed Dialing: 1-100
• For One-Touch Dialing : 1-4

[OK] button

(2)

(3)

(1)
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STEP5: Click the [Apply] button.
The [Speed Dialing] dialog box is displayed when you click the [Apply] button.

STEP6: Specify the Starting 1000-Slot Memory Block Number field, then click the [Execute] button.

When the memory area allocation is completed, a dialog box is displayed to notify the com-
pletion of the process.

STEP7: Click the [OK] button.

Range settings have now been completed.

<Release Memory Area>

To delete memory areas assigned to the stations at a time, follow these steps:

STEP1: Check the [Station Speed Dialing] radio button or the [One-Touch Dialing] radio button, then 
click the [Read] button.
PCPro starts reading the memory area setting status for the registered station numbers.

STEP2: Select the station number (multiple selections are available) to delete the memory area, then 
click the [Release Memory Area] button.
The [Memory Allocation] screen is displayed.

[Execute] button

Starting 1000-Slot
Memory Block Number

field

[OK] button
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STEP3: Check the “Release Memory Blocks for use” check box, then click the [OK] button.

STEP4: Click the [Apply] button.
A dialog box is displayed to confirm the deletion of the 10-Slot Memory Block data.

Tips: When Deleting Memory Area by One Station
To delete the assigned memory area by one station, do the following operations.
1. Right-click the registered station number from the Station No. field on the Setting Area.
2. Click the “Release Memory Blocks for use” on the displayed menu.
3. Click the [Apply] button.

The memory area of the selected station number will be deleted.

STEP5: Click the [Yes] button.

When the deletion of the memory areas is completed, a dialog box is displayed to notify the
completion of the process.

STEP6: Click the [OK] button.

Memory Areas have now been released.

[OK] button

“Release Memory Blocks for use” 
check box

[Yes] button

[OK] button
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Directory Number Assignment for Station Speed Dialing

In the [Directory Number Assignment for Station Speed Dialing] settings, you can set the called party
number/station number and station name for Station Speed Dialing. 

STEP1: Check the [Called Party Number/Station Name] button for Station Speed Dialing/One-Touch 
Dialing on the [Speed Dialing] screen.
The [Directory Number Assignment for Station Speed Dialing] screen is displayed.

Continued on next page

No. Item Description

(1) [Read] button Click to read the called party number/station number and 
called party name registered to the Memory Slot No.

(2) [Apply] button Click to write the set contents to the SV9300.

(3)

[<<Back] button

(1)

(2)

(5)

(4)
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Continued on next page

No. Item Description

(3) [Station No.] 
tab

[Station Speed 
Dialing] radio 
button

Check to read the data by specifying the station number 
used for Station Speed Dialing.

[One-Touch 
Dialing] radio 
button

Check to read the data by specifying the station number 
used for One-Touch Dialing.

Station No. 
field

Enter the station number used for Station Speed Dialing 
or One-Touch Dialing.
• Station No.: 0-9, *, #

1000-Slot 
Memory Block 
Number field

Displays the 1000-Slot Memory Block number.
* The 1000-Slot Memory Block number is displayed after 

clicking the [Read] button.

Starting 10-
Slot Memory 
Block Number 
field

Displays the Starting 10-Slot Memory Block number.
* The Starting 10-Slot Memory Block number is dis-

played after clicking the [Read] button.

Number of 
Slots field

Displays the number of slots.
*  The number of slots is displayed after clicking the 

[Read] button.

(4) [Memory Area Allocation] 
button

Click to verify the memory area usage for each block 
number on the [Memory Area Allocation] screen and 
specify the block number to edit the memory area.

(5) Setting Area Memory Slot 
No. field

Displays the block numbers.

Abbreviated 
Code field

Displays the Abbreviated Code for Station Speed Dialing.
* This field is displayed only when reading the data with a 

specified station number for Station Speed Dialing.

Access Code 
field

Assign the Access Code.
• Access Code: 0-9, *, # (up to 4 digits) (however, A, B 

are automatically converted to *, #)
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STEP2: Check the [Station Speed Dialing] radio button or the [One-Touch Dialing] radio button.
STEP3: Enter the station number in the station number field, then click the [Read] button.

PCPro starts reading data for the specified station number.
STEP4: Verify the contents displayed on the setting area.

No. Item Description

(5) Setting Area Called Party 
Number/Sta-
tion No. field

Assign the called party number/station number.
• Called Party Number/Station No.: 0-9, C, D, *, # (up to 

26 digits) (however, A, B are automatically converted to 
*, #)

Station Name 
field

Set the station name (up to 16 characters)

Illumination 
Color field

Select an illumination color of Multiline Terminal for 
each calling party assigned to the Block number when an 
incoming call is terminated.
• Illumination Color: Red, Green, Blue, Yellow, Purple, 

Light Blue, White, Rotation

Department 
field

Select the Department from the dropdown list.
• Department: 00-99/NONE
* When Department Name is registered, the [00: Depart-

ment Name] is displayed.

Called Party 
Name (Simpli-
fied Chinese) 
field

Set the called party name using Simplified Chinese (up to 
16 characters).
* This field is displayed only when Simplified Chinese is 

selected by the Chinese Character settings.
Page 9-42

Called Party 
Name (Tradi-
tional Chi-
nese) field

Set the called party name using Traditional Chinese (up to 
16 characters).
* This field is displayed only when Traditional Chinese is 

selected by the Chinese Character settings.
Page 9-42
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Tips: Verifying Memory Area Usage and Editing Memory Area
When you click the [Memory Area Allocation] button, the [Memory Area Allocation] screen
is displayed. In the [Memory Area Allocation] screen, you can verify the memory area usage
for each block number and edit the memory area such as the memory area allocation by the
block number specification.

For the details, refer to the “Verifying Memory Area Usage and Editing Memory Area”.
Page 4-156

 
STEP5: Set the Access Code field, Calling Party Number/Station No. field, Station Name field, Illu-

mination Color field and Department field, then click the [Apply] button.
* When the Chinese character is set by the Optional Settings for Chinese, also set the Called

Party Name (Simplified Chinese) field or the Called Party Name (Traditional Chinese)
field.

When the writing of setting data is completed, a dialog box is displayed to notify the com-
pletion of the process.

STEP6: Click the [OK] button.

The directory number assignment for Station Speed Dialing has now been completed.

[OK] button
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1000-Slot Memory Block Number

To assign the called party number (calling party number) and the station name for each 1000-Slot 
Memory Block number, follow these steps:

STEP1: Click the [Called Party Number (Calling Party Number)/Station Name] button for 1000-Slot 
Memory Block Number on the [Speed Dialing] screen.
The [Called Party Number (Calling Party Number)/Station Name for 1000-Slot Memory 
Block Number] screen is displayed.

Continued on next page

No. Item Description

(1) [Read] button Click to read the setting status of 1000-Slot Memory 
Block number.

(2) [Apply] button Click to write the set contents to the SV9300.

(3) 1000-Slot Memory Block 
Number field

Select a 1000-Slot Memory Block number from the 
dropdown list.
• 1000-Slot Memory Block Number: 00-99
*1 After reading the setting status, a service name 

assigned for a 1000-Slot Memory Block is displayed 
with the 1000-Slot Memory Block number.

*2 This field is not displayed when the search mode is 
active.

(7)

[<<Back] button

(3)

(1)

(2)

(4)
(5) (6)
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Continued on next page

No. Item Description

(4) Starting 10-Slot Memory Block 
Number field

Select a Starting 10-Slot Memory Block number from the 
dropdown list.
• Starting 10-Slot Memory Block Number: 00-99
* This field is not displayed when the search mode is 

active.

(5) Number of Slots field Select the number of slots from the dropdown list.
• Number of Slots: 10, 20, 30, 40, 50, 60, 70, 80, 90, 100, 

300, 500, 1000
* This field is not displayed when the search mode is 

active.

(6) [Search...] button Click to display the [Search] screen.

(7) Setting Area Memory Slot 
No. field

Displays the 1000-Slot Memory Block number.
• 1000-Slot Memory Block Number: 00-99

Access Code 
field

Assign the Access Code.
• Access Code: 0-9, *, # (up to 4 digits) (however, A, B 

are automatically converted to *, #)

Called Party 
Number 
(Calling Party 
Number) field

Assign the Called Party number (Calling Party number)/
Station number.
• Called Party Number (Calling Party Number):

0-9, A, B, C, D, *, # (up to 26 digits)

Station Name 
field

Assign the Station name of Called Party (up to 16 
characters).

Station Name 
(Simplified 
Chinese) field

Assign the Station name of Called Party.
* This field is displayed only when the “Simplified Chi-

nese” check box is selected under [Tools] > [Settings] > 
[Options...] > [Chinese Character]. Page 9-42

Station Name 
(Traditional 
Chinese) field

Assign the Station name of Called Party.
* This field is displayed only when the “Traditional Chi-

nese” check box is selected under [Tools] > [Settings] > 
[Options...] > [Chinese Character]. Page 9-42
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STEP2: Set the items (3) to (5). Then click the [Read] button.
PCPro starts reading the setting for the selected 1000-Slot Memory Block number.

STEP3: Verify the contents displayed on the setting area.
STEP4: If you want to search for and access contact information, click the [Search...] button.

The [Search] screen appears.

Continued on next page

No. Item Description

(7) Setting Area Illumination 
Color field

Select an illumination color of Multiline Terminal for 
each calling party assigned to the Block number when an 
incoming call is terminated.
• Illumination Color: Red, Green, Blue, Yellow, Purple, 

Light Blue, White, Rotation

Department 
field

Select the Department from the dropdown list.
• Department: 00-99/NONE
* When Department Name is registered, the [00: Depart-

ment Name] is displayed.

No. Item Description

(1) Search field Type a character string of up to 64 bytes in the text field. 
Available characters: alphanumeric characters, simplified/
traditional Chinese characters

(3)

(1)

(2)
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STEP5: Type a character string in the [Search] field.
STEP6: If necessary, select the check box for the fields you want to search. Then click the [Search] 

button.

The search process begins. When the process is completed, the work window displays the
matching records and the total number of matches.

No. Item Description

(2) Search Option area If necessary, select the check box for the following search 
options (multiple selection available):
• Called Party Number
• Station Name
• Station Name (Simplified Chinese)
• Station Name (Traditional Chinese)
• Illumination Color
• Department

(3) [Search] button Click to start searching.
* When you use this button to start searching, the search 

screen will remain after the result is returned.

(1)

(2)

(4)
(3)
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NOTE 1: PCPro does not search the Memory Slot No. and Access Code fields.
NOTE 2: PCPro returns records that partially match the specified search string.
NOTE 3: Conditions of the search function are as follows:

- The search string is case-insensitive. (For example, “smith” will match “smith,”“Smith”
and “SMITH.”)

- Escape characters cannot be used in input strings. (For example, an asterisk is not inter-
preted as a wildcard but as a letter.)

NOTE 4: When more than one field in a record matches the search criteria, each matching field is 
counted separately and added to the total count of matches. The Block Number of the record, 
however, is not repeated in the list of read system data grids.

Example
Suppose a record contains the following information:
Block Number: 02000
Called Party Number (Calling Party Number): 12345
Station Name: 1234

If you search for “1234” in the Called Party Number (Calling Party Number) and Station
Name fields, the total count of matches will be two, but only a single record with Block Num-
ber 2000 will be shown in the list of read system data grids.

NOTE 5: A maximum of 1000 records are displayed in the list of read system data grids. If the number 
of matching records exceeds the limit, the first 1000 records, sorted by Block Number in as-
cending order, will be displayed in the grids.

No. Item Description

(1) [Read] button Click to retrieve information about the block shown in the 
current list.

(2) [Apply] button Click to write the changes you have made in the SV9300.

(3) Total count of matches Displays the total count of matches.

(4) [Exit Search Mode] button Click to clear the search result and to exit the search 
mode.
*1 This button is only displayed in Search Mode.
*2 When this button is clicked, the search results are 

removed and the following fields become active:
• 1000-Slot Memory Block Number
• Starting 10-Slot Memory Block Number
• Number of Slots
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NOTE 6: The [Search] screen can be used only in the [Called Party Number (Calling Party Number)/
Station Name for 1000-Slot Memory Block Number] screen. If you click the [<<Back] but-
ton on the screen, the [Search] screen will be closed.

STEP7: Add necessary changes. Then click the [Apply] button.
When the writing of setting data is completed, a dialog box is displayed to confirm the 
completion of the process.

STEP8: Click the [OK] button.

The settings for each 1000-Slot Memory Block number have now been completed.

Verifying Memory Area Usage and Editing Memory Area

This section explains how to verify the memory area usage and other editing methods with the [Memory
Area Allocation] screen.

Tips: In Memory Area Usage, approximately 200 lines of data can be read in about 5 minutes.

The [Memory Area Allocation] screen is displayed when you click the [Memory Area Allocation] 
button on the [Memory Allocation for Station Speed/One-Touch Dialing] screen or [Directory Number
Assignment for Station Speed Dialing] screen.

[OK] button

(2)

(5)

[Close] button

(3) (4)

(1)
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No. Item Description

(1) [Read] button Click to verify the memory area usage.

(2) 1000-Slot Memory Block Num-
ber field

Select the 1000-Slot Memory Block number to be used 
for Station Speed Dialing from a dropdown list.

(3) “Highlight un-allocated 10-Slot 
Memory Blocks in which speed 
dial entry is stored” check box

Check to highlight un-allocated 10-Slot Memory Blocks 
in which speed dial entry is stored.
* No operation is available for the memory area while un-

allocated 10-Slot Memory Blocks are highlighted.

(4) Search Area [Station Speed 
Dialing] radio 
button

Check to search the station number set for Station Speed 
Dialing.

[One-Touch 
Dialing] radio 
button

Check to search the station number set for One-Touch 
Dialing.

Station No. 
field

Enter the station number to search.

[Search] button Click to search the memory area usage for station number 
entered to the Station No. field.

(5) 10-Slot Memory Area Displays the memory area usage for each 10-Slot Memory 
Block number.
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<Verifying Memory Area Usage>

To verify the memory area usage (allocated/none) for each 10-Slot Memory Block Number (00-99), 
follow these steps:

STEP1: Click the [Read] button.
PCPro starts reading the memory area registered to 10-Slot Memory Block numbers.

STEP2: Verify the read memory area usage.

Tips: Verifying Un-allocated 10-Slot Memory Blocks in Which Speed Dial Entry is Stored
If you want to verify the un-allocated 10-Slot Memory Blocks in which speed dial entry is
stored, check the “Highlight un-allocated 10-Slot Memory Blocks in which speed dial entry
is stored” check box, then click the [Read] button.
Un-allocated 10-Slot Memory Blocks in which speed dial entry is stored, are highlighted.

* No operation is available for the memory area while un-allocated 10-Slot Memory Blocks
in which speed dial entry is stored are highlighted.

The memory area usage has now been verified.

Highlighted
Un-allocated

10-Slot Memory
Blocks
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<Verifying Setting Status of Allocated Memory Area>

To verify the setting status for the allocated memory area, follow these steps:

STEP1: Click the [Read] button, if necessary.
PCPro starts reading the memory area registered to 10-Slot Memory Block numbers.

STEP2: Place the mouse cursor on the allocated memory area.
Information set to the selected memory area is displayed on a pop-up window.

STEP3: Verify the information displayed on a pop-up window.

* The following information is displayed on a pop-up window.
- The block numbers to be used and the setting status
- The service features in use (Station Speed Dialing/One-Touch Dialing)
- Station number
- The number of 10-Slot Memory Blocks to be used and the setting status

The setting status of allocated memory area has now been verified.
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<Memory Area Allocation by Block Number Specification>

To assign the memory area by specifying the block number of a un-allocated memory, follow these
steps:

STEP1: Click the [Read] button, if necessary.
PCPro starts reading the memory area registered to 10-Slot Memory Block numbers.

STEP2: Right-click the un-allocated memory on the 10-Slot Memory Area, then click the “Use as 
Station Speed Dialing” or “Use as One-Touch Dialing”.

The [Memory Area Settings] screen is displayed.
STEP3: Specify the Station No. field and the 10-Slot Memory Blocks field, then click the [Apply] 

button.

When the writing of setting data is completed to the selected memory area, a dialog box is
displayed to notify the completion of the process.

Use as Station Speed Dialing

Use as One-Touch Dialing

[Apply] button

Number of 10-Slot Memory
Blocks field

Station No. field
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STEP4: Click the [OK] button.

The memory area allocation by block number specifications has now been completed.

<Editing 10-Slot Memory>

To set/change the Access Code, called party number/station number and called party name for each al-
located/un-allocated block number, follow these steps:

STEP1: Click the [Read] button, if necessary.
PCPro starts reading the memory area registered to 10-Slot Memory Block numbers.

STEP2: Right-click the 10-Slot Memory to be set or changed on the 10-Slot Memory Area, then click 
the “Edit this 10-Slot Memory”.

The [Directory Number Assignment for Station Speed Dialing] screen is displayed.
* When you specify the memory that stations are assigned, then click the “Edit this 10-Slot

Memory”, the screen is switched to the [Directory Number Assignment for Station Speed
Dialing] screen for station number specification ([Station No.] tab).
When you specify the un-allocated memory, then click the “Edit this 10-Slot Memory”,
the screen is switched to the [Called Party Number (Calling Party Number)/Station Name
for 1000-Slot Memory Block Number] screen.
Set or change the Access Code, called party number/station number and station name on
these setting screens.

The specified 10-Slot Memory has now been edited.

[OK] button

Edit this
10-Slot Memory
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<Clearing Data in the 10-Slot Memory>

To clear data in the 10-Slot Memory which is left in un-allocated memory area, follow these steps:

STEP1: Click the [Read] button, if necessary.
PCPro starts reading the memory area registered to 10-Slot Memory Block numbers.

STEP2: Right-click the 10-Slot memory on the 10-Slot Memory Area, then click the “Clear data in 
this 10-Slot Memory”.

STEP3: Click the [Yes] button.

When the clearing of data in the 10-Slot Memory is completed, a dialog box is displayed to
notify the completion of the process.

STEP4: Click the [OK] button.

The data in the 10-Slot Memory has now been cleared.

Clear data in this 10-Slot
Memory

[Yes] button

[OK] button
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<Changing the Number of Memory Blocks for Use>

To change the number of 10-Slot Memory Blocks in the allocated memory area for each 10-Slot Mem-
ory Block number, follow these steps:

STEP1: Click the [Read] button, if necessary.
PCPro starts reading the memory area registered to 10-Slot Memory Block numbers.

STEP2: Right-click the allocated memory area on the 10-Slot Memory Area, then click the “Change 
the number of Memory Blocks for use”.

The [Memory Area Settings] screen is displayed.
STEP3: Change the number of 10-Slot Memory Blocks with a slider, then click the [Apply] button.

A dialog box is displayed to confirm the change of the number of 10-Slot Memory Blocks.

NOTE: You cannot change station numbers when changing the number of 10-Slot Memory Blocks.

Change the number of
Memory Blocks for use

[Apply] button

Number of 10-Slot Memory
Blocks field
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STEP4: Click the [Yes] button.

When the change of the number of 10-Slot Memory Blocks for use is completed, a dialog
box is displayed to notify the completion of the process.

STEP5: Click the [OK] button.

The number of 10-Slot Memory Blocks for use has now been changed.

<Moving Memory Area>

To move the set contents of the allocated memory area to the un-allocated memory area, follow these
steps:

STEP1: Click the [Read] button, if necessary.
PCPro starts reading the memory area registered to 10-Slot Memory Block numbers.

STEP2: Right-click the allocated memory area on the 10-Slot Memory Area, then click the “Move 
Memory Blocks for use”.

[Yes] button

[OK] button

Move Memory Blocks
for use
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STEP3: Right-click the memory area to which you want to move, then click the “Move Here”.

A dialog box is displayed to confirm the move of selected memory area.
STEP4: Click the [Yes] button.

When the move of selected memory area is completed, a dialog box is displayed to notify the
completion of the process.

STEP5: Click the [OK] button.

The selected memory area has now been moved.

Move Here

[Yes] button

[OK] button
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<Releasing Memory Blocks for Use>

To clear the allocated memory blocks for each block number, follow these steps:

STEP1: Click the [Read] button, if necessary.
PCPro starts reading the memory area registered to 10-Slot Memory Block numbers.

STEP2: Right-click the allocated memory area on the 10-Slot Memory Area, then click the “Release 
Memory Blocks for use”.

A dialog box is displayed to confirm the release of the Memory Blocks.
STEP3: Click the [Yes] button.

A dialog box is displayed to confirm the clearing of released Memory Blocks data.
STEP4: Click the [Yes] button.

When the release of the Memory Blocks and the clearing of the Memory Blocks data are
completed, a dialog box is displayed to notify the completion of the process.

Release Memory Blocks
for use

[Yes] button

[Yes] button
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STEP5: Click the [OK] button.

The Memory Blocks for use have now been released.

<Adding Station (Station Speed Dialing)>

To add a station to the allocated memory area set to the Station Speed Dialing, follow these steps:

STEP1: Click the [Read] button, if necessary.
PCPro starts reading the memory area registered to 10-Slot Memory Block numbers.

STEP2: Right-click the allocated memory area on the 10-Slot Memory Area, then click the “Add Sta-
tion (Station Speed Dialing)”.

The [Memory Area Settings] screen is displayed.

[OK] button

Add Station
(Station Speed

Dialing)
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STEP3: Enter the station number to the Station No. field, then click the [Apply] button.

When the writing of setting data is completed, a dialog box is displayed to notify the com-
pletion of the process.

STEP4: Click the [OK] button.

Adding a station to the allocated memory area has now been completed.

[Apply] button

Station No. field

[OK] button
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<Searching Memory Area that the Station Uses>

To search the memory area that the station uses for each station number, follow these steps:

STEP1: Click the [Read] button, if necessary.
PCPro starts reading the memory area registered to 10-Slot Memory Block numbers.

STEP2: Enter the station number to the Station No. field.

STEP3: Check the [Station Speed Dialing] radio button or the [One-Touch Dialing] radio button, then 
click the [Search] button.
The memory area for the appropriate station number becomes a selective state when you
click the [Search] button.

A memory area that the station uses has now been searched.

Station No. field
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Call Pickup Group

The [Call Pickup Group] menu provides options to:
• View the list of Call Pickup Groups
• Add a new Call Pickup Group
• Delete or edit the existing Call Pickup Groups (for example, verifying or adding station data)

The system data to be affected in the [Call Pickup Group] menu is as follows.
- CM16 Y=0: Next station number in Call Pickup Group

NOTE 1: Up to 2 to 60 stations can be registered per Call Pickup Group.
NOTE 2: There is no constrain for the number of groups of Call Pickup Group.
NOTE 3: Information about the following stations can be viewed in the List of Groups area and the [List 

of Available Stations] window. These stations can be included in a Call Pickup Group.
- Single Line station
- Multiline Terminal station (including IP Station)
- Virtual line station
- PS station
- Standard SIP station

NOTE 4: For the following features, set the data by System Data Mode or Command Mode.
- Station number included in Group Diversion (CM16 Y=2)
- Pilot station in Call Pickup Group (CM16 Y=8)

NOTE 5: A station cannot be assigned to more than one Call Pickup Group. To transfer a member station 
from one Call Pickup Group to another, delete the station from the current group first, and then 
add the station to a new group.

NOTE 6: For the details of Call Pickup Group, refer to the “Programming Manual”.
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Do either of the following to see the [Call Pickup Group] screen in the work window:
• Click [Call Pickup Group] on the standard mode submenu.
• On the Main Menu, click [Edit] > [Call Pickup Group] in this order.

Continued on next page

No. Item Description

(1) [Read] button Click to retrieve information about Call Pickup Groups in the List 
of Groups area.

(2) [List of Available Stations] 
button

Click to display the [List of Available Stations] screen and to view 
stations not assigned to a Call Pickup Group.

(5)

(2)

(1)

[Call Pickup
 Group] Menu

(3)

(4)

(6)



Chapter 4 Standard Mode

4-172 NWA-088656-001 Rev.8.0

[Service] Category

No. Item Description

(3) List of 
Groups 
area

No. field Displays Group Numbers (starting from 1), which are assigned 
sequentially to each Call Pickup Group.
* If an error is detected in the data of a certain Call Pickup Group, a 

different sequential number (starting from 1) will be assigned to 
the group.

[Edit Group] 
field: [Edit] 
button

Click to retrieve information about Call Pickup Groups in the [Edit 
Group] screen, which is displayed when you click the button.

[Delete Group] 
field: [Delete] 
button

Click to delete the Call Pickup Group of your choice. When the 
group is deleted, the List of Groups area is updated to reflect the lat-
est information.

Station No. 
field

Displays the station numbers in a Call Pickup Group.
Station Numbers: 0 to 9, *, #

(4) [New Group] button Click to add a new group to the system. The [New Group] screen is 
displayed.

(5) [Edit Group] button Click to add stations to an existing group, change the order of sta-
tions, or view stations already assigned to a group. The [Edit Group] 
screen is displayed.

(6) [Delete Group] button Click to delete existing groups from the system. The [Delete Group] 
screen is displayed.
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Viewing, Editing, or Deleting Groups

To view, edit or delete groups, follow the steps below.
If you know the station number of a member station of the target Call Pickup Group, you can also use
the number to edit or delete the group. For details, see “Editing Groups” or “Deleting a Group.” 

Page 4-177 or Page 4-180

STEP1: On the [Call Pickup Group] screen, click the [Read] button.
PCPro starts retrieving Call Pickup Group information.

STEP2: In the [List of Groups] area, view the information about Call Pickup Groups.
• To edit a Call Pickup Group, go to STEP3.
• To delete a Call Pickup Group, go to STEP5.

NOTE: If an incorrect chain is detected in a certain Call Pickup Group, “ERR” is indicated in the 
[No.] field. In that case, click the [Edit] button and check the chain of the group.

STEP3: To edit a Call Pickup Group, click the [Edit] button in the [Edit Group] field for the group of 
your choice.
The [Edit Group] screen is displayed.

STEP4: On the [Edit Group] screen, edit the current data.
For details, see “Editing Groups.” Page 4-177

[List of Groups] area
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STEP5: To delete a Call Pickup Group, click the [Delete] button in the [Delete Group] field for the 
group of your choice.

An alert message appears, asking if you want to delete the group.

STEP6: Click the [Yes] button.

The target group is deleted.
When the process is completed, a confirmation message appears.

STEP7: Click the [OK] button.

The management of existing Call Pickup Groups has now been completed.

[Delete] button

[Yes] button

[OK] button
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Adding New Group

To add a new group, follow these steps:

STEP1: Click the [New Group] button on the [Call Pickup Group] screen.
The [New Group] screen is displayed.

No. Item Description

(1) [Apply] button Click to register the station number entered in the Station Numbers fields.

(2) [List of Available 
Stations] button

Click to display the [List of Available Stations] screen and to view sta-
tions not assigned to a Call Pickup Group.

(3) Station Numbers 
field

Enter a station number to register to a group.
• Grid display: Up to 60 lines
• Input characters: 0 to 9, *, #, blank field 
• Input length: Up to 8 digits (default: blank field)

(4) [Up] ( ) button Click to move the station number selected in the Station Numbers field 
one line upward.

(5) [Down] ( ) button Click to move the station number selected in the Station Numbers field 
one line downward.

(6) [Clear] button Click to clear the setting of the Station Numbers field.

(7) Display of the num-
ber of Station Num-
bers

Displays the number of station numbers to be assigned to the group and 
the capacity of the group (example: 9/60).

(6)

(3)

[<<Back] button
(7)

(5)

(4)
(2)

(1)
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STEP2: Set the Station Numbers field.

Tips: Finding Stations Not Assigned to a Call Pickup Group
Stations not assigned to a Call Pickup Group can be viewed as follows:
1.On the [New Group] screen, click the [List of Available Stations] button to display the

[List of Available Stations (Call Pickup Group)] screen.
2.In the [List of Available Stations (Call Pickup Group)] screen, click the [Read] button.

STEP3: Click the [Apply] button.
The station number entered in the Station Number field is registered to the group.

When the process is completed, a confirmation message appears.

STEP4: Click the [OK] button.

A new group has now been added.

[Read] button

[OK] button



Chapter 4 Standard Mode

4-177 NWA-088656-001 Rev.8.0

[Service] Category

Editing Groups

To view stations of a Call Pickup Group or add stations to an existing group, follow these steps: 

STEP1: Click the [Edit Group] button on the [Call Pickup Group] screen.
The [Edit Group] screen is displayed.

Continued on next page

No. Item Description

(1) [Read] button Click to read the station numbers assigned to the group in the Station No. 
in the Group field.

(2) [Apply] button Click to save and activate changes.

(3) [List of Available 
Stations] button

Click to display the [List of Available Stations] screen and to view sta-
tions not assigned to a Call Pickup Group.

(4) Station No. in the 
Group field

Enter a station number which belongs in the group (the station number 
pre-registered on the [New Group] screen).
• Input characters: 0 to 9, *, #, blank field 
• Input length: Up to 8 digits (default: blank field)

(8)

(5)

[<<Back] button

(4) (3)

(9)

(7)

(6)

(2)
(1)
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STEP2: In the Station No. in the Group field, enter a station number of the group, and then click the 
[Read] button.
The station numbers assigned to the target group are displayed in the Station Numbers As-
signed to the Group field.

No. Item Description

(5) Station Numbers 
Assigned to the 
Group field

Displays the station numbers assigned to the group in the Station No. in 
the Group field.
• Grid display: Up to 60 lines
• Input characters: 0 to 9, *, #, blank field 
• Input length: Up to 8 digits (default: blank field)
* The Station Numbers Assigned to the Group field can only be edited 

when the list of the station number is read by the [Read] button.

(6) [Up] ( ) button Click to move the station number selected in the Station Numbers 
Assigned to the Group field one line upward.

(7) [Down] ( ) button Click to move the station number selected in the Station Numbers 
Assigned to the Group field one line downward.

(8) [Clear] button Click to clear the setting of the Station No. in the Group field and Station 
Numbers Assigned to the Group field.

(9) Display of the num-
ber of Station Num-
bers

Displays the number of station numbers currently assigned to the group 
and the capacity of the group (example: 9/60).
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STEP3: View the station numbers assigned to the group which are read in the Station Numbers As-
signed to the Group field.

NOTE: If the group configuration which is read by the [Read] button is wrong (a chain is not formed 
correctly), delete the group and then register it again. For details of deleting a Call Pickup 
Group, see “Viewing, Editing, or Deleting Groups” or “Deleting a Group.”

Page 4-173 or Page 4-180

Tips: Finding Stations Not Assigned to a Call Pickup Group
Stations not assigned to a Call Pickup Group can be viewed as follows:
1.On the [Edit Group] screen, click the [List of Available Stations] button to display the [List

of Available Stations (Call Pickup Group)] screen.
2.In the [List of Available Stations (Call Pickup Group)] screen, click the [Read] button.

Station Numbers
Assigned to

the Group field

[Read] button
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STEP4: Enter the station numbers to be added in the Station Numbers Assigned to the Group field.
STEP5: Change the order of the station numbers by the   button, if necessary.
STEP6: Click the [Apply] button.

The station numbers entered in STEP4 are added to the target group.

The target Call Pickup Group has now been edited.

Deleting a Group

To delete a Call Pickup Group follow these steps:

STEP1: Click the [Delete] button on the [Call Pickup Group] screen.
The [Delete Group] screen is displayed.

Continued on next page

No. Item Description

(1) [Read] button Click to read the station numbers assigned to the group in the Station No. 
in the Group field.

(2) [Delete] button Click to delete the group in which the station number entered in the Sta-
tion No. in the Group field belongs.

(3) Station No. in the 
Group field

Enter a station number which belongs in the group to be deleted.
• Input characters: 0 to 9, *, #, blank field 
• Input length: Up to 8 digits (default: blank field)

(4)

[<<Back] button

(3)

(5)

(2)
(1)
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STEP2: In the Station No. in the Group field, enter a station number of the group, and then click the 
[Read] button.
The station numbers assigned to the target group are displayed in the Station Numbers As-
signed to the Group field.

STEP3: Click the [Delete] button.

An alert message appears, asking if you want to delete the group. 

STEP4: Click the [Yes] button.

The target group is deleted. 
When the process is completed, a confirmation message appears.

No. Item Description

(4) Station Numbers 
Assigned to the 
Group field

Displays the station numbers assigned to the group in the Station No. in 
the Group field.

(5) Display of the num-
ber of Station Num-
bers

Displays the number of station numbers currently assigned to the group 
and the capacity of the group (example: 9/60).

[Delete] button

[Yes] button
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STEP5: Click the [OK] button.

The target group has now been deleted.

[OK] button
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UCD Group

The [UCD Group] menu allow you to register a new UCD Group, add/view/edit (changing the order of
stations) stations to the existing UCD Groups and delete UCD Groups.

The system data to be affected in the [UCD Group] menu are as follows.
- CM17 Y=0: Next station number in ACD/UCD Group
- CM17 Y=1: Pilot station in ACD/UCD Group
- CM17 Y=2: ACD/UCD Group number

NOTE 1: Up to 1 to 60 stations can be registered per UCD Group.
NOTE 2: A maximum of 100 UCD Groups can be registered.
NOTE 3: Information about the following stations can be viewed in the List of Groups area and the [List 

of Available Stations] screen. These stations can be included in a UCD Group.
- Single Line station
- Multiline Terminal station (including IP Station)
- Virtual line station
- PS station
- Standard SIP station

NOTE 4: For the following features, set the data by System Data Mode or Command Mode.
- ACD/UCD service for internal call (CM17 Y=4)
- ACD/UCD service for C.O./DID incoming call (CM17 Y=5)
- ACD/UCD service for Tie Line incoming call (CM17 Y=6)
- ACD/UCD service for DID/Automated Attendant (CM17 Y=7)
- ACD/UCD Delay Announcement Service (CM17 Y=A)
- Designation of number of queuing in each ACD/UCD Group (CM17 Y=B)

NOTE 5: A station cannot be assigned to more than one UCD Group. To transfer a member station from 
one UCD Group to another, delete the station from the current group first, and then add the 
station to a new group.

NOTE 6: The pilot station and the UCD Group numbers cannot be changed. Delete the group before add-
ing a new group again.

NOTE 7: For the details of UCD Group, refer to the “Programming Manual”.
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Do either of the following to see the [UCD Group] screen in the work window:
• Click [UCD Group] on the standard mode submenu.
• On the Main Menu, click [Edit] > [UCD Group] in this order.

Continued on next page

No. Item Description

(1) [Read] button Click to retrieve information about UCD Groups in the List of Groups 
area.

(2) [List of Available Sta-
tions] button

Click to display the [List of Available Stations] screen and to view 
stations not assigned to a UCD Group.

[UCD Group] Menu

(5)

(1)

(2)

(3)

(4)

(6)
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No. Item Description

(3) List of 
Groups 
area

No. field Displays Group Numbers (starting from 1), which are assigned 
sequentially to each UCD Group.
* If an error is detected in the data of a certain UCD Group, a dif-

ferent sequential number (starting from 1) will be assigned to the 
group.

UCD Group 
No. field

Displays UCD Group Numbers.
UCD Group Numbers: 00 to 99, blank field

[Edit Group]
field: [Edit]
button

Click to retrieve information about UCD Groups in the [Edit 
Group] screen, which is displayed when you click the button.

[Delete Group]
field: [Delete]
button

Click to delete the UCD Group of your choice. When the group is 
deleted, the List of Groups area is updated to reflect the latest 
information.

Station No.
field

Displays the station numbers in a UCD Group.
Station Numbers: 0 to 9, *, #
* Pilot Stations, if any, are displayed at the top of their UCD 

Group.

Note field Displays additional information about the station.
Output information: Pilot Station, blank field

(4) [New Group] button Click to add a new group to the system. The [New Group] screen 
is displayed.

(5) [Edit Group] button Click to add stations to an existing group, change the order of 
stations, or view stations already assigned to a group. The [Edit 
Group] screen is displayed.

(6) [Delete Group] button Click to delete existing groups from the system. The [Delete 
Group] screen is displayed.
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Viewing, Editing, or Deleting Groups

To view, edit or delete groups, follow the steps below.
If you know the station number of a member station of the target UCD Group, you can also use the num-
ber to edit or delete the group. For details, see “Editing Groups” or “Deleting a Group.” 

Page 4-190 or Page 4-194

STEP1: On the [UCD Group] screen, click the [Read] button.
PCPro starts retrieving UCD Group information.

STEP2: In the [List of Groups] area, view the information about UCD Groups.
• To edit a UCD Group, go to STEP3.
• To delete a UCD Group, go to STEP5.

NOTE: If an incorrect chain is detected in a certain UCD Group, “ERR” is indicated in the [No.] 
field. In that case, click the [Edit] button and check the chain of the group.

STEP3: To edit a UCD Group, click the [Edit] button in the [Edit Group] field for the group of your 
choice.
The [Edit Group] screen is displayed.

STEP4: On the [Edit Group] screen, edit the current data.
For details, see “Editing Groups.” Page 4-190

[List of Groups] area
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STEP5: To delete a UCD Group, click the [Delete] button in the [Delete Group] field for the group 
of your choice.

An alert message appears, asking if you want to delete the group.

STEP6: Click the [Yes] button.

The target group is deleted.
When the process is completed, a confirmation message appears.

STEP7: Click the [OK] button.

The management of existing UCD Groups has now been completed.

[Delete] button

[Yes] button

[OK] button
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Adding New Group

To add a new group, follow these steps:

STEP1: Click the [New Group] button on the [UCD Group] screen.
The [New Group] screen is displayed.

Continued on next page

No. Item Description

(1) [Apply] button Click to register the station number entered in the Station Numbers fields.

(2) [List of Available 
Stations] button

Click to display the [List of Available Stations] screen and to view sta-
tions not assigned to a UCD Group.

(3) UCD Group No. 
field

From the dropdown list, select the UCD Group No. to register.
• Setting range: 00 to 99 (default: 00)

(4) Station Numbers 
field

Enter a station number to register to a group. Put the pilot station number 
at the top of the group.
• Grid display: Up to 60 lines
• Input characters: 0 to 9, *, #, blank field
• Input length: Up to 8 digits (default: blank field)

(5) [Up] ( ) button Click to move the station number selected in the Station Numbers field 
one line upward.

(6) [Down] ( ) button Click to move the station number selected in the Station Numbers field 
one line downward.

(3)

(7)

(4)

[<<Back] button
(8)

(5)

(6)

(2)

(1)
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STEP2: Set the UCD Group No. field and the Station Numbers field.

Tips: Finding Stations Not Assigned to a UCD Group
Stations not assigned to a UCD Group can be viewed as follows:
1.On the [New Group] screen, click the [List of Available Stations] button to display the

[List of Available Stations (UCD Group)] screen.
2.In the [List of Available Stations (UCD Group)] screen, click the [Read] button.

STEP3: Click the [Apply] button.
The station number entered in the Station Numbers field is registered to the group specified
in the UCD Group No. field.

When the process is completed, a confirmation message appears.

No. Item Description

(7) [Clear] button Click to clear the setting of the UCD Group No. field and the Station 
Number field.

(8) Display of the num-
ber of Station Num-
bers

Displays the number of station numbers to be assigned to the group and 
the capacity of the group (example: 9/60).

[Read] button
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STEP4: Click the [OK] button.

A new group has now been added.

Editing Groups

To view stations of a UCD Group or add stations to an existing group, follow these steps: 

STEP1: Click the [Edit Group] button on the [UCD Group] screen.
The [Edit Group] screen is displayed.

Continued on next page

No. Item Description

(1) [Read] button Click to read the station numbers assigned to the group in the Station No. 
in the Group field.

(2) [Apply] button Click to save and activate changes.

(3) [List of Available 
Stations] button

Click to display the [List of Available Stations] screen and to view sta-
tions not assigned to a UCD Group.

[OK] button

(10)

(7)

[<<Back] button

(6)

(3)

(11)

(9)

(8)

(2)

(5)

(4)

(1)
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No. Item Description

(4) Station No. in the 
Group field

Enter a station number which belongs in the group (the station number 
pre-registered on the [New Group] screen).
• Input characters: 0 to 9, *, #, blank field
• Input length: Up to 8 digits (default: blank field)

(5) UCD Group No. 
field

Displays the UCD Group No.(a group number registered to the pilot sta-
tion)
• Displayed Number: 00 to 99
* The UCD Group No. is displayed only when it is correctly read by the 

[Read] button.

(6) Pilot Station field Displays the Pilot Station of the UCD Group.
* The Pilot Station of the UCD Group is displayed only when it is cor-

rectly read by the [Read] button.

(7) Station Numbers 
Assigned to the 
Group field

Displays the station numbers assigned to the group in the Station No. in 
the Group field.
• Grid display: Up to 60 lines
• Input characters: 0 to 9, *, #, blank field
• Input length: Up to 8 digits (default: blank field)
* The Station Numbers Assigned to the Group field can only be edited 

when the station numbers assigned to the group are read by the [Read] 
button.

(8) [Up] ( ) button Click to move the station number selected in the Station Numbers 
Assigned to the Group field one line upward.
The station number at the top of the list is a pilot number, and cannot be 
moved to anywhere else on the list.

(9) [Down] ( ) button Click to move the station number selected in the Station Numbers 
Assigned to the Group field one line downward.

(10) [Clear] button Click to clear the setting of the Station No. in the Group field, UCD 
Group No. field, Pilot Station field, and the Station Numbers Assigned to 
the Group field.

(11) Display of the num-
ber of Station Num-
bers

Displays the number of station numbers currently assigned to the group 
and the capacity of the group (example: 9/60).
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STEP2: In the Station No. in the Group field, enter a station number of the group, and then click the 
[Read] button.
The station numbers assigned to the target group are displayed in the Station Numbers As-
signed to the Group field.

STEP3: View the station numbers assigned to the group which are read in the Station Numbers As-
signed to the Group field.

NOTE: If the group configuration which is read by the [Read] button is wrong (a chain is not formed 
correctly), delete the group and then register it again. For details of deleting a UCD Group, 
see “Viewing, Editing, or Deleting Groups” or “Deleting a Group.” Page 4-186 or 
Page 4-194

Station Numbers
 Assigned to the

 Group field
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Tips: Finding Stations Not Assigned to a UCD Group
Stations not assigned to a UCD Group can be viewed as follows:
1.On the [Edit Group] screen, click the [List of Available Stations] button to display the [List

of Available Stations (UCD Group)] screen.
2.In the [List of Available Stations (UCD Group)] screen, click the [Read] button.

STEP4: Enter the station numbers to be added in the Station Numbers Assigned to the Group field.
STEP5: Change the order of the station numbers by the   button, if necessary.
STEP6: Click the [Apply] button.

The station numbers entered in STEP4 are added to the target group.

The target UCD Group has now been edited.

[Read] button
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Deleting a Group

To delete a UCD Group, follow these steps:

STEP1: Click the [Delete] button on the [UCD Group] screen.
The [Delete Group] screen is displayed.

Continued on next page

No. Item Description

(1) [Read] button Click to read the station numbers assigned to the group in the Station No. 
in the Group field.

(2) [Delete] button Click to delete the group in which the station number entered in the Sta-
tion No. in the Group field belongs.

(3) Station No. in the 
Group field

Enter a station number which belongs in the group to be deleted.
• Input characters: 0 to 9, *, #, blank field
• Input length: Up to 8 digits (default: blank field)

(4) UCD Group No. 
field

Displays the UCD Group No.(a group number registered to the pilot sta-
tion)
• Displayed Number: 00 to 99
* The UCD Group No. is displayed only when it is correctly read by the 

[Read] button.

(6)

[<<Back] button

(5)

(3)

(7)

(2)

(4)

(1)
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STEP2: In the Station No. in the Group field, enter a station number of the group, and then click the 
[Read] button.
The station numbers assigned to the target group are displayed in the Station Numbers As-
signed to the Group field.

STEP3: Click the [Delete] button.

An alert message appears, asking if you want to delete the group.

No. Item Description

(5) Pilot Station field Displays the Pilot Station of the UCD Group.
* The Pilot Station of the UCD Group is displayed only when it is cor-

rectly read by the [Read] button.

(6) Station Numbers 
Assigned to the 
Group field

Display the station numbers assigned to the group in the Station No. in 
the Group field.

(7) Display of the num-
ber of Station Num-
bers

Displays the number of station numbers currently assigned to the group 
and the capacity of the group (example: 9/60).

[Delete] button
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STEP4: Click the [Yes] button.

The target group is deleted.
When the process is completed, a confirmation message appears.

STEP5: Click the [OK] button.

The target group has now been deleted.

[Yes] button

[OK] button
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Station Hunting Group

The [Station Hunting Group] menu allow you to register a new Station Hunting Group, add/view/edit
(changing the order of stations) stations to the existing Station Hunting Groups and delete Station Hunting
Groups.

The system data to be affected in the [Station Hunting Group] menu are as follows.
- CM18 Y=0: Next station number in Station Hunting Group
- CM18 Y=1: Kind of station numbers included in Station Hunting Group

NOTE 1: Up to 2 to 60 stations can be registered per Station Hunting Group.
NOTE 2: There is no constrain for the number of groups in Station Hunting Groups.
NOTE 3: Information about the following stations can be viewed in the List of Groups area and the [List 

of Available Stations] screen. These stations can be included in a Station Hunting Group.
- Single Line station
- Multiline Terminal station (including IP Station)
- Virtual line station
- PS station
- Standard SIP station
- ISDN station

NOTE 4: For the following features, set the data by System Data Mode or Command Mode.
- Secretary station (CM18 Y=2)

NOTE 5: A station cannot be assigned to more than one Station Hunting Group. To transfer a member 
station from one Station Hunting Group to another, delete the station from the current group 
first, and then add the station to a new group.

NOTE 6: The Pilot Station and mode of the Station Hunting Group cannot be changed. Delete the group 
once before adding a new group again.

NOTE 7: For CM18 Y=0, set the station hunting group with the pilot station assigned by CM57 Y=33.
NOTE 8: In service originating station numbers specified by CM13 Y=64, assign a pilot station number 

specified by CM57 Y=33 as a pilot station and assign others as member stations.
NOTE 9: For the details of Station Hunting Group, refer to the “Programming Manual”.
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Do either of the following to see the [Station Hunting Group] screen in the work window:
• Click [Station Hunting Group] on the standard mode submenu.
• On the Main Menu, click [Edit] > [Station Hunting Group] in this order.

Continued on next page

No. Item Description

(1) [Read] button Click to retrieve information about Station Hunting Groups in the List 
of Groups area.

(2) [List of Available Sta-
tions] button

Click to display the [List of Available Stations] screen and to view 
stations not assigned to a Station Hunting Group.

(2)

(3)
[Station Hunting

 Group] menu

(1)

(4)

(6)(5)
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No. Item Description

(3) List of 
Groups 
area

No. field Displays Group Numbers (starting from 1), which are assigned 
sequentially to each Station Hunting Group.
* If an error is detected in the data of a certain Station Hunting 

Group, a different sequential number (starting from 1) will be 
assigned to the group.

[Edit Group]
field: [Edit]
button

Click to retrieve information about Station Hunting Groups in the 
[Edit Group] screen, which is displayed when you click the button.

[Delete Group]
field: [Delete]
button

Click to delete the Station Hunting Group of your choice. When 
the group is deleted, the List of Groups area is updated to reflect 
the latest information.

Type of Group 
field

Displays the Station Hunting type.
Station Hunting type: Terminal/Circular/Secretarial 

Station No.
field

Displays the station numbers in a Station Hunting Group.
Station Numbers: 0 to 9, *, #
* Pilot Stations, if any, are displayed at the top of their Station 

Hunting Group.

Note field Displays additional information about the station.
Output information: Pilot Station, blank field

(4) [New Group] button Click to add a new group to the system. The [New Group] screen 
is displayed.

(5) [Edit Group] button Click to add stations to an existing group, change the order of 
stations, or view stations already assigned to a group. The [Edit 
Group] screen is displayed.

(6) [Delete Group] button Click to delete existing groups from the system. The [Delete 
Group] screen is displayed.
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Viewing, Editing, or Deleting Groups

To view, edit or delete groups, follow the steps below.
If you know the station number of a member station of the target Station Hunting Group, you can also
use the number to edit or delete the group. For details, see “Editing Groups” or “Deleting a Group.” 

Page 4-204 or Page 4-207

STEP1: On the [Station Hunting Group] screen, click the [Read] button.
PCPro starts retrieving Station Hunting Group information.

STEP2: In the [List of Groups] area, view the information about Station Hunting Groups.
• To edit a Station Hunting Group, go to STEP3.
• To delete a Station Hunting Group, go to STEP5.

NOTE: If an incorrect chain is detected in a certain Station Hunting Group, “ERR” is indicated in 
the [No.] field. In that case, click the [Edit] button and check the chain of the group.

STEP3: To edit a Station Hunting Group, click the [Edit] button in the [Edit Group] field for the group 
of your choice.
The [Edit Group] screen is displayed.

STEP4: On the [Edit Group] screen, edit the current data.
For details, see “Editing Groups.” Page 4-204

[List of Groups] area



Chapter 4 Standard Mode

4-201 NWA-088656-001 Rev.8.0

[Service] Category

STEP5: To delete a Station Hunting Group, click the [Delete] button in the [Delete Group] field for 
the group of your choice.

An alert message appears, asking if you want to delete the group.

STEP6: Click the [Yes] button.

The target group is deleted.
When the process is completed, a confirmation message appears.

STEP7: Click the [OK] button.

The management of existing Station Hunting Groups has now been completed.

[Delete] button

[Yes] button

[OK] button
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Adding New Group

To add a new group, follow these steps:

STEP1: Click the [New Group] button on the [Station Hunting Group] screen.
The [New Group] screen is displayed.

Continued on next page

No. Item Description

(1) [Apply] button Click to register the station number entered in the Station Numbers fields.

(2) [List of Available 
Stations] button

Click to display the [List of Available Stations] screen and to view sta-
tions not assigned to a Station Hunting Group.

(3) Group Type field From the dropdown list, select the group type of Station Hunting to regis-
ter.
• Group Type: Terminal/Circular/Secretarial (default: Terminal)

(4) Station Numbers 
field

Enter a station number to register to a group.
• Grid display: Up to 60 lines
• Input characters: 0 to 9, *, #, blank field 
• Input length: Up to 8 digits (default: blank field)

(5) [Up] ( ) button Click to move the station number selected in the Station Numbers fields 
one line upward.

(6) [Down] ( ) button Click to move the station number selected in the Station Numbers fields 
one line downward.

(7) [Clear] button Click to clear the setting of the Station Numbers fields.

(7)

(4)

(3)

[<<Back] button

(2)

(8)

(6)

(5)

(1)
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STEP2: Set the Group Type field and the Station Numbers field.
Tips: Finding Stations Not Assigned to a Station Hunting Group

Stations not assigned to a Station Hunting Group can be viewed as follows:
1.On the [New Group] screen, click the [List of Available Stations] button to display the

[List of Available Stations (Station Hunting Group)] screen.
2.In the [List of Available Stations (Station Hunting Group)] screen, click the [Read] button.

STEP3: Click the [Apply] button.
The station number entered in the Station Number fields is registered to the group.

When the process is completed, a confirmation message appears.

STEP4: Click the [OK] button.

A new group has now been added.

No. Item Description

(8) Display of the num-
ber of Station Num-
bers

Displays the number of station numbers to be assigned to the group and 
the capacity of the group (example: 9/60).

[Read] button

[OK] button
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Editing Groups

To view stations of a Station Hunting Group or add stations to an existing group, follow these steps: 

STEP1: Click the [Edit Group] button on the [Station Hunting Group] screen.
The [Edit Group] screen is displayed.

Continued on next page

No. Item Description

(1) [Read] button Click to read the station numbers assigned to the group in the Station No. 
in the Group field.

(2) [Apply] button Click to save and activate changes.

(3) [List of Available 
Stations] button

Click to display the [List of Available Stations] screen and to view sta-
tions not assigned to a Station Hunting Group.

(4) Station No. in the 
Group field

Enter a station number which belongs in the group (the station number 
pre-registered on the [New Group] screen.
• Input characters: 0 to 9, *, #, blank field 
• Input length: Up to 8 digits (default: blank field)

(5) Group Type field Displays the group type of Station Hunting to register from a dropdown 
list.
• Group Type: Terminal/Circular/Secretarial 
* The group type of the Station Hunting is displayed only when it is cor-

rectly read by the [Read] button.

(10)

(7)

[<<Back] button

(6)

(3)

(11)

(9)

(8)

(2)

(5)

(4)

(1)
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STEP2: In the Station No. in the Group field, enter a station number of the group, and then click the 
[Read] button.
The station numbers assigned to the target group are displayed in the Station Numbers As-
signed to the Group field.

No. Item Description

(6) Pilot Station field Displays the Pilot Station of the Station Hunting.
* The Pilot Station of the Station Hunting is displayed only when it is cor-

rectly read by the [Read] button.

(7) Station Numbers 
Assigned to the 
Group field

Displays the station numbers assigned to the group in the Station No. in 
the Group field.
• Grid display: Up to 60 lines
• Input characters: 0 to 9, *, #, blank field 
• Input length: Up to 8 digits (default: blank field)
* The Station Numbers Assigned to the Group field can only be edited 

when the station numbers assigned to the group field are read by the 
[Read] button.

(8) [Up] ( ) button Click to move the station number selected in the Station Numbers 
Assigned to the Group field one line upward.
* For a Station Hunting-Terminal group, the pilot number is shown at the 

top of the list, and cannot be moved to anywhere else on the list.

(9) [Down] ( ) button Click to move the station number selected in the Station Numbers 
Assigned to the Group field one line downward.

(10) [Clear] button Click to clear the setting of the Station No. in the Group field, Group 
Type field, Pilot Station field, and the Station Numbers Assigned to the 
Group field.

(11) Display of the num-
ber of Station Num-
bers

Displays the number of stations currently assigned to the group and the 
capacity of the group (example: 9/60).
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STEP3: View the station numbers assigned to the group which are read in the Station Numbers As-
signed to the Group field.

NOTE: If the group configuration which is read by the [Read] button is wrong (a chain is not formed 
correctly), delete the group and then register it again. For details of deleting a Station Hunt-
ing Group, see “Viewing, Editing, or Deleting Groups” or “Deleting a Group.” 

Page 4-200 or Page 4-207

Tips: Finding Stations Not Assigned to a Station Hunting Group
Stations not assigned to a Station Hunting Group can be viewed as follows:
1.On the [Edit Group] screen, click the [List of Available Stations] button to display the [List

of Available Stations (Station Hunting Group)] screen.
2.In the [List of Available Stations (Station Hunting Group)] screen, click the [Read] button.

Station Numbers
 Assigned to the

 Group field

[Read] button
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STEP4: Enter the station numbers to be added in the Station Numbers Assigned to the Group field.
STEP5: Change the order of the station numbers by the   button, if necessary.
STEP6: Click the [Apply] button.

The station numbers entered in STEP4 are added to the target group.

The target Station Hunting Group has now been edited.

Deleting a Group

To delete a Station Hunting Group, follow these steps:

STEP1: Click the [Delete] button on the [Station Hunting Group] screen.
The [Delete Group] screen is displayed.

Continued on next page

No. Item Description

(1) [Read] button Click to read the station numbers assigned to the group in the Station No. 
in the Group field.

(2) [Delete] button Click to delete the group in which the station number entered in the Sta-
tion No. in the Group field belongs.

(3) Station No. in the 
Group field

Enter a station number which belongs in the group to be deleted.
• Input characters: 0 to 9, *, #, blank field 
• Input length: Up to 8 digits (default: blank field)

(6)

[<<Back] button

(5)

(3)

(7)

(2)

(4)

(1)
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STEP2: In the Station No. in the Group field, enter a station number of the group, and then click the 
[Read] button.
The station numbers assigned to the target group are displayed in the Station Numbers As-
signed to the Group field.

STEP3: Click the [Delete] button.

An alert message appears, asking if you want to delete the group.

No. Item Description

(4) Group Type field Displays the group type of Station Hunting to register from a dropdown 
list.
• Group Type: Terminal/Circular/Secretarial 
* The group type of the Station Hunting is displayed only when it is cor-

rectly read by the [Read] button.

(5) Pilot Station field Displays the Pilot Station of the Station Hunting.
* The Pilot Station of the Station Hunting Group is displayed only when 

it is correctly read by the [Read] button.

(6) Station Numbers 
Assigned to the 
Group field

Displays the station numbers assigned to the group in the Station No. in 
the Group field.

(7) Display of the num-
ber of Station Num-
bers

Displays the number of stations currently assigned to the group and the 
capacity of the group (example: 9/60).

[Delete] button
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STEP4: Click the [Yes] button.

The target group is deleted.
When the process is completed, a confirmation message appears.

STEP5: Click the [OK] button.

The target group has now been deleted.

[Yes] button

[OK] button
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User Web Portal Management

The [User Web Portal Management] menu provides the following features.
• Verifying the Web Server Setting Status of SV9300 Page 4-212
• Starting, Stopping and Restarting Web Server Page 4-213
• Port Settings for the Web Server Page 4-214
• Account Settings Page 4-215
• Verifying or Changing List of Settings Page 4-220
• Log Collections Page 4-225
• Accessing to User Web Portal Page 4-228

Do either of the following to see the [Web Server Settings] screen of the [User Web Portal Management]
menu in the work window:

• Click [User Web Portal Management] on the standard mode submenu.
• On the Main Menu, click [Edit] > [User Web Portal Management] in this order.

(1)

[User Web Portal
Management]

Menu

(5)
(6)

(2)

(4)

(3)

(7)
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No. Item Description

(1) [Read] button Click to read the Web Server status and port settings of the 
Web Server.

(2) Web Server status field Displays the operating status of the Web Server.
• Operating status of Web Server: 

Now Starting.../Working(HTTPS)/Working(HTTP)/Stop

(3) Start and stop 
the Web Server 
Area

[Start] button Click to start the Web Server. The [User Web Portal Manage-
ment] screen is displayed when you click this button.

[Stop] button Click to stop the Web Server.

[Restart] 
button

Click to restart the Web Server. The [User Web Portal Man-
agement] screen is displayed when you click this button.

(4) Port settings 
area for the 
Web Server

Maintenance 
Port field

Displays the settings of Maintenance Port
• Settings of Maintenance Port: Available/Not Available

VoIP Port field Displays the settings of VoIP Port
• Settings of VoIP Port: Available/Not Available

Port No. field Displays the port number of the Web Server.
• HTTPS: 443, 1024-65534
• HTTP  : 80, 1024-65534

Connection 
mode field

Displays the connection mode used for the Web Server.
• HTTPS
• HTTP

(5) [Account Settings>>] button Click to verify or change the account settings of User Web 
Portal.

(6) [List of Settings>>] button Click to verify or change the setting of service memory for 
each item set by the [User Web Portal Management] menu 
and the corresponding system data.

(7) [Get Log>>] button Click to perform storage settings of logs or obtain logs of 
User Web Portal.
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Verifying the Web Server Setting Status of SV9300

To verify the Web Server setting status of SV9300, follow these steps:

STEP1: Click the [Read] button on the [Web Server Settings] screen. 
A setting status of the Web Server is read.

STEP2: Verify the setting status displayed on the [Web Server Settings] screen.

The Web Server setting status of SV9300 has now been verified.
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Starting, Stopping and Restarting Web Server

To start or restart the Web Server, follow these steps:

<Starting or Restarting Web Server>

STEP1: Click the [Read] button on the [Web Server Settings] screen.
A setting status of the Web Server is read.

STEP2: Click the [Start] button or the [Restart] button on the [Web Server Settings] screen.
The [User Web Portal Management] screen is displayed.

STEP3: Set the item (2).

No. Item Description

(1) [Apply] button Click to start or restart the Web Server with set contents.

(2) Port settings 
area for the 
Web Server

[Maintenance 
Port] radio 
button

Select “Available” when using a Maintenance Port.
• Maintenance Port: Available/Not Available

[VoIP Port] 
radio button

Select “Available” when using a VoIP Port.
• VoIP Port: Available/Not Available

Port No. for the 
Web Server 
field

Set the port number of the Web Server.
• HTTPS: 443, 1024-65534
• HTTP  : 80, 1024-65534

[Connection 
mode] radio 
button

Select the connection mode for the Web Server.
• HTTPS
• HTTP

(1)

(2)
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STEP4: Click the [Apply] button.
Web Server is started or restarted by the set contents.

The Web Server has now been started or restarted.

<Stopping Web Server>

STEP1: Click the [Read] button on the [Web Server Settings] screen.
A setting status of the Web Server is read.

STEP2: Click the [Stop] button on the [Web Server Settings] screen.
The Web Server is stopped.

The Web Server has now been stopped.

Port Settings for the Web Server

To set or change the port settings to be used for the Web Server, refer to the STEPS of <Starting or 
Restarting Web Server>. Page 4-213

Port settings for Web Server have now been set or changed.
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Account Settings

For account settings, you can set the user account to be used on User Web Portal.

NOTE: Set the account to suit the operation of the customer. It is recommended to create one 
account a minimum for administrator in a system. “User” is set as the default data of User 
permission.

When you click the [Account Settings >>] button on the [Web Server Settings] screen, 
The [Account Settings] screen is displayed.

[<<Back] button

(1)

(3)

(2)
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<Changing User Permission, Password Clear>

To change the User permission or clear the password for each User ID (Station No.), follow these steps:

STEP1: Click the [Read] button.
The account information of User Web Portal is read from SV9300.
List of accounts is displayed in the work window.

No. Item Description

(1) [Read] button Click to read the account information of the User Web 
Portal from the SV9300.

(2) [Range Settings] button Click to change the user permission for multiple users.

(3) Account 
Information
Display Area

User ID
 (Station No.) 
field

Displays User IDs (Station No.).

Name field Displays the names assigned to the station numbers using 
the Name Display feature.
* For details of Name Display, refer to the “Programming 

Manual”.

User permis-
sion field

Displays the user permission set for each User ID (Station 
No.).
User permission: Administrator/Supervisor/User/

Unauthorized User
* Currently-operated user permission is displayed in this 

field. If the user permission set to the service memory 
and system data differs, user permission is displayed by 
“*” (green color). In such a case, verify the set contents 
on the [List of Settings] screen.

Password 
setting field

Displays the password setting status for each User ID 
(Station No.).
Password Setting Status: Set/Unestablished

Config field Click to change the account settings.
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STEP2: Click the [...] button of the User ID for which you want to change the setting.

If you click the [...] button, the [User Web Portal Management] screen is displayed.
STEP3: Set the items (3) and (4).

Continued on next page

No. Item Description

(1) [Apply] button Click to write the set contents to the SV9300.

(2) User ID (Station No.) field Displays the Use ID (Station No.).

[...] button

(1)

(2)

(3)

(4)
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STEP4: Click the [Apply] button.
PCPro writes the set contents to the SV9300.

Changing user permission and password clear have now been completed.

<Changing User Permissions by Range Settings>

To change the user permission for multiple users at a time, follow these steps:

STEP1: Click the [Read] button.
The account information of User Web Portal is read from SV9300.
List of accounts is displayed in the work window.

STEP2: Select the all User IDs for which you want to change the setting. Then click the [Range 
Settings] button.

If you click the [Range Settings] button, the [User Web Portal Management] screen is dis-
played.

No. Item Description

(3) User permission field Specify the user permission to the selected User ID 
(Station No.).
User permission: Administrator/Supervisor/User/

Unauthorized User

(4) “Clear the Password” check box Click to clear the password for selected User ID (Station 
No.).
* If you clear the password, a station number is assigned 

as a default data.

[Range Settings]
button
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STEP3: Set the item (3).

STEP4: Click the [Apply] button. 
PCPro writes the set contents to the SV9300.

NOTE: Passwords of users cannot be cleared by the range settings.

Changing user permissions by range settings have now been completed.

No. Item Description

(1) [Apply] button Click to write the set contents to the SV9300.

(2) User ID (Station No.) field Display the User IDs (Station No.) selected on the 
[Account Settings] screen.

(3) User permission field Specify the user permission to the selected User IDs 
(Station No.).
User Authority: Administrator/Supervisor/User/

Unauthorized User

(1)

(2)

(3)
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Verifying or Changing List of Settings

In the list of Settings, you can verify or change the settings of the service memory used for each setting
item on the User Web Portal and system data corresponded to the service memory.

NOTE: About List of Settings.
• Set contents using User Web Portal by users are saved into the service memory.
• The system makes contents in the service memory set by user higher priority than system

data settings and operates.
• In the [List of Settings] screen, the setting status of system data and service memory can be 

compared (change the set contents if necessary).
• Enough care should be taken to change the contents in the service memory while the ser-

vice of User Web Portal is operating.
• The set contents to be saved as the service memory are as follows.

- Name Display
- Type of My Line Information on Multiline Terminal
- Illumination Color of Multiline Terminal for Internal Call
- Illumination Color of Multiline Terminal for External Call
- Use permission for User Web Portal

To verify or change the settings of the service memory used for each setting item on the User Web Portal
and system data corresponded to the service memory, follow these steps:

STEP1: Click the [List of Settings >>] button on the [Web Server Settings] screen.
The [List of Settings] scree is displayed.
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STEP2: Select the item to be read by the Setting Item pull-down menu. Then click the [Read] button.
List of settings is read from the SV9300.

Continued on next page

No. Item Description

(1) [Apply] button Click to write the set contents to the SV9300.

(2) [Read] button Click to read the list of settings from the SV9300.

(3) Setting Item pull-down menu Click  to select the setting item from the pull-down 
menu.
Setting Item:
- Name Display
- Type of My Line Information on Multiline Terminal
- Illumination Color of Multiline Terminal for Internal 

Call
- Illumination Color of Multiline Terminal for External 

Call
- User permission for User Web Portal

(4) “Edit Service Memory” check 
box

Check to edit values for the service memory.

[<<Back] button     

(1)
(2)

(5)

(3)

(4)
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Tips: Setting Item for User Web Portal, Related System Data and Service Memory
The following table shows the details of the items set on the User Web Portal and related
system data and service memory.

Continued on next page

No. Item Description

(5) List of settings 
Area

Diff. field Displays “ * ” if there is difference between the service 
memory and the system data setting.
* In actual operations, set contents in the service memory 

have a higher priority than system data settings.

User ID 
(Station No.) 
field

Displays User IDs (Station No.)

System Data 
field

Displays the setting status of system data used for the item 
selected by the Setting Item pull-down menu.

Service 
Memory field

Displays the setting status of service memory when using 
the item selected by the Setting Item pull-down menu on 
the User Web Portal.

Setting Item System Data Service Memory

Name Display CM77 Y=1
• No data (default)

• Station Name assignment with 
character (for English) 
(Maximum 16 characters)

CMEF Y=00
• No data (as per system data if no 

data is assigned)
• Station Name assignment with 

character (for English) 
(Maximum 16 characters)

Type of My Line 
Information on Multiline 
Terminal

CM12 Y=57
• As pert CM08, 1st=2000 (default)
• Station No.
• Station Name
• Station No. + Name
• Station Name + No.

CMEF Y=05
• As per System Data (default)
• Station No.
• Station Name
• Station No. + Name
• Station Name + No.
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Continued on next page

Setting Item System Data Service Memory

Illumination Color of 
Multiline Terminal for 
Internal Call

CM12 Y=83
• Red (7 color LED terminal)/Red 

(3 color terminal) (default)
• Green (7 color LED terminal)/

Green (3 color terminal)
• Blue (7 color LED terminal)/

Yellow (3 color terminal)
• Yellow (7 color LED terminal)/

Yellow (3 color terminal)
• Purple (7 color LED terminal)/

Yellow (3 color terminal)
• Light Blue (7 color LED termi-

nal)/Yellow (3 color terminal)
• White (7 color LED terminal)/

Yellow (3 color terminal)
• Rotation (7 color LED terminal)/

Yellow (3 color terminal)

CMEF Y=06
• As per System Data (default) 

• Green (7 color LED terminal)/
Green (3 color terminal)

• Blue (7 color LED terminal)/
Yellow (3 color terminal)

• Yellow (7 color LED terminal)/
Yellow (3 color terminal)

• Purple (7 color LED terminal)/
Yellow (3 color terminal)

• Light Blue (7 color LED termi-
nal)/Yellow (3 color terminal)

• White (7 color LED terminal)/
Yellow (3 color terminal)

• Rotation (7 color LED termi-
nal)/Yellow (3 color terminal)

Illumination Color of 
Multiline Terminal for 
External Call

CM12 Y=84
• Red (7 color LED terminal)/

Red (3 color terminal) (default)
• Green (7 color LED terminal)/

Green (3 color terminal)
• Blue (7 color LED terminal)/

Yellow (3 color terminal)
• Yellow (7 color LED terminal)/

Yellow (3 color terminal)
• Purple (7 color LED terminal)/

Yellow (3 color terminal)
• Light Blue (7 color LED termi-

nal)/Yellow (3 color terminal)
• White (7 color LED terminal)/

Yellow (3 color terminal)
• Rotation (7 color LED terminal)/

Yellow (3 color terminal)

CMEF Y=07
• As per System Data (default)

• Green (7 color LED terminal)/
Green (3 color terminal)

• Blue (7 color LED terminal)/
Yellow (3 color terminal)

• Yellow (7 color LED terminal)/
Yellow (3 color terminal)

• Purple (7 color LED terminal)/
Yellow (3 color terminal)

• Light Blue (7 color LED termi-
nal)/Yellow (3 color terminal)

• White (7 color LED terminal)/
Yellow (3 color terminal)

• Rotation (7 color LED termi-
nal)/Yellow (3 color terminal)
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STEP3: Verify the contents displayed on the List of settings area.
STEP4: When changing the data setting, check the “Edit Service Memory” check box.

Checking this check box, you can change the settings of the Service Memory field.
STEP5: Change the System Data field and the Service Memory field.

Enter the desired data when the Setting Item is Name Display. Other than that, select the data 
from the pull-down menu.

STEP6: Click the [Apply] button.
PCPro writes the set contents to the SV9300.

The list of settings has now been verified or changed.

Setting Item System Data Service Memory

Use permission for User 
Web Portal

CM12 Y=55
• User (default)
• Administrator
• Supervisor
• User
• Unauthorized User

CMEF Y=08
• As per System Data (default)
• Administrator
• Supervisor
• User
• Unauthorized User



Chapter 4 Standard Mode

4-225 NWA-088656-001 Rev.8.0

[Service] Category

Log Collections

In log collections, the contents operated by customers using User Web Portal are stored in the system
as logs. In the [Get Log] screen, you can collect their logs. To collect logs for User Web Portal, follow
these steps:

NOTE: Log collections are available only for a LAN connection.

STEP1: Click the [Get Log] button on the [Web Server Settings] screen.
The [Get Log] screen is displayed.

STEP2: Click the [Read] button.
Read the log information from the SV9300.

Continued on next page

No. Item Description

(1) [Apply] button Click to write the set contents to the SV9300.

(2) [Read] button Click to read the log information from the SV9300.

(3) [Stored operation log of the User 
Web Portal] radio button

Select whether to store the logs for User Web Portal by the 
radio button.
[Stored operation log of the User Web Portal] radio 
button: Store/Not Stored

[<<Back] button     

(1)
(2)

(3)
(4)

(5)
(6)
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STEP3: Click the [Get Log...] button.
The output screen for logs is displayed.

STEP4: Click the [...] button and select the destination to save the log file on the dialog box.

No. Item Description

(4) The latest time for stored opera-
tion log field

Displays the latest date and the time that the operation logs 
for User Web Portal are stored.
*1 The latest time is updated when system data is changed

from CAT/PCPro (the update of latest time is a subject
not just for User Web Portal but for all system data).

*2 Stored logs are cleared when SV9300 is reset.

(5) [Get Log...] button Click to download the logs for User Web Portal.

(6) Saved folder of the log file field Displays the saved folder of the downloaded file when 
downloading logs.

No. Item Description

(1) Download File field Displays the file name of logs to be downloaded.

(2) [...] button Open the dialog box to select a log file and set the output 
destination of the log file to be downloaded.

(3) Range Area [All] radio 
button

Check to download the all logs stored in the User Web 
Portal.

[Date Specify] 
radio button

Check to download the log of the specified period.
• Start Date: Specify the start date of an extracting period
• End Date : Specify the end date of an extracting period

(4) [Download] button Click to download the logs.

(5) [Cancel] button Click to cancel the operation.

(2)(1)

(5)

(3)

(4)



Chapter 4 Standard Mode

4-227 NWA-088656-001 Rev.8.0

[Service] Category

STEP5: Select the range of logs to download.
• When downloading all logs, check the [All] radio button.
• When downloading logs for the specific time period, check the [Date Specify] radio button

 and specify the Start Date and the End Date.
STEP6: Click the [Download] button.

The log file is downloaded. The destination of the saved log file is displayed on the [Get Log] 
screen.
*1 When downloading a log file, the port function of LAN port which is connecting PCPro

(set by CM40 Y=00: 30) is changed and remained to “Operation Log Output”. In addi-
tion, when a port function of LAN port which is not connected to PCPro is set to “Oper-
ation Log Output”, the port function is cleared.

*2  Do not download logs for User Web Portal from two PCPro at a time.

Tips: Operation Log of User Web Portal
In the log collection, operation logs as shown below can be downloaded.
An example of operation logs:

-- 2014/01/26 17:02:23 - - - [floor] SC-4244 V2.1.1/1.9.0.40
Type  Date/Time User Permission Operator Target User Operation Log Remarks
01 2014/01/26 05:02:27 - - - Web Server start 80
01 2014/01/26 09:32:53 0 3102 3102 Login OK
01 2014/01/26 09:43:55 0 3102 3102 Logout (User)
01 2014/01/26 09:44:34 0 3102 3102 Login OK
01 2014/01/26 09:45:35 0 3102 3102 Logout (User)
01 2014/01/26 09:46:27 0 3102 3102 Login OK
01 2014/01/26 09:49:00 0 3102 3102 Logout (User)
01 2014/01/26 09:49:10 0 3102 3102 Login OK
01 2014/01/26 09:49:17 0 3102 3102 Logout (User)
01 2014/01/26 09:49:28 0 3102 3102 Login OK
01 2014/01/26 09:49:35 0 3102 3102 Logout (User)
01 2014/01/26 09:49:43 0 3102 3102 Login OK
01 2014/01/26 09:51:48 0 3102 3102 Logout (User)
01 2014/01/26 10:16:03 2 2401 2401 Login OK
01 2014/01/26 10:16:49 0 2401 2401 Login OK
01 2014/01/26 10:29:09 0 2401 2401 Logout (TimeOut)
01 2014/01/26 10:30:55 0 2401 2401 Login OK
01 2014/01/26 11:01:43 0 2401 2401 Logout (TimeOut)

### END ###

- Type : 01(fixed): log related to User Web Portal
- Date/Time : Operated date/time
- User Permission: 0 (Administrator)/1 (Supervisor)/2 (User)/3 (Unauthorized User)
- Operator : User ID (Station No.) operated by User Web Portal
- Target User : User ID (Station No.) which is changed the setting by an operator
- Operation Log : Displays the operated contents
- Remarks : Additional information of operation log

The logs stored in User Web Portal have now been collected.
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Accessing to User Web Portal

To access to User Web Portal, follow these steps:

STEP1: Open the Web browser and access to “https: //xx.xx.xx.xx/” (“http: //xx.xx.xx.xx/” for an 
HTTP communication).
The [Login] screen for User Web Portal is displayed.

NOTE 1: The “xx.xx.xx.xx” part of URL represents an IP address for either VOIP port or Mainte-
nance port of Unit01 of SV9300.

NOTE 2: When a port number is changed, add a colon (:) + a port number after the IP address as 
follows.
An example: https: //xx.xx.xx.xx:443 (when the port number is changed to 443)

STEP2: Enter the Station No. and the Password to login.

Continued on next page

No. Item Description

(1) [English/Japanese] button Switches the display languages (English/Japanese).

(2) [Simple display /Full display] 
button

Switches between Simple and Full display modes.

(3) Version Displays the current version of your SV9300.

(4) [Station No.] field As the user account, enter the station number of the
station which is currently used by the user.

(1)

(2)

(4)

(5)

[Login] button

(3)



Chapter 4 Standard Mode

4-229 NWA-088656-001 Rev.8.0

[Service] Category

NOTE: The kind of stations that can be used as the user account are as follows.
- Single Line Station
- Multiline Terminal Station (including IP Station)
- Standard SIP Station

You have now been accessed to User Web Portal.

No. Item Description

(5) [Password] field Enter the password of the station which is currently
used by the user.
* Default value is the same as the station number.



Chapter 4 Standard Mode

4-230 NWA-088656-001 Rev.8.0

[Service] Category

Terminal Phonebook

Terminal Phonebook is in addition to the personal directory (Station Speed Dialing) and system directory
(System Speed Dialing). 
Terminal Phonebook by each station number of the DT900 Series can be created on PCPro. When you cre-
ate Terminal Phonebook with the same content and assign it to each terminal in your department or orga-
nization, you can provide the Terminal Phonebook shared between them.
By choosing Terminal Phonebook from a list which is read from an HTTP server, Terminal Phonebook can
be downloaded from an HTTP server. 

Using the [Terminal Phonebook] menu, you can create Terminal Phonebook by each station number of
DT900 Series and can download it to the terminals.
For creating Terminal Phonebook, an external file (Excel file) is required. For downloading Terminal
Phonebook to a terminal, an HTTP server is used.

An example of Terminal Phonebook creation is as follows: 
(1) Creating directory data (Excel)

Read a sample file (Excel) of a directory data, edit the data and save it.
(2) Changing the Excel file to a Terminal Phonebook zip

After resizing a head shot and changing the directory format, create a zip file included the head shot
and directory data for downloading.

NOTE 1: A directory data created on the [Terminal Phonebook] menu is available only for DT900 Series 
(except DT920).

NOTE 2: Terminal Phonebook zip for downloading can be used for DT900 Series (except DT920) accom-
modated in the SV9300 or SV9500. For downloading to the SV9500, an HTTP server which is 
not used by SV9300 PCPro is required.
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NOTE 3: When creating Terminal Phonebook zip used on DT900 Series (except DT920) accommodated 
in the SV9500, refer to the related manual of the SV9500.

The [Terminal Phonebook] screen appears by operating either of the following ways: 
• Click the [Terminal Phonebook] on the sub menu in Standard Mode.
• Click the [Edit] - [Terminal Phonebook] menu in the main menu.

No. Item Description

(1) [Create Data] button Click to create directory data or a terminal list for down-
loading Terminal Phonebook. The [Terminal Phonebook] 
screen appears.

(2) [HTTP Server Setting] button Click to set the initial settings of an HTTP server. The 
[Whole Setting] menu in the [HTTP Server Settings] 
screen appears.

(3) [Read Data (Excel)] button Click to read the created directory data (Excel). The [Read 
Data (Excel)] screen appears.

(4) [Create ZIP File] button Click to create Terminal Phonebook zip. The [Create ZIP 
File] screen appears.

(5) [Check Security] button Click to check an authorization for downloading the cre-
ated Terminal Phonebook zip. The [Starting and Stopping] 
menu in the [HTTP Server Setting] screen appears.

(1)

[Terminal 
Phonebook]

Menu

(5)

(6)

(2)

(4)

(3)

(7)

(8)
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(6) [Start HTTP Server] button Click to start an HTTP server. The [Starting and Stopping] 
menu in the [HTTP Server Settings] screen appears.

(7) [Notify Data] button Not used.

(8) [Stop HTTP Server] button Click to stop an HTTP server. The [Starting and Stopping] 
menu in the [HTTP Server Settings] screen appears.

No. Item Description
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Setting Operation

Operating environment configuration and creating Terminal Phonebook are as follows: 

NOTE 1: When logging on to PCPro with a manager account, HTTP Server Settings cannot be edited 
(available only for readout). 

NOTE 2: The Terminal Phonebook log is stored in the “TerminalPhonebook.log” file.

1. Create Data
Create directory data or a terminal list for downloading. 

Page 4-234

2. HTTP Server Setting Set initial settings of an HTTP server. Page 4-242

3. Read Data (Excel)
Read the created directory data (Excel). 

Page 4-244

4. Create ZIP File

Create Terminal Phonebook zip as following steps: 
Page 4-245

(1) Resize the head shot data.
(2) Create a zip file by each terminal (station number) and then

save it in the HTTP server.

5. Check Security
Check an authorization for downloading the created Terminal 
Phonebook zip. Page 4-248

6. Start HTTP Server
Start an HTTP server to download the created Terminal Phone-
book zip by terminals. Page 4-249

7. Stop HTTP Server
Stop an HTTP server after the created Terminal Phonebook zip 
has been downloaded by a terminal. Page 4-250
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Create Data

Directory data or a terminal list for downloading can be created by editing a sample Excel file. The sam-
ple file is created during the PCPro installation. 
If the Excel file has been already created, go to HTTP Server Setting. 

NOTE 1: Be sure to create the following sheets in directory data (Excel): 
M_USER
M_TEL
TERMINAL
station number (by each station number) 

* The maximum 100 sheets can be created as the “station number” sheet. 
NOTE 2: An available file format is “xlsx” or “xlsm” for directory data (Excel). Other formats in Ex-

cel (such as “xls” or “csv”) cannot be used. 
NOTE 3: Macros in Excel is used to create directory data (Excel). Be sure to enable macros in Excel 

before starting the following steps. For the details, see the <Enabling Macro in Excel> in 
Chapter 1.

STEP1: Click the [Create Data] button on the [Terminal Phonebook] screen.
The [Open file] screen is displayed.

STEP2: Select the Excel file for creating directory data, and then click the [Open] button.
The Excel file is opened.
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STEP3: Edit the user information in the M_USER sheet. 
NOTE: The user information in the M_USER sheet can be omitted. 

No. Column Item Description

(1) ID Input the ID number.
• ID: 1-10000
NOTE 1: When assigning the user information, be sure to set 

this item.
NOTE 2: The overlapping ID number cannot be used.

(2) U_NAME Input the user name.
• U_NAME: Any text string
NOTE: When assigning the user information, be sure to set 

this item.

(3) U_KANA Not used.

(4) USERID Input the number such as an employee number. (Option)

[M_USER] Sheet
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STEP4: Edit the telephone number information in the M_TEL sheet. 

(5) P1

For remarks column. (Option)(6) P2

(7) P3

No. Column Item Description

(1) ID Input the ID number.
• ID: 1-60000
NOTE 1: Be sure to set this item.
NOTE 2: The overlapping ID number cannot be used.

(2) NUMBER1 Input the telephone number.
• NUMBER1: 0-9, *, # (Maximum 32 digits)
NOTE 1: Be sure to set this item.
NOTE 2: The overlapping telephone number cannot be used.
NOTE 3: When specifying the station number, the maximum 

digits is 31.

(3) NAME Input the display name.
• NAME: Maximum 32 characters
NOTE: Be sure to set this item.

(4) U_NAME Choose the user name from the U_NAME column in the 
M_USER sheet or input it. (Option)
• U_NAME: Any text string

(5) KANA Not used.

No. Column Item Description

[M_TEL] Sheet
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NOTE: When creating multiple directory data (Excel), be sure to specify the same photo file making 
a pair with the same telephone number on the PICTURE column. If the different photo file 
is specified by each directory data (Excel), the PICTURE data may be overwritten by the 
specified data later due to access rights.

STEP5: Edit the terminal list information (such as a terminal name, a station number, an IP address/
subnet or access authority) in the TERMINAL sheet by each terminal which is downloaded 
directory data. 

(6) OFFICENAME Input the company name. (Option)
• OFFICENAME: Maximum 32 characters

(7) NUMBER2 Input the second telephone number. (Option)
• NUMBER2: 0-9, *, # (Maximum 32 digits)

(8) NUMBER3 Input the third telephone number. (Option)
• NUMBER3: 0-9, *, # (Maximum 32 digits)

(9) NUMBER4 Input the fourth telephone number. (Option)
• NUMBER4: 0-9, *, # (Maximum 32 digits)

(10) PICTURE Input the photo file name with full path. (Option)
• PICTURE: Maximum 128 characters

(11) P1

For remarks column. (Option)(12) P2

(13) P3

No. Column Item Description

[TERMINAL]
Sheet
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No. Column Item Description

(1) ID Input the ID number.
• ID: 1-10000
NOTE 1: Be sure to set this item.
NOTE 2: The overlapping ID number cannot be used.

(2) NUMBER1 Choose the station number in the list that is displayed by 
clicking the NUMBER1 column. (The displayed list is the 
registered station number in the M_TEL sheet.)
Or, input the station number.
NOTE 1: Be sure to set this item.
NOTE 2: The overlapping station number cannot be used.
NOTE 3: When the unregistered station number in the M_TEL 

sheet is input, an error occurs.

(3) T_NAME Input the terminal name.
• NAME: Any text string
NOTE: Be sure to set this item.

(4) U_NAME Choose the user name from the U_NAME column in the 
M_USER sheet or input it. (Option)
• U_NAME: Any text string

(5) KIND Input the kind of the terminal. (Option)
• KIND: Any text string

(6) ADDRESS Input the IP address/subnet mask of the terminal.
• ADDRESS: Maximum 28 characters
NOTE 1: Be sure to set this item.
NOTE 2: The domain name is also available.
NOTE 3: When the authority of the RIGHTS column is “IP ad-

dress designation” or “Only HTTP Server”, this data 
should be input with an IPv4 format.

NOTE 4: When the authority of the RIGHTS column is “In the 
identical sub-net”, this data should be input with a 
CIDR format.

(7) RIGHTS Input the authority for access to Terminal Phonebook zip.
• RIGHTS: IP address designation/In the identical sub-

net/Only HTTP Server 
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NOTE 1: The data in the ADDRESS or RIGHTS column is displayed as security information on the 
[Phonebook] menu in the [HTTP Server Settings] screen.

NOTE 2: The address data in the ADDRESS column must be indicated with the following formats ac-
cording to the RIGHTS column: 

(8) VERSION Input the version of Terminal Phonebook. 
• VERSION: Maximum two digits of an integer part 
NOTE 1: Be sure to set this item.
NOTE 2: When specifying the decimal place, specify a digit of 

the decimal part.

(9) F_MAKEFILE Input whether to create a zip file.
• F_MAKEFILE: TRUE (created)/FALSE (not created)
NOTE: When creating Terminal Phonebook zip, be sure to set 

“TRUE” (created). If this item is blank, the system 
handles it as “FALSE” (not created).

(10) F_NOTICE Input whether to inform a terminal via the system.
• F_NOTICE: FALSE (not informed)
NOTE: Be sure to set to “FALSE” (not informed). If this item 

is blank, the system handles it as “FALSE” (not in-
formed). 

(11) P1

For remarks column. (Option)(12) P2

(13) P3

Authority of RIGHTS Format in ADDRESS

IP address designation IPv4 format 
Example:xxx.xxx.xxx.xxx

xxx: 0-255
Only HTTP Server

In the identical sub-net CIDR format 
Example: xxx.xxx.xxx.xxx/yy

xxx: 0-255
yy: 8-32
When the CIDR notation (/yy) is omitted or 
“/32” is specified, the IP address is assumed to 
be an unicast address (a single IP address).

No. Column Item Description
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NOTE 3: When a terminal is a DHCP client, its IP address varies. In this case, set the RIGHTS column 
to “In the identical sub-net” and then specify the IP address with a CIDR format within the 
range of IP addresses assigned by the DHCP server.

STEP6: Edit the directory data information (such as a telephone number or a file path of a head shot) 
by each station number in the station number sheet. 

No. Column Item Description

(1) ID Input the ID number.
• ID: 1-1000
NOTE 1: Be sure to set this item.
NOTE 2: The overlapping ID number cannot be used.

(2) NUMBER1 Choose the station number in the list that is displayed by 
clicking the NUMBER1 column. (The displayed list is the 
registered station number in the M_TEL sheet.)
Or, input the telephone number.
• NUMBER1: 0-9, *, # (Maximum 32 digits)
NOTE 1: Be sure to set this item.
NOTE 2: The overlapping station number cannot be used.
NOTE 3: When specifying the station number, the maximum 

digits is 31.

(3) NAME Display name 
NAME entered in the M_TEL sheet is automatically set.
NOTE: Be sure to set this item.

(4) KANA Not used.

(5) OFFICENAME Company name 
• OFFICENAME entered in the M_TEL sheet is automat-

ically set. (Option)

Station number
Sheet
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You have now created the directory data (Excel).

(6) NUMBER2 The second telephone number 
• NUMBER2 entered in the M_TEL sheet is automati-

cally set. (Option)

(7) NUMBER3 The third telephone number 
• NUMBER3 entered in the M_TEL sheet is automati-

cally set. (Option)

(8) NUMBER4 The fourth telephone number 
• NUMBER4 entered in the M_TEL sheet is automati-

cally set. (Option)

(9) F_PICTURE Input whether to include a head shot to a directory data.
• F_PICTURE: TRUE (included)/FALSE (not included)
NOTE: Be sure to set this item.

(10) GROUP Group number (Fixed 0)
• GROUP: 0-19 (Default: 0)
NOTE: Do not change the default value.

(11) SOUND Sound information (Fixed 0)
• SOUND: 0-18 (Default: 0)
NOTE 1: Do not change the default value.
NOTE 2: Sound information cannot be set to a terminal by us-

ing Terminal Phonebook. The ringing tone follows the 
conditions of Distinctive Ringing in the system. For 
details, refer to “Features and Specifications Manual 
(Business/Hotel)”.

(12) LAMP Lamp information (Fixed 0)
• LAMP: 0-10 (Default: 0)
NOTE 1: Do not change the default value.
NOTE 2: Call indicator lamp information cannot be set to a 

terminal by using Terminal Phonebook. The call indi-
cator lamp follows the conditions of Multiline Termi-
nal in the system. For details, refer to “Programming 
Manual”.

(13) P1

For remarks column. (Option)(14) P2

(15) P3

No. Column Item Description
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HTTP Server Setting

The initial settings of the HTTP server (such as a storage location of Terminal Phonebook zip in the
HTTP server) can be configured. 

NOTE 1: Set the URL/IP address to an IP address, a domain name or URL of PCPro. Do not set others 
(such as an existing HTTP server or an external HTTP server).

NOTE 2: The HTTP protocol is not supported. Use TLS for the encryption protocol.
NOTE 3: When using a domain name to the URL/IP address, an environment of converting a domain 

name to an IP address is required. Prepare any method for domain name resolution such as 
a DNS server.

NOTE 4: Do not set the Control connection port to a port number overlapped within other services 
such as a port number of an FTP server.

NOTE 5: Set the Root folder to a server or a folder which is readable/writable by PCPro.
NOTE 6: Set the Root folder to a storage location of head shot data, Terminal Phonebook zip and the 

terminal list. This field is mandatory even if the Terminal Phonebook zip is created without 
the HTTP server of PCPro.
- httproot\image

The created head shot data is stored.
- httproot\terminal\<station number>

The created Terminal Phonebook zip (ContactList.zip) and the terminal list (PhoneBook-
List.csv) are stored.

NOTE 7: To download the stored Terminal Phonebook zip of each station number in the HTTP server 
to a terminal, the following steps are required on the Terminal Settings menu: 
1)Display the setting folder name screen of the downloading file with the Terminal Settings

menu on the terminal screen. 
2)Set to “terminal\YYYY” on the screen. 

* YYYY indicates a station number of a terminal. For example, when downloading Termi-
nal Phonebook zip of the station number 2000, set to “terminal\2000” on the setting
folder name screen.
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STEP1: Click the [HTTP Server Setting] button on the [Terminal Phonebook] screen.
The [Whole Setting] menu in the [HTTP Server Settings] screen is displayed.

NOTE: For details of the [Whole Setting] menu, refer to “HTTP Server Settings”. Page 9-50

STEP2: Specify the URI/IP address and the Control connection port. 

STEP3: Click the [...] button next to the Root folder field.
The [Browse for Folder] screen is displayed.

STEP4: Select the root folder, and then click the [OK] button.
The [Browse for Folder] screen closes.

STEP5: Click the [Apply] button.
The settings have been saved, the message informed process complete is displayed.

STEP6: Click the [OK] button. 

STEP7: Click the [Close] button.

You have now configured the HTTP server settings.

[URL/IP address] area

[Control connection 
port] area

[Root folder] area

[OK] button
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Read Data (Excel)

The created directory data (Excel) is read out.

STEP1: Click the [Read Data (Excel)] button on the [Terminal Phonebook] screen.
The [Read Data (Excel)] screen is displayed

STEP2: Click the [...] button.
The [Terminal Phonebook] screen is displayed. 

STEP3: Select the created directory data (Excel), and then click the [Open] button.
The [Terminal Phonebook] screen closes.

STEP4: Click the [Read] button.
The data has been read, the message informed process complete is displayed in the current
window.

NOTE: If the readout failed, an error message and the [Log Display] button are displayed in the cur-
rent window. Check the displayed result (log) by clicking the [Log Display] button, and read 
out the data again. 

STEP5: Click the [Finish] button.
The [Terminal Phonebook] screen is displayed.

You have now read the directory data (Excel).

[...] button
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Create ZIP File

Head shot data in the directory data (Excel) is changed to the suitable data size. 
A zip file is created by each a terminal (station number) and the head shot data, the zip file is stored in
the HTTP server.

NOTE 1: Note the following conditions for resizing the head shot data:
• The head shot data making a pair with a telephone number is created by using the spec-

ified original photo data in the directory data (Excel).
• Available file formats of the original photo data are as follows:

JPG, PNG, BMP, GIF, TIF
• When creating 10,000 head shot data, the free space of about 150MB is required. 

To create many head shot data may take up a large space on the hard disk of the HTTP 
server. Check the free hard disk space before specifying the data stored folder (the root 
folder in the HTTP server). 

• For reference, to create 10,000 head shot data takes about 60 minutes (when creating all 
head shot data).

NOTE 2: Note the following conditions for creating a zip file:
• A zip file is created on the “terminal\YYYY” under the root folder in the HTTP server. 

For example, when the root folder is “\\localhost\httproot”, a zip file will be created on 
the “\\localhost\httproot\terminal\YYYY” folder.

* YYYY indicates a station number of a terminal. When “*” or “#” is used as the 
number, the system changes into “A” or “B”. 
For example, when the station number is “20*#”, the folder will be named as 
“20AB”.

• The created zip file name is “ContactList.zip” (fixed). 
• When creating 1,000 telephone number and 1,000 head shot data, the file size of about 

10MB is required.
DT900 Series requires the free space of about 1GB to register Terminal Phonebook zip 
of 100 terminals. 

• For reference, to create Terminal Phonebook zip of 100 terminals (including 1,000 tele-
phone number and 1,000 head shot data) takes about 15 minutes (when the all head shot 
data are previously created). 

NOTE 3: Note the following conditions of a terminal list:
• Terminal Phonebook provides a terminal list together with Terminal Phonebook zip.
• A terminal list is created on the “\\localhost\httproot\terminal\YYYY” folder same as Ter-

minal Phonebook zip.
* YYYY indicates a station number of a terminal.

• The created file name is “PhoneBookList.csv” (fixed). 
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STEP1: Click the [Create ZIP File] button on the [Terminal Phonebook] screen.
The [Terminal Phonebook > Create ZIP of Phonebook > Create Head shot] screen is dis-
played

STEP2: Check the displayed data in the [Confirm the telephone number list of create a head shot] 
area.
If errors are found in the list, correct them in the external Excel file and read out the Excel
file again. 

STEP3: Click the [Create] button to create a head shot data.
When the head shot data has been already created, go to STEP4.
To check the “Create all a head shot. When a check mark is removed, only unregistration or
a new file is create.” check box, new head shot data is created by using all of the head shot
data in the Excel file even if the head shot data already created.
If you want to refresh and to create only the unregistered or new data, uncheck the check
mark. 

NOTE: If the head shot data creation failed, an error message and the [Log Display] button are dis-
played in the current window. Check the displayed result (log) by clicking the [Log Display] 
button, and create the head shot data again. 

The head shot data has been created, the message informed process complete is displayed in
the current window.

STEP4: Click the [Next >>] button.
The [Terminal Phonebook > Create ZIP of Phonebook > Create ZIP] screen is displayed.

[Confirm the telephone number
list of create a head shot.] area

[Create all a head shot. When 
a check mark is removed, only 
unregistration or a new file is 
create.] checkbox
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STEP5: Check the displayed data in the [Confirm the station number list of create a ZIP.] area. 

STEP6: Click the [Create] button to create a Terminal Phonebook zip.
NOTE: If the zip file creation failed, an error message and the [Log Display] button are displayed 

in the current window. Check the displayed result (log) by clicking the [Log Display] button, 
and create the zip file again. 

Terminal Phonebook zip or a terminal list have been created, the message informed process
complete is displayed in the current window.

STEP7: Click the [Finish] button.
The [Terminal Phonebook] screen is displayed.
The data has been read, the message informed process complete is displayed in the current
window.

You have now created the Terminal Phonebook zip.

[Confirm the station number list
of create ZIP.] area
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Check Security

Check an authorization for downloading the created Terminal Phonebook zip.
NOTE 1: A terminal follows the access authority assigned on each terminal or each zip file for down-

loading. The zip file which is not displayed in the zip files list on the [Phonebook] menu in 
the [HTTP Server Settings] screen cannot be downloaded even if the zip file exists. 

NOTE 2: The Terminal Phonebook information on the [Phonebook] menu in the [HTTP Server Set-
tings] screen is created by reading the directory data (Excel) on the [Terminal Phonebook 
> Read Data (Excel)] screen. In default setting, an empty list is displayed. 
The [Redisplay] button is used to reload the newest Terminal Phonebook information. 
Selecting the Terminal Phonebook information in the list and clicking the [Delete] button, 
the Terminal Phonebook zip of the selected information is deleted. 

NOTE 3: The zip files list on the [Phonebook] menu in the [HTTP Server Settings] screen cannot be 
edited. If you want to change the data in the list, edit the directory data (Excel) and then read 
out the excel file again.

STEP1: Click the [Check Security] button on the [Terminal Phonebook] screen. 
The [Phonebook] menu in the [HTTP Server Settings] screen is displayed

NOTE: For details of the [Phonebook] menu, refer to “HTTP Server Settings”. Page 9-47 

STEP2: Check the [Access Rights] column in the [Zip file of Terminal Phonebook Data (Whole)] list.
If errors are found in the list, correct them in the external excel file and read out the excel file
again. 

NOTE: Be sure to set the [Access Rights] data in the directory data (Excel) and read out it in ad-
vance.

You have now checked the access authority for downloading Terminal Phonebook zip.

[Zip file of Terminal Phonebook
Data (Whole)] area
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Start HTTP Server

Start the HTTP server for downloading the Terminal Phonebook zip to terminals.
NOTE 1: When PCPro is installed, a root certificate of the HTTP server is stored as the following for-

mat. 
<PCPro installed folder>\sample\http\ServerCertificate.der

NOTE 2: When a terminal needs a root certificate of the HTTP server, register it in the terminal in 
advance. The root certificate can be downloaded to the terminal by using the FTP server.

NOTE 3: When downloading Terminal Phonebook zip to terminals with an existing HTTP server or 
an external HTTP server, the HTTP server of PCPro does not start. (When the URL/IP ad-
dress data on the [Whole Setting] menu in the [HTTP Server Settings] screen is not assigned, 
the HTTP Server of PCPro cannot be started.) 

NOTE 4: When accessing from the multiple clients (terminals) at the same time, the download request 
may be denied. In this case, wait for a while and try again. 

STEP1: Click the [Start HTTP Server] button on the [Terminal Phonebook] screen. 
The [Start and Stop] menu in the [HTTP Server Settings] screen is displayed

NOTE: For details of the [Start and Stop] menu, refer to “HTTP Server Settings”. Page 9-47

STEP2: Click the [Start] button.
The HTTP server started. 

The HTTP server has now been started.

[Start] button
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Stop HTTP Server

After Terminal Phonebook zip is downloaded to a terminal and the data in the terminal is updated, stop
the HTTP server with the following steps:

STEP1: Click the [Stop HTTP Server] button on the [Terminal Phonebook] screen. 
The [Start and Stop] menu in the [HTTP Server Settings] screen is displayed

NOTE: For details of the [Start and Stop] menu, refer to “HTTP Server Settings”. Page 9-47 

STEP2: Click the [Stop] button. 

A confirmation message is displayed. 

STEP3: Click the [Yes] button. 

The HTTP server has now been stopped.

[Stop] button

[Yes] button
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[Maintenance] Category

The [Maintenance] Category is organized into the following five submenus:
• System Check and Report
• Port Status/Lamp Status Page 4-256
• Fault Display Page 4-268
• System Data Save/Load/Verify Page 4-270
• Reset Page 4-282
• Maintenance Report Page 4-287

System Check and Report

The [System Check and Report] menu reads the check result of system, system configuration, detailed in-
formation of blades and ports from the SV9300 and presents the information in HTML format. Further-
more, checks whether the duplicate IP addresses exist or not, and detects line/trunk blades requiring the
firmware upgrade. Work in the following steps:
As for the items displayed in the system report and their contents, refer to the “System Report Display Item
List Table”. Page 8-4

NOTE: The [System Check and Report] menu saves one system report for one connection account.
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STEP1: Take one of these actions:
• Click submenu [System Check and Report] in Standard Mode.
• On the Main Menu, click [System] > [Maintenance] > [System Check and Report] in this or-

der.
The [System Check and Report] screen is displayed in the work window.

• To edit the read out information from the SV9300: Go to STEP2.
• To leave the read out information from the SV9300 unchanged: Go to STEP5.

No. Item Description

(1) [Read] button Click to read a system report from the SV9300.

(2) Read Items field Displays the read items set currently.

(3) [Setting of Read Item] 
button

Click to change the read items.

(4) [Report Display] button Click to display the system report again or confirm the information in 
off-line (Same as Report. Page 8-1)

(5) System Check Result 
Display Area

Displays the check result of the system (default: blank).
* The check result is displayed when various alarm such as some 

duplicate IP addresses, some blades with older firmware version 
than CPU’s version, VoIPDB which needs update of firmware or 
controlling chassis alarm is detected.

(2) (3)

(1)

[System Check
 and Report]

 menu
(4)

(5)
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STEP2: Click the [Setting of Read Item] button.
A screen is displayed, allowing you to select items to be read out from the SV9300.

STEP3: Check items (1) to (4) as needed.

Continued on next page

No. Item Description

(1) “System Summary” 
check box

Check to read out the following system summary (default: checked):
• System Summary

MJ Alarms, Operation Status of Dual CPU
Version information
Status of Unit
VoIPDB information

• Network Information
IP Address Information
Routing Information

• License
Hardware Key Code
License Data Name
Feature Name

• Numbering Plan

[OK] button

(1)

(2)

(3)

(4)
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STEP4: Click the [OK] button.
You are directed back to the [System Check and Report] screen. The item that has been selected
in STEP3 is displayed in the Read Item field.

STEP5: Click the [Read] button.
The browser launches to display the System Report.

No. Item Description

(2) “Unit/Slot Informa-
tion” check box

Check to read out the Unit/Slot information for each SV9300 (default: 
checked).
• Unit Information
• Expansion Chassis Information
• Slot Information

Mounted Blade, Firmware Version
* When this check box is checked, “System Summary” check box is auto-

matically checked.

(3) “Port Information” 
check box

Check to read out the port information registered in the physical port 
(default: checked).
* When this check box is checked, “System Summary” check box and 

“Unit/Slot Information” check box are automatically checked.

(4) “Virtual Port Infor-
mation” check box

Check to read out the following virtual port information (default: 
checked):
• IP terminal ports

Station No., IP Address, Status, Terminal Type
• Peer to peer CCIS trunk ports
• SIP trunk ports
• Wireless PCS terminal ports/Standard SIP ports
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Tips: System Check Result
• When the following check results are detected, please confirm the details by a system 

report. Page 8-3
- There are some duplicate IP addresses. Please confirm them.
- The Default Gateway Address are set to both VoIP port and maintenance port. Please con-

firm the settings.
- Controlling chassis alarm has occurred. Click here for details.
- Expansion chassis alarm has occurred. Click here for details.
- Station/Trunk blade alarm has occurred. Click here for details.

• When “Some blades have been detected whose firmware versions are older than CPU’s 
version.” or “Please update the firmware of the VoIPDB.” is displayed, execute the 
Firmware Upgrade. Click the link (underline part) of “Click here for details” to launch the
[Firmware Upgrade (Line/Trunk Blade)] menu. Page 4-77

System report has now been displayed.
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Port Status/Lamp Status

The [Port Status/Lamp Status] menu reads the list of busy trunks and busy stations, blade information and
the status of port operation from the SV9300 and displays such on the screen. Because the operating status
can be updated automatically for Blade LED status and Busy trunk information features, you can verify
their status on the screen in real time. One of the following action will display the [Port Status/Lamp Sta-
tus] screen in the work window:

• Click submenu [Port Status/Lamp Status] in Standard Mode.
• On the Main Menu, click [System] > [Maintenance] > [Port Status/Lamp Status] in this order.

No. Item Description

(1) [Busy trunk status] radio 
button

Check to view the status of each busy trunk and terminal information 
that is connected to SV9300.

(2) [Busy stations] radio 
button

Check to view the list of busy stations in the system.

(3) [Blade LED status] 
radio button

Check to view the LED indication of selected blade.

(4) [Busy trunk informa-
tion] radio button

Check to view the busy status of selected trunk number.

[Port Status/Lamp
 Status] menu

[Next >>] button

(1)

(3)

(2)

(4)
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Busy Trunk Status

You can confirm the status of each busy trunk and terminal information that is connected to SV9300.

STEP1: Check the [Busy trunk status] radio button on the [Port Status/Lamp Status] screen.
STEP2: Check the [Next] button.

The [Status Trunk Status] screen appears on the work window.

Continued on next page

No. Item Description

(1) [Check for busy 
trunks] button

Click to check whether the busy trunks exist or not from SV9300.

(2) [Read] button Click to read the busy trunks from SV9300.

(1)

(2)

[<< Back] button
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No. Item Description

(3) Busy Trunks 
Information 
Display Area

Trunk No. field Displays the Trunk No. of the busy trunks.

Kind field Displays the trunk kind of the busy trunks.
• Trunk Kind: COT/OD/LD/DID/BRT (BLI)/PRT/CCT/

DTI(T1)/DTI (E1)/QSIG/IP Trunk/SIP Trunk

Unit No. field Displays the Unit No. of the busy trunks.
• 01 to 50, blank field
* This field becomes a blank when the trunk kind is “IP/SIP 

Trunk”.

Slot No. field Displays the Slot No. of the busy trunks.
• 01 to 18, blank field
* This field becomes a blank when the trunk kind is “IP/SIP 

Trunk”.

CKT No. field Displays the CKT No. of the busy trunks.
• 01 to 32, blank field
* This field becomes a blank when the trunk kind is “IP/SIP 

Trunk”.

Terminal Kind 
Using the 
Trunk field

Displays the terminal kind of the terminal using a trunk. 
• Terminal Kind: Station/Virtual Station/ISDN Terminal/

Trunk/DESKCON/Other (EN No.)

Terminal Infor-
mation field

Displays the terminal information of the terminal using a 
trunk.
• Terminal Information:Station No. /Trunk No./DESKCON 

No./Blank field
*1 This field becomes a blank if there is no additional infor-

mation.
*2 For ISDN terminals, B channel No. (example: 2000_1) is 

added after the station number.
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STEP3: Click the [Read] button.
The trunk numbers of the busy trunks and the terminal information using the trunks are dis-
played on the Busy Trunk Information Display Area.

Tips: Check for Busy Trunk Status
Before reading the busy trunk status by the [Read] button, if you want to check whether busy
trunks exist or not, click the [Check for busy trunks] button. You can check whether busy
trunks exist or not. 

STEP4: Confirm the contents displayed on the Busy Trunks Information Display Area.

The Busy Trunks have now been confirmed.
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Busy Stations

You can confirm the list of busy stations.

STEP1: Check the [Busy stations] radio button on the [Port Status/Lamp Status] screen.
STEP2: Check the [Next] button.

The [Busy Stations] screen appears on the work window.

No. Item Description

(1) [Check for busy stations] button Click to check whether the busy stations exist or not from 
SV9300.

(2) [Read] button Click to read the busy stations from SV9300.

(3) Busy Stations 
Information 
Display Area

Station No. 
field

Displays the Station No. of the busy stations.

Kind field Displays the station kind of the busy stations.
• Station Kind: Single Line/Digital Multiline 

Terminal/DT700 Series/Wireless Terminal/
Standard SIP Station/Modem/ISDN 
Terminal/Other

Unit No. field Displays the Unit No. of the busy stations.
• 01 to 50, blank field

Slot No. field Displays the Slot No. of the busy stations.
• 01 to 18, blank field

CKT No. field Displays the CKT No. of the busy stations.
• 01 to 32, blank field

[<< Back] button

(2)

(1)

(3)
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STEP3: Click the [Read] button.
The list of the station numbers of the busy stations are displayed on the Busy Stations Infor-
mation Display Area.

Tips: Check for Busy Stations
Before reading the busy stations by the [Read] button, if you want to check whether busy 
stations exist or not, click the [Check for busy stations] button. You can check whether busy 
stations exist or not. 

STEP4: Confirm the contents displayed on the Busy Stations Information Display Area.

The Busy Stations have now been confirmed.
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Blade LED Status

You can confirm the LED indication of the selected blade.

STEP1: Check the [Blade LED status] radio button on the [Port Status/Lamp Status] screen.
STEP2: Check the [Next] button.

The [Blade LED Status] screen appears on the work window.

Continued on next page

No. Item Description

(1) [Read] button Click to read a blade information from the SV9300 having its unit 
number and slot number specified in (4) and (5).

(2) [Reset] button Click to reset the blade specified by (4) and (5).

(3) [Return] button Click to return the [Port Status/Lamp Status] screen.

(4) Unit No. field Select the unit number of blade from which you want to display the 
status.
• 01 to 50 (default: 01)

(5) Slot No. field Select the slot number of blade from which you want to display the status
• 01 to 18 (default: 01) 

(6) “Auto Update” check 
box

Check to do the Auto Update.

(4)
(6) (7)

(5)

(8)

(1)
(2)

(3)
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Continued on next page

No. Item Description

(7) Auto Update Time 
Setting field

Select the Auto Update time.
• Every 30 sec., Every 1 min. to Every 10 min.

(default: Every 30 sec.)

(8) Status Display Area Unit No. field Displays the Unit No. during the status display.

Slot No. field Displays the Slot No. during the status display.

Blade Name 
field

Displays the blade name during the status display.
* When a blade for SV8300 is mounted, a blade type + 

“*NV” are displayed.

Clock Source 
Status field

Displays the clock source status of the specified blade.
• Sync.(1st): 

The blade is set to the first priority blade to receive the 
synchronization signal.

• Sync.(1st) Synchronized:
The blade is set to the first priority blade to receive the 
synchronization signal and the blade is synchronized.

• Sync.(2nd):
The blade is set to the second priority blade to receive 
the synchronization signal.

• Sync.(2nd) Synchronized:
The blade is set to the second priority blade to receive 
the synchronization signal and the blade is synchro-
nized.

* The clock source supports only for BRT/PRT/CCT/
DTI blade.
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NOTE: When the blade reset is executed to the blade by the [Reset] button, which is set to receive 
the synchronization signal, the following dialog box is displayed.
• When the blade is synchronized:

No. Item Description

(8) Status Display Area Blade Status 
field

View this area to confirm the status of specified blade 
with lamp indication. The following status display is 
available.
• Live LED

Blue (blink) : Normal operation
Blue (lit) : In setting up/In upgrading

• Port status
Black : The channel has not been occupied.
Red : The channel has been occupied.
Blue (blink) : No system data setting/etc.
Red (blink) : Make busy
Red (blink fast): Make busy (Trunk Route)

• Lamp Indications (Alarm)
Red (blink): Alarm On
Black : Alarm Off

• Lamp Indications (Information)
Green (blink): D channel link On
Black : D channel link Off/etc.
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• When the blade is not synchronized:

* When the blade reset is executed to the blade, which is set to receive the synchronization
signal, note that the equipment during synchronization goes into temporarily asynchro-
nous states.

STEP3: Specify the unit number and slot number of the blade from which you want to do the status 
display on the [Blade LED Status] screen, then click the [Read] button.
The LED indication of the selected blade is displayed on the Status Display Area.

STEP4: Confirm the contents displayed on the Status Display Area.

The Blade LED Status now has been confirmed.
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Busy Trunk Information

You can confirm the busy status of selected trunk.

STEP1: Check the [Busy trunk information] radio button on the [Port Status/Lamp Status] screen.
STEP2: Check the [Next] button.

The [Busy Trunk Information] screen appears on the work window.

Continued on next page

No. Item Description

(1) [Read] button Click to read a trunk information from the SV9300 having its trunk num-
ber specified in (3).

(2) [Return] button Click to return the [Port Status/Lamp Status)] screen.

(3) The Lead Trunk 
Number field

Select the lead trunk number of trunk which you want to display the sta-
tus.
• 000 to 496 (default: 000)

(4) “Auto Update” check 
box

Check to do the Auto Update.

(5) Auto Update Time 
Setting field

Select the Auto Update time.
• Every 30 sec., Every 1 min. to Every 10 min. (default: Every 30 sec.)

(3)
(4) (5)

(6)

(1)
(2)
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STEP3: Specify the head trunk number of trunk from which you want to do the status display on the 
[Busy Trunk Information] screen, then click the [Read] button.
The LED indication of the selected trunk is displayed on the Status Display Area.

STEP4: Confirm the contents displayed on the Status Display Area.

The Busy Trunk Information now have been confirmed.

No. Item Description

(6) Status Display Area View this area to confirm the status of specified port of trunk with lamp 
indication. The following status display is available.
(16 trunks from the lead trunk number can be displayed.)
Black : The channel is idle
Red : The channel is in use
Blue (blink) : No system data setting/etc.
Red (blink) : Make busy
Red (blink fast): Make busy (Trunk Route)
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Fault Display

The [Fault Display] menu lets you read fault information stored on the SV9300, and view and conform it.
Fault Display provides the following functions:

• Display a read the fault information stored on the SV9300
• Clear the alarm lamp
• Create a fault report

NOTE: To do the Fault Display, the setting of system data (CMEA) is required beforehand.

STEP1: Do either of the following:
• Click [Fault Display] on the standard mode submenu.
• On the main menu, click [System] > [Maintenance] > [Fault Display] in this order.
The [Fault Display] screen appears in the work window.

Continued on next page

No. Item Description

(1) [Read] button Reads fault information stored on the SV9300 and dis-
plays it in the Fault Display area.

(2) Access Date field Displays the date and time at which the fault informa-
tion was last read.

(3) [Report Display] button Displays the report on which the fault information was 
last read.

(2)

(4)

(5)

(6)

(3)

(1)

[Fault Display]
 Menu
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STEP2: Click the [Read] button.
The fault is displayed in the Fault Display Area and Data fields.

NOTE: The fault report (.html) is automatically displayed when a fault information is read by clicking 
the [Read] button. The report can be confirmed even if the connection with SV9300 is not es-
tablished.

The Fault Display have now been displayed.

No. Item Description

(4) [Clear] button Click to clear the alarm lamp (MJ/MN).

(5) Fault Display 
Area

Number field Displays the unique number assigned to the fault infor-
mation.

Occurrence Date 
and Time field

Displays the date and time at which the fault occurred.

Error Type field Displays the number of the fault type.

Alarm field Displays the alarm type of the fault.
-- : No alarm
MN : MN alarm
MJ : MJ alarm

Unit/Slot/Circuit 
field

Displays relevant information only if the fault infor-
mation pertains to a unit, slot or circuit; otherwise, this 
field becomes a blank.

(6) Data field Displays detailed information about the fault selected 
in the Fault Display area.
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System Data Save/Load/Verify

The [System Data Save/Load/Verify] menu makes it possible to:

When connecting with the SV9300:
• Save : Saves system data registered on the SV9300 to PCPro.
• Load : Loads system data saved on PCPro into the SV9300.
• Verify : Compares system data registered on the SV9300 with system data saved on PCPro.

When connecting with Virtual PBX:
• Save : Saves system data on PCPro to the file which is not used on Virtual PBX.
• Load : Not used.
• Verify : Compares system data edited on PCPro with system data in the selected file.

One of the following action will display [System Data Save/Load/Verify] screen in the work window.
• Click submenu [System Data Save/Load/Verify] in Standard Mode.
• On the Main Menu, click [System] > [System Data Save/Load/Verify] in this order.

NOTE: While saving, loading or verifying system data, do not attempt to write and read system data to 
and from the SV9300 by using CAT or any other application.

(1)

(2)

[System Data
 Save/Load/
Verify] menu

(3)
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No. Button Name Description

(1) [Save] Click to save system data. The [Save] screen is displayed.

(2) [Load] Click to load system data. The [Load] screen is displayed.
NOTE: When connecting with Virtual PBX, this button is not active.

(3) [Verify] Click to verify system data. The [Verify] screen is displayed.
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Saving System Data

You can save the system data registered on the SV9300 to PCPro in these steps:

STEP1: Click [Save] button in the [System Data Save/Load/Verify] screen.
The [Save] screen is displayed in the work window.

STEP2: Select the area of the system data to be saved in the Area Name field.
The number of the selected system data area is displayed in the System Data Area Number
field. If you have chosen to specify an Area Number, enter the Area Number of the system
data in the Area Number field.

* Only Area No. 1 is verified.

Continued on next page

System Data Area Name Area Number Remarks

Verification 
Object

: Applicable
–: Not applicable

All system data + All service 
memory + Registration data by 
MAC authentication + DBM 
data (PHS/OAI)

1,2,4,80,81 *

All system data (except Speed 
Dialing)

1 System data only 

All service memory 2 Service memory only –

Area Name field
Area Number field
Office Name field

[Save] button

[Select Folder] buttonFile Name field

[<<Back] button
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NOTE: When the Connection Type of Connection Accounts is “Virtual PBX (office data file)”, note 
the following conditions:
- For System Data Area Name, the area name of Virtual PBX is automatically set. This data

is not editable. 
- Office Name is editable.
- While connecting with Virtual PBX, the editing system data on PCPro cannot be loaded/

saved to the Virtual PBX (office data file) because the file cannot be overwritten. In this
case, save the editing data as another file name. 

STEP3: Enter an office name.
The office name can be entered up to 32 characters (no limitation in the kind of character).

STEP4: Click the [Select Folder] button.
A dialog box is displayed for specifying a folder and file name.

System Data Area Name Area Number Remarks

Verification 
Object

: Applicable
–: Not applicable

Call History Data 3 –

Speed Dial Data 4 CM73,74 –

Registration data by MAC 
authentication

80 –

DBM data (PHS/OAI) 81 –

Voice data of VRS 
(CPU Memory: Flash-ROM)

84 

Voice data of VRS 
(CF Memory) for Migration

83 –

– Enter the Area 
Number

The area number is 
saved specifying it.

Depends on the spec-
ified area number.
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STEP5: Specify the file name and the folder of the file to be saved in which the system data is to be 
saved, and click the [Save] button.
You are directed back to the [Save] screen. The specified folder and the file name are dis-
played in the File name field.

STEP6: Click the [Save] button.
A dialog box is displayed, confirming to save the system data.

STEP7: Click the [Yes] button. 

A dialog box is displayed, offering a visual indication of the progress of the system data save
process. To cancel the process, click the [Cancel] button.
A dialog box appears to let you know when the system data save is complete.

STEP8: Click the [OK] button.

You are directed back to the [Save] dialog box.
STEP9: Click the [<< Back] button.

You are directed back to the [System Data Save/Load/Verify] screen.

The system data has now been saved.

Save In field

File name field

[Save] button

[Yes] button

[OK] button
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Loading System Data

You can load the system data saved onto PCPro into the SV9300 in these steps:

NOTE: Before applying system data that has been loaded into the SV9300, be sure to make a back 
up of the data and reset the system in STEP5 and STEP6. If the SV9300 is powered off or a 
system data back up is executed without first executing a system reset, the loaded system data 
would be lost.

STEP1: Click [Load] button in the [System Data Save/Load/Verify] screen.
The [Load] screen is displayed in the work window.

STEP2: Click the [Select File] button.
A dialog box is displayed for specifying a folder and file name.

No. Item Description

(1) Select the File Name field Displays the specified folder and file name.

(2) File 
Informa-
tion field

Date/Time field Displays the Date & Time at which the specified system 
data file was saved.

Office Name field Displays the registered office name when the system data 
was saved.

(3) Detail 
Informa-
tion field

Area Name field Displays the name of the area containing the system data file 
to be loaded.

Area Number field Displays the number of the area containing the system data 
file to be loaded.

(2)

(3)

(1)

[Load] button

[Select File] button

[<< Back] button
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STEP3: Specify the file name and the folder where the system data is saved, and click the [Open] but-
ton.

STEP4: Click the [Load] button.
A dialog box is displayed to confirm the load of the system data.

NOTE: About Confirmation Dialog Box When Loading System Data
• Clicking the [Load] button when the CPU blade is in On-line mode, the following dialog

box is displayed.

*1 It is recommended to load the system data in Off-line mode (the SENSE switch of the CPU 
blade is set to E/F). Click the [No] button to return to the [Load] screen.

*2 System data for Area number 82, 83 and 84 can be loaded only in Off-line mode (the 
SENSE switch of the CPU blade is set to E/F).

Save In field

File name field
[Open] button
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• A system data file for SV8300 cannot be loaded. If you try to load the system data file for
SV8300, the following dialog box is displayed.

STEP5: Click the [Yes] button.

A dialog box is displayed, offering a visual indication of the progress of the system data load
process. To cancel the process, click the [Cancel] button. When the system data load process
completes, a dialog box is displayed, allowing you to reset the system.

STEP6: Click the [Yes] button.

The system data loaded into the SV9300 is written to flash ROM, and a system reset is exe-
cuted. A dialog box is displayed to notify the completion of the system reset.

STEP7: Click the [OK] button.

You are directed back to the [Load] screen.
STEP8: Click the [<< Back] button.

You are directed back to the [System Data Save/ Load/ Verify] screen.

The system data has now been loaded.

[Yes] button

[Yes] button

[OK] button
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Verifying System Data

You can compare the following system data in these steps:
- The system data registered on the SV9300 and the system data saved on PCPro
- The editing system data of Virtual PBX on PCPro and the selected system data

* As for the Area No. to be targeted for the verification, refer to the table (STEP2) in “ Saving System
Data”. Page 4-272

STEP1: Click [Verify] button in the [System Data Save/Load/Verify] screen.
The [Verify] screen is displayed in the work window.

STEP2: Click the [Select File] button.
A dialog box is displayed for specifying a folder and file name.

No. Item Description

(1) Select the File Name field Displays the specified folder and file name.

(2) File
Informa-
tion field

Date/Time field Displays the Date & Time at which the specified system 
data file was saved.

Office Name field Displays the office name registered when the system data 
was saved.

(3) Detail 
Informa-
tion field

Area Name field Displays the name of the area containing the system data file 
to be verified.

Area Number field Displays the number of the area containing the system data 
file to be verified.

(2)

(3)

(1)

[Verify] button

[Select File] button
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STEP3: Specify the folder in which the file to be verified is saved and the file name, and click the 
[Open] button.

STEP4: Click the [Verify] button.
A dialog box is displayed, confirming the system data verification.

NOTE: A system data file for SV8300 cannot be verified. If you try to verify the system data file for 
SV8300, the following dialog box is displayed.

STEP5: Click the [Yes] button.

A dialog box indicating the progress of system data verification is displayed. To cancel the
verification process, click the [Cancel] button.
A dialog box appears to let you know when the system data verify is completed.

Save In field

File name field
[Open] button

[Yes] button
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STEP6: Click the [OK] button.
• In case that there are some different points.

• In case that there are no different points.

The result of verifying is displayed in the [Verify] screen.

[OK] button

[OK] button

Result of Verifying field

[<< Back] button
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STEP7: If the verification processes has found mismatches, open the file “<Connection Account>-
Verify.log” at the save destination displayed in the Result of Verifying field and confirm the 
mismatches.

STEP8: Click the [<< Back] button.
You are directed back to the [System Data Save/Load/Verify] screen.

The system data has now been verified.
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Reset

The [Reset] lets you reset the CPU blade (System Reset), the blade reset and IP Trunk (P2P CCIS) reset.
Do either of the following to see the [Reset] screen in the work window:

• Click the [Reset] on the standard mode submenu.
• On the Main Menu, click the [System] > [Reset] in this order.

System Reset

STEP1: Select System Reset in the Kind of Reset field.
The display contents in the work window change for System Reset.

STEP2: Click the [Reset] button.
A dialog box appears to let you know whether the system data is backed up.

No. Item Description

(1) Kind of Reset field Select the kind of reset.
• System Reset/Blade Reset/IP Trunk (P2P CCIS) Reset 

(default: System Reset)

(2) [Reset] button Click to execute a reset.

(2)
(1)

[Reset] Menu
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STEP3: Specify whether to back up system data or not.
• To execute a system reset after backing up system data : Click the [Yes] button.
• To execute a system reset without backing up system data: Click the [No] button.

When the system reset process completes, a dialog box appears to alert you to the comple-
tion.

STEP4: Click the [OK] button.

The system reset is now completed.

Blade Reset

STEP1: Select [Blade Reset] in the kind of Reset field.
The display contents in the work window change for Blade Reset.

[Yes] button

[OK] button

(1)

(3)(2)
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STEP2: Select the Unit No. and Slot No. to be reset, then click the [Reset] button.
A dialog box appears to let you know whether the blade is reset or not.

STEP3: Click the [Yes] button.
When the blade reset process completes, a dialog box appears to alert you to the completion.

NOTE: When the blade reset is executed to the blade by the [Reset] button, which is set to receive 
the synchronization signal, the following dialog box is displayed.
• When the blade is synchronized:

No. Item Description

(1) [Reset] button Click to execute the blade reset.

(2) Unit No. Select the Unit No. of blade to be reset.
• 01 to 50 (default: 01)

(3) Slot No. Select the Slot No. of blade to be reset.
• 01 to 18 (default: 01)

[Yes] button
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• When the blade is not synchronized:

* When the blade reset is executed to the blade, which is set to receive the synchronization
signal, note that the equipment during synchronization goes into temporarily asynchro-
nous states.

STEP4: Click [OK] button.

The blade reset is now completed.

IP Trunk (P2P CCIS) Reset

STEP1: Select [IP Trunk (P2P CCIS) Reset] in the kind of Reset field.
The display contents in the work window change for IP Trunk (P2P CCIS) Reset.

[OK] button

(1)
(2)
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STEP2: Select IP Trunk (P2P CCIS) Reset in the Kind of Reset field, then click the [Reset] button.
A dialog box appears to let you know whether the IP Trunk (P2P CCIS) is reset or not.

STEP3: Click the [Yes] button.
When the IP Trunk (P2P CCIS) Reset process completes, a dialog box appears to alert you
to the completion.

STEP4: Click the [OK] button.

IP Trunk (P2P CCIS) Reset is now completed.

No. Item Description

(1) [Reset] button Click to execute the reset.

(2) Reset Type field Select the reset type.
• After initial construction/Under operation 

(default: After initial construction)

[Yes] button

[OK] button
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Maintenance Report

The [Maintenance Report] menu can create the maintenance report (Excel file) and output the information
of maintenance work (such as inspection check and system data changes using PCPro) performed by main-
tenance personnels at the customers’ environment. By submitting this maintenance report to the custom-
ers, you can report the details and results of the actual maintenance work.
The maintenance report can be created in the following steps:

<Works at the Customers’ 
Environment>

<Works at the Office>

<Report to the Customer>

(1) Perform maintenance works (such as inspection check and 
system data changes using PCPro).

(2) Register the system data (CM04 Y=70) related to the mainte-
nance report (the setting is required for the first time only).

(3) Retrieve system data changes information.

* The reading of station information and settings is required to 
include a station list in the maintenance report.

(4) Edit the report data retrieved at the customer’s environment.

(5) Create the maintenance report.

(6) Submit the maintenance report to the customer.

. .
 . 

. .
 .

. .
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Works at the Customer's Environment

Inspection, 
System Data

Change Works

System Data
Registration

Retrieving System
Data Changes Infor.EndStart Exit

Set the system data 
(CM04 Y=70) related to 
the maintenance report.
* For the first time only. PC (PCPro)

Retrieve sysmte data changes info. 
(it takes about 5 minutes).

Adding
Info.

Change
History

System Data Changes

PC (PCPro)

* System data change histories are automatically stored.

Change
History

Report to the Customer

Making
Report

Editing
Report

Handing in
Report

Works at the Office

Return to 
the Office

Maintenance
Report

A created file (Excel file) 
can be edited freely.

* Select the extraction conditions and create the maintenance 
 report (output time is about 3 minutes).

PC (PCPro)

Adding
Info.

Change
History

Entry

6

Maintenance Works

54

32

1
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The following items can be output on a maintenance report.
• Customer’s system overview
• Station information and settings*1

• Result of system data change: Station*2 *3

• Result of system data change: C.O.line/Tie line*4 *5

• Result of system data change: DID number*6

• Result of system data change: Speed dialing*7

• Inspection result
• History of changed system data

*1 Details of “Station information and settings are as follows.
Tenant number, station number, IP address, service restriction class, kind of terminal connection
status, the number of Station Speed Dialing, the number of One-Touch Dialing and firmware ver-
sion

*2 The stations to be targeted for a maintenance report are as follows.
Single Line station, Digital Multiline Terminal station, ISDN Terminal station, IP Multiline Ter-
minal station (including Cradle Phone), Soft Phone and Standard SIP station

*3 When the following setting is changed, they are displayed on the Change Station field of the 
System data change: Station as a report.
- Using memory area for Station speed dialing of stations
- Using memory area for One-Touch key of stations
- Name Display
- Contents of key numbers of stations

*4 The trunks to be targeted for maintenance reports are as follows. 
C.O.line, Analog Tie line (for a local call), Analog Tie line (for a toll call), ISDN-Basic Rate 
Interface, ISDN-Primary Rate Interface, High-Speed Digital Tie line, No.7 CCIS, SIP trunk, IPT
(P2P CCIS)

*5 When the setting of trunk routes or terminating method is changed, they are displayed on the
Change Trunk field of the System data change: C.O.line/Tie line as a report.

*6 When the name to be displayed at terminating the DID calls or the setting of terminating method
is changed, they are displayed on the Change DID Number field of the System data change: DID
number as a report.

*7 When the setting of calling number or calling name for Speed Dialing is changed, they are dis-
played on the System data change: Speed dialing as a report.
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The followings are also available by the [Maintenance Report] menu.
• You can specify the time period for the report to be created.
• You can create or edit the maintenance report without connecting SV9300.
• The [Maintenance Report] menu creates a report from the system data change history for the 

connected SV9300, regardless of connection patterns (such as LAN, Modem and RS-232C).
Example: even when changing data of A office by a modem connection from the work place before-

hand, and changing data at A office by a RS-232C connection at a later date, the both data
can be output into one report as data for A office.

• Reports for two or more offices can be managed by one PCPro.
• After creating the report, all the items can be edited in Microsoft Excel.
• The features such as macro or link are not included in the created maintenance report (Excel file).
• The maintenance report (excel file) is created by dividing the following 11 sheets (the number of 

created sheets depends on the items selected by the [Make Report (2/8)] screen).
- Cover
- Index
- Customer’s system overview
- Station list
- System data change: Station
- System data change: C.O.line/Tie line
- System data change: DID number
- System data change: Speed dialing
- Inspection result
- History of changed system data
*1 The page numbers of the maintenance report are assigned throughout the report instead of assign-

ing by the sheet.
*2 The header and footer are displayed on the pages other than Cover.

Header (upper right): page x (example: page 2)
Footer (lower right): filing date (example: Monday, March 10, 2014)

NOTE 1: When doing maintenance work, create a connection account for each customer to connect with 
SV9300.

NOTE 2: To create the maintenance report, the following conditions must be met on PC.
- Microsoft Excel 2010 or later is pre-installed on your PC

* Install the Excel on the same PC to which the PCPro is installed.
- Macro settings in Excel is effective.

* For details, refer to the “<Enabling Macro in Excel>” in Chapter 1.
- The printer in use is set normally.

NOTE 3: Only assigned system data using PCPro can be output as the history of changed system data.
NOTE 4: When PCPro is connected with SV9300, the part of information (such as Customer’s Info. 

(Company Name) and Service Start Date) can be set to SV9300 side.
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The [Maintenance Report] menu allows you to read the station information and settings, retrieve system
data changes information, edit/create report data and perform the maintenance of report data (such as 
deleting, importing, or exporting report data). 

• Reading Station Information and Settings Page 4-293
• Retrieving System Data Changes Page 4-294
• Making Report Page 4-295
• Maintenance Report Data Page 4-314

One of the following action will display the [Maintenance Report] screen in the work window.
• Click submenu [Maintenance Report] in Standard Mode.
• On the Main Menu, click [System] > [Maintenance] > [Maintenance Report] in this order.

(1)

(3)

(4)

[Maintenance
 Report] menu

(2)
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Tips: Before working with the [Maintenance Report] menu
When creating the maintenance report for the first time, be sure to set the system data (CM04 
Y=70) related to the maintenance report by System Data Mode. Page 6-1
*1 The information set by CM04 Y=70 become the default values for the following items set by 

the [Maintenance Report] menu.
The [Make Report (3/8)] screen (for cover settings)
- Customer Info. (Company Name) field: set by CM04 Y=70>01
- Customer Info. (Dept. Name 1) field: set by CM04 Y=70>02
- Customer Info. (Dept. Name 2) field: set by CM04 Y=70>03
- Dealer Info. (Company Name) field: set by CM04 Y=70>04
- Dealer Info. (Address 1) field: set by CM04 Y=70>05
- Dealer Info. (Address 2) field: set by CM04 Y=70>06
- Dealer Info. (TEL) field: set by CM04 Y=70>07
- Dealer Info. (FAX) field: set by CM04 Y=70>08
The [Make Report (5/8)] screen (for customer’s system overview settings)
- System name field: set by CM04 Y=70>00
- Service Start Date field: set by CM04 Y=70>10
- Comment field: set by CM04 Y=70>11, 12
- Inspection Date Info. area: set by CM04 Y=70>16-19

*2 Do this work at the customer’s environment.

No. Item Description

(1) [Station Information 
and Settings] button

Click to read the station information and settings.
* Be sure to read the station information and settings when creating a 

maintenance report including them.

(2) [System Data Changes] 
button

Click to read the system data changes information from the connected 
system.
* Note that this work is performed at the customer’s environment.

(3) [Make Report] button Click to edit the report data and create the maintenance report.

(4) [Maintenance Report 
Data] button

Click to delete, import, or export report data.
* Usually, this feature is not used.
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Reading Station Information and Settings

This feature reads the station information and settings by connecting to the system. To read the station
information and settings, follow these steps:

NOTE: Be sure to read the station information and settings when creating a maintenance report in-
cluding them.

STEP1: Click the [Station Information and Settings] button on the [Maintenance Report] screen.
A dialog box is displayed to confirm the reading of station information and settings.

STEP2: Click the [Yes] button.

* When the reading of the station information and settings is completed, a dialog box is dis-
played to notify the completion of the process.

STEP3: Click the [OK] button.

The reading station information and settings now have been completed.

[Yes] button

[OK] button
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Retrieving System Data Changes

This feature reads the system data changes information by connecting to the system. To retrieve the sys-
tem data changes information, follow these steps:

NOTE: Complete the system data changes work at the customer’s environment before doing this 
work.

STEP1: Click the [System Data Changes] button on the [Maintenance Report] screen.
A dialog box is displayed to confirm the retrieving system data changes information.

STEP2: Click the [Yes] button.

* When the system data changes information has already retrieved, a dialog box is displayed
to confirm the data overwrite. Click the [No] button when using the existing data without
any change.

When the reading of data requiring for the maintenance report is completed, a dialog box is
displayed to confirm the completion of the process.

STEP3: Click the [OK] button.

The retrieving system data changes information now has been completed.

[Yes] button

[OK] button
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Making Report

You can create the maintenance report based on the system data changes information retrieved at the
customer’s environment and display in Microsoft Excel. In creating a report, set the following items
according to the screen.

NOTE 1: “3. Cover Settings”, “4. Index Settings”, “5. Settings of Customer’s System Overview” and 
“6. Inspection Result Entry” can be set only when these items are selected as the output items 
by the [Make Report (2/8)] screen.

NOTE 2: The setting values set by the each Make Report screen are maintained even if PCPro is 
exited.

1. Selecting System
Select the system to be included on the maintenance report with the 
[Make Report (1/8)] screen. Page 4-296

2. Selecting Output Items
Select the items to be included on the maintenance report with the 
[Make Report (2/8)] screen. Page 4-298

3. Cover Settings
Full in the information to be included on the cover of the mainte-
nance report with the [Make Report (3/8)] screen. Page 4-300

4. Index Settings
Full in the information to be included on the index of the mainte-
nance report with the [Make Report (4/8)] screen. Page 4-303

5. Settings of 
Customer’s System 
Overview

Full in the information to be included on the customer’s 
system overview of the maintenance report with the [Make Report 
(5/8)] screen. Page 4-304

6. Inspection Result 
Entry

Fill in the inspection result of the maintenance work with the [Make
Report (6/8)] screen. Page 4-306

7. Time Period Settings
Specify the time period to be included on the maintenance 
report with the [Make Report (7/8)] screen. Page 4-308

8. Making Report
Create the maintenance report with the [Make Report (8/8)]
screen. Page 4-310
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<Selecting System>

STEP1: Click the [Make Report] button on the [Maintenance Report] screen.
The [Make Report (1/8)] screen is displayed in the work window.

Continued on next page

No. Item Description

(1) System List Area System Name 
field

Displays the system name (CM04 Y=70>00) read 
from SV9300.
*1 When a system name is changed by the [Make 

Report (5/8)] screen, the system name after the 
change is displayed.

*2 This field becomes a blank when no system name 
is registered to SV9300.

Hardware Key 
Code field

Displays the Hardware Key Codes.

Connection 
Account field

Displays the connection account of the system.

(2)

[<< Back] button

(1)

[Next >>] button
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Tips: Using System List Area
Click the title of each field on the System List area to sort on appropriate column.

STEP2: Select the system to be included on the maintenance report from the System List area.

Tips: Selecting Multiple Systems for Report Output
When more than one report data is output into one maintenance report, select multiple 
systems to create the report from the System List area (use the “Ctrl” key and left mouse 
button to select multiple systems).

STEP3: Click the [Next] button.
The [Make Report (2/8)] screen is displayed in the work window.

Move on the Selecting Output Items, next.

No. Item Description

(1) System List Area Last Access Date 
field

Displays the date and time at which the system data 
changes information was retrieved on the [Mainte-
nance Report] screen.
* This field becomes a blank when report data has not 

been read.

Last Update Date 
field

Displays the date and time at which the maintenance 
report was last created on the [Maintenance Report] 
screen.
* This field becomes a blank when the maintenance 

report has not been created.

(2) “Create maintenance report from more 
than one report data.” check box

Such as replacing a CPU blade, check to output the 
report data (data for each Hardware Key Code) of the 
multiple systems (CPU) into one maintenance report 
(default: unchecked).
*1 Usually, this feature is not used.
*2 When using this feature, select multiple systems to 

create the report from the System List area (use the 
“Ctrl” key and left mouse button to select multiple 
systems).

*3 When the setting of this check box (checked/
unchecked) is changed, the pre-selected system is 
canceled.
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<Selecting Output Items>

STEP1: Check the check box of the items to be included on the maintenance report.
* The following steps describes for the steps when check boxes of all items are selected.

Continued on next page

No. Item Description

(1) [Select All] button Click to check the check boxes of all items.

(2) [Release All] button Click to uncheck the check boxes of all selected items.

(3) “Cover” check box Check to include the cover on the maintenance report (default: checked).
* The [Make Report (3/8)] screen is displayed only when this check box 

is checked.

(4) “Index” check box Check to include the index on the maintenance report (default: checked).
* The [Make Report (4/8)] screen is displayed only when this check box 

is checked.

(5) “Customer’s system 
overview” check box

Check to include the customer’s system overview on the maintenance 
report (default: checked).
* The [Make Report (5/8)] screen is displayed only when this check box 

is checked.

(6) “Station list” check 
box

Check to include the station list on the maintenance report (default: 
checked).
* This check box cannot be selected when no station data exist.

[<< Back] button

(3)

(4)
(5)

(6)
(7)

(8)
(9)

(10)
(11)

(13)

(12)

[Next >>] button

(2)
(1)
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STEP2: Click the [Next] button.
The [Make Report (3/8)] screen is displayed in the work window.

NOTE: The Make Report screen displayed when clicking the [Next >>] button differs depending on 
the items to be checked on the [Make Report (2/8)] screen (the Make Report screens of the 
unchecked items are not displayed).

Move on the Cover Settings, next.

No. Item Description

(7) “System data change: 
Station” check box

Check to include the System data change: Station on the maintenance 
report (default: checked).
* This check box cannot be selected when no data is changed.

(8) “System data change: 
C.O.line/Tie line” 
check box

Check to include the System data change: C.O.line/Tie line on the main-
tenance report (default: checked).
* This check box cannot be selected when no data is changed.

(9) “System data change: 
DID number” check 
box

Check to include the System data change: DID number on the mainte-
nance report (default: checked).
* This check box cannot be selected when no data is changed.

(10) “Speed dialing” 
check box

Check to include the System data change: Speed dialing on the mainte-
nance report (default: checked).
* This check box cannot be selected when no data is changed.

(11) “Inspection result” 
check box

Check to include the Inspection result on the maintenance report 
(default: checked).
* The [Make Report (6/8)] screen is displayed only when this check box 

is checked.

(12) “History of changed 
system data” check 
box

Check to include the History of changed system data on the maintenance 
report (default: checked).
* This check box cannot be selected when no data is changed.

(13) Memo field Memo field can be noted such as the status of the maintenance work 
regarding the selected system.
• Up to 1500 characters (default: blank field)
*1 The information filled in the Memo field are not included on the 

maintenance report.
*2 The line feed entry is available.
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<Cover Settings>

STEP1: Set the items (1) through (13).
* On the items (6) through (13) (the fields marked with “*”), the information registered to

SV9300 is displayed (only when the information is registered). Edit the registered infor-
mation if necessary.

Continued on next page

No. Item Description

(1) Report Name field Fill in the information to be included on the cover page of the mainte-
nance report as the report name.
• Up to 100 characters (default: Maintenance Report)
* The line feed entry is not available.

(2) Submit Date field Fill in the date to be included on the cover page of the maintenance 
report as the submit date.
• Up to 100 characters (default: Day/Month/Year [example: Monday, 

March 10, 2014])
*1 The line feed entry is not available.
*2 The current date (date of the PC) is displayed on the Submit Date 

field.

(3) Report Subtitle 1 
field

Fill in the information to be included on the cover page of the mainte-
nance report as the Report Subtitle 1.
• Up to 100 characters (default: Month/Year Inspection)
* The line feed entry is not available.

[<< Back] button [Next >>] button

(1)
(2)
(3)
(4)
(5)

(9)
(10)
(11)

(6)
(7)
(8)

(12)
(13)
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Continued on next page

No. Item Description

(4) Report Subtitle 2 
field

Fill in the information to be included on the cover page of the mainte-
nance report as the Report Subtitle 2.
• Up to 100 characters (default: blank field)
* The line feed entry is not available.

(5) Report Subtitle 3 
field

Fill in the information to be included on the cover page of the mainte-
nance report as the Report Subtitle 3.
• Up to 100 characters (default: blank field)
* The line feed entry is not available.

(6) *Customer Info. 
(Company Name) 
field

Fill in the information to be included on the cover page of the mainte-
nance report as the Customer Info. (Company Name).
• Up to 100 characters (default: displays the Customer Info. (Company 

Name) read from SV9300)
*1 The line feed entry is not available.
*2 This field becomes a blank when the system data (CM04 Y=70>01) 

is not assigned to SV9300.

(7) *Customer Info. 
(Dept. Name 1) field

Fill in the information to be included on the cover page of the mainte-
nance report as the Customer Info. (Dept. Name 1).
• Up to 100 characters (default: displays the Customer Info. (Dept. Name 

1) read from SV9300)
*1 The line feed entry is not available.
*2 This field becomes a blank when the system data (CM04 Y=70>02) 

is not assigned to SV9300.

(8) *Customer Info. 
(Dept. Name 2) field

Fill in the information to be included on the cover page of the mainte-
nance report as the Customer Info. (Dept. Name 2).
• Up to 100 characters (default: displays the Customer Info. (Dept. Name 

2) read from SV9300)
*1 The line feed entry is not available.
*2 This field becomes a blank when the system data (CM04 Y=70>03) 

is not assigned to SV9300.
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No. Item Description

(9) *Dealer Info. (Com-
pany Name) field

Fill in the information to be included on the cover page of the mainte-
nance report as the Dealer Info. (Company Name).
• Up to 100 characters (default: displays the Dealer Info. (Company 

Name) read from SV9300)
*1 The line feed entry is not available.
*2 This field becomes a blank when the system data (CM04 Y=70>04) 

is not assigned to SV9300.

(10) *Dealer Info. 
(Address 1) field

Fill in the information to be included on the cover page of the mainte-
nance report as the Dealer Info. (Address 1).
• Up to 100 characters (default: displays the Dealer Info. (Address 1) 

read from SV9300)
*1 The line feed entry is not available.
*2 This field becomes a blank when the system data (CM04 Y=70>05) 

is not assigned to SV9300.

(11) *Dealer Info. 
(Address 2) field

Fill in the information to be included on the cover page of the mainte-
nance report as the Dealer Info. (Address 2).
• Up to 100 characters (default: displays the Dealer Info. (Address 2) 

read from SV9300)
*1 The line feed entry is not available.
*2 This field becomes a blank when the system data (CM04 Y=70>06) 

is not assigned to SV9300.

(12) *Dealer Info. (TEL) 
field

Fill in the information to be included on the cover page of the mainte-
nance report as the Dealer Info. (TEL).
• Up to 100 characters (default: displays the Dealer Info. (TEL) read 

from SV9300)
*1 The line feed entry is not available.
*2 This field becomes a blank when the system data (CM04 Y=70>07) 

is not assigned to SV9300.

(13) *Dealer Info. (FAX) 
field

Fill in the information to be included on the cover page of the mainte-
nance report as the Dealer Info. (FAX).
• Up to 100 characters (default: displays the Dealer Info. (FAX) read 

from SV9300)
*1 The line feed entry is not available.
*2 This field becomes a blank when the system data (CM04 Y=70>08) 

is not assigned to SV9300.
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STEP2: Click the [Next] button.
The [Make Report (4/8)] screen is displayed in the work window.

NOTE: The Make Report screen displayed when clicking the [Next >>] button differs depending on 
the items to be checked on the [Make Report (2/8)] screen (the Make Report screens of the 
unchecked items are not displayed).

Move on the Index Settings, next.

<Index Settings>

STEP1: In the Work Outlines area, fill in the information to be included on the index page of the 
maintenance report.

No. Item Description

(1) Work Outlines Area Fill in the information to be included on the index page of the mainte-
nance report as the Work Outlines.
• Up to 100 characters

The following fixed phrases are displayed as the default.
Report Period: Day/Month/Year - Day/Month/Year*2

*1 The line feed entry is available.
*2 For the date of the Report Period, the current dates (the dates of PC) 

are displayed for both on the Start/End date (example: Report Period: 
Monday, March, 2014 - Monday, March, 2014).

[<< Back] button [Next >>] button

(1)
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STEP2: Click the [Next] button.
The [Make Report (5/8)] screen is displayed in the work window.

NOTE: The Make Report screen displayed when clicking the [Next >>] button differs depending on 
the items to be checked on the [Make Report (2/8)] screen (the Make Report screens of the 
unchecked items are not displayed).

Move on the Settings of Customer’s System Overview, next.

<Settings of Customer’s System Overview>

STEP1: Set the items (1) through (3).
* On the items (1) and (2) (the fields marked with “*”), the information registered to

SV9300 is displayed (only when the information is registered). Edit the registered infor-
mation if necessary.

Continued on next page

No. Item Description

(1) *System Name field Fill in the information to be included on the customer’s system overview 
of the maintenance report as the System Name.
• Up to 100 characters (default: displays the system name (CM04 

Y=70>00) read from SV9300)
*1 The line feed entry is not available.
*2 This field becomes a blank when the system data (CM04 Y=70>00) 

is not assigned to SV9300.

[<< Back] button
[Next >>] button

(3)

(4)

(1)
(2)
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STEP2: Click the [Next] button.
The [Make Report (6/8)] screen is displayed in the work window.

NOTE: The Make Report screen displayed when clicking the [Next >>] button differs depending on 
the items to be checked on the [Make Report (2/8)] screen (the Make Report screens of the 
unchecked items are not displayed).

Move on the Inspection Result Entry, next.

No. Item Description

(2) *Service Start Date 
field

Fill in the information to be included on the customer’s system overview 
of the maintenance report as the Service Start Date.
• Up to 100 characters (default: displays the service start date (CM04 

Y=70>10) read from SV9300)
*1 The line feed entry is not available.
*2 This field becomes a blank when the system data (CM04 Y=70>10) 

is not assigned to SV9300.

(3) Comment Area Fill in the information to be included on the customer’s system overview 
of the maintenance report as the Comment.
• Up to 1000 characters

The following fixed phrases are displayed as the default.
All OK,
Recommended UPS battery replacement date:
Recommended fan battery replacement date:
(It is recommended to replace the fan every 4 years)

*1 The line feed entry is available.
*2 The date read from SV9300 (CM04 Y=70>11, 12) is displayed 

(example: Recommended UPS battery replacement date: Monday, 
March 10, 2014).

(4) Inspection Date Info. 
field

Displays the Inspection Date information registered to SV9300. This 
field can be used for editing the Comment area as a auxiliary field 
(default: displays the registered data in CM04 Y=70>16-19).
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<Inspection Result Entry>

STEP1: Fill in the inspection result of the maintenance work for each field of the Inspection Checklist 
area.

Continued on next page

No. Item Description

(1) [Check All] button Click to check the check boxes of all items.

(2) [Release All] button Click to uncheck the check boxes of all selected items.

(3) Inspection Check-
list Area

“Output to report” 
check box

Outputs the inspection items of the checked rows to 
the maintenance report (default: checked*).
* Some items in Station category, Trunk category and 

Accessory Device category are excluded.

Item field Displays the items to be inspected.

Sub Item field Displays the target for verification of the inspection 
items.

Recommended 
Inspection 
Frequency field

Displays the recommended cycle of the inspection 
items.

Measurement field Fill in the information or result of the inspected items.
• Up to 100 characters
* The line feed entry is not available.

[<< Back] button

(2)
(1)

(3)

[Next >>] button
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STEP2: Click the [Next] button.
The [Make Report (7/8)] screen is displayed in the work window.

Move on the Time Period Settings, next.

No. Item Description

(3) Inspection Check-
list Area

Result field Evaluate the inspection result and check to the appro-
priate check boxes (such as OK, NG, N/A) (default: 
unchecked).

Treatment field Check to the appropriate check boxes whether the 
corrective action is taken or not (default: unchecked). 
When the corrective action is taken, fill in the informa-
tion of the action.
• Up to 100 characters
*1 The line feed entry is not available except the Self 

Check Item field, the Customer’s Indication field 
and the Operator’s Comment field.

*2 For the Customer’s Indication field and the Opera-
tor’s Comment field, up to 1000 characters can be 
entered.
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<Time Period Settings>

STEP1: Specify the time period to be included in the maintenance report.
• To include the all system data change histories without specifying the time period:

Click the [All stored data (not specify time period)] radio button.
• To include the system data change histories with specifying the time period:

Click the [Specify time period] radio button, then specify the Start field and End field.

Continued on next page

No. Item Description

(1) Explanation field Displays the time period of existing report data (exam-
ple: Report data stored in PCPro is from 2014/09/29 
17:52:42 to 2014/09/29 17:52:42).
* For the time period, the report data from beginning 

to end which is the targeted system is displayed.

(2) [All stored data] radio button Click to include the system data change histories of 
the all time periods (default: unchecked).

(3) [Specify time period] radio button Click to include the system data change histories with 
specifying the time period (default: checked).

(4) Start field Specify the start time/date of the time period to be 
included in the maintenance report when the [Specify 
time period] radio button is checked (default: displays 
the time period of the report data which has not been 
output yet).

[<< Back] button [Next >>] button

(5)

(1)

(2)

(3)
(4)

(6)
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* On the Report history area, up to five report histories are displayed in order of the latest histories.

STEP2: Click the [Next] button.
The [Make Report (8/8)] screen is displayed in the work window.

Move on the Making Report, next.

No. Item Description

(5) End field Specify the end time/date of the time period to be 
included in the maintenance report when the [Specify 
time period] radio button is checked (default: end 
time/date* of the report data).
* When the report data history which was output by 

the end time/date exists, the end time/date + one 
second is displayed.

(6) “Report history” 
Area*

Output Date field Displays the time/date at which the maintenance report 
is output.

Report Period 
field

Displays the report period of the maintenance report.
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<Making Report>

NOTE: To create the maintenance report, the following conditions must be met on PC.
- Microsoft Excel 2010 or later is pre-installed on your PC.

* Install the Excel on the same PC to which the PCPro is installed.
- Macro settings in Excel is effective.

* For details, refer to the “<Enabling Macro in Excel>” in Chapter 1.
- The printer in use is set normally.
- Close all other Excel files when creating the maintenance report.

STEP1: Click the [View Sample] button.

No. Item Description

(1) [View Sample] 
button

Click to view a sample of the maintenance report.
* The report histories of the time/date and the time period are not main-

tained when viewing the sample of the maintenance report.

(2) [Create Report] 
button

Click to create the maintenance report.
* When the maintenance report is created by this button, the report histo-

ries (such as the time/date and the time period of the report) is saved.

(3) Note field A note for the installation of Microsoft Excel and macro settings are 
described.
Click the link (underline part) of “And be sure that macro security is set 
to a proper level. Refer to the following help. [How to enable macro]” to 
display the help for macro settings.

(4) [Finish] button Click to return to the [Maintenance Report] screen.

[<< Back] button (4)

(1)

(3)

(2)



Chapter 4 Standard Mode

4-311 NWA-088656-001 Rev.8.0

[Maintenance] Category

Tips: Using View Sample feature
The View Sample feature is used to confirm the information entered so far in the sample of
the maintenance report. When editing is required for the output sample, return to the previ-
ous Make Report screen and edit the entered data. The View Sample feature can be used any
number of times. Make the report when no problem is found in the sample of the maintenance
report.

The [Save As] screen is displayed.

STEP2: Specify the folder and file name to which the sample of the maintenance report is created, 
then click the [Save] button.
Excel is launched and starts creating the sample of the maintenance report.
* When the report file of the same file name exists, the dialog box is displayed to confirm

the file overwrite. Click the [No] button to output with an another file name without over-
writing the file.

When creating the sample of the maintenance report is completed, a dialog box is displayed
to notify the completion of the process. 

STEP3: Click the [Yes] button.

The sample of the maintenance report is displayed in Excel.

STEP4: Verify the information displayed on the sample of the maintenance report.
* Go to STEP6 to create the report by the displayed information.

[Yes] button
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STEP5: Change the entered data of the Make Report screen for which the editing is required. Then, 
repeat the STEP1 to STEP4.

STEP6: Click the [Create Report] button.
The [Save As] screen is displayed.

STEP7: Specify the folder and file name to which the maintenance report is created, then click the 
[Save] button.
Excel is launched and starts creating the maintenance report.
* When the report file of the same file name exists, the dialog box is displayed to confirm

the file overwrite. Click the [No] button to output with an another file name without over-
writing the file.

When creating the maintenance report is completed, a dialog box is displayed to notify the
completion of the process.

STEP8: Click the [Yes] button.

The maintenance report is displayed in Excel.

[Yes] button
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STEP9: Edit the information of the maintenance report in Excel, if necessary.
STEP10: Print the maintenance report from Excel.
STEP11: Click the [Finish] button.

You are directed back to the [Maintenance Report] screen.

The creation of the maintenance report has now been completed.
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Maintenance Report Data

The [Maintenance Report Data] menu can delete the unnecessary report data, import the report data
which is used on the other PCs to an own PC and export the report data which is used on an own PC to
other PCs.

Continued on next page

No. Item Description

(1) [Delete] button Click to delete the report data and the history of output 
report.

(2) [Import] button Click to import the stored report data on other PCs to 
an own PC and create the report from an own PC.
*1 Usually, this feature is not used. 
*2 When the report data in the same system as the 

report data stored in the PC used was imported, the 
report data is automatically merged.

*3 When there is no stored report data in the PC used, 
or report data in other systems was imported, the 
report data is newly added in the System List area.

(3) [Export] button Click to export the stored report data on an own PC to 
other PCs and create the report from other PCs.
*1 Usually, this feature is not used.
*2 The exported report data will be saved in ZIP 

format.

(3)
(2)

(1)

(4)

[<< Back] button
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No. Item Description

(4) System List Area Last Access Date 
field

Displays the date and time at which the system data 
changes information was retrieved on the [Mainte-
nance Report] screen.
• Display format: YYYY/MM/DD HH:MM:SS

(Example: 2014/03/10 15:20:12)
* This field becomes a blank when report data has not 

been read.

System Name 
field

Displays the system name (CM04 Y=70>00) read 
from SV9300.
*1 When a system name is changed by the [Make 

Report (5/8)] screen, the system name after the 
change is displayed.

*2 This field becomes a blank when no system name 
is registered to SV9300.

Hardware Key 
Code field

Displays the Hardware Key Codes.

Connection 
Account field

Displays the latest connection account connected to 
the system.

Last Update Date 
field

Displays the date and time at which the maintenance 
report was last created on the [Maintenance Report] 
screen.
• Display format: YYYY/MM/DD HH:MM:SS

(Example: 2014/03/10 15:20:12)
* This field becomes a blank when a maintenance 

report has not been output.
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<Deleting Report Data>

STEP1: Select the row of the report data to delete from the System List area.
STEP2: Click the [Delete] button.

A dialog box is displayed to confirm the deletion of the report data.
STEP3: Click the [Yes] button.

The selected report data and the output report history are deleted.

The report data has now been deleted.

<Importing Report Data>

NOTE: For importing report data, the following data is exempt.
- The [Make Report (2/8)] screen: the selecting status of the output items
- The [Make Report (3/8)] screen: Report Name, Report Subtitle 1-3
- The [Make Report (4/8)] screen: Work Outlines area of the Index
- The [Make Report (5/8)] screen: Comment field of the customer’s system overview
- The [Make Report (6/8)] screen: Inspection checklist area

STEP1: Select the row from the System List Area, then click the [Import] button.
The [Open] screen is displayed.

[Yes] button
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STEP2: Select the report data in the [Open] screen, then click the [Open] button.

The importing report data starts.
When the importing report data is completed, a dialog box is displayed to notify the comple-
tion of the import process.

STEP3: Click the [OK] button.

The report data has now been imported.

[Open] button[Open] button

[OK] button
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<Exporting Report Data>

NOTE: For exporting report data, the following data is exempt.
- The [Make Report (2/8)] screen: the selecting status of the output items
- The [Make Report (3/8)] screen: Report Name, Report Subtitle 1-3
- The [Make Report (4/8)] screen: Work Outlines area of the Index
- The [Make Report (5/8)] screen: Comment field of the customer’s system overview
- The [Make Report (6/8)] screen: Inspection checklist area

STEP1: Select the row from the System List Area, then click the [Export] button.
The screen to specify where to save the report data is displayed.

STEP2: Specify the destination to save the report data, then click the [OK] button.

The exporting report data starts and the data is saved in ZIP format.
When the exporting report data is completed, a dialog box is displayed to notify the comple-
tion of the export process.

STEP3: Click the [OK] button.

The report data has now been exported.

[OK] button

[OK] button
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Wizard Mode

Wizard Mode provides screens, which are the equivalent of system
data settings of the Programming Manual.

• By entering system data in order according to the screen, settings of the service
feature will be completed.

• Because supplemental remarks of the system data and recommended value to im-
plement the service are displayed on the screen, the system data for the service
can be set easily.

This chapter explains how to switch to Wizard Mode, use Wizard
Mode and to set each category.

• Switching to Wizard Mode
• Using Wizard Mode
• [CCIS Features] Category
• [ISDN Features] Category
• [CCIS Features (Command Mode)] Category
• [ISDN Features (Command Mode)] Category
• [WCS Features (Command Mode)] Category
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Switching to Wizard Mode

You can switch the submenu view to Wizard Mode in one of the following operations:
• Click mode selector tab [  Wizard] tab.
• On the Main Menu, click [Edit] > [Wizard] in this order.

On the Main Menu,
[Edit] > [Wizard]

Mode selector tab
[       Wizard]
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Using Wizard Mode

The Wizard Mode is organized into the following submenus.Work with the setup screen as instructed in
the page shown in the Refer column.

*1 You can set the service feature by assigning multiple commands (such as more than one trunk numbers)
at a time. By saving the setting data into a script file, you can work in off-line mode.

*2 You can set the service feature to read or write system data per command (available only in on-line
mode).

Continued on next page

Submenu Category Menu Choice
Reference 

Page

CCIS Features*1 *4 CCIS (P2P CCIS) Programming*3 Page 5-6

CCIS (TDM) Programming Page 5-15

ISDN Features*1 PRI Programming*4 Page 5-23

CCIS Features (Command Mode)*2 *5 IPT (P2P CCIS) Basic Programming Page 5-30

TDM Basic Programming Page 5-33

ISDN Features (Command Mode)*2 *5 Basic Programming (BRI) Page 5-36

Basic Programming (PRI) Page 5-39

DID Addressing Page 5-42

WCS Features (Command Mode)*2 *5 Basic Programming Page 5-44

PS Data Programming Page 5-47

Wizard Mode submenu
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*3 CCIS (P2P CCIS) Programming is intended for IPT (P2P CCIS).
*4 When setting CCIS Features or doing PRI Programming, use the CCIS Features menu or the ISDN

Features menu. However, when reading the system data after these service features are set, use the
CCIS Features (Command Mode) menu or the ISDN Features (Command Mode) menu.

*5 In command modes such as the CCIS Features (Command Mode) and the ISDN Features (Command
Mode), if  in submenus of each category is clicked, the system data menu necessary to provide the
service feature are expanded to the tree. By assigning the system data menu expanded to the tree in
order, the basic system data of the appropriate category can be assigned.

Continued on next page

No. Item Description

(1) System Data menus Displays system data necessary to assign for each feature.
* When the connection with SV9300 is established, reads and displays 

system data in the work window (if there is no select/entry item such as 
Unit number).

(2) [Read] button Click to read system data registered in the SV9300.
* Effective only when system data to be read exists.

(3) [Apply] button Click to write the assigned system data to the SV9300.
* Effective only when system data to be written exists.

(4) [Previous] ( ) 
button

Click to switch the previous system data setting screen.

(1)

[Expand All]
button

[Callapse All] 
button

(6)

(5)

(4)

(3)
(2)

(8)

(7)

(7)



Chapter 5 Wizard Mode

5-5 NWA-088656-001 Rev.8.0

Using Wizard Mode

No. Item Description

(5) [Next] ( ) button Click to switch the next system data setting screen.
* When switching to the last screen to set the system data (such as for a 

system reset and a blade reset),  is displayed.

(6) [Recommend] button Click to change the assigned system data to recommended values.
* Effective only when system data to be written exists.

(7) Supplemental 
Remarks Display

Displays supplemental remarks (displays only when preconditions and 
precautions of the service settings exist).

(8) Recommended Value 
Display

Displays recommended values (displays only when recommended 
values exist).
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[CCIS Features] Category

In the [CCIS Features] category, the following CCIS features can be set.
• CCIS (P2P CCIS) Programming
• CCIS (TDM) Programming  Page 5-15

CCIS (P2P CCIS) Programming

The CCIS (P2P CCIS) data can be set by the following procedures.

(1) Essential Data Settings : Assign the essential data for CCIS (P2P CCIS) Programming with
the [CCIS (P2P CCIS) Programming (1/4)] screen.

(2) Numbering Plan Data Settings: Assign the numbering plan data with the [CCIS (P2P CCIS) 
Programming (2/4)] screen.

(3) Optional Data Settings : Assign the optional data with the [CCIS (P2P CCIS) Programming
(3/4)] screen.

(4) System Data Registration : Register the assigned data to SV9300 with the [CCIS (P2P CCIS)
Programming (4/4)] screen.

Tips: Concerning the Setting Method
When doing the following settings, assign the data according to the “explanation” and “setting
values” described in the setting items on each screen.



Chapter 5 Wizard Mode

5-7 NWA-088656-001 Rev.8.0

[CCIS Features] Category

STEP1: Click the [CCIS (P2P CCIS) Programming] menu from submenu of the [CCIS FEATURES] 
category.
The [CCIS (P2P CCIS) Programming (1/4)] screen is displayed in the work window.

Continued on next page

No. Item Description

(1) [Read] button Click to read the data by focusing on the available data (available only in 
on-line mode).

(2) [Originating and 
destination settings] 
radio button

Click to register the originating and destination data.

(3) [Destination 
settings] radio button

Click to register the additional destination data.

(4) Data selection 
pulldown menu

Click  to select data to be assigned for the following items.
• The Number of Voice Channel
• Starting Virtual Port No.
• Voice Channel Route No.
• Common Channel Handler (CCH) No.

(1)
[CCIS (P2P CCIS)

 Programming]
 menu

(7)

(3)(2)
(4)
(5)

[Next>>] button

(6)
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Tips: Reading Feature by Focusing on the Available Data
When launching the [CCIS (P2P CCIS) Programming (1/4)] screen, or clicking the [Read] 
button on the screen, you can read the data by focusing on the available data for the following
fields. Because the only available data is displayed in each field, each data can be assigned 
easily.
- Starting Virtual Port No.
- Voice Channel Route No.
- Common Channel Handler (CCH) No.
* This feature is available only when connected to the SV9300.

STEP2: Click the [Read] button, if necessary.
STEP3: Check the [Originating and destination settings] radio button or the [Destination settings] radio 

button.
• When the [Originating and destination settings] radio button is checked: Go to STEP4.
• When the [Destination settings] radio button is checked: Go to STEP6.

STEP4: Click the [Available Trunk] button.
The [List of Available Trunks] screen is displayed.

No. Item Description

(5) Data Entry field Enter the data to be assigned for the following items.
• Starting Trunk No. (for Voice Channel)
• Common Control Channel Trunk No.
• Originating Point Code (Self)
• Originating Office Number
• Destination Point Code (Mate)
• IP Address of the Opposite Office
*1 Only 0-9 (up to 4 digits) can be set for Originating Office Number.
*2 Enter the Destination Point Code (Mate) including periods. “0.0.0.0” 

and “255.255.255.255” cannot be set.

(6) Explanation field Describes the set contents of each item.

(7) [Available Trunks] 
button

Click to display the [List of Available Trunks] screen. This screen is used 
to confirm the available trunk number when assigning the Starting Trunk 
number. 
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STEP5: Confirm the available trunk numbers, then click the [Close] button.

NOTE: The list of available trunk numbers can be read only in on-line mode.

STEP6: Set the necessary items, then click the [Next >>] button.
The [CCIS (P2P CCIS) Programming (2/4)] screen is displayed in the work window.

[Close] button
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NOTE: The entry conditions differ depending on the registration method specified by the STEP3. Set 
the data according to the entry conditions as shown the table below.

: Data entry/selection required, –: Random entry/selection

Tips: A Starting Trunk Number Assignment
Match the Starting Trunk No. (for Voice Channel) field with the available trunk numbers con-
firmed by the [List of Available Trunks] screen.
* In the CCIS (P2P CCIS) Programming, the trunk numbers for voice channel are assigned for

the number of voice channels in order from the Starting Trunk number.

Setting Item

Entry Condition

When Setting 
Originating and 

Destination

When Setting 
Destination

The Number of Voice Channel  (Unselectable)

Starting Trunk No. (for Voice Channel)  (No entry is available)

Common Control Channel Trunk No.  

Starting Virtual Port No.  (Unselectable)

Voice Channel Route No.  

Common Channel Handler (CCH) No.  

Originating Point Code (Self)  –

Originating Office Number – –

Destination Point Code (Mate) – 

IP Address of the Opposite Office – 
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STEP7: When setting the Numbering Plan, set the necessary items, then click the [Next >>] button.

The [CCIS (P2P CCIS) Programming (3/4)] screen is displayed in the work window.

No. Item Description

(1) Data Entry field Enter the data to be assigned for the following items.
• Access Code
• Area Code

(2) Data selection pull-
down menu

Click  to select data to be assigned for the following items.
• Maximum No. of Sending Digits
• Route Pattern No.
• LCR Pattern No.
• IP Address Pattern No.

(3) Explanation field Describes the set contents of each item.

[Next >>] button

(3)(1)
(2)
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STEP8: Set the necessary items for the optional features, then click the [Next >>] button.
Set the data related to Common Channel Handler (CCH) No. and the system (CM08) here.

Tips: When Applying Default Data
To assign the default data for each setting item in the Optional Feature Settings Area, click the
[Set Default Data] button, then click the [Next >>] button.

The assigned data for CCIS (P2P CCIS) Programming is generated, and the [CCIS (P2P CCIS)
Programming (4/4)] screen is displayed in the work window.

No. Item Description

(1) [Set Default Data] 
button

Click to assign the default data for each item in the Optional Feature 
Settings Area.

(2) [Clear] button Click to clear the input data in the Optional Feature Settings Area.

[Next >>] button

(2)

Optional Feature
Settings Area

(1)
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STEP9: Confirm the generated data, then click the [Apply] button.

After clicking the [Apply] button, a dialog box is displayed to confirm the registration of the
input data.

NOTE: The [Apply] button is effective only in on-line mode.

No. Item Description

(1) [Apply] button Click to write the generated data to the SV9300.

(2) [Export] button Click to export the generated data to the script file.

(3) Setting 
Data Area

CMD field Displays the command code and Y number assigned in the [CCIS 
(P2P CCIS) Programming] screen.

FD field Displays the first data of the command code assigned in the [CCIS 
(P2P CCIS) Programming] screen.

SD field Displays the second data of the command code assigned in the 
[CCIS (P2P CCIS) Programming] screen.

ED field Displays the command code-specific SV9300 response data 
assigned in the [CCIS (P2P CCIS) Programming] screen.

Message field Uses to edit the script file created by the export feature.

(4) [Quit] button Click to return the [CCIS (P2P CCIS) Programming (1/4)] screen.

[<< Back] button

(2)

(4)

(3)

(1)
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Tips: Creating a Script File
With the export feature, you can save the input data to a script file without registering to the
system. The created script file can be used in off-line mode.
After clicking the [Export] button, the [Save As] screen is displayed. Specify the folder to which
the script file is saved, then click the [Save] button.

* For the reading method of the script file, see “Script”. Page 4-90

STEP10: Click the [Yes] button.

STEP11: Click the [Quit] button.
You are directed back to the [CCIS (P2P CCIS) Programming (1/4)] screen.

The CCIS (P2P CCIS) Programming has now been set.

[Save] button

[Yes] button
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CCIS (TDM) Programming

The CCIS (TDM) data can be set by the following procedures.

(1) Essential Data Settings : Assign the essential data for CCIS (TDM) Programming with the 
[CCIS (TDM) Programming (1/4)] screen.

(2) Numbering Plan Data Settings: Assign the numbering plan data with the [CCIS (TDM) Program-
ming (2/4)] screen.

(3) Optional Data Settings : Assign the optional data with the [CCIS (TDM) Programming (3/4)] 
screen.

(4) System Data Registration : Register the assigned data to SV9300 with the [CCIS (TDM) Pro-
gramming (4/4)] screen.

Tips: Concerning the Setting Method
When doing the following settings, assign the data according to the “explanation” and “setting
values” described in the setting items on each screen.

STEP1: Click the [CCIS (TDM) Programming] menu from submenu of the [CCIS FEATURES] 
category.
The [CCIS (TDM) Programming (1/4)] screen is displayed in the work window.

(1)[CCIS (TDM)
 Programming]

 menu

(7)

(3)(2)
(4)

(5)

[Next>>] button

(6)
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No. Item Description

(1) [Read] button Click to read the data by focusing on the available data (available only 
in on-line mode).

(2) [Originating and 
destination settings] 
radio button

Click to register the originating and destination data.

(3) [Destination set-
tings] radio button

Click to register the additional destination data.

(4) Data selection 
pulldown menu

Click  to select data to be assigned for the following items.
• Unit No.
• Slot No.
• Trunk Blade No.
• Voice Channel Route No.
• Signal Channel Route No.
• Common Channel Handler (CCH) No.
• Clock Source

(5) Data Entry field Enter the data to be assigned for the following items.
• Starting Trunk No. (for Voice Channel)
• Common Control Channel Trunk No.
• Originating Point Code (Self)
• Originating Office Number
• Destination Point Code (Mate)
* Only 0-9 (up to 4 digits) can be set for Originating Office Number.

(6) Explanation field Describes the set contents of each item.

(7) [Available Trunks] 
button

Click to display the [List of Available Trunks] screen. This screen is 
used to confirm the available trunk number when assigning the Starting 
Trunk No. 
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Tips: Reading Feature by Focusing on the Available Data
• When launching the [CCIS (TDM) Programming (1/4)] screen, or clicking the [Read] button

on the screen, you can read the data by focusing on the available data for the following fields.
Because the only available data is displayed in each field, each data can be assigned easily.
- Unit No.
- Slot No.
- Trunk Blade No.
- Voice Channel Route No.
- Signal Channel Route No.
- Common Channel Handler (CCH) No.
- Clock Source

• When the Unit number is changed, the available Slot numbers and the Clock Source setting
are automatically read.

* This feature is available only in on-line mode.

STEP2: Click the [Read] button, if necessary.
STEP3: Check the [Originating and destination settings] radio button or the [Destination settings] radio 

button.
• When the [Originating and destination settings] radio button is checked: Go to STEP4.
• When the [Destination settings] radio button is checked: Go to STEP6.

STEP4: Click the [Available Trunk] button.
The [List of Available Trunks] screen is displayed.

STEP5: Confirm the available trunk numbers, then click the [Close] button.

NOTE: The list of available trunk numbers can be read only in on-line mode.

[Close] button
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STEP6: Set the necessary items, then click the [Next >>] button.
The [CCIS (TDM) Programming (2/4)] screen is displayed in the work window.

NOTE: The entry conditions differ depending on the registration method specified by the STEP3. Set 
the data according to the entry conditions as shown the table below.

: Data entry/selection required, –: Random entry/selection

Tips: A Starting Trunk Number Assignment
Match the Starting Trunk No. (for Voice Channel) field with the available trunk numbers con-
firmed by the [List of Available Trunks] screen.
* In the CCIS (TDM) Programming, the 23 trunk numbers (for voice channel) are assigned in

order from the Starting Trunk number.

Setting Item

Entry Condition

When Setting 
Originating and 

Destination

When Setting 
Destination

Unit No.  (Unselectable)

Slot No.  (Unselectable)

Trunk Blade No.  (Unselectable)

Starting Trunk No. (for Voice Channel)  (No entry is available)

Common Control Channel Trunk No.  

Voice Channel Route No.  

Signal Channel Route No.  (Unselectable)

Common Channel Handler (CCH) No.  

Originating Point Code (Self)  –

Originating Office Number – –

Destination Point Code (Mate) – 

Clock Source – (No entry is available)
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STEP7: When setting the Numbering Plan, set the necessary items, then click the [Next >>] button.

The [CCIS (TDM) Programming (3/4)] screen is displayed in the work window.

No. Item Description

(1) Data Entry field Enter the data to be assigned for the following items.
• Access Code
• Area Code
• Digits to be added

(2) Data selection pull-
down menu

Click  to select data to be assigned for the following items.
• Maximum No. of Sending Digits
• Route Pattern No.
• LCR Pattern No.
• Number of digit to be deleted from Area Code

(3) Explanation field Describes the set contents of each item.

[Next >>] button

(3)(1)
(2)
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STEP8: Set the necessary items for the optional features, then click the [Next >>] button.
Set the data related to Voice Channel Route No., Trunk Blade No., Common Channel Handler 
(CCH) No. and the system (CM08) here.

Tips: When Applying Default Data
To assign the default data for each setting item in the Optional Feature Settings Area, click the
[Set Default Data] button, then click the [Next >>] button.

The assigned data for CCIS (TDM) Programming is generated, and the [CCIS (TDM) Program-
ming (4/4)] screen is displayed in the work window.

No. Item Description

(1) [Set Default Data] 
button

Click to assign the default data for each item in the Optional Feature 
Settings Area.

(2) [Clear] button Click to clear the input data in the Optional Feature Settings Area.

[Next >>] button

(2)

Optional Feature
Settings Area

(1)
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STEP9: Confirm the generated data, then click the [Apply] button.

After clicking the [Apply] button, a dialog box is displayed to confirm the registration of the
input data.

NOTE: The [Apply] button is effective only in on-line mode.

No. Item Description

(1) [Apply] button Click to write the generated data to the SV9300.

(2) [Export] button Click to export the generated data to the script file.

(3) Setting 
Data Area

CMD field Displays the command code and Y number assigned in the [CCIS 
(TDM) Programming] screen.

FD field Displays the first data of the command code assigned in the [CCIS 
(TDM) Programming] screen.

SD field Displays the second data of the command code assigned in the 
[CCIS (TDM) Programming] screen.

ED field Displays the command code-specific SV9300 response data 
assigned in the [CCIS (TDM) Programming] screen.

Message field Uses to edit the script file created by the export feature.

(4) [Quit] button Click to return the [CCIS (TDM) Programming (1/4)] screen.

[<< Back] button

(2)

(4)

(3)

(1)
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Tips: Creating a Script File
With the export feature, you can save the input data to a script file without registering to the
system. The created script file can be used in off-line mode.
After clicking the [Export] button, the [Save As] screen is displayed. Specify the folder to which
the script file is saved, then click the [Save] button.

* For the reading method of the script file, see “Script”. Page 4-90

STEP10: Click the [Yes] button.

STEP11: Click the [Quit] button.
You are directed back to the [CCIS (TDM) Programming (1/4)] screen.

The CCIS (TDM) Programming has now been set.

[Save] button

[Yes] button
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[ISDN Features] Category

In the [ISDN Features] category, the ISDN PRI data can be set.

PRI Programming

The ISDN PRI data can be set by the following procedures.

(1) Essential Data Settings : Assign the essential data for PRI Programming with the [PRI Program-
ming (1/3)] screen.

(2) Optional Data Settings : Assign the optional data with the [PRI Programming (2/3)] screen.
(3) System Data Registration: Register the assigned data to SV9300 with the [PRI Programming 

(3/3)] screen.

Tips: Concerning the Setting Method
When doing the following settings, assign the data according to the “explanation” and “setting
values” described in the setting items on each screen.

STEP1: Click the [PRI Programming] menu from submenu of the [ISDN FEATURES] category.
The [PRI Programming (1/3)] screen is displayed in the work window.

(1)[PRI Programming]
 menu

(5)

(2)

[Next>>] button

(4)

(3)
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Tips: Reading Feature by Focusing on the Available Data
• When launching the [PRI Programming (1/3)] screen, or clicking the [Read] button on the

screen, you can read the data by focusing on the available data for the following fields. 
Because the only available data is displayed in each field, each data can be assigned easily.
- Unit No.
- Slot No.
- Trunk Blade No.
- Voice Channel Route No.
- Signal Channel Route No.
- DCH No.
- Clock Source

• When the Unit number is changed, the available Slot numbers and the Clock Source setting
are automatically read.

* This feature is available only in on-line mode.

No. Item Description

(1) [Read] button Click to read the data by focusing on the available data (available only 
in on-line mode).

(2) Data selection pull-
down menu

Click  to select data to be assigned for the following items.
• Unit No.
• Slot No.
• Trunk Blade No.
• The Number of Voice Channels
• Voice Channel Route No.
• Signal Channel Route No.
• DCH No.
• ISDN PRI Protocol
• Clock Source
• Send of expanded information on Low Layer Compatibility (LLC) 

information element

(3) Data Entry field Enter the data to be assigned for the following items.
• Starting Trunk No.

(4) Explanation field Describes the set contents of each item.

(5) [Available Trunks] 
button

Click to display the [List of Available Trunks] screen. This screen is 
used to confirm the available trunk number when assigning the Starting 
Trunk number. 
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STEP2: Click the [Read] button, if necessary.
STEP3: Click the [Available Trunk] button.

The [List of Available Trunks] screen is displayed.
STEP4: Confirm the available Trunk No. then click the [Close] button.

NOTE: The list of available trunk numbers can be read only in on-line mode.

STEP5: Set the necessary items, then click the [Next >>] button.
The [PRI Programming (2/4)] screen is displayed in the work window.

[Close] button
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NOTE: In the essential data settings for PRI Programming, set the data according to the entry condi-
tions as shown the table below.

: Data entry/selection required, –: Random entry/selection

Tips: A Starting Trunk Number Assignment
Match the Starting Trunk No. field with the available trunk numbers confirmed by the [List of 
Available Trunks] screen.
* In the PRI Programming, the 24 trunk numbers are assigned in order from the Starting Trunk

number and the 24th trunk number is assigned to DCH number.

Setting Item Entry Condition

Unit No. 

Slot No. 

Trunk Blade No. 

The Number of Voice Channels 

Starting Trunk No. 

Voice Channel Route No. 

Signal Channel Route No. 

DCH No. 

ISDN PRI Protocol 

Clock Source 

Send of expanded information on Low Layer 
Compatibility (LLC) information element

–
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STEP6: Set the necessary items for the optional features, then click the [Next >>] button.
Set the data related to Voice Channel Route No. and Trunk Blade No. here.

Tips: When Applying Default Data
To assign the default data for each setting item in the Optional Feature Settings Area, click the
[Set Default Data] button, then click the [Next >>] button.

The assigned data for PRI Programming is generated, and the [PRI Programming (3/3)] screen
is displayed in the work window.

No. Item Description

(1) [Set Default Data] 
button

Click to assign the default data for each item in the Optional Feature 
Settings Area.

(2) [Clear] button Click to clear the input data in the Optional Feature Settings Area.

[Next >>] button

(2)

Optional Feature
Settings Area

(1)
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STEP7: Confirm the generated data, then click the [Apply] button.

After clicking the [Apply] button, a dialog box is displayed to confirm the registration of the
input data.

NOTE: The [Apply] button is effective only in on-line mode.

No. Item Description

(1) [Apply] button Click to write the generated data to the SV9300.

(2) [Export] button Click to export the generated data to the script file.

(3) Setting 
Data Area

CMD field Displays the command code and Y number assigned in the [PRI 
Programming] screen.

FD field Displays the first data of the command code assigned in the [PRI 
Programming] screen.

SD field Displays the second data of the command code assigned in the [PRI 
Programming] screen.

ED field Displays the command code-specific SV9300 response data 
assigned in the [PRI Programming] screen.

Message field Uses to edit the script file created by the export feature.

(4) [Quit] button Click to return the [PRI Programming (1/3)] screen.

(2)

(4)

(3)

(1)
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Tips: Creating a Script File
With the export feature, you can save the input data to a script file without registering to the
system. The created script file can be used in off-line mode.
After clicking the [Export] button, the [Save As] screen is displayed. Specify the folder to which
the script file is saved, then click the [Save] button.

* For the reading method of the script file, see “Script”. Page 4-90

STEP8: Click the [Yes] button.

STEP9: Click the [Quit] button.
You are directed back to the [PRI Programming (1/3)] screen.

The PRI Programming has now been set.

[Save] button

[Yes] button



Chapter 5 Wizard Mode

5-30 NWA-088656-001 Rev.8.0

[CCIS Features (Command Mode)] Category

[CCIS Features (Command Mode)] Category

In the [CCIS Features (Command Mode)] category, the following basic system data can be assigned.
• IPT (P2P CCIS) Basic Programming
• TDM Basic Programming  Page 5-33

IPT (P2P CCIS) Basic Programming

In the IPT (P2P CCIS) Basic Programming, assign the following system data according to the screen.

The setting procedures are as follows.

STEP1: Click  of the [IPT (P2P CCIS) BASIC PROGRAMMING] menu from submenu of the [CCIS 
FEATURES (COMMAND MODE)] category to expand the tree.

NOTE: Items marked by  /  will not invoke a setup screen when they are clicked.

Menu Name Setting Commands

IPT (P2P CCIS) Basic Pro-
gramming

• CM10 : IPT (P2P CCIS) Registration
• CM0B: LAN Port Data Assignment
• CM30 : Trunk Data
• CM35 : Trunk Route Data
• CMA7: CCIS Channel/IP Trunk/SIP Trunk Data 1
• CMA8: CCIS Channel/IP Trunk/SIP Trunk Data 2
• CM8A: LCR/Toll Restriction Development Table
• CM5B: IP Address for IP Trunk Point-to-Multipoint Connection
• CM08 : Basic Services
• CME0: System Reset



Chapter 5 Wizard Mode

5-31 NWA-088656-001 Rev.8.0

[CCIS Features (Command Mode)] Category

STEP2: Click the [CM10: IPT (P2P CCIS) REGISTRARION] menu from the expanded tree view. 
The [CM10: IPT (P2P CCIS) REGISTRARION] screen is displayed.

STEP3: Click the [Read] button.
The system data currently assigned to the SV9300 is displayed on the screen.

NOTE: The [Read] button is effective only when system data to be read exists.

STEP4: Set the necessary items.

Tips: System Data Settings
• When assigning system data, assign the system data with supplemental remarks and recom-

mended values displayed on the setting screen of each command as a guide. In addition, click
the [Recommend] button to change to the recommended value of the system data (effective
only when recommended values exist).

• For details of the “IPT (P2P CCIS) Basic Programming”, refer to the “System Manual”.
• For details of each command, refer to the “Command Manual”.

STEP5: Click the [Apply] button.
The assigned system data is written to the SV9300.

NOTE: Be sure to click the [Apply] button when the setting of system data is changed. The set contents 
will not be reflected unless clicked the [Apply] button.

[CM10: IPT (P2P CCIS)
REGISTRATION] Menu
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STEP6: Click the  button.
The [CM0B: LAN PORT DATA ASSIGNMENT (VoIP port)] screen is displayed.

STEP7: Also repeat the operations from STEP3 to STEP6 for the next [CM0B: LAN PORT DATA 
ASSIGNMENT (VoIP port)] menu to the [CM08: BASIC SERVICES] menu.

Tips: Changing System Data
When changing the setting of system data, display the setting screen of the command necessary
to change by the   buttons, then assign the system data again (STEP3-STEP5).

STEP8: Click the [Reset] button on the [CME0: SYSTEM RESET] screen.

The system reset is executed.

The IPT (P2P CCIS) Basic Programming has now been set.

[Reset] button
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TDM Basic Programming

In the TDM Basic Programming, assign the following system data according to the screen.

The setting procedures are as follows.

STEP1: Click  of the [TDM BASIC PROGRAMMING] menu from submenu of the [CCIS 
FEATURES (COMMAND MODE)] category to expand the tree.

NOTE: Items marked by  /  will not invoke a setup screen when they are clicked.

Menu Name Setting Commands

TDM Basic Programming • CM05 : Blade Data
• CM10 : TDM Terminal/Trunk Registration
• CM04 : A-Law/µ-law Setting for Each Unit, Destination to 

Receive the Synchronous Signal
• CM35 : Trunk Route Data
• CM30 : Trunk Data (Voice Channel)
• CM35 : Trunk Route Data
• CM30 : Trunk Data (Signaling Channel)
• CM35 : Trunk Route Data
• CMAA: DTI/BRT/PRT/CCT Functions
• CMA7 : CCIS Channel/IP Trunk/SIP Trunk Data 1
• CMA8 : CCIS Channel/IP Trunk/SIP Trunk Data 2
• CM08 : Basic Services
• CME0 : System Reset
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STEP2: Click the [CM05: BLADE DATA] menu from the expanded tree view.
The [CM05: BLADE DATA] screen is displayed.

STEP3: Click the [Read] button.
The system data currently assigned to the SV9300 is displayed on the screen.

NOTE: The [Read] button is effective only when system data to be read exists.

STEP4: Set the necessary items.

Tips: System Data Settings
• When assigning system data, assign the system data with supplemental remarks and recom-

mended values displayed on the setting screen of each command as a guide. In addition, click
the [Recommend] button to change to the recommended value of the system data (effective
only when recommended values exist).

• For details of the “TDM Basic Programming”, refer to the “Programming Manual”.
• For details of each command, refer to the “Command Manual”.

STEP5: Click the [Apply] button.
The assigned system data is written to the SV9300.

NOTE: Be sure to click the [Apply] button when the setting of system data is changed. The set contents 
will not be reflected unless clicked the [Apply] button.

[CM05: BLADE
 DATA] Menu



Chapter 5 Wizard Mode

5-35 NWA-088656-001 Rev.8.0

[CCIS Features (Command Mode)] Category

STEP6: Click the  button.
The [CM10: TDM TERMINAL/TRUNK REGISTRATION] screen is displayed.

STEP7: Also repeat the operations from STEP3 to STEP6 for the [CM10: TDM TERMINAL/TRUNK 
REGISTRATION] menu to the [CM08: BASIC SERVICES] menu.

Tips: Changing System Data
When changing the setting of system data, display the setting screen of the command necessary
to change by the   buttons, then assign the system data again (STEP3-STEP5).

STEP8: Click the [Reset] button on the [CME0: SYSTEM RESET] screen.

The system reset is executed.

The TDM Basic Programming has now been set.

[Reset] button
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[ISDN Features (Command Mode)] Category

In the [ISDN Features (Command Mode)] category, the following basic system data can be assigned.
• Basic Programming (BRI)
• Basic Programming (PRI)  Page 5-39
• DID Addressing  Page 5-42

Basic Programming (BRI)

In the Basic Programming (BRI), assign the following system data according to the screen.

The setting procedures are as follows.

STEP1: Click  of the [Basic PROGRAMMING (BRI)] menu from submenu of the [ISDN 
FEATURES (COMMAND MODE)] category to expand the tree.

NOTE: Items marked by  /  will not invoke a setup screen when they are clicked.

Menu Name Setting Commands

Basic Programming (BRI) • CM05 : Blade Data
• CMAA: DTI/BRT/PRT/CCT Functions
• CMAC: ISDN Functions
• CM10 : TDM Terminal/Trunk Registration
• CM04 : A-Law/µ-law Setting for Each Unit, Destination to 

Receive the Synchronous Signal
• CME5 : Station, Trunk Line Make Busy
• CM30 : Trunk Data
• CM35 : Trunk Route Data
• CME0 : Blade Reset
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STEP2: Click the [CM05: BLADE DATA] menu from the expanded tree view.
The [CM05: BLADE DATA] screen is displayed.

STEP3: Click the [Read] button.
The system data currently assigned to the SV9300 is displayed on the screen.

NOTE: The [Read] button is effective only when system data to be read exists.

STEP4: Set the necessary items.

Tips: System Data Settings
• When assigning system data, assign the system data with supplemental remarks and recom-

mended values displayed on the setting screen of each command as a guide. In addition, click
the [Recommend] button to change to the recommended value of the system data (effective
only when recommended values exist).

• For details of the “Basic Programming (BRI)”, refer to the “Programming Manual”.
• For details of each command, refer to the “Command Manual”.

STEP5: Click the [Apply] button.
The assigned system data is written to the SV9300.

NOTE: Be sure to click the [Apply] button when the setting of system data is changed. The set contents 
will not be reflected unless clicked the [Apply] button.

[CM05: BLADE
 DATA] Menu
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STEP6: Click the  button.
The [CMAA: DTI/BRT/PRT/CCT FUNCTIONS] screen is displayed.

STEP7: Also repeat the operations from STEP3 to STEP6 for the [CMAA: DTI/BRT/PRT/CCT 
FUNCTIONS] menu to the [CM35: TRUNK ROUTE DATA] menu.

Tips: Changing System Data
When changing the setting of system data, display the setting screen of the command necessary
to change by the   buttons, then assign the system data again (STEP3-STEP5).

STEP8: Select the Unit No. and the Slot No. to be reset on the [CME0: BLADE RESET] screen, then 
click the [Reset] button.

The blade reset is executed.

The Basic Programming (BRT) has now been set.

[Reset] button

SLOT No. field
UNIT No. field
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Basic Programming (PRI)

In the Basic Programming (PRI), assign the following system data according to the screen.

The setting procedures are as follows.

STEP1: Click  of the [BASIC PROGRAMMING (PRI)] from submenu of the [ISDN FEATURES 
(COMMAND MODE)] category to expand the tree.

NOTE: Items marked by  /  will not invoke a setup screen when they are clicked.

Menu Name Setting Commands

Basic Programming (PRI) • CM05 : Blade Data
• CM10 : TDM Terminal/Trunk Registration
• CM04 : A-Law/µ-law Setting for Each Unit, Destination to 

Receive the Synchronous Signal
• CM30 : Trunk Data (B Channel)
• CM35 : Trunk Route Data
• CM30 : Trunk Data (D Channel)
• CM35 : Trunk Route Data
• CMAA: DTI/BRT/PRT/CCT Functions
• CMA9 : ISDN (PRI) D-Channel Assignment
• CME0 : System Reset
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STEP2: Click the [CM05: BLADE DATA] menu from the expanded tree view.
The [CM05: BLADE DATA] screen is displayed.

STEP3: Click the [Read] button.
The system data currently assigned to the SV9300 is displayed on the screen.

NOTE: The [Read] button is effective only when system data to be read exists.

STEP4: Set the necessary items.

Tips: System Data Settings
• When assigning system data, assign the system data with supplemental remarks and recom-

mended values displayed on the setting screen of each command as a guide. In addition, click
the [Recommend] button to change to the recommended value of the system data (effective
only when recommended values exist).

• For details of the “Basic Programming (PRT)”, refer to the “Programming Manual”.
• For details of each command, refer to the “Command Manual”.

STEP5: Click the [Apply] button.
The assigned system data is written to the SV9300.

NOTE: Be sure to click the [Apply] button when the setting of system data is changed. The set contents 
will not be reflected unless clicked the [Apply] button.

[CM05: BLADE
 DATA] Menu



Chapter 5 Wizard Mode

5-41 NWA-088656-001 Rev.8.0

[ISDN Features (Command Mode)] Category

STEP6: Click the  button.
The [CM10: TDM TERMINAL/TRUNK REGISTRATION] screen is displayed.

STEP7: Also repeat the operations from STEP3 to STEP6 for the [CM10: TDM TERMINAL/TRUNK 
REGISTRATION] menu to the [CMA9: ISDN (PRI) D-CHANNEL ASSIGNMENT] menu.

Tips: Changing System Data
When changing the setting of system data, display the setting screen of the command necessary
to change by the   buttons, then assign the system data again (STEP3-STEP5).

STEP8: Click the [Reset] button on the [CME0: SYSTEM RESET] screen.

The system reset is executed.

The Basic Programming (PRT) has now been set.

[Reset] button
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DID ADDRESSING

In the DID Addressing, assign the following system data according to the screen.

The setting procedures are as follows.

STEP1: Click  of the [DID ADDRESSING] from submenu of the [ISDN FEATURES (COMMAND 
MODE)] category to expand the tree.

NOTE: Items marked by  /  will not invoke a setup screen when they are clicked.

STEP2: Click the [CM76: DIGIT CONVERSION ON DID CALL] menu from the expanded tree view.
The [CM76: DIGIT CONVERSION ON DID CALL] screen is displayed.

STEP3: Click the [Read] button.
The system data currently assigned to the SV9300 is displayed on the screen.

NOTE: The [Read] button is effective only when system data to be read exists.

STEP4: Set the necessary items.

Menu Name Setting Commands

DID Addressing • CM76: Digit Conversion on DID Call

[CM76: DIGIT
 CONVERSION
 ON DID CALL]

 Menu
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Tips: System Data Settings
• When assigning system data, assign the system data with supplemental remarks and recom-

mended values displayed on the setting screen of each command as a guide. In addition, click
the [Recommend] button to change to the recommended value of the system data (effective
only when recommended values exist).

• For details of the “DID Addressing”, refer to the “Programming Manual”.
• For details of each command, refer to the “Command Manual”.

STEP5: Click the [Apply] button.
The assigned system data is written to the SV9300.

NOTE: Be sure to click the [Apply] button when the setting of system data is changed. The set contents 
will not be reflected unless clicked the [Apply] button.

STEP6: Click the  button.
The [CM76: DIGIT CONVERSION ON DID CALL] screen is displayed.

STEP7: Also repeat the operations from STEP3 to STEP6 for the rest of [CM76: DIGIT CONVERSION 
ON DID CALL] menus.

Tips: Changing System Data
When changing the setting of system data, display the setting screen of the command necessary
to change by the   buttons, then assign the system data again (STEP3-STEP5).

The DID Addressing has now been set.
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[WCS Features (Command Mode)] Category

In the [WCS Features (Command Mode)] category, the following basic system data can be assigned.
• Basic Programming
• PS Data Programming  Page 5-47

Basic Programming

In the Basic Programming, assign the following system data according to the screen.

The setting procedures are as follows.

STEP1: Click  of the [BASIC PROGRAMMING] menu from submenu of the [WCS FEATURES 
(COMMAND MODE)] category to expand the tree.

NOTE: Items marked by  /  will not invoke a setup screen when they are clicked.

Menu Name Setting Commands

Basic Programming • CM05 : Blade Data
• CM10 : TDM Terminal/Trunk Registration
• CMAD: ZT Calling Area/PAD Data Assignment
• CMAE: ZT Operation Data Assignment
• CME5 : CS/ZT Make Busy
• CME0 : Blade Reset
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STEP2: Click the [CM05: BLADE DATA] menu from the expanded tree view.
The [CM05: BLADE DATA] screen is displayed.

STEP3: Click the [Read] button.
The system data currently assigned to the SV9300 is displayed on the screen.

NOTE: The [Read] button is effective only when system data to be read exists.

STEP4: Set the necessary items.

Tips: System Data Settings
• When assigning system data, assign the system data with supplemental remarks and recom-

mended values displayed on the setting screen of each command as a guide. In addition, click
the [Recommend] button to change to the recommended value of the system data (effective
only when recommended values exist).

• For details of the “Basic Programming”, refer to the “Programming Manual”.
• For details of each command, refer to the “Command Manual”.

STEP5: Click the [Apply] button.
The system data assigned are written to the SV9300.

NOTE: Be sure to click the [Apply] button when the setting of system data is changed. The set contents 
will not be reflected unless clicked the [Apply] button.

[CM05: BLADE
 DATA] Menu
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STEP6: Click the  button.
The [CM10: TDM TERMINAL/TRUNK REGISTRATION] screen is displayed.

STEP7: Also repeat the operations from STEP3 to STEP6 for the [CM10: TDM TERMINAL/TRUNK 
REGISTRATION] menu to the [CME5: STATION, TRUNK LINE MAKE BUSY] menu.

Tips: Changing System Data
When changing the setting of system data, display the setting screen of the command necessary
to change by the   buttons, then assign the system data again (STEP3-STEP5).

STEP8: Select the Unit No. and the Slot No. to be reset on the [CME0: BLADE RESET] screen, then 
click the [Reset] button.

The blade reset is executed.

The Basic Programming has now been set.

[Reset] button

SLOT No. field
UNIT No. field
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PS Data Programming

In the PS Data Programming, assign the following system data according to the screen.

The setting procedures are as follows.

STEP1: Click  of the [PS DATA PROGRAMMING] menu from submenu of the [WCS FEATURES 
(COMMAND MODE)] category to expand the tree.

NOTE: Items marked by  /  will not invoke a setup screen when they are clicked.

STEP2: Click the [CM10: WIRELESS TERMINAL REGISTRATION] menu from the expanded tree 
view.
The [CM10: WIRELESS TERMINAL REGISTRATION] screen is displayed.

Menu Name Setting Commands

PS Data Programming • CM10: Wireless Terminal Registration
• CM1D: PS-ID Assignment/PS Operation Data Download
• CM12: Station Class-1
• CM15: Service Restriction Class A
• CM41: System Timer Data

[CM10: WIRELESS
 TERMINAL

 REGISTRATION]
 Menu
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STEP3: Click the [Read] button.
The system data currently assigned to the SV9300 is displayed on the screen.

NOTE: The [Read] button is effective only when system data to be read exists.

STEP4: Set the necessary items.

Tips: System Data Settings
• When assigning system data, assign the system data with supplemental remarks and recom-

mended values displayed on the setting screen of each command as a guide. In addition, click
the [Recommend] button to change to the recommended value of the system data (effective
only when recommended values exist).

• For details of the “PS Data Programming”, refer to the “Programming Manual”.
• For details of each command, refer to the “Command Manual”.

STEP5: Click the [Apply] button.
The assigned system data is written to the SV9300.

NOTE: Be sure to click the [Apply] button when the setting of system data is changed. The set contents 
will not be reflected unless clicked the [Apply] button.

STEP6: Click the  button.
The [CM1D: PS-ID ASSIGNMENT/PS OPERATION DATA DOWNLOAD] screen is dis-
played.

STEP7: Also repeat the operations from STEP3 to STEP6 for the [CM1D: PS-ID ASSIGNMENT/PS 
OPERATION DATA DOWNLOAD] menu to the [CM41: SYSTEM TIMER DATA] menu.

Tips: Changing System Data
When changing the setting of system data, display the setting screen of the command necessary
to change by the   buttons, then assign the system data again (STEP3-STEP5).

The PS Data Programming has now been set.
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System Data Mode

System Data Mode is suitable for configuring system data while
confirming commands. This chapter explains how to switch to and
use System Data Mode.

• Switching to System Data Mode
• Using System Data Mode
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Switching to System Data Mode

You can switch the submenu view to System Data Mode in one of the following operations:
• Click mode selector tab [  System Data] tab.
• On the Main Menu, click [Edit] > [System Data] in this order.

[Edit] > [System Data]
 on the main menu

[     System Data] tab of
 Mode selector tab
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Using System Data Mode

Configuring System Data

Follow instructions below to configure system data in System Data Mode.

STEP1: Click submenu  in System Data Mode to expand the tree and then click the appropriate com-
mand.
The system data registered in SV9300 is loaded, then an appropriate screen is displayed.

NOTE: Items marked by  /  will not invoke a setup screen when they are clicked.

STEP2: Click the [Read] button.
Enter a number used as a key, such as CM12 or 18, then click the [Read] button.

Tips 1: Creating a Script File
When clicking the [Read] button and loading the system data on the [System Data] screen, the
read data is automatically stored in the following folder as the script file. This script files can
be re-used by “Script” ( Page 4-90 ).
<install folder>\pbxfiles\systemdata\<Name of Connection Accounts>

Tips 2: Operations When Setting without Reading System Data
Even if the system data is assigned without a reading operation by the [Read] button, you can
register the editing data without making them ineffective by the following operations.
1. Click the [Apply] button after editing system data.
2. Click the [Yes] button when the dialog box for the confirmation is displayed.
3. When the differences between edited data and read data is displayed by blue color, confirm

the changed contents, then click the [Apply] button again.
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STEP3: Set system data as needed.

No. Item Description

(1) [Read] button Click to read system data registered in the SV9300. This button is used to 
restore system data to the original settings.

(2) [Apply] button Click to write the set system data to the SV9300.

(3) Data Entry field Enter data to be set. 

(4) Data selection 
pulldown menu

Click  to select data to be set.

(5) Data selection radio 
buttons

Check the data to be set.

(6) Button Click to run the functions of the SV9300.

(7) Tab The maximum number of the tab can be changed in the “Options”. For 
more details, refer “Environmental Setup”. Page 9-39

System
Data Mode

submenu

(7)

(5)

(4)
(3)

(2)

(1)

(6)
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Tips: Copying System Data for Each Index
By doing the following operations, you can copy the system data settings which is included a
index* in the screen to the another index of the same system data.
* A index means the fields to initially assign the data in the Station No. and the Trunk No. fields

such as in CM12 and CM30.
Example: The setting procedures when copying the data assigned to the Station No. 1111 in
CM12 to the Station No. 2222. are as follows.
1. Enter the Station No. 1111 in the Station No. field, then click the [Read] button.

The data assigned to the Station No. 1111 is read.

2. Enter the Station No. 2222 in the Station No. field, then click the [Apply] button.
3. After the confirmation dialog box is displayed, click the [Yes] button.

The data to be changed for the Station No. 2222 is displayed by the blue color.
4. Confirm the contents to be changed, then click the [Apply] button again.

The setting data is applied to the SV9300.

NOTE: The input data in a Data Entry field is displayed as right-aligned. Scroll the screen when enter-
ing the data or confirming the data assigned to the Data Entry field in which the data is not 
displayed on the right edge.

STEP4: Click [Apply] button.

NOTE: Be sure to click the [Apply] button after changes have been made to system data. The changes 
would not be reflected on the SV9300 without clicking the [Apply] button.

System data has now been set.

Station No. field
(Index)
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Searching for System Data Pertaining to Function Settings

You can search for a function name and set system data. Do as instructed below.

STEP1: Enter part of the function name in the Search Character Entry field in a submenu display.
• Character length : Up to 256 characters
• Alphabetical character: Upper case and lower case are searched as same characters.

STEP2: Click the [Start] button. 
A list of search results is displayed in the View Search Results field.

STEP3: Click an item to be set in the View Search Results field.
A screen for configuring the selected command is displayed.
* If a line of View Search Field is clicked, an appropriate part in the work window is displayed

in boxed text with blue color as the following screen.

System data pertaining to a function setting has now been located.
For the subsequence course of operation, refer to STEP2 and STEP3, “Configuring System Data”.

Page 6-3

“Within command parameters”
 check box

[Start] button

Search Character Entry field

View Search Results field

Search Status Display field
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Special System Data Entered in the System Data Mode

This section describes the description of special system data (CM05, 10, 20, 23, 49, 90, 97, 9A) entered in
the System Data Mode.

CM05

Y 1ST DATA 2ND DATA

No. MEANING DATA MEANING DATA MEANING

0 Blade Type XX ZZ XX : Unit No. (01-50)
ZZ : Slot No. (01-18)

10 Digital Line Circuit Blade for 
Multiline Terminal/
DSS Console/DESKCON 
(GCD-8DLCA/GCD-8DLCA-
A/GCD-16DLCA/
GCD-16DLCA-A)

20 Analog Line Circuit Blade for 
Single Line Telephone 
(GCD-4LCF/GCD-8LCF)

21 LLC (OPX) Blade 
(GCD-4DIOPA)

30 C.O. Trunk Blade 
(GCD-4COTA/GCD-4COTB/
GCD-4COTB-A/GCD-4COTC/
GCD-4COTC-A)

31 OD Trunk Blade (GCD-
4ODTA)

32 Direct Inward Dialing Trunk 
Blade (GCD-4DIOPA)

33 LD Trunk Blade (GCD-
4DIOPA)

40 Basic Rate (2B + D) Interface 
Trunk Blade (GCD-2BRIA)

41 ISDN Primary Rate (23B + D/
30B + D) Interface Blade 
(GCD-PRTA)

42 CCIS (1.5 Mbps/2 Mbps)
Trunk Blade (GCD-CCTA)

43 T1 (1.5 Mbps) Digital Trunk 
Interface Blade (GCD-PRTA)

45 QSIG (GCD-PRTA)

Continued on next page
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: Default

Y 1ST DATA 2ND DATA

No. MEANING DATA MEANING DATA MEANING

0 Blade Type XX ZZ XX : Unit No. (01-50)
ZZ : Slot No. (01-18)

47 E1 (2 Mbps)
Digital Trunk Interface Blade 
(GCD-PRTA)

60 ISDN Line Circuit Blade 
(GCD-2BRIA)

70 In-Skin UMS Blade 
(GCD-VM00)

71 Conference Blade (GCD-
PVAA)

73 Conference Blade (GCD-RGA)
[9300V3]

NONE No data

1 Trunk Blade number 000

127
NONE

Trunk Blade number 000

Trunk Blade number 127
No data

2 Number of Highway 
channel for ISDN Data 
Communication

XX : Unit No. (01-50)
ZZ : Line/Trunk chassis 

No. (01-03)
01: Slot 01-06
02: Slot 07-12
03: Slot 13-18

01

16
NONE

Number of Highway channel for 
ISDN Data Communication

No data

~ ~

~
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CM10

Y 1ST DATA 2ND DATA

No. MEANING DATA MEANING DATA MEANING

00 TDM terminal/Trunk 
registration

XXYYZZ Physical Port number
XX: Unit number (01-50)
YY: Slot number (01-18)
ZZ: Circuit number 

(01-32)

X-
XXXX
XXXX

Single Line station number (1-8 
digits) 
X: 0-9, A (*), B (#)

D000

D511

Trunk number (C.O./Tie Line, 
Paging, Radio Paging) 

E000

E007

DESKCON number (0-7)

E100

E131

DSS Console number (00-31)

EC00

EC31

Add-on Module number

EE3 XXX Blade number of ZT Interface 
“XXX” represents ZT number 
(000-255).

EFX

EF
XXXX
XXXX

ISDN line station number
X-XXXXXXXX represents 
ISDN line station number.
X: 0-9, A (*), B (#)

FX

F
XXXX
XXXX

Multiline Terminal station num-
ber X-XXXXXXXX represents 
My Line number.
X: 0-9, A (*), B (#)

NONE No data

Continued on next page

~
~

~
~

~
~
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: Default

Y 1ST DATA 2ND DATA

No. MEANING DATA MEANING DATA MEANING

01 IP terminal registration 0000

1535

Virtual Port number 
(for IP terminal)

FX

F
XXXX
XXXX

IP Station number
X: 0-9, A (*), B (#)

E100

E131

DSS Console number (00-31)

EC00

EC31

Add-on Module number

EEC000

EEC127

SIP Converter number

NONE No data

02 IPT (P2P CCIS) registra-
tion

000

511

Virtual Port number 
(for IPT [P2P CCIS])

D000

D511

Trunk No.

NONE No data

03 SIP trunk registration XXYYY Virtual Port number 
(for SIP trunk)
XX : 01-50 (Unit No.)
XXX: 000-127 (Port No. 

for voice channel)

D000

D511

Trunk No.

NONE No data

04 Standard SIP station regis-
tration

XXX

XXXX

Virtual Port number
XXX-XXXX
: 000-1023

X

XXXX
XXXX

Standard SIP station No.
X: 0-9, A (*), B (#)

NONE No data

~ ~
~

~
~

~ ~
~

~ ~
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CM20

: Default

Y
ACCESS CODE

SETTING DATA

No. MEANING DATA MEANING

0
1
2
3

Numbering Plan Group 0
Numbering Plan Group 1
Numbering Plan Group 2
Numbering Plan Group 3

X

XXXX

X: 0-9, A (*), 
B (#)

A004-A097 Page 6-12

800-828

A100-A199

A230-A277

A400-A649
[9300V8]

100-515

NONE No data

4 Single Digit Feature 
Access Code for BT 
connection

X X: 0-9, A (*), 
B (#)

2
3
4
5
6
7
8
9

NONE

Call Back/Trunk Queuing-Outgoing
Executive Override
Camp On
Call Waiting
Message Reminder Set
Step Call
Message Waiting Record
Voice Mail Transfer
Single Digit Feature Access Code is not avail-
able

5 Single Digit Feature 
Access Code for RBT 
connection

X X: 0-9, A (*), 
B (#)

1

2
6
8
9

NONE

Internal Tone/Voice Signaling (Voice Call-
Multiline Terminal/Attendant)
Call Back/Trunk Queuing-Outgoing
Message Reminder Set
Message Waiting Record
Voice Mail Transfer
Single Digit Feature Access Code is not avail-
able

Continued on next page

~
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SETTING DATA
REMARKS

DATA MEANING

A004 Outgoing Trunk Queueing/Call Back/Call Completion to 
Busy Subscriber (CCBS) Set
[For EMEA]

When Outgoing Trunk Queueing, Call Back 
and Completion of Calls to Busy Subscriber 
(CCBS) share the same access code.

A005 Outgoing Trunk Queueing/Call Back/Call Completion to 
Busy Subscriber (CCBS) Cancel
[For EMEA]

A006 Executive Right of Way (Executive Override)

A007 Camp-On by Station (Transfer method)

A008 Call Park-System Set For Single Line Station/Multiline Terminal/
Attendant Console

A009 Call Park-System Retrieve

A010 Call Forwarding-All Calls Set

A011 Call Forwarding-All Calls Cancel

A012 Call Forwarding-No Answer/Busy Line Set CM20 Y=0-3: A012, A013 are used when Call 
Forwarding-No Answer and Busy Line share 
the same access code.A013 Call Forwarding-No Answer/Busy Line Cancel

A014 Call Forwarding-Busy Line Set

A015 Call Forwarding-Busy Line Cancel

A016 Call Forwarding-No Answer Set

A017 Call Forwarding-No Answer Cancel

A018 Call Forwarding-I’m here (Destination) Set

A019 Call Forwarding-I’m here (Destination) Cancel

A020 Call Pickup-Group

A021 Call Pickup-Direct

A022 Do Not Disturb Set From station

A023 Do Not Disturb/Return Message Schedule Cancel

A024 Wake Up Call/Timed Reminder Set

A025 Wake Up Call/Timed Reminder Cancel

A026 Wake Up Call/Timed Reminder Check

A027 Wake Up Call Set from Predetermined Station (Single Wake 
Up time operation)

A028 Wake Up Call Set from Predetermined Station (Multiple 
Wake Up time operation)

Continued on next page
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A029 Maid Status

A033 Monitor

A034 Intra-office termination on Tandem connection

A035 Intra-office termination on Tandem connection DT Sending (Mark out System)

A037 Call Pickup-Designated Group

A040 MW Lamp Control Set

A041 MW Lamp Control Reset

A043 Day Night Mode Change by Station Dialing

A044 ACD/UCD Station Busy Out Set

A045 ACD/UCD Station Busy Out Reset

A046 Call Hold

A047 TAS Answer A

A048 TAS Answer B

A049 TAS Answer C

A050 TAS Answer D

A051 TAS Answer E

A058 Trunk Hold

A059 Trunk Answer

A062 Call Park-Tenant Set/Retrieve For single line station/Multiline Terminal

A064 Station Speed Dialing Origination

A065 Station Speed Dialing Entry

A066 Station Speed Dialing Cancel

A067 System Speed Dialing Origination For 2-4 digits origination
Maximum of 26 digits

A069 Last Number Redial

A070 Paging Answer Zone 0

A071 Paging Answer Zone 1

A072 Paging Answer Zone 2

A073 Paging Answer Zone 3

A074 Paging Answer Zone 4

SETTING DATA
REMARKS

DATA MEANING

Continued on next page
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A075 Paging Answer Zone 5

A076 Paging Answer Zone 6

A077 Paging Answer Zone 7

A078 Paging Answer Zone 8

A079 Paging Answer Zone 9

A080 Speaker/Radio Paging Cancel (Delay Operation)

A081 Individual Trunk Access

A084 OAI Terminal Mode Set Facility (MSF)

A085 Account Code

A086 Authorization Code

A087 Forced Account Code

A088 Priority Call 0 These calls are routed to the operator.

A089 Priority Call 1

A090 Special Operator Call 0

A091 Special Operator Call 1

A092 Special Operator Call 2

A093 Special Operator Call 3

A094 Emergency Call

A095 Individual Attendant Access/Inter Position Transfer

A097 Direct Data Entry

800 Operator Call

SETTING DATA
REMARKS

DATA MEANING

Continued on next page
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801 1 digit Station Maximum of 6 digits station number should be 
assigned when providing PMS.

802 2 digits Station

803 3 digits Station

804 4 digits Station

805 5 digits Station

806 6 digits Station

807 7 digits Station

808 8 digits Station

823 2-3 digits Station

824 2-4 digits Station

825 2-5 digits Station

826 2-6 digits Station

827 2-7 digits Station

828 2-8 digits Station

A100 Voice Response System Access Record

A101 Voice Response System Access Replay

A102 Voice Response System Access Delete

A103 Announcement Service Record

A104 Announcement Service Group 0 Replay

A105 Announcement Service Group 1 Replay

A106 Announcement Service Group 2 Replay

A107 Announcement Service Group 3 Replay

A108 Announcement Service Group 4 Replay

A109 Announcement Service Delete

A110 Name Display For Multiline Terminal, Attendant Console

A113 Voice Message Waiting Service-System
(Setting of station numbers to be sent)

A114 Voice Message Waiting Service-Individual
(Setting of station numbers to be sent)

A115 Voice Message Waiting Service-System Record

A116 Voice Message Waiting Service-System Replay

SETTING DATA
REMARKS

DATA MEANING

Continued on next page
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A118 Voice Message Waiting Service-System Delete

A119 Voice Message Waiting Service-System/Individual 
(Reset of station numbers to be sent)

A120 Voice Message Waiting Service-System/Individual Retrieve

A125 Call Waiting (Camp-On by station-Call Waiting Method)

A126 LCR Group 0

A127 LCR Group 1

A128 LCR Group 2

A129 LCR Group 3 Assign A129 only when the LCR Group access 
code is included in the area code table in 
CM8A (Closed Numbering).

A130 Internal Zone Paging Group 0 Paging Access

A131 Internal Zone Paging Group 1

A132 Internal Zone Paging Group 2

A133 Internal Zone Paging Group 3

A134 Internal Zone Paging Group 4

A135 Internal Zone Paging Group 5

A136 Internal Zone Paging Group 6

A137 Internal Zone Paging Group 7

A138 Internal Zone Paging Group 0 Meet-me Answer

A139 Internal Zone Paging Group 1

A140 Internal Zone Paging Group 2

A141 Internal Zone Paging Group 3

A142 Internal Zone Paging Group 4

A143 Internal Zone Paging Group 5

A144 Internal Zone Paging Group 6

A145 Internal Zone Paging Group 7

A146 Message Waiting/Message Reminder Search

A147 Message Waiting/Message Reminder Retrieve

A148 Message Reminder Set

A149 Message Reminder Cancel

SETTING DATA
REMARKS

DATA MEANING

Continued on next page
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A154 Return Message Schedule Set Cancel Code: Set data A023.

A155 Day/Night Mode change, Attendant Lockout from DESK-
CON

For DESKCON without MODE key

A156 Attendant Programming for Remote Access to System 
(DISA), System Speed Dialing, Date/Time Change and Tone 
Ringer Change from DESKCON

For DESKCON without PROG key

A157 FLF Authorization Code Recognition

A158 Sending of Hooking Signal to C.O. line/Centrex from PB 
telephone

A163 Voice Call/Ring Tone Programming For Multiline Terminal

A164 All Zone Internal Paging For calling

A165 Voice Message Waiting Service-Individual All Clear when 
the called station does not answer

A170 Malicious Call Trace
[Australia Only]

A180 Split Call Forwarding-All Calls Set

A181 Split Call Forwarding-All Calls Cancel

A182 Split Call Forwarding-Busy Line/-No Answer Set

A183 Split Call Forwarding-Busy Line/-No Answer Cancel

A188 Whisper Page

A189 Call Forwarding-Not Available Set

A190 Call Forwarding-Not Available Cancel

A191 Call Forwarding-Not Available Replay

A192 Number Sharing Set from sub station

A193 Number Sharing Cancel from sub station

A194 Number Sharing Set from main station

A195 Number Sharing Cancel from main station

A196 Set Relocation

A197 System Clock Setup by Station Dialing

A198 Call Park-System Set which retrieved by dialing station num-
ber

A199 Call Park-System Retrieve by dialing station number

A230 Station Class change with Station Authorization Code

SETTING DATA
REMARKS

DATA MEANING

Continued on next page
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A231 Station Authorization Code/Password Change

A232 Pad Lock Set by Station Authorization Code

A233 Pad Lock Reset by Station Authorization Code

A234 Call Pickup-Group (Pilot)

A239 IP Station Logout

A241 Call Forwarding-Logout/Call Forwarding-PS Out of Cell 
(Zone)/Call Forwarding-Standard SIP station Off Hook/
Power Off/Cable Pulled Out Set

A242 Call Forwarding-Logout/Call Forwarding-PS Out of Cell 
(Zone)/Call Forwarding-Standard SIP station Off Hook/
Power Off/Cable Pulled Out Cancel

A243 System Speed Dialing origination (1-8 digits abbreviated 
Code: depends on CM42>77)

A256 Mobility Access Mode Set
(Trunk Access Code 1)

A257 Mobility Access Mode Cancel

A258 PS Location Search For PS Location Display (Multiline Terminal 
LCD)

A259 Reverse Contrast on LCD For available terminals, refer to CM13 Y=66.

A260 Do Not Disturb-Override/Call Forwarding-All Calls Override

A261 Dual Ringing Set

A262 Dual Ringing Cancel

A263 Peer-to-Peer Connection for Station-to-Station Call with 
Standard SIP station Set

When the call is originated only with a station 
number (without Access Code), the RTP route 
set by CM15 Y=229 is applied.

A264 Peer-to-Peer Connection for Station-to-Station Call with 
Standard SIP station Cancel

A267 Mobility Access Mode Set
(Trunk Access Code 2)

A268 Mobility Access Mode Set
(Trunk Access Code 3)

A269 Mobility Access Mode Set
(Trunk Access Code 4)

SETTING DATA
REMARKS

DATA MEANING

Continued on next page
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SETTING DATA
REMARKS

DATA MEANING

A272 Power ON/OFF by Multiline Terminal Power Saving
(for own tenant)

A273 Power ON/OFF by Multiline Terminal Power Saving
(for tenant specification)

A274 Wake Up Call Set with Snooze
[9300V3]

A275 Malicious Call Set by Malicious Call number specification
[9300V3]

A276 Malicious Call Delete by Malicious Call number specifica-
tion
[9300V3]

A277 Copy key data of Multiline Terminal
[9300V4]

A400

A649

Group Messaging by Access Code Dialing Pattern 000

Group Messaging by Access Code Dialing Pattern 249
[9300V8]

Set the Pattern No. of message that is delivered 
by Group Messaging by Access Code Dialing.
Broadcast destination is to be assigned by 
CM57 Y=38.

100

163

Trunk Route 00

Trunk Route 63

Data is to be assigned for Trunk Routes corre-
sponding to the access codes for outgoing trunk 
calls (COT, LDT, ODT, etc.).

200

231

Route Advance Block 00

Route Advance Block 31

Data is to be assigned in the following two 
cases; there are two or more trunk routes for 
outgoing call, and for determining the seizing 
order of the trunk route.

300

323

Tenant Block 00

Tenant Block 23

Data is to be assigned when the purpose and 
method of the same access code varies with 
each tenant.

500

515

Kind of Special Terminal Block 00

Kind of Special Terminal Block 15

Data is to be assigned when the purpose and 
method of the same access code varies with 
each special terminal (single line station).

~ ~ ~

~ ~ ~

~ ~ ~

~ ~ ~

~ ~ ~
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CM23
: Default

CM49

Y
TENANT

SETTING DATA

No. MEANING DATA MEANING

00

23

Tenant Block 00

Tenant Block 23

00

63

Tenant 00

Tenant 63

A004

A097
800

828
A100

A199

Services (Refer to CM20
Page 6-11)

100

163

Trunk Route 00

Trunk Route 63

200

231

Route Advance Block 00

Route Advance Block 31

NONE No data

Y
VRS No./TENANT No.

SETTING DATA

No. MEANING DATA MEANING

00 Function of Voice 
Response System

XXX: VRS number (000-015) 01 XX 1st Answering Message of Automated 
Attendant
XX: Message No. (00-63)

02 XX 2nd Answering Message/Night 
Message of Automated Attendant
XX: Message No. (00-63)

03000 Night Announcement Service

04 X Z X: Announcement Service Group (0-4)
Z: Announcement Service Message 

No. (0-9)

05 XX Message on Hold Service Transfer 
Trunk Line
XX: Message No. (00-63)

06 XX Transferred Trunk Line
Message Service (No Answer)
XX: Message No. (00-63)

Continued on next page
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Y
VRS No./TENANT No.

SETTING DATA

No. MEANING DATA MEANING

00 Function of Voice 
Response System

XXX: VRS number (000-015) 07 XX Transferred Trunk Line
Message Service (Busy)
XX: Message No. (00-63)

08 XX Voice Message Waiting Service
XX: Message No. (00-09)

09 Voice Message Waiting 
Service-Individual

0A00 Call Forwarding Intercept Announce-
ment

0B0 XX First Announcement of ACD/UCD 
Delay Announcement (for incoming 
trunk call)
XX: ACD/UCD Group No. (00-99)

0B1 XX First Announcement of ACD/UCD 
Delay Announcement (for Station call)
XX: ACD/UCD Group No. (00-99)

0C XX Answering Message on Automatic 
Wake Up/Timed Reminder
XX: Message No. (00-63)

0D00 Announcement Service when the called 
station does not answer DID/Tie Line 
call

0E00 Announcement Service when DID/Tie 
Line call terminates to busy station

0F XX Attendant Delay Announcement
XX: Message No. (00-63)

10 Announcement Service for OAI

11 XX Second Announcement of ACD/UCD 
delay announcement (for incoming 
trunk call)
XX: ACD/UCD Group No. (00-99)

12 XX ACD/UCD Overflow Announcement
XX: ACD/UCD Group No. (00-99)

13 XX Announcement-PS/Standard SIP 
station No Answer
XX: Message Group No. (00-63)

Continued on next page
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: Default

Y
VRS No./TENANT No.

SETTING DATA

No. MEANING DATA MEANING

00 Function of Voice 
Response System

XXX: VRS number (000-015) 15 XX Announcement-PS Out of Cell (Zone)/
Power Off/-Standard SIP station Off 
Hook/Power Off/Cable Pulled Out
XX: Message Group No. (00-63)

16 XX Multi-connection Announcement 
Service for OAI
XX: Message Group No. (02-63)

17 XX Voice Guide
XX: Message No. (00-63)

1800 Announcement Service for Queue 
Limit for TAS/Overflow for TAS 
Queue

1900 Restriction Announcement for Wake 
Up call

21 XX Announcement Service for Call 
Forwarding-Logout (IP Station)
XX: Message Group No. (00-63)

2200 Announcement Service for the rejected 
calling number information

2300 Restriction announcement for an 
incoming call with calling party num-
ber

24 XX VRS Waiting Message (1st/2nd)
XX: VRS Waiting Message No. (00-

63)

2500 Guide announcement when setting 
Wake Up Call/Timed Reminder
[9300V3]

2600 Answering announcement for Wake Up 
Call with Snooze
[9300V3]

NONE No data

Continued on next page
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: Default

Y
VRS No./TENANT No.

SETTING DATA

No. MEANING DATA MEANING

01 Message No. of 1st 
Answering Message of 
Automated Attendant

00-63: Tenant No 00-63
NONE

Message No. assigned by CM49 Y=00
No data

02 Message No. of 2nd 
Answering Message/Night 
Message of Automated 
Attendant

05 Message No. of Hold 
Service

06 Message No. of 
Transferred Trunk Line 
(No Answer)

07 Message No. of 
Transferred Trunk Line 
(Busy)

08 Message No. of Automatic 
Wake Up/Timed Reminder

0A Message No. of Attendant 
Delay Announcement

10 Message Group No. of PS/
Standard SIP station No 
Answer

12 Message Group No. of PS/
Out of Cell (Zone)/Power 
Off/Standard SIP station 
Call Forwarding-Not 
Available

13 Message No. of Voice 
Guide

00: When Message Reminder is 
set

01: When service is set
02: When service is canceled
03: When Call Forwarding-All 

Calls/Do Not Disturb is set

00-63

NONE

Message No. assigned by CM49 Y=00 
(Not available for IP Station)
No data

14 Message Group of Call 
Forwarding- Logout (IP 
Station) Announcement 
service

00-63: Tenant No. 00-63
NONE

Message No. assigned by CM49 Y=00
No data

Tenant No. of transferring
station should be set.
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CM90

Multiline Terminal

Y SETTING DATA

No. MEANING DATA MEANING

00 Setting of Functions X

XXXXXXXX

Station number
• My Line number (FX-FXXXXXXXX)
• Multiline number (Ordinary Station)
• Multiline number (assigned by CM11)
X: 0-9, A (*), B (#)

A000

A031
A100

A131

Automatic Intercom number

A200

A700
A201

A701

A224

A724

Manual Intercom number

B000

B900
B001

B901

B024

B924

Dial Intercom number

Continued on next page
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Y SETTING DATA

No. MEANING DATA MEANING

00 Setting of Functions AA01

AA05
AA11

AA15

AA71

AA75

Loop Line number for Multiline Terminal Attendant 
Position

AAX Z
X: Multiline Terminal Attendant Position No. (0-7)
Z : Loop Line No. (1-5)

AB00

AB99

ICI/OPR Line number for Multiline Terminal Atten-
dant Position number

D000

D511

Trunk number

F0XXX Service access code
XXX
004: OG Queuing/Call Back (OQ/CB)/Call Comple-

tion to Busy Subscriber (CCBS) Set/Cancel
[For EMEA]

006: Executive Right of Way (EROW)
(Executive Override)

010: Call Forwarding-All Calls Set/Cancel (FDA)

012: Call Forwarding-No Answer/Busy Line Set/
Cancel (FDB/N)

016: Call Forwarding-No Answer Set/Cancel (FDN)

018: Call Forwarding-Destination Set (FDDS)
019: Call Forwarding-Destination Cancel (FDDC)

020: Call Pickup-Group (PICK)

021: Call Pickup-Direct (DPICK)

022: Do Not Disturb Set/Reset (DND)

024: Automatic Wake Up (WU)/Timed Reminder

026: Automatic Wake Up (WU)/Timed Reminder 
check

027: Wake Up Call set from predetermined station 
(Single Wake Up time operation) (SWU)

Continued on next page
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: Default

Y SETTING DATA

No. MEANING DATA MEANING

00 Setting of Functions F0XXX Service access code
XXX
028: Wake Up Call set from predetermined station 

(Multiple Wake Up time operation) (MWU)

029: Maid Status

033: Monitoring

040: Message Waiting Lamp Set (MWS)
041: Message Waiting Lamp Reset (MWR)

044: ACD/UCD Busy out (UCDB)

046: Call Hold (CHLD)

047: TAS Answer A (TASA)
048: TAS Answer B (TASB)
049: TAS Answer C (TASC)
050: TAS Answer D (TASD)
051: TAS Answer E (TASE)

058:  (HOLD) for Trunk Line Appearance

059: Trunk Answer

067: System Speed Dialing (2-4 digits)

069: Last Number Redial (LAST)

085: Account Code (ACC)

097: Direct Data Entry

100: Trunk Route 00

163: Trunk Route 63

200: Route Advance 00

231: Route Advance 31

300: Operator Call (OPR)

A25: Call Waiting (CW)

A26: LCR Group 0
A27: LCR Group 1
A28: LCR Group 2

A46: Call History screen start

Continued on next page
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: Default

Y SETTING DATA

No. MEANING DATA MEANING

00 Setting of Functions F0XXX Service access code
XXX
A70: Malicious Call Trace

[Australia Only]

A80: Split Call Forwarding-All Calls Set/Cancel
A82: Split Call Forwarding-Busy Line/No Answer 

Set/Cancel

A88: Whisper Page

A94: Number Sharing Set/Cancel

A97: System Clock Setup by Station Dialing

A98: Call Park-System Set which retrieved by dial-
ing station number

B34: Call Pickup-Group (Pilot)

B39: IP Station Logout

B43: System Speed Dialing origination (4 digits/1-8 
digits abbreviated Code)

B51: Connection between Soft Phone and PS

B54: Restriction of additional participants to confer-
ence Set/Cancel

B56: Mobility Access Mode Set/Cancel

B58: PS Location Search

B61: Dual Ringing Set/Cancel

B74: Wake Up Call with Snooze
[9300V3]

F1XXX Multiline Terminal operation
XXX
000: Stack Dial  
001: Save & Repeat (1) (S&R1)
002: Voice Call (VOICE)
004: Hooking   (TRF)

005: Message Waiting Lamp/Message Reminder 
(MW/MR)

007: DTMF Additional Dial 
(Programmable) (PBPRG)

Continued on next page
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: Default

Y SETTING DATA

No. MEANING DATA MEANING

00 Setting of Functions F1XXX Multiline Terminal operation
XXX
008: DTMF Additional Dial (Fixed Width) (PBIX)

009: Hooking Signal sent to outside (SHF)

010:   (HOLD)

011:  
012:  (CNF)
013: Save & Repeat (2) (S&R2)
014: Save & Repeat (3) (S&R3)

015:   (RECALL)

016:   (SPKR)
017:  (MIC) Use as a one-touch mute key
020: Release key (RLS)

032: OAI Function Key 0

047: OAI Function Key 15

058: QoS Display on IP Station

064: Do Not Disturb (HDND)
065: Room Cutoff (HRC)
066: Message Waiting (HMW)
067: Wake Up (HWU)
068: Check In (CK-IN)
069: Room Status (RSTS)

070: Call Record (REC)
071: Print Out (PRINT)
072: Group (GROUP)
073: Details (DETAL)
074: Set (SET)
075: Reset (RESET)
076: Cancel (CNL)
077: Release (HRLS)
079: Language (Hotel Console)
080: Do Not Disturb Override (DNDOV)/Call For-

warding-All Calls Override

085: Voice Message Waiting Service Individual Set 
when called station is no answer or busy

090: Headset/Handset Key

Continued on next page
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Y SETTING DATA

No. MEANING DATA MEANING

00 Setting of Functions F1XXX Multiline Terminal operation
XXX
091: Record (Voice Mail Live Record)
092: Pause (Voice Mail Live Record)
093: Re-record (Voice Mail Live Record)
094: End (Voice Mail Live Record)
095: Erase (Voice Mail Live Record)

098: Voice Mail Key
(Destination of CM51 Y=15)

099: Select Key of Calling Number Display or Call-
ing Name Display

F11XX 00: Station Speed Dialing 00 (SPD00)

99: Station Speed Dialing 99 (SPD99)

F12XX 01: Trunk Group 01 Busy Lamp (TGB01)

62: Trunk Group 62 Busy Lamp (TGB62)

70: Internal Zone Paging Group 0 (PG0)

77: Internal Zone Paging Group 7 (PG7)

99: All Zone Internal Paging

F13XX 00: Day/Night Mode change by Tenant 00

63: Day/Night Mode change by Tenant 63

64: Permission/Restriction of Remote Maintenance

F15XX ACD/UCD Group Number Busy Lamp
XX: ACD/UCD Group No. (00-99)

99: All Zone Internal Paging

F16XX 00: Event Occurrence Notice Button 01

63: Event Occurrence Notice Button 64

F17XX 00: Multiline Terminal Power Saving - Tenant 00

63: Multiline Terminal Power Saving - Tenant 63

F3XXZ Call Park-Tenant (CP001-CP638)
XX: Group Number (00-63)
Z : Serial Number (1-8)

Continued on next page
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: Default

Y SETTING DATA

No. MEANING DATA MEANING

00 Setting of Functions F40XX 00: TAS Answer on Tenant 00 (ANS00)
01: TAS Answer on Tenant 01 (ANS01)

63: TAS Answer on Tenant 63 (ANS63)

F41XX 00: Pooled Line Number 00-Tenant 00/
Trunk Route 00 (POL00)

63: Pooled Line Number 63-Tenant 63/
Trunk Route 63 (POL63)

F5000 Call Park-System (CPSY)

F5001 Transfer to VMS

F5010 Caller ID Display

F5011 Call Redirect for transferring to station

F5012 Call Redirect for transferring to VMS

F5013 Mute Key

F5015 Scroll Directory

F5020 Alarm Display

F5024 Live Monitoring

F5025 Emergency Notification

F5026 Record (Voice Mail Live Record-CCIS)

F5027 End (Voice Mail Live Record-CCIS)

F5028 Play (Voice Mail Live Record-CCIS)

F5030 Scroll down to change a row which displays twofold 
font on LCD (available for Multiline Terminals with 
LCD except Dterm/DtermIP)

F5031 Scroll up to change a row which displays twofold 
font on LCD (available for Multiline Terminals with 
LCD except Dterm/DtermIP)

F5033 Reverse Contrast on LCD (available for Multiline 
Terminals with non-color LCD except Dterm/
DtermIP)

F5034 Linkage with Smart device (Connection)

Continued on next page
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: Default

Y SETTING DATA

No. MEANING DATA MEANING

00 Setting of Functions F5035 Linkage with Smart device (Path)

F5036 Security

F51XX 00: One Touch Group Messaging Group 00

63: One Touch Group Messaging Group 63
[9300V5]

F6010

F6017

Call Termination from FX Line 0 (FX0)

Call Termination from FX Line 7 (FX7)

F6020

F6027

Call Termination from WATS Line 0 (WATS0)

Call Termination from WATS Line 7 (WATS7)

F6030

F6037

Call Termination from CCSA Line 0 (CCSA0)

Call Termination from CCSA Line 7 (CCSA7)

F7XXZ Relay Control Function Key
XX: Relay Group No. (00-31) assigned by CM44
Z : Circuit No. (0-3) assigned by CM44
312, 313: External Relay Interface of CPU blade

01 Multiline Terminal ringing tone 
by Day Mode/Night Mode

0
1
2
3

Day Mode: No ringing/Night Mode: Ringing
Day Mode: Ringing/Night Mode: No ringing
Day Mode: No ringing/Night Mode: No ringing
Day Mode: Ringing/Night Mode: Ringing

02 Ringing sending method when 
terminating a call to Line/Trunk 
key on Multiline Terminal

0
1

Delayed Ringing
No Delayed Ringing

03 Call Indicator Lamp control 0
1

Not available
Available (The lamp lights on call termination or 
recall.)

04 Group Feature Key 0
1

To provide
Not provided

05 Calling Number Display when 
an incoming call is terminated to 
the subline or TAS of Multiline 
Terminal
[9300V3]

0
1

Not displayed
To display

Continued on next page
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: Default

Y SETTING DATA

No. MEANING DATA MEANING

09 Copy of Multiline Terminal key 
assignment

X

XXXXXXXX
NONE

Copied Station number (Digital Multiline Terminal 
and IP Multiline Terminal Only)

No data

10 Key setting of programmable 
pattern 1

– Same as CM90 Y=00

14 Setting of Message number for 
One-Touch Group Messaging
[9300V5]

00

63
NONE

Message number for One-Touch Group Messaging

No data

90 Read the number of Line Keys 
for Multiline Terminal (Only 
display)

XX
NONE

The Number of Line Keys Logout Status/ 
Disconnected/ Non-Multiline Terminal

~
~
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SN716 DESKCON

• DESKCON Call Selection Key

Y SETTING 
DATA

FUNCTION
STANDARD 

KEY SETTING
REMARKS

No. MEANING

00 Setting of 
Functions

F6000

F6007

C.O. Incoming Call 0 (LDN0)

C.O. Incoming Call 7 (LDN7)

LDN0

F6010

F6017

Call Termination from FX Line 0 (FX0)

Call Termination from FX Line 7 (FX7)

F6020

F6027

Call Termination from WATS Line 0 
(WATS0)

Call Termination from WATS Line 7 
(WATS7)

F6030

F6037

Call Termination from CCSA Line 0 
(CCSA0)

Call Termination from CCSA Line 7 
(CCSA7)

F6040

F6047

Tie Line Incoming Call 0 (TIE0)

Tie Line Incoming Call 7 (TIE7)

TIE0

F6050

F6053

Special Operator Call 0 (SPA0)

Special Operator Call 3 (SPA3)

F6054 Priority Call 0 (PRI0)

F6055 Priority Call 1 (PRI1)

F6056 Emergency Call (EMGC)

F6060 Operator Call (ATND) ATND

F6061 Recall (RCL) RCL

F6062 Serial Call Termination (SRL)

F6063 Call Forwarding-No Answer (NANS) NANS

F6064 Call Forwarding-Busy Line (BUSY) BUSY

F6065 Call Forwarding-Intercept (ICPT)

F6066 Off-Hook Alarm (EMG)

Continued on next page
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• DESKCON Function Key

Y SETTING 
DATA

FUNCTION
STANDARD 

KEY SETTING
REMARKS

No. MEANING

00 Setting of 
Functions

F6067 Attendant Interposition Calling/Transfer 
(TF) (Transferred DESK CONSOLE 
Answer Key/lamp)

F6068 Call Forwarding-No Answer for a call 
which is transferred to another station once

Y SETTING 
DATA

FUNCTION
STANDARD 

KEY SETTING
REMARKS

No. MEANING

00 Setting of 
Functions

F6100 Room Cutoff (RC) For Hotel DESKCON
• Use the ANSWER key as the SET 

key for Hotel features.
F6101 Message Waiting (MW)

F6102 Do Not Disturb (DND)

F6103 Wake Up/Do Not Disturb Override
(WU/OV)/Call Forwarding-All Calls Over-
ride

F6104 Reset (RESET)

F6105 Serial Call Set (SC)

F6106 Flash over trunk (CAS) (SHF)

F6107 Busy Verification (BV) BV

F6108 Do Not Disturb Override (DNDOV)/Call 
Forwarding-All Calls Override

For Hotel DESKCON
• Do not assign this data to key num-

bers 1 to 4.
F6109 Wake Up (WU)

F6110 Mode (MODE) Day/Night mode 
change,
ATT Lockout

F6111 Programming (PROG)
• Remote Access to System (DISA)
• Memory Allocation for Called Party 

Numbers
• Date and Time
• Tone Ringer

F6112 Out pulse (PB signal) short (SPB)

F6113 Out pulse (PB signal) long (LPB)

Continued on next page



Chapter 6 System Data Mode

6-35 NWA-088656-001 Rev.8.0

Using System Data Mode

Y SETTING 
DATA

FUNCTION
STANDARD 

KEY SETTING
REMARKS

No. MEANING

00 Setting of 
Functions

F6120 Malicious Call Trace
[Australia Only]

F6121 Last Number Redial

F6122 Select Key of Calling Number Display or 
Calling Name Display

F6123 Transfer to VMS

F6124 Emergency Notification

F6144 Call Park-System

F6150

F6159

Paging 0

Paging 9

PAGE0

F6200 Source (SRC) SRC

F6201 Destination (DEST) DEST

F6202 Cancel (CANCEL) CANCEL

F6203 Talk (TALK) TALK

F6204 Hold (HOLD) HOLD

F6205 Start (START)

F6240

F6245

Loop 1 (LOOP 1)

Loop 6 (LOOP 6)

LOOP 1

LOOP 6

F6252 Answer (ANSWER) ANSWER

F6253 Release (RELEASE) RELEASE

F1201

F1262

Lamp indication when trunks are all busy 
in Trunk Group 01 (TGB01)

Lamp indication when trunks are all busy 
in Trunk Group 62 (TGB62)

Maximum 6 keys 
per DESKCON

F7XXZ XX Z
XX : Relay Group No. (00-31) 

assigned by CM44
Z : Circuit No. (0-3) assigned by 

CM44
312, 313: External Relay Interface of CPU 

blade

Relay 
Control Function 
Key

~ ~

~ ~ ~

~ ~
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• DESKCON Multi-Function Key No. 01-04

Y No.
DESKCON 

STATUS No. MEANING
SETTING 

DATA
FUNCTION REMARKS

00 00 Idle state F6100 Room Cutoff (RCOF)

F6102 Do Not Disturb (DND)

F6104 Reset (RESET)

F6110 Mode (MODE)

F6111 Programming (PROG)
• Remote Access to System (DISA)
• Memory Allocation for Called Party Num-

bers
• Date and Time Tone Ringer 

01 When 
answering or 
originating

F6105 Serial Call Set (SC)

F6106 Flash Over Trunk (CAS, Centrex) (SHF)

F6112 Out pulse (PB Signal) Short (SPB)

F6113 Out pulse (PB Signal) Long (LPB)

02 When the 
called station 
is busy

F6107 Busy Verification (BV) Attendant Override

F6119 Operator Monitoring (MONIT) [Australia Only]

03 When the 
called station 
is in DND

F6108 Do Not Disturb Override (DDOV)

04 When access-
ing Hotel fea-
tures

F6100 Room Cutoff (RCOF) For Hotel 
DESKCON

F6101 Message Waiting (MW)

F6102 Do Not Disturb (DND)

F6104 Reset (RESET)

F6109 Wake Up (WU)



Chapter 6 System Data Mode

6-37 NWA-088656-001 Rev.8.0

Using System Data Mode

Add-On Module

Y SETTING DATA

No. MEANING KEY No. DATA MEANING

00 Setting of Functions 30

54

X

XXXXXXXX

Station number
• My Line number (FX-FXXXXXXXX)
• Multiline number (Ordinary Station)
• Multiline number (assigned by CM11)
X: 0-9, A (*), B (#)

A000

A031
A100

A131

Automatic Intercom number

A200

A700
A201

A701

A224

A724

Manual Intercom number

B000

B900
B001

B901

B024

B924

Dial Intercom number

D000

D511

Trunk number

30

89

F11XX XX:
00-99: Station Speed Dialing 00-99

87

89

F0043 Day/Night Key

Continued on next page

~ ~
~

~
~

~
~

~
~

~
...

~
~

~
~
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: Default

CM97

Y SETTING DATA

No. MEANING KEY No. DATA MEANING

02 Ringer sending method 
when terminating a call 
to Line/Trunk key on 
Multiline Terminal

30

54

0
1

Delayed Ringing
No Delayed Ringing

10 Key setting of program-
mable pattern 1

– – Same as CM90 Y=00

DSS CONSOLE 
NUMBER

DSS KEY 
NUMBER

SETTING DATA

DATA MEANING

00

31

00

59

X

XXXXXXXX

Station number

DXXX Trunk number
(XXX: 000-511)

F13XX XX
00: Day/Night Mode Change by Tenant 00

63: Day/Night Mode Change by Tenant 63

56 F1052 Function Change key

57

59

F0043 Night key 

F1048 Room Cutoff-Set/Reset

F1049 Message Waiting-Set/Reset

F1050 Call Recording

F1051 Check-In/Out

F1053 Do Not Disturb-Set/Reset

F1054 No Answer
Indication for Wake Up Call

F1055 Function Key used for busy out display from ACD/
UCD Group

~

~ ~ ~

~ ~

~
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CM9A
: Default

Y 1ST DATA 2ND DATA

No. MEANING DATA MEANING DATA MEANING

00

03

Setting of Soft 
Key function for 
each Pattern 
Number (Pattern 
Number 0-3)

aa bb aa : Status Number (00-11)
00: Idle State
01: During dialing 

(Holding no call)
02: During dialing 

(Holding a station/trunk)
03: During calling for a station

(Holding no call)
04: During calling for a station

(Holding a station/trunk)
05: Being called
06: When called party station is 

busy 
(Holding no call)

07: When called party station is 
busy 
(Holding a station/trunk)

08: When called party sets DND
09: Trunk Busy
10: During Speaking

(Holding no call)
11: During Speaking 

(Holding a station/trunk)
bb: Soft Key Number (00-15)

00-03: Indicated on 1st display
04-07: Indicated on 2nd display
08-11: Indicated on 3rd display
12-15: Indicated on 4th display

F5002

F5003
F5014

F5015

F5029
F5038 

F5039

FXXXX

NONE

Scroll key to change the Soft key 
indication
Ringer Tone Changing
Dial By Name for System Speed 
Dialing
Dial By Name for Station Speed 
Dialing
Call History
Search for Dial By Name for Sys-
tem Speed Dialing/Station Speed 
Dialing
Malicious Call List Set key
[9300V3]
Function key (Same as F0XXX, 
F1XXX, F50XX of CM90)
No data

Continued on next page

~
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: Default

Y 1ST DATA 2ND DATA

No. MEANING DATA MEANING DATA MEANING

10

13

Setting of Soft 
Key name for 
each Pattern 
Number (Pattern 
Number 0-3)

aa bb aa : Status Number (00-11)
00: Idle State
01: During dialing 

(Holding no call)
02: During dialing 

(Holding a station/trunk)
03: During calling for a station

(Holding no call)
04: During calling for a station

(Holding a station/trunk)
05: Being called
06: When called party station is 

busy 
(Holding no call)

07: When called party station is 
busy 
(Holding a station/trunk)

08: When called party sets DND
09: Trunk Busy
10: During Speaking

(Holding no call)
11: During Speaking 

(Holding a station/trunk)
bb: Soft Key Number (00-15)

00-03: Indicated on 1st display
04-07: Indicated on 2nd display
08-11: Indicated on 3rd display
12-15: Indicated on 4th display

XX...XXX

NONE

Soft Key name indicated on LCD
(2-12 characters)
No data

Continued on next page

~
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: Default

Y 1ST DATA 2ND DATA

No. MEANING DATA MEANING DATA MEANING

18 Setting of Soft 
Key name for 
each Pattern 
Number (Pattern 
Number 0) (for 
Russian)
[Asia]

aa bb aa : Status Number (00-11)
00: Idle State
01: During dialing 

(Holding no call)
02: During dialing 

(Holding a station/trunk)
03: During calling for a station

(Holding no call)
04: During calling for a station

(Holding a station/trunk)
05: Being called
06: When called party station is 

busy 
(Holding no call)

07: When called party station is 
busy 
(Holding a station/trunk)

08: When called party sets DND
09: Trunk Busy
10: During Speaking

(Holding no call)
11: During Speaking 

(Holding a station/trunk)
bb: Soft Key Number (00-15)

00-03: Indicated on 1st display
04-07: Indicated on 2nd display
08-11: Indicated on 3rd display
12-15: Indicated on 4th display

XX...XXX

NONE

Soft Key name indicated on LCD
(2-12 characters)
No data

Continued on next page
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: Default

Y 1ST DATA 2ND DATA

No. MEANING DATA MEANING DATA MEANING

22 Setting of Soft 
Key name for 
each Pattern 
Number (for Sim-
plified Chinese) 
(Pattern Number 
0)

aa bb aa : Status Number (00-11)
00: Idle State
01: During dialing 

(Holding no call)
02: During dialing 

(Holding a station/trunk)
03: During calling for a station

(Holding no call)
04: During calling for a station

(Holding a station/trunk)
05: Being called
06: When called party station is 

busy 
(Holding no call)

07: When called party station is 
busy 
(Holding a station/trunk)

08: When called party sets DND
09: Trunk Busy
10: During Speaking

(Holding no call)
11: During Speaking 

(Holding a station/trunk)
bb: Soft Key Number (00-15)

00-03: Indicated on 1st display
04-07: Indicated on 2nd display
08-11: Indicated on 3rd display
12-15: Indicated on 4th display

XX...XXX

NONE

Soft Key name indicated on LCD 
(Maximum 3 characters)
No data

26 Setting of Soft 
Key name for 
each Pattern 
Number (for Tra-
ditional Chinese)
(Pattern Number 
0)
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Command Mode

Command Mode is suitable for quick entry on the command line.
For experts, this chapter explains how to switch to Command Mode
and how to use the command window and trace windows.
As for the details of commands used in Command Mode, refer to
the “Command Manual”.

• Switching to Command Mode
• Using Command Mode
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Switching to Command Mode 

You can switch the submenu view to Command Mode in one of the following operations:
• Click [  Command] tab of Mode selector tab.
• On the Main Menu, click [Edit] > [Command] in this order.
• Click  on the toolbar.

Command Mode icon
 in the toolbar

[Edit] > [Command]
 on the main menu

[     Command] tab of
 Mode selector tab
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Using Command Mode

In Command Mode, command and trace are available.
• Command
• Trace Information Page 7-12

Command

On the [Command] menu, commands can be entered into the command entry console to read or set system
data.
Performing either of the following procedures will display the [Command] screen in the work window:

• On the command mode submenu, click [Command].
• Click the command shortcut icon  on the toolbar. 

Continued on next page

No. Item Description

(1) Command entry 
console

Enter a command to invoke or set system data. For usage information, 
refer “Command Entry”. Page 7-4

(2) Function key labels Display functions or characters assigned to the PC’s function keys.

(3) [Advanced...] button Click to display the [Advanced] screen. For more details, “Command 
Screen Preferences”. Page 7-9

(1)

[Command]
menu

(2)
(3)
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Command Entry

Commands are entered in combination of system data (command, first data, second data) and control
codes.

<Control Code List>

There are three modes of control code entry, as follows:
• Classic Mode : Control codes entry that are assigned to [.], [Space], [/] and other keys.
• Standard Mode : Control codes entry that are assigned to a PC’s function keys.
• Enter Mode : Control codes entry that are assigned to [Enter] key.

Continued on next page

No. Item Description

(4) Entry mode/Charac-
ter mode display

Displays the present control code entry mode (Classic/Standard/Enter) 
and the ON/OFF states of the character mode.
• The ON/OFF states of the character mode have the following mean-

ings:
- Character mode OFF: Only 0 to 9 and A to F comma (,), period (.) can 

be entered (a to f are automatically converted to 
A to F). The control key is inoperable.

- Character mode ON : All data can be entered. The control code is oper-
able.

• Function key F12 is used to switch the character mode ON and OFF.

Control 
Code

Meaning

Control Keys

Classic 
Mode

Standard 
Mode

Enter Mode

[ST] Start of command entry. [/] (slash) [F9] [Esc]

[DE] • End of command entry
• End of first data entry
• Read second data that has been set 

in input first data.

[Space] [F8] [Enter]

[EXE] Set second data. [.] (period) [F2] [Enter]

[CE] Cancel entries. [:] (colon) [F3] []

[S] Read the second data that has been 
set as the next batch of first data.

[Enter] [F4] []
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Tips: Function Keys Used in Classic Mode
In Classic Mode, use function keys to enter characters that are assigned to control keys.
• [F2] ... [.] (period)
• [F3] ... [:] (colon)
• [F4] ... [-] (hyphen)
• [F5] ... [space]
• [F6] ... [/] (slash)

<List of System Data Entry Constraints>

Control 
Code

Meaning

Control Keys

Classic 
Mode

Standard 
Mode

Enter Mode

[-] Read the second data that has been 
set as the previous batch of first 
data.

[-] (hyphen) [F5] []

[SYY] Read second data with the next Y 
number.

[F9] [F6] [F9]

[-YY] Read second data with the previous 
Y number.

[F10] [F7] [F10]

[CCC] Reset second data to its default. CCC ([C]X~ 3 
times)

[F12] [Delete]

HELP Displays the Help [F1] [F1] [F1] 

CHAR Switching entry limitation of second 
data

[F12] [F10] [F12] 

CLR Deletes characters in a command 
entry console

[F11] [F11] [F11] 

System Data Entry Rules Remarks

Command • Single-byte alphanumeric characters 
(0 to 9, A to F, a to f) 

• Up to 6 characters

a through f are automatically converted to 
uppercase.

First data • Single-byte alphanumeric characters 
(0 to 9, A to F, a to f), Comma [,] 

• Up to 16 characters

a through f are automatically converted to 
uppercase.

Second data • Up to 256 characters
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<Reading System Data (Second Data)>

STEP1: Enter [ST].
• Classic Mode : [/] key
• Standard Mode : [F9] key
• Enter Mode : [Esc] key

STEP2: Enter a command and then enter [DE].
• Classic Mode : Command + [Space] key
• Standard Mode : Command + [F8] key
• Enter Mode : Command + [Enter] key

STEP3: Enter first data and then enter [DE].
• Classic Mode : First data + [Space] key
• Standard Mode : First data + [F8] key
• Enter Mode : First data + [Enter] key

Second data is displayed.

STEP4: To view the second data that has been set as the next batch of first data, enter [S].
• Classic Mode : [Enter] key
• Standard Mode : [F4] key
• Enter Mode : [] key

The second data that has been set as the next batch of first data is displayed.

STEP5: To view the second data that has been set as the previous batch of first data, enter [-].
• Classic Mode : [-] key
• Standard Mode : [F5] key
• Enter Mode : [] key

The second data that has been set as the previous of first data is displayed.

STEP6: To view second data with the next Y number, enter [SYY].
• Classic Mode : [F9] key
• Standard Mode : [F6] key
• Enter Mode : [F9] key

Second data with the next Y number is displayed.
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STEP7: To view second data with the previous Y number, enter [-YY].
• Classic Mode : [F10] key
• Standard Mode : [F7] key
• Enter Mode : [F10] key

Second data with the previous Y number is displayed.

<Writing System Data (Second Data)>

STEP1: Enter [ST].
• Classic Mode : [/] key
• Standard Mode : [F9] key
• Enter Mode : [Esc] key

STEP2: Enter a command and then enter [DE].
• Classic Mode : Command + [Space] key
• Standard Mode : Command + [F8] key
• Enter Mode : Command + [Enter] key

STEP3: Enter first data and then enter [DE].
• Classic Mode : First data + [Space] key
• Standard Mode : First data + [F8] key
• Enter Mode : First data + [Enter] key

The current second data is displayed.

STEP4: Change the second data and then enter [EXE].
• Classic Mode : Second data + [.] key
• Standard Mode : Second data + [F2] key
• Enter Mode : Second data + [Enter] key

System data (second data) has now been written to the SV9300.

NOTE 1: In Classic Mode, “CCC” cannot be entered as second data. Use Standard Mode when it is nec-
essary to enter “CCC” as second data.
* In Classic Mode, “CCC” is used to reset second data to its default.

NOTE 2: To enter a space to the second data on Standard Mode, use the [Shift] + [Space] Key.
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<Resetting System Data (Second Data) to Its Default>

STEP1: Enter [ST].
• Classic Mode : [/] key
• Standard Mode : [F9]key
• Enter Mode : [Esc] key

STEP2: Enter a command and then enter [DE].
• Classic Mode : Command + [Space] key
• Standard Mode : Command + [F8] key
• Enter Mode : Command + [Enter] key

STEP3: Enter first data and then enter [DE].
• Classic Mode : First data + [Space] key
• Standard Mode : First data + [F8] key
• Enter Mode : First data + [Enter] key

Second data is displayed.

STEP4: Enter [CCC].
• Classic Mode : “CCC” + [Enter] key
• Standard Mode : [F12] key
• Enter Mode : [Delete] key

System data (second data) has now been reset to its default.
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Command Screen Preferences

The [Command] screen operation and displays can be modified through the following [Advanced]
screen. Click the [Advanced] button in the [Command] screen to display the [Advanced] screen.

Continued on next page

No. Item Description

(1) Input Mode Choose from the following Command entry modes as a control code of 
entry mode:
• Classic/Standard/Enter (default: Standard) 

For more details, refer “<Control Code List>”. Page 7-4

(2) [ForeColor] button Click to change the color of the character in the command entry Con-
sole. The [Color] dialog box is displayed.
For more details, refer “<Color Settings>”. Page 7-10

(3) Font, size Displays the font and size of characters used for character entry into the 
command entry console.

(4) [Select Font] but-
ton

Click to change the font and character size of the command entry con-
sole. The [Font] dialog box is displayed. 
For more details, refer “<Font Settings>”. Page 7-11

(5) [BackColor] but-
ton 

Click to change the background color of the command entry console. 
The [Color] dialog box is displayed. 
For more details, refer “<Color Settings>”. Page 7-10

(1)

(2) (4)
(3)

(7)

(5)

(6)

(8) (9)
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<Color Settings>

The text color and the background color can be specified in the [Color] dialog box.
After selecting a color, click the [OK] button. For more details, browse through help on the [Color] dialog
box.

No. Item Description

(6) Sample Displays sample setting of the font, character size, text color and back-
ground color selected.

(7) [Set As Default] 
button

Click to reset the settings entered in the [Command] screen to their 
defaults.

(8) [OK] button Click to apply the changes in the [Command] screen and close [Com-
mand] screen.

(9) [Cancel] button Click the close the [Command] screen without applying the changes.

[OK] button
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<Font Settings>

The font and character size in the command entry console is specified in the [Font] dialog box. After se-
lecting a font and a character size, click the [OK] button. For more details, browse through help on the
[Font] dialog box.

[OK] button
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Trace Information

The [Trace] menu confirms trace information that is transmitted from the SV9300 randomly.
One of the following action will display a [Trace Information] screen in the work window:

• Click submenu [Trace Information] in Command Mode.
• On the Main Menu, click [System] > [Maintenance] > [Trace Information] in this order.

NOTE 1: To perform the Trace Information, setting of system data (CMF6) is required in advance.
NOTE 2: This menu is reserved for NEC technicians and need not be used in most situations.

(1)

(2)

(3) (4)

(5)

(6)
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Continued on next page

No. Item Description

(1) Option Time 
Stamp

Executes a time stamp at intervals of a specified time span.
• 10 seconds/30 seconds/1 minute/Stop (default: Stop)
* Time Stamp is not executed if “Stop” is selected.
* Selected items are checked.

Capture 
file

Select whether to write (save) the trace information file transmitted from 
the SV9300 or not.
• Start capture/Stop capture (default: Stop capture)
*1 A screen appears if “Start capture” is selected. Select the destination 

folder in which a file is created.
*2 Capture file creates a file (File Name: Trc_ + Connection Account 

name + number + .log) to the destination folder and stores the trace 
information. If the same file already exists in that folder, it is over-
written.

*3 A number of file name is added from 001 to the highest file number 
set by the Capture file in ascending order.

*4 If you have opted for “Stop capture”, trace information is not written 
to a file.

*5 Selected items are checked.
*6 If you change from “Stop capture” to “Start capture”, the first starting 

file is cleared.
*7 The size of capture file is the maximum size set by the Capture file. 

A file is written to the next file when the file size is beyond the max-
imum size.

*8 When the number of files is beyond the maximum number of files, 
the existing files are overwritten from the oldest file (Trc_ + Connec-
tion Account name + 001.log).

File 
Size...

Displays the [File Size] screen. Set the number of files and the maximum 
file size on a per file.

File 
Delete

Deletes the file (Trc_ + Connection Account name + value (1 to 10) + 
.log) that has been created by selecting [File Output].
* Click to see a message box that asks if you are sure to delete the file.
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No. Item Description

(2) Text field Displays the trace information transmitted from the SV9300.
Only the latest trace information portion of text is displayed.
*1 Select the character string to stop the trace information display tem-

porarily.
Deselect the character string to resume the display of the trace infor-
mation on the screen, including information hidden when in the 
selected state.

*2 The trace information up to 1MB can be displayed on the screen. 
Messages are displayed when excessing the limit, then the indication 
for the trace information will temporarily stop. Clear the trace infor-
mation by the [Clear] button to resume the indication.

*3 When the indication has stopped, the latest trace information up to 
1MB is saved from then (the trace information is displayed when the 
indication is resumed).

*4 When the “Start capture” is selected by the Capture file, the logs after 
reaching to the maximum value on the screen display are also output 
the file.

(3) [Time Stamp] button Click to add the date and time (YYYY/MM/DD HH:MM:SS) at which 
the button was clicked in the Text field.

(4) [Clear] button Click to clear the trace information displayed in the Text field.
* The file is not cleared.

(5) [Close] button Click to end the trace.
* Trace information is not written to a file if the [Trace Information] 

screen is closed.

(6) Status bar Displays the name of the logon account connected to the SV9300, the 
path name of the file output folder and the amount of the trace informa-
tion.
*1 For a Connection Account name, the Connection Account name con-

nected to SV9300 is displayed. A blank is displayed when not con-
nected to SV9300.

*2 For a path name of the file output folder, the path name of the file that 
outputs the trace information is displayed. A blank is displayed when 
the “Stop capture” is selected by the Capture file.

*3 For an amount of trace information, the trace information displayed 
on the Text field and the trace information saved when the indication 
is stopped are displayed.
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Report

This chapter explains how to view fault information, system con-
figuration information, the check result of the system, the results of
read system data and a log of system data updates stored on the
SV9300 from PCPro in a report format.
The [Report] menu allows you to save and view information most
recently read from the SV9300 on PCPro.
For more information about the kinds of reports that can be dis-
played, see instructions on viewing report-specific information.
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Fault Display

Displays an fault report.

NOTE: To display an fault report, the read out of fault information by the [Fault Display] screen is re-
quired beforehand. Page 4-268

STEP1: On the Main Menu, click [Tools] > [Reports] > [Fault Display] in this order.
The [Open File] screen appears.

STEP2: Select a file and click the [Open] button. 
Displays a fault information report.
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System Check and Report

Displays a system report.

NOTE: To display a system report, the reading information by the [System Check and Report] screen 
is required beforehand.  Page 4-251

STEP1: On the Main Menu, click [Tools] > [Reports] > [System Check and Report] in this order.
The [Open File] screen appears.

STEP2: Select a file and click the [Open] button.
The system report appears.
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The table below shows the displayed items on the system report.

NOTE: The items to be displayed on the system report differ depending on the reading items selected 
by the [System Check and Report] menu.  Page 4-253

<System Report Display Item List Table>

*1 This fields is displayed when using Dual CPU.

Continued on next page

Report 
Category

Item Description

System Check 
Result

– Checks whether the following various alarm 
is detected, and displays the result.
• Some duplicate IP addresses
• Some blades with older firmware version 

than CPU’s version
• VoIPDB which needs update of firmware
• Controlling chassis alarm 

System 
Summary

PCPro Version Displays the version of PCPro.

Connection Account Displays the connection account of the 
SV9300 with which PCPro has established a 
communication link.

Read Date/Time (PC) Displays the Date/Time when the system 
report is read.

MJ Alarms Displays the MJ Alarm information of the 
system.
• On/Off

Operation Status of Dual CPU*1 <Unit>
Displays the Unit of Dual CPU.
• Unit01-Unit04

<Operation Status>
Displays the operation status of Dual CPU.
• CPU0: XXX/XXXX
• CPU1: XXX/XXXX

XXX/XXXX: ACT/STBY
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Continued on next page

Report 
Category

Item Description

System 
Summary

Version Infor-
mation List for 
Each Unit

Unit No. Displays the list of the Unit numbers cur-
rently in use.
*1 The Unit numbers are displayed by blue 

color with underline.
*2 For Dual CPU system, the version infor-

mation is displayed as follows.
XX (CPU0: ZZZ/ZZZZ)/
XX (CPU1: ZZZ/ZZZZ)
XX: 01-04 (Unit No.)
ZZZ/ZZZZ: ACT/STBY

Version Information Displays the version information of the sys-
tem (all Units)

Status List for 
Each Unit

Unit No. Displays the list of registered Unit numbers. 
The indication when setting the Failover fea-
ture is as follows.
• Unit01 display when the Primary is 

assigned: 01 (Primary)
• Unit display when the Secondary is 

assigned: xx (Secondary)
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Continued on next page

Report 
Category

Item Description

System 
Summary

Status List for 
Each Unit

Status Displays the status of the registered Units.
[The status when the Failover feature is inef-
fective]

• Unit01: 
Disconnect/Operating normally

• Unit02 or later: 
Disconnect/Normal mode/Survival mode

[The status when the Failover feature is 
effective]

• Unit01: 
Disconnect/Operating normally

• Secondary Unit: 
Disconnect/Normal mode/Failover mode

• Unit02 or later (except Secondary Unit): 
Disconnect/Normal mode (Connecting to 
Primary)/Normal mode (Connecting to 
Secondary)/Survival mode

Connecting Status 
to Primary

Displays the connecting status to the Primary 
Unit.
• Connecting Status: Disconnect/Connecting
* Displays only when the Failover feature is 

effective.

Connecting Status 
to Secondary

Displays the connecting status to the Second-
ary Unit.
• Connecting Status: Disconnect/Connecting
* Displays only when the Failover feature is 

effective.

Alarm Displays the occurrence of alarms of CPU 
blade.
• Alarm: FAN alarm/AC input failure/Power 

off alarm/Battery alarm
* When there is no alarm, “No alarm” is dis-

played in this field.
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Continued on next page

Report 
Category

Item Description

System 
Summary

Status List for 
Each Unit

JACK Insertion Sta-
tus

Displays the insertion status of a mini jack 
for audio input/output on the front of CPU 
blade.
• JACK Insertion Status:

Inserted/Not inserted

VoIPDB 
Information 
List for Each 
Unit

Unit No. Displays the list of registered Unit numbers. 
* For Dual CPU system, the Unit numbers 

are displayed as follows.
XX (CPU0: ZZZ/ZZZZ)/
XX (CPU1: ZZZ/ZZZZ)
XX: 01-04 (Unit No.)
ZZZ/ZZZZ: ACT/STBY

VoIPDB Kind Displays the kind of VoIPDB.
• VoIPDB Kind: GPZ-64IPLD/GPZ-

128IPLD/PZ-64IPLC-A/
PZ-128IPLC-A

Firmware Version <Blade>
 “-” is displayed in this field.

<CPU Blade>
 “-” is displayed in this field.

<Difference>
 “-” is displayed in this field.

Operation Status Displays the operation status of VoIPDB.
• Operation Status:

Normal operation/Operation stopped

LAN Cable Con-
nection Status

Displays the LAN Cable connection status of 
VoIPDB.
• LAN Cable Connection Status:

Connected/Disconnected
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Continued on next page

Report 
Category

Item Description

Network Infor-
mation

IP Address 
Information 
List for Each 
Unit

Unit No. Displays the Unit numbers.

Port Displays the kind of port.
• When using single CPU:

Maintenance Port/VOIP Port/RTP Port
• When using Dual CPU:

Maintenance Port (CPU0/1: ACT/STBY)/
VOIP Port (CPU0/1: ACT/STBY)/
RTP Port (CPU0/1: ACT/STBY)

IP Address Displays the IP addresses.

Subnet Mask Displays the Subnet Mask
* This field becomes a blank for a RTP port 

of Subnet Mask.

Default Gateway Displays the Default Gateway.
* This field becomes a blank for a RTP port 

of Default Gateway.

VLAN Displays the setting status of the VLAN.
• VLAN: Effective
* This field becomes a blank if setting of the 

VLAN is not effective.

VLAN ID Displays the VLAN ID.

Priority of VLAN 
ID

Displays the priority of VLAN ID.
*  This field becomes a blank if the setting of 

VLAN is not effective.

Routing Infor-
mation List for 
Each Unit

Unit No. Displays the Unit No.

Destination Address Displays the destination address.

Network Mask Displays the network mask.

Gateway Address Displays the gateway address.

Status Displays the setting status to a Routing 
Table.
• Status: OK/NG
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*1 This fields is displayed when using Dual CPU.
*2 This fields is displayed when using Single CPU.

Continued on next page

Report 
Category

Item Description

License Hardware Key Code*2 Displays the Hardware Key Code.

Hardware Key Code (CPU0)*1

Hardware Key Code (CPU1)*1

License List No. Displays the license data numbers.

License Data Name Displays the license data names.

Software Key Code Displays the Software Key Codes.

Authentication 
Status

Displays the Authentication Status of the 
license.

A: Authorized Status
N: Unauthorized Status

Option Value 
List

No. Displays the kind numbers of option values.

Feature Name Displays the feature names of option values.
* As for the correspondence between the 

feature names and the related licenses, 
refer to the “Correspondence Table for 
Option Values and Related Licenses”

 Page 8-18

Used Displays the number of the using option val-
ues.

Valid Displays the number of the retaining option 
values.

Remains Displays the number of the remaining option 
values.
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Continued on next page

Report 
Category

Item Description

Unit 
Information

– Provides the screen display of the blade 
mounted in each slot of SV9300. The blade 
name in different colors for each blade type 
and the clock source status are displayed.
<Blade Name>
• Station/CS blade: Light blue
• Trunk blade : Light yellow
• Other blades : Light red
*1 If the blade name is clicked, this field 

moves to the Details of Port (Line/Trunk 
Blade) category.

*2 As for the indication when blades for 
SV8300 are mounted, refer to the “Indi-
cation When Blades for SV8300 Are 
Mounted”. Page 8-21

*3 For the disconnected Expansion Chassis, 
the background color is displayed with 
gray.

<Clock Source Status>
• Sync.(1st): 

The blade is set to the first priority blade to 
receive the synchronization signal.

• Sync.(1st) Synchronized: 
The blade is set to the first priority blade to 
receive the synchronization signal and the 
blade is synchronized.

• Sync.(2nd): 
The blade is set to the second priority blade 
to receive the synchronization signal.

• Sync.(2nd) Synchronized: 
The blade is set to the second priority blade 
to receive the synchronization signal and 
the blade is synchronized.

* The clock source supports only for BRT/
PRT/CCT/DTI blade.
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Continued on next page

Report 
Category

Item Description

Expansion 
Chassis Infor-
mation

Unit No. Displays the Unit No.

Expansion Chassis Displays the Expansion Chassis No.

Operation Status Displays the operation status of Expansion 
Chassis.
• Operation Status: Normal operation/

Disconnected

Alarm Displays the alarm of Expansion Chassis.
• Alarm: FAN alarm/AC input failure/Power 

off alarm/Battery alarm
*1 If there is no alarm, “No alarm” is dis-

played.
*2 For the Expansion Chassis accommo-

dated to the Remote Unit which is not in 
a normal mode operation status with a 
Main Unit, and the Expansion Chassis 
which is not connected to the Controlling 
Chassis, “-” is displayed.

Slot 
Information

Unit No. Displays the Unit numbers.

Slot No. Displays the Slot numbers.
*1 The Slot number for which system data is 

assigned, is displayed by blue color with 
underline.

*2  When blades for SV8300 are mounted, 
“*NV” appears next to a blade type.

*3 If the Slot number is clicked during read-
ing the port information, this field moves 
to the Details of Port (Line/Trunk Blade) 
category.
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Continued on next page

Report 
Category

Item Description

Slot 
Information

Mounted Blade Displays the kind of the mounted blade.
*1 “-” is displayed if no line/trunk blade is 

mounted.
*2 As for the blade type displayed in this 

field, refer to the “Blade Type List 
Table”. Page 8-19

Firmware 
Version

Line/Trunk Blade Displays the firmware version of the line/
trunk blade.
*1 “-” is displayed if no line/trunk blade is 

mounted.
*2 “Updating” is displayed during firmware 

update.

CPU Blade Displays the firmware version in the CPU 
program.
*1 “-” is displayed if no line/trunk blade is 

mounted.
*2 “Updating” is displayed during firmware 

update.

Difference Compares the firmware version of the line/
trunk blade and that in a CPU program, and 
displays the result.

Old : The firmware version of the 
mounted blade is older than that 
in a CPU program.

New : The firmware version of the 
mounted blade is newer than 
that in a CPU program.

OK : The firmware version of the 
mounted blade corresponds 
with that in a CPU program.

Unknown: The blade has not been 
mounted, or the firmware 
update is in progress.

* “-” is displayed if not applicable blade is 
mounted.
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Continued on next page

Report 
Category

Item Description

Slot 
Information

System Data Setup condition Compares the blade type of the mounted 
line/trunk blade and that is assigned by 
system data, then displays the result.

OK

NG

Only System
Data

-

: The blade type of the 
mounted blade corresponds 
with the blade type assigned 
by system data.

: The blade type of the 
mounted blade does not cor-
responds with the blade type 
assigned by system data.

: The line/trunk blade is 
unmounted and only system 
data is assigned.

: The line/trunk blade is 
unmounted and no system 
data is assigned.

Detail Displays the setting values of system data 
and the blade types.
* “-” is displayed if no system data is 

assigned.

Ports Blade Displays the number of ports of the blade.
* “-” is displayed if no line/trunk blade is 

mounted.

Assigned Displays the number of ports registered by 
system data.
*1 “0” is displayed when no system data is 

assigned.
*2 No data is displayed when unable to read 

the port information by the option set-
tings.
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Continued on next page

Report 
Category

Item Description

Slot 
Information

Operation Status Displays the operation status of line/trunk 
blades.
• Operation Status: Normal operation/Opera-

tion stopped
* “-” is displayed if no line/trunk blade is 

mounted.

Link Connection Displays the link connection of blades.
• Link Connection: Line 1 alarm

Line 2 alarm
Line 3 alarm
Line 4 alarm

*1 When there is no link connection, “No 
alarm” is displayed.

*2  “-” is displayed if no line/trunk blade is 
mounted and the Link Connection is for 
the blade which is not targeted.

Serial No. Displays the Serial numbers of blades.
*1 “-” is displayed if no line/trunk blade is 

mounted.
*2 This field becomes a blank if the line/

trunk blade is not targeted for the Serial 
No. Display.

Lot No. Displays the Lot numbers of blades.
The fourth digit of the Lot No. is the hard-
ware version.
*1 “-” is displayed if no line/trunk blade is 

mounted.
*2 This field becomes a blank if the line/

trunk blade is not targeted for the Lot No. 
Display.
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*3 Displays the slot that the system data is registered.

Continued on next page

Report 
Category

Item Description

Line/Trunk 
blade ports *3

Unit No. Displays the Unit numbers.

Slot No. Displays the Slot numbers.

CKT No. Displays the CKT numbers.

Port Displays the port numbers.

Data Displays the data assigned to the port.
* This field becomes a blank if no data is 

assigned.

Mounted Blade Displays the blade name of the mounted 
blade.
* When blades for SV8300 are mounted, 

“*NV” appears next to a blade type.

Terminal Type Displays the terminal type number and the 
terminal type information.
*1 This field becomes a blank when no con-

nection is established, or the result when 
reading data is NONE.

*2 As for the terminal type displayed in this 
field, refer to the “Terminal Type List 
Table”. Page 8-22

Number of buttons Displays the number of buttons on Multiline 
Terminal.
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*4 Displays only the port that the station number is registered.
*5 Displays only the port that the IP trunk is registered.
*6 Displays only the port that the SIP trunk is registered.

Continued on next page

Report 
Category

Item Description

IP terminal 
ports
(IP Station No./
DSS Console 
No./Add-on 
Module No./
SIP Converter 
No.) *4

Virtual Port Displays the virtual port numbers.

Data Displays the station numbers.

IP Address Displays the IP addresses.
* This field becomes a blank if no IP address 

information is read.

Status Displays the connection status.
N : Registered Status
A : Unregistered Status
(Blank): Unavailable to read the registered 

information

Terminal Type Displays the terminal type number and the 
terminal type information.
*1 This field becomes a blank when no con-

nection is established, or the result when 
reading data is NONE.

*2 As for the terminal type displayed in this 
field, refer to the “Terminal Type List 
Table”. Page 8-22

Number of buttons Displays the number of buttons on Multiline 
Terminal.

Peer to Peer 
CCIS trunk 
ports *5

Virtual Port Displays the virtual port numbers.

Trunk No. Displays the trunk numbers.

SIP trunk ports 
*6

Unit No. Displays the Unit numbers.

Virtual Port Displays the virtual port numbers.

Trunk No. Displays the trunk numbers.
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*4 Displays only the port that the station number is registered.
*7 Numbering Plan Information is displayed for each Numbering Plan Group. The tenant group to which

a Numbering Plan (Access Code) is not registered is not displayed.

Report 
Category

Item Description

Wireless PCS/
PHS terminal 
ports/Standard 
SIP ports *4

Virtual Port Displays the virtual port numbers.

Station No. Displays the station numbers.

IP Address Displays the IP addresses.
* This field becomes a blank if no IP address 

information is read.

Status Displays the connection status.
N : Registered Status
A : Unregistered Status
(Blank): Unavailable to read the registered 

information

Terminal type Displays the terminal type numbers and the 
terminal type information.
*1 This field becomes a blank when no con-

nection is established, or the result when 
reading data is NONE.

*2 As for the terminal type displayed in this 
field, refer to the “Terminal Type List 
Table”. Page 8-22

Numbering 
Plan

Numbering 
Plan Informa-
tion List for 
Each Number-
ing Plan 
Group*7

Access Code Displays the Access Code.

Data Displays the setting data for the Access 
Code.

Description Displays the meaning of setting data.
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The table below shows the correspondence for option values and relates licenses displayed on the system
report.

<Correspondence Table for Option Values and Related Licenses>

Option Value
Description

No. Feature Name

001 PORT Capacity Port Capacity License

010 VoIP Channels VoIP Channels (IP-PAD) License

011 IP Trunk P2P CCIS Channels License

012 IP Ports DtermIP/DT800/DT700 Series License

016 Remote Unit Number of Remote Unit License

017 SIP TRK Channels SIP Trunk Channels License

018 Soft Phone DtermSP30/SP350 License

019 Soft Phone ACD Soft Phone ACD License (DtermSP30/SP350 ACD)

023 Mobility Access Mobility Access License

024 STD SIP Phone Standard SIP Terminal License

025 Embedded 32P CNF Embedded Conference License

029 UC Connector SVL Server-less UC Connector Client License

043 UMS PORT UM8000 Mail Port License

044 UMS FAX PORT UM8000 Mail FAX Port License

045 UMS TTS PORT UM8000 Mail TTS for MS Outlook License

046 UMS CLIENT UM8000 Mail View App Session License

047 UMS LANGUAGE UM8000 Mail Multilanguage Support License

048 UMS HOSPI LANG UM8000 Mail Hospitality Language License

049 UMS TTS LANG UM8000 Mail TTS Language License

060 PVA PORT SMB8000 Multimedia Conference Ports License

061 RGA PORT RGA Conference Port license

062 RGA Enhance I RGA Conference Enhance I (Conference Call Recording) License

065 RGA Language RGA Additional Language License
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The table below shows the blade types displayed in the Slot Information category (Mounted Blade).

<Blade Type List Table>

Blade Type Blade Name 

Telephone (LC) • LC(4+4) : GCD-4LCF + GPZ-4LCF
• LC(4) : GCD-4LCF
• LC(4+8) : GCD-4LCF + GPZ-8LCF
• LC(8+4) : GCD-8LCF + GPZ-4LCF
• LC(8+8) : GCD-8LCF + GPZ-8LCF
• LC(8) : GCD-8LCF
• DIOP(LLC) : GCD-4DIOPA/GCD-4DIOPB
• LC(4+4) *NV : CD-4LCA + PZ-4LCA
• LC(4) *NV : CD-4LCA
• LC(4+8) *NV : CD-4LCA + PZ-8LCE
• LC(8+4) *NV : CD-8LCA + PZ-4LCA
• LC(8+8) *NV : CD-8LCA + PZ-8LCE
• LC(8) *NV : CD-8LCA
• DIOP(LLC) *NV: CD-4DIOPA/CD-4DIOPB
* “NV” implies a blade for SV8300.

Telephone (DLC/DESKCON) • DLCA(16) : GCD-16DLCA/GCD-16DLCA-A
• DLCA(8+8) : GCD-8DLCA + GPZ-8DLCB 
• DLCA(8) : GCD-8DLCA/GCD-8DLCA-A
• DLCA(16) *NV : CD-16DLCA
• DLCA(8+8) *NV: CD-8DLCA + PZ-8DLCB
• DLCA(8) *NV : CD-8DLCA
* “NV” implies a blade for SV8300.

Telephone (ILC) • ILC(2+2) : GCD-2BRIA + GPZ-2BRIA
• ILC(2) : GCD-2BRIA
• ILC(2+2) *NV: CD-2BRIA + PZ-2BRIA
• ILC(2) *NV : CD-2BRIA
* “NV” implies a blade for SV8300.

Continued on next page
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Blade Type Blade Name

Trunk (COT/DID/LD/OD) • COT(4+4) : GCD-4COTC + GPZ-4COTG/GPZ-4COTG-A
GCD-4COTC-A + GPZ-4COTE/GPZ-4COTG/
GPZ-4COTG-A
GCD-4COTB + GPZ-4COTF/GPZ-4COTF-A
GCD-4COTB-A + GPZ-4COTF/GPZ-4COTF-A
GCD-4COTA + GPZ-4COTE/GPZ-4COTG-A

• COT(4) : GCD-4COTC/GCD-4COTC-A/GCD-4COTB/
GCD-4COTB-A/GCD-4COTA

• ODT(4) : GCD-4ODTA
• DIOP(DID) : GCD-4DIOPA/GCD-4DIOPB
• DIOP(LD) : GCD-4DIOPA/GCD-4DIOPB
• COT(4+4) *NV : CD-4COTC + PZ-4COTG/CD-4COTB + 

PZ-4COTF/CD-4COTA + PZ-4COTE
• COT(4) *NV : CD-4COTC/CD-4COTB/CD-4COTA
• ODT(4) *NV : CD-4ODTA
• DIOP(DID) *NV: CD-4DIOPA/CD-4DIOPB
• DIOP(LD) *NV : CD-4DIOPA/CD-4DIOPB
* “NV” implies a blade for SV8300.

Trunk (BRT) • BRI(4+4) : GCD-2BRIA + GPZ-2BRIA
• BRI(4) : GCD-2BRIA
• BRI(4+4) *NV: CD-2BRIA + PZ-2BRIA
• BRI(4) *NV : CD-2BRIA
* “NV” implies a blade for SV8300.

Trunk (PRT/DTI/CCT/QSIG) • PRT : GCD-PRTA
• CCT : GCD-CCTA
• CCT(E1) : GCD-CCTA
• DTI(T1) : GCD-PRTA
• QSIG : GCD-PRTA
• DTI(E1) : GCD-PRTA
• PRT *NV : CD-PRTA
• CCT *NV : CD-CCTA
• CCT(E1) *NV: CD-CCTA
• DTI *NV : CD-PRTA
• QSIG *NV : CD-PRTA
• DTI(E1) *NV : CD-PRTA
* “NV” implies a blade for SV8300.

Continued on next page
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Tips 1: Concerning Displayed Blade Information
• When the blade names are displayed as follows, they mean that the appropriate blades are

mounted in slots and also system data is correctly assigned.
Example: COT(4), LC(8+8), DIOP(LD), PRT and others
* Numeric values such as (4) and (8+8) displayed with the blade name mean the number of

available ports of the mounted blade. For example, LC(8+8) means that the LC blade with
capacity of 16 ports is mounted.

• When the blade name is displayed in brackets or “!” mark is displayed in front of the blade
name, they mean the following states.
- When displayed in brackets : The system data for the appropriate blade has been 

assigned. However, the blade is not mounted in the Slot. 
Example: (DLC), (COT), (DIOP(LD))

- When displayed with “!” mark: The system data for the appropriate blade has been 
assigned. However, the blade which differs from the 
assigned system data is mounted in the Slot.
Example: ! DLC, ! COT, ! DIOP(LD)

Tips 2: Indication When Blades for SV8300 Are Mounted
• When blades for SV8300 are mounted, a blue line on the left side of the blade display and

“*NV” at the end of the blade name appear as follows.

Right-Click Menu Description

CSI • CSIB *NV: CD-4CSIB/CD-4CSIB-A
* “NV” implies a blade for SV8300

Others • VM00 : GCD-VM00
• PVA : GCD-PVA
• RGA : GCD-RGA
• VM00 *NV: CD-VM00
• PVA *NV : CD-PVAA
* “NV” implies a blade for SV8300.

“*NV”
indication

A blue line
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The table below shows the terminal types displayed in the port information of the system report.

<Terminal Type List Table>

Report Display 
Contents

Terminal Type Remarks

(blank) Single Line Station

(blank) ISDN Terminal Station

02: Dterm IP INASET Dterm IP INASET

03: Dterm85 (Series i) (IP 
Adapter Type)

Dterm85 (Series i) 
(IP Adapter Type)

05: Dterm85 (Series i) (IP 
Bundled Type)

Dterm85 (Series i) 
(IP Bundled Type)

10: DtermSP30 DtermSP30

12: DT710 DT710

13: DT730/DT710 (Self-
labeling)

DT730/DT710 (Self-labeling)

14: DT750 DT750

15: MH240 MH240

16: SP350 SP350

17: DT730DG DT730DG

18: DT730CG DT730CG

19: DT770G DT770G

21: DT830/DT830DG DT830/DT830DG

22: DT830CG DT830CG

23: DT820 DT820
 NOTE 1

24: DT820 (Self-labeling) DT820 (Self-labeling)
 NOTE 2

25: DT930 DT930CG
 NOTE 3

Available from 9300V7 software. 



Chapter 8 Report

8-23 NWA-088656-001 Rev.8.0

System Check and Report

NOTE 1: For 9300V3 software or before, “12: DT710” is displayed as a terminal type.
NOTE 2: For 9300V3 software or before, “13: DT730/DT710 (Self-labeling)” is displayed as a terminal 

type.
NOTE 3: For 9300V3 software or before, “23: DT820” is displayed as a terminal type.
NOTE 4: For 9300V3 STEP2 to 9300V6 software, “23: DT820” is displayed as a terminal type. For 

9300V3 software or before, “12: DT710” is displayed as a terminal type.
NOTE 5: DT510 is available from 9300V9 software or later. The terminal type between DT510 and 

DT410 cannot be identified by the System Check and Report. Also, DT510 is identified as 
DT410 for 9300V6 software or before (DT510 cannot be accommodated to SV9300 when using 
9300V7/V8 software).

26: DT920 DT920
NOTE 4

Available from 9300V7 software.

27: DT920 (Self-labeling) DT920 (Self-labeling) Available from 9300V7 software.

28: DT930 (Touch panel) DT930 (Touch panel) Available from 9300V7 software.

41: Dterm85 (Dterm Series i) Dterm85 (Dterm Series i)

42: Dterm85 (Dterm Series i) 
Russian

Dterm85 (Dterm Series i) 
Russian

43: DT310 DT310

44: DT330 DT330

45: DT330 Chinese DT330 Chinese

46: DT510/DT410 DT510/DT410 
NOTE 5

47: DT430 DT430

48: DT430 Chinese DT430 Chinese

49: DT530 DT530 Available from 9300V7 software.

70: Paging Adapter Paging Adapter

80: Standard SIP Station Standard SIP Station

FF: Others PS and others

Report Display 
Contents

Terminal Type Remarks
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System Data

Displays the System Data report of each command read out from the SV9300.

NOTE: To display the System Data report, the reading system data is required beforehand by clicking 
the [Read] button on the [System Data] screen. Page 6-3

STEP1: On the main menu, click [Tools] > [Reports] > [System Data] in this order.
The [Open File] dialog box appears.

The report files of each command are stored in the folder of Connection Accounts.
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STEP2: Select a file and click the [Open] button.
Displays a system data of specified report file.



Chapter 8 Report

8-26 NWA-088656-001 Rev.8.0

Log Viewer

Log Viewer

Displays a system data history of upgrade report.

STEP1: On the Main Menu, click [Tools] > [Reports] > [Log Viewer] in this order.
The [Open File] dialog box appears.

STEP2: Select a file and click the [Open] button.
The [System Data History of Update Report] appears.
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9

Settings

This chapter focuses on the various settings of PCPro.

• Connection Account
• PCPro Account
• System Data Conversion Tool
• Environmental Setup
• System Data Off-line Readout/Edit
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Connection Account

To create a connection account used to establish a communication link between the SV9300/Virtual PBX
and PCPro, follow these steps:

STEP1: In the [PCPro] window, select one of the following:
• On the Main Menu, click [Tools] > [Connection Accounts] in this order.
• Click  the toolbar. 
The [Connection Accounts] screen is displayed.

Continued on next page

No. Item Description

(1) Connection 
Accounts list

Displays a list of connection accounts registered on PCPro.
PCPro registered by default are the following accounts (the default 
accounts cannot be changed or removed).:
• IP (LAN Default): 

IP connection, IP address: 192.168.1.1, Port number: 60000
• IP (VoIP Default): 

IP connection, IP address: 172.16.1.1, Port number: 60000
• RS-232C (9600bps): 

direct connection (RS-232C connection), COM port: COM1, baud rate 
(bps): 9600 

(2)

(1)

(4)

(3)

(5)
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STEP2: Click [Add...] button.
The [Connection Accounts] screen is displayed.

STEP3: Enter a connection account name in the Connection Account field.

NOTE: The connection account name can be up to 128 characters long. A connection account name 
cannot be defined in duplicate.

The subsequent course of action varies with each connection account.
• IP Connection Page 9-4
• RS-232C Connection (Direct Connection) Page 9-5
• Modem/Terminal Adapter Connection Page 9-6
• Virtual PBX Connection (Office data file) Page 9-8

No. Item Description

(2) [Add...] button Click to add an additional connection account. The [Connection 
Accounts] screen is displayed. For more details, refer STEP2 and later.
• Up to 1000 connection accounts can be added.

(3) [Remove] button Click to delete the connection account selected from the Connection 
Accounts list.

(4) [Properties...] button Click to view details on the connection account selected from the Con-
nection Accounts list or to edit its settings.

(5) [Close] button Click to close the [Connection Accounts] screen.

Connection Account field
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IP Connection

STEP4: Select “IP” from the Connection Type field.
The display of the Preferences Area will change to suit a IP connection.

STEP5: Set items (1) and (2).

STEP6: Click the [OK] button.
The connection account is added to the [Connection Accounts] screen.

No. Item Description

(1) IP Address field Enter the IP address of the SV9300.
• 0.0.0.1 to 255.255.255.254 (default: 192.168.1.1)

(2) Port Number field Enter the communication port number of the SV9300.
• 60000 (fixed value) 

(3) Time-out timer of 
receiving data from 
the system (second) 
field

Enter the timer value of time-out while receiving data from the system.
• xx to xx (default: 8) 

(1)

(2)

[OK] button

Connection Account field

Connection Type field
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STEP7: Click [Close] button in the [Connection Accounts] screen. 
The [Connection Accounts] screen closes, and returns you to the [PCPro] window.

A connection account for an IP connection has now been created.

RS-232C Connection (Direct Connection)

STEP4: Select “Direct” from the Connection Type field.
The display of the Preferences Area will change to suit an RS-232C connection (direct con-
nection).

STEP5: Set items (1) and (2).

No. Item Description

(1) COM Port field Choose from the following PCPro RS-232C connection ports to con-
nect PCPro to the SV9300:
• COM1 to COMX (default: COM1) 

* An usable COM port detected by PC is displayed.

(2) Baud field Choose from the following band rate between PCPro and SV9300:
• 1200/2400/4800/9600/19200 (default: 9600)

(1)

(2)

[OK] button

Connection Account field

Connection Type field
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STEP6: Click the [OK] button.
The connection account is added to the [Connection Accounts] screen.

STEP7: Click [Close] button in the [Connection Accounts] screen.
The [Connection Accounts] screen closes, returning you to the [PCPro] window.

A connection account for an RS-232C connection (direct connection) has now been created.

Modem/Terminal Adapter Connection

STEP4: Select “Modem” or “Terminal Adapter” from the Connection Type field.
The display of the Preferences Area will change to suit a selected connection.

STEP5: Set items (1) to (7). 

(3) Time-out timer of 
receiving data from 
the system (second) 
field

Enter the timer value of time-out while receiving data from the system.
• xx to xx (default: 8) 

No. Item Description

[OK] button

Connection Account field

Connection Type field

(1)

(4)

(3)

(2)

(5)

(6)
(7)
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STEP6: Click the [OK] button.
The connection account is added to the [Connection Accounts] screen.

STEP7: Click [Close] button in the [Connection Accounts] screen. 
The [Connection Accounts] screen closes, and returns to the [PCPro] window.

A connection account for a modem/terminal adapter connection has now been created.

No. Item Description

(1) COM Port field Choose the RS-232C port of PCPro to which the modem is connected 
from the following:
• COM1 to COMX (default: COM1) 

* An usable COM port detected by PC is displayed.

(2) Dial Type field Select the dialing type of the line used for communication.
• Tone/Pulse (default: tone)

* This item is only for Modem Connection.

(3) Phone Number field Enter the connection destination phone number.
• Up to 40 digits (default: blank field)

(4) Disconnecting 
String field

Enter a character string used by the modem to clear the communication 
link.
• Up to 50 single-byte characters (default: ATH) 

(5) Modify Initializa-
tion String field

Enter a modem initialization character string as for specifying a partic-
ular speed.
• Up to 50 single-byte characters (default: blank field)

(6) External modem 
requires password 
entry

If the SV9300 uses an external modem to connect to PCPro, select this 
password if a password is required to gain access to the external 
modem. (default: unchecked).

(7) Operator assisted 
call

Select this check box to perform a dial-up connection from a telephone 
set connected to the modem. (default: unchecked).
* If this item is enabled, only the COM Port/Disconnecting string/

Modify Initialization string field becomes functional.

(8) Time-out timer of 
receiving data from 
the system (second) 
field

Enter the timer value of time-out while receiving data from the system.
• xx to xx (default: 8) 



Chapter 9 Settings

9-8 NWA-088656-001 Rev.8.0

Connection Account

Virtual PBX Connection (Office data file)

NOTE: When using “Virtual PBX” of Connection Type, note the following conditions: 
- The supported system data is SV9300. The system data of SV8300 is not supported.
- The specified system data must be included “Area number 1: All system data (except Speed

Dialing)”.

STEP4: Select “Virtual PBX” from the Connection Type field.
The display of the Preferences Area changes to suit a Virtual PBX connection. 

No. Item Description

(1) File Name field The specified system data file name with the full path is displayed.

(2) [...] button Click to choose the system data file of Virtual PBX.

(3) File 
Infor-
mation

Date The last saved date of the specified system data file is displayed.

Office 
Name

The office name (which is registered when the specified system data 
file is saved) is displayed.

(1)

(3)

(4)

(5)

(2)

[OK] button

[Connection Account] field

[Connection Type] field
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STEP5: Click the [...] button.
The [Connection Accounts] screen is displayed.

STEP6: Choose the system data file of Virtual PBX, and then click the [Open] button.
The chosen system data file is read out.

NOTE: When the specified system data file is not “Area number 1: All system data (except Speed 
Dialing)”, a warning message is displayed. Try to choose a correct system data file again.

STEP7: Click the [OK] button.
The connection account is added to the [Connection Accounts] screen.

STEP8: Click [Close] button in the [Connection Accounts] screen.
The [Connection Accounts] screen closes, returning you to the [PCPro] window.

A connection account for a Virtual PBX connection (Office data file) has now been created.

(4) Detail 
Infor-
mation

Area 
Name

The area name of the loading system data file is displayed.

Area 
Number

The area number of the loading system data file is displayed.

(5) Time-out timer of 
receiving data from 
the system (second) 
field

Enter the timer value of time-out while receiving data from the system.
• xx to xx (default: 8) 

No. Item Description
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PCPro Account

The kinds of PCPro Account

The following default accounts are prepared for logging on to PCPro:
• admin : This account is used for maintenance personnel. PCPro allows this account to use all func-

tions.
• manager : This account is used for a manager of end users. The usable functions are limited on 

PCPro. For details of the usable functions, refer to the “Available Functions for Manager 
Account” list.

The following table shows the user names and the default passwords for each PCPro account at log on.

NOTE 1: Be sure to change the default passwords for an “admin” account and a “manager” account. 
you cannot operate a PCPro without changing the default password of each account. 
For details of a password change, see “Changing Password of PCPro Account”.

Page 9-12
NOTE 2: Both prepared user name “admin” and “manager” cannot be changed.
NOTE 3: The HTTP Server Settings screen cannot be opened on the Tools menu with a manager account. 

To open the HTTP Server Settings screen with the manager account, use the “HTTP Server Set-
ting” button in the Terminal Phonebook screen.

Available functions of a manager account are as follows: 

PCPro Account User Name Default Passwords

admin admin admin

manager manager manager



Chapter 9 Settings

9-11 NWA-088656-001 Rev.8.0

PCPro Account

Available Functions for Manager Account

Available Functions Remarks

Main Menu File Exit

View Toolbars Standard 
Buttons

The User settings and the Service 
menu cannot be changed.

Status bar

Tooltips

Edit Terminal Phonebook

Tools PCPro 
Accounts...

Change 
Password...

Window Close All

Help Help

License

About SV9300 PCPro...

Toolbar Edit Terminal Phonebook Toolbar cannot be changed.

Tools PCPro 
Accounts...

Change 
Password...

Help Help

Submenu 
(Standard 
Mode only)

[Services] 
category

Terminal Phonebook Other mode cannot be displayed.



Chapter 9 Settings

9-12 NWA-088656-001 Rev.8.0

PCPro Account

Changing Password of PCPro Account

The password associated with the name of a user who is logged in to PCPro can be changed in these steps:

NOTE 1: The password entered here is not linked to the password on the SV9300.
NOTE 2: Be sure to change the default passwords for an “admin” account and a “manager” account. 

You cannot operate a PCPro without changing the default password of each account.
NOTE 3: The passwords that can be set for an “admin” account and a “manager” account are as 

follows.
- Input length: Eight or more digits (up to sixteen digits)
- Input characters: 0 to 9, A to Z, a to z

NOTE 4: When a password does not meet the above setting conditions in a login to a PCPro and the pass-
word is not changed, the PCPro will be terminated.

NOTE 5: User Name and password are very important information. Handle them with extreme care.
NOTE 6: Default password is given for initial maintenance and operational settings. To enhance security 

of the password, change the default password in the course of the initial settings and periodi-
cally thereafter.

NOTE 7: Even if you conduct periodical password change, preventing unauthorized access is difficult if 
you use passwords that have low security strength (short password) or can be easily guessed 
(such as “123456789”, “abcdefg”, “password”, or “Administrator”). Use a complicated and 
not easily predictable password that contains alphabet letters (upper case and lower case), 
numbers, and symbols.

NOTE 8: If you use your control password with a low strength password on a device that can be con-
trolled over a network, there is a risk of allowing an illegal access by a malicious third person. 
If an illegal access takes place, not only information leakage, but also damage to the system 
resulting from compromising availability and integrity, or used as a stepping stone for a cyber 
attack by a botnet may occur. We shall bear absolutely no liability and responsibility for any 
illegal accesses that occur because the product was used with a low strength password. 

STEP1: On the Main Menu, click [Tools] > [PCPro Accounts] > [Change Password] in this order.
The [Change Password] screen is displayed.

New password field

[OK] button

Confirm new password field
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STEP2: Type the password you want to register in the New password field.
STEP3: Type the new password again in the Verify the Confirm new password field.
STEP4: Click the [OK] button. 

Tips: If you forget the changed password
If you forget the changed password, re-install the PCPro by the following procedures.
1.Uninstall the PCPro. Page 2-25
2.Delete <Installation Folder>\SV9300 PCPro\userdb folder
3. Re-install the PCPro. Page 2-2

The password associated with the user who is logged on to PCPro has now been changed.
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System Data Off-line Readout/Edit

The system data which is read out from Virtual PBX (which is assumed as the system data file of the sys-
tem) can be displayed or be edited on PCPro. The system data edited on PCPro can be saved as another
system data file. 
Listing all of the system data of Virtual PBX is also available, and the results of executing them can be
saved as a script file. 

NOTE 1: This feature is available only for a admin user. For details of PCPro account, refer to “The 
kinds of PCPro account” in PCPro Account.

NOTE 2: When “Virtual PBX” in Connection Type is chosen, the usable functions on PCPro are limited. 
For details, refer to “PCPro Account” in Chapter 9.

To use the system data files makes it possible for the followings without connecting the system: 
• Contents in the system data file can be displayed without loading to the system.

The desired system data file is registered as Virtual PBX, and PCPro can be connected with it. To dis-
play the system data, System Data Mode, the Script menu, or other menus in Standard Mode are used.
For details, refer to “Virtual PBX Connection (Office data file)” of Connection Account in Chapter 9.

• The system data file can be edited and be saved as another system data file.
After connecting with Virtual PBX, the system data can be edited by using System Data Mode, the
Script menu, or other menus in Standard Mode. The edited system data is saved as another file name
on the System Data Save menu. 
For details, refer to “System Data Save/Load/Verify” in [Maintenance] Category in Chapter 4.

• All of the system data in the system data file can be listed and be saved to an external file (script file).
After connecting with Virtual PBX, all of the system data can be listed by using a scenario of all system
data list on the Script menu.
For details, refer to “Listing the All Office data in the Office Data File” in [Tools] Category.

Page 4-101
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Available functions while connecting with Virtual PBX are as follows: 

Available Functions While Connecting with Virtual PBX

Available Functions Remarks

Main Menu File Exit

View Toolbars Standard 
Buttons

The User settings and the Service 
menu cannot be changed.

Status bar

Tooltips

System Connect...

Disconnect...

System Data Save/Load/Verify

Maintenance System Check 
and Report

Edit Standard

System Data

Command

Blade Configuration

Speed Dialing

Call Pickup Group

UCD Group

Station Hunting Group

Tools Connection Accounts... Environmental Setup is not dis-
played.

PCPro 
Accounts...

Change 
Password...

Script

Station Copy/Key Copy

Reports System Check 
and Report...

System Data...

Communication Log...
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NOTE 1: The system data of Virtual PBX cannot be saved by using the system data backup command 
(CMEC Y=6). (See the “< Unavailable commands while using Virtual PBX >”.) When saving 
the edited system data, use the System Data Save menu and save it as another file name.

Main Menu Window Close All

Help Help

License

About SV9300 PCPro...

Toolbar Connect... Toolbar cannot be changed.

Disconnect...

Command

Script

System Data Save/Load/Verify

Help

Submenu Standard

System Data

Command

Standard
Mode

Implement Blade Configuration

Tools Script

Services Speed Dialing

Call Pickup Group

UCD Group

Station Hunting Group

Maintenance System Check and Report

System Data Save/Load/Verify

Listup All CMD

Command
Mode

Command Trace Information is unavailable.

Available Functions While Connecting with Virtual PBX

Available Functions Remarks
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NOTE 2: While using Virtual PBX, the reading, writing and execution by the following commands are 
not available.
< Unavailable commands while using Virtual PBX >
1. The commands that require physical hardware (such as every kind of reset, system data

backup, downloading, settings of MAC address, clock control, lamp control, reading infor-
mation of connecting devices and its status, or commands required to use in an off-line
mode).

2. The commands that access memory except the system data (such as clearing the SRAM area
or the SMDR billing data, traffic information, fault information, or license information).
*1For details of the unavailable commands while using Virtual PBX, see “Unavailable

Command List Table” Page 9-18
*2 Even for the commands that are not listed in “Unavailable Command List Table,” some

commands are not used by this feature.
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The unavailable commands while using Virtual PBX are as follows.

<Unavailable Command List Table>

Unavailable Command Description Remarks

CM00>02 SRAM Area All Clear

CM00>10 Billing Memory Clear (SRAM)

CM00>11 Record for SMDR Clear (SRAM)

CM02 Setting of System Clock/Reading out of Day-
light Saving Time

CM0B Y=000>90 Unit No. setting Available on off-
line mode

CM0B Y=0XX>88 Read the MAC address of the Maintenance Port 
(for STBY-CPU)

CM0B Y=0XX>89 Read the MAC address of the Maintenance Port 
(for Single CPU/ACT-CPU)

CM0B Y=1XX>88 Read the MAC address of the VoIP Port (for 
STBY-CPU)

CM0B Y=1XX>89 Read the MAC address of the VoIP Port (for Sin-
gle CPU/ACT-CPU)

CM0B Y=1XX>153 SNTP query

CM0B Y=2XX>70 MAC Address of the VoIPDB (for STBY-CPU)

CM0B Y=2XX>80 MAC Address of the VoIPDB (for Single CPU/
ACT-CPU)

CM0C Y=50 Start updating IP Station firmware

CM0C Y=52 Remote System Upgrade (Main/Remote/Sec-
ondary unit)

CM0C Y=53 Downloading CPU Program (for STBY-CPU)

CM12 Y=29 Applying LCD display settings of Multiline Ter-
minal

CM12 Y=89 Reset for Multiline Terminal
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CM12 Y=90 MAC Address automatic registration in Fixed 
Connection Mode/Registered IP Station MAC 
Address display/clear

CM12 Y=92 MAC Address registration in Fixed Connection 
Mode

CM12 Y=93 Security Lock Cancel (forced) for DT700/
DT800/DT900 Series

CM12 Y=96 Standard SIP station connection status (Only 
display)

CM12 Y=101 Login lock state

CM1D Y=20 PS/Standard SIP station Configuration Settings

CM60 Y=90 DESKCON Soft Reset

CM81 Y=29 Restriction state by Scam Call detection

CMAF Y=998 Work Memory All Clear of DBM (for PCS)

CMB3 Y=9>999 Clear all UCD PEG COUNT data

CMB5 PEG COUNT

CMB6 Network Statistics

CMBA Y=99 Clearing the cache table

CME1 To display Check Sum data on CPU memory / 
To display Check Sum data on Speech Synthesis 
memory

CME6 Y=50 Destination of ISDN Alternative Routing in 
Remote Unit survival mode (station basis)

Not writable

CME8 Firmware download / VoIPDB Firmware down-
load

CMEA Y=0 Fault information display

CMEA Y=1 Clear External Alarm Kind (MJ/JN)

CMEA Y=6>01 Display the call logs that are collected in the 
CPU (Only Display) or clear the logs

CMEA Y=6>11 Terminals/VoIPDB to collect fault logs

CMEC Y=0 Battery release

Unavailable Command Description Remarks
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CMEC Y=1 Line status display [See Line Status Display 
Operation]

CMEC Y=5 System data copy from ACT-CPU to STBY-
CPU by manual operation

CMEC Y=6 System data backup

CMEC Y=7 SDRAM Data Clear Available on off-
line mode

CMEC Y=8 System data copy from the Main unit to Remote 
units

CMEC Y=9 Applying Day Mode/Night Mode to all Multi-
line Terminals

CMEC Y=C Change Power ON/OFF by Multiline Terminal 
Power Saving

CMEC Y=D VRS data

CMF6 Operation Log/MP-FP Command Output

CMF7 HIGHWAY Channel Memory Read/Reassign-
ment

CMF8 Option Value/Hardware KEY Code Read

CMF9 System Status Display

CMFA Read the IP Station firmware version

CMFB Remote Program Download Information Read

CMFC VoIPDB Information Read

Unavailable Command Description Remarks
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Establishing a Communication Link with Virtual PBX

To establish a communication link between PCPro and Virtual PBX, follow these steps: 

STEP1: Launch PCPro. Page 2-4
STEP2: On the Main Menu, click [System] > [Connect...].

The [Connect] screen is displayed.
STEP3: Select Virtual PBX in Connection Account.
STEP4: When connecting with Virtual PBX, log on to PCPro with an account assigned Virtual PBX in 

Connection Type. For details of Connection Type, refer to “Connection Account”.
Page 9-2 

STEP5: Click the [Connect] button.
If you successfully log on to Virtual PBX, a dialog appears saying “Successfully connected to
the System(Virtual PBX).”. 

The [Connect] screen closes. The following information list is displayed on the status bar in the
[PCPro] window: 
• Connection Account (account in which PCPro is connected to Virtual PBX)
• BIOS version of Virtual PBX
• Virtual PBX version
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If you fail to log on to Virtual PBX, a dialog appears saying “The file could not be found.”. Take
remedial action as recommended in “Troubleshooting a Connect Failure.” 

A communication link has now been established between PCPro and Virtual PBX.
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Clearing a Communication Link with Virtual PBX

To clear a communication link between PCPro and Virtual PBX, follow these steps: 

STEP1: On the Main Menu, click [System] > [Disconnect...] in this order.
The [Disconnect] dialog box is displayed.

STEP2: Click the [Disconnect] button. 

The [Disconnect] dialog box closes. The connection information displayed on the status bar in
the [PCPro] window disappears.

The communication link to Virtual PBX has now been cleared.

No. Item Description

(1) [Save and Discon-
nect] button

Not used.

(2) [Disconnect] button Click to clear the communication link to Virtual PBX.
NOTE: By clicking this button, the system data you edited will be also 

cleared. When you need the edited system data, save as another sys-
tem data file by using System Data Save before disconnecting Virtu-
al PBX.

(1) (2)
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System Data Conversion Tool

System Data Conversion Tool is the tool to convert the system data for SV8300 to that for SV9300. Be-
cause System Data Conversion Tool automatically converts the system data, maintenance personnel can
set the system data without resetting all system data. In addition, by a report of system data conversion,
you can compare the system data before the conversion and after the conversion.

The system data targeted for system data conversion is the following five types.
• Commands that the meaning of second data is changed
• Commands that the default data is changed
• Commands that the second data is changed to recommended data for SV9300
• Merged commands due to simplify the complicated commands
• Commands related to Speed Dialing expansion

NOTE 1: By using System Data Conversion Tool for SV9300, you cannot convert from the system data 
for NEAX2000 IPS to that for SV9300.

NOTE 2: When converting system data from SV8300 using this tool, if the setting of soft keys is changed 
from the default setting, the modified conditions is applied.

NOTE 3: The history of scripts changed by System Data Conversion Tool is not outputted on the history 
of changed system data in a Maintenance Report.

NOTE 4: As for the system clock assigned by CM02, the date and the time is set at executing a script.
NOTE 5: The script output for SV9300 executes the system data backup (CMEC Y=6) at the end of the 

script.
NOTE 6: The way of starting Remote Units is the same as usual.
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Tips: Memory to be used for Speed Dialing
• The contents of registered 1000-Slot Memory Blocks (00-19) for SV8300 are also copied to

the 1000-Slot Memory Blocks (00-19) for SV9300. The contents of registered 300 memories
for SV8300 are also copied to the 300 memory area for SV9300.

• For Station Speed Dialing, because the allocation of memory area is the same even after a
system data conversion and uses the same access codes and Line/Trunk Features keys, you
can still use them the same as before. To expand the number of blocks for each station, it is
necessary to allocate the memory area again.

• For System Speed Dialing (300 memories), it is necessary to allocate the memory area man-
ually for the memory by 1000 units (for details, refer to the “UNIVERGE SV9300 Migration
Manual”).

• For System Speed Dialing (4000 memories), targeted 1000-Slot Memory Blocks are automat-
ically set to “For all tenants” area of System Speed Dialing. Access codes and Line/Trunk
Feature keys can be used for conventional 4000 memories and System Speed Dialing 2-4 dig-
its origination.

Memory by 1000 unit

00 19

00 19 20 99

300 Memories

SV8300

Memory by 1000 unitSV9300

1000-Slot Memory Block No.

00 19

00 19 20 99

SV8300

SV9300

1000-Slot Memory Block No.

4000 Memories

For all Tenants
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• Because targeted 1000-Slot Memory Blocks are automatically set to “For all tenants”, an
area used for Calling Name Display for incoming call from ISDN/T1-ANI/MFC-R2 route (as-
signed by SV8300 CM35 Y=156) functions as usual.

00 19

00 19 20 99

SV8300

SV9300

1000-Slot Memory Block No.

For Calling Name Display

For all Tenants
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Procedures for System Data Conversion

Procedures for system data conversion are as follows.

Tips 1: Preparing System Data File for SV8300
To save the system data file for SV8300 by the [System Data Save/Load/Verify] menu, specify
the following system data area.
System data area (Area number: 1, 2, 4, 80, 81): All system data + All service memory +
Registration data by MAC authentication + DBM data (SRAM) 
For details, refer to the “UNIVERGE SV8300 PC Programming Manual”.

1. Preparing the System 
Data File for SV8300

Save the all system data of SV8300 by the [System Data Save/Load/
Verify] menu of SV8300 PCPro.

2. System Data Conver-
sion

By using System Data Conversion Tool of SV9300 PCPro, convert 
the system data file (*.syd) saved by the [System Data Save/Load/
Verify] menu of SV8300.

Page 9-28
Conversion procedures are as follows.
Step1: Select of Office Data
Step2: Confirmation of the selected contents
Step3: Execute conversion
Step4: Display of Converted Result

3. Switching SV9300 to 
Off-Line Mode

Switch SV9300 to off-line mode. For details of the switching 
method to off-line mode, refer to the “Command Manual”.

4. Clearing all System 
Data for SV9300

Clear all system data of SV9300 using System Data Mode or Com-
mand Mode of SV9300 PCPro. Page 6-1, Page 7-1

5. Executing the Script 
File after System Data 
Conversion

Execute the script file (scenario) file after system data conversion 
using the [Script] menu. Page 4-98
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Tips 2: Time required for System Data Conversion
In general, the time required for system data conversion is about one hour.
1. Preparing the system data for SV8300 : 15 minutes
2. System data conversion : 10 minutes
3. Switching SV9300 to off-line mode : 5 minutes
4. Clearing all system data for SV9300 : 5 minutes
5. Executing the script (scenario) file after system data conversion: 20 minutes

* Depending on the system data setting condition of the system to be converted, operation
time increases or decreases.

System Data Conversion

STEP1: Take one of these actions:
• Click [Start] > [NEC SV9300 PCPro] > [NEC System Data Conversion Tool] in order in

Windows OS.
• On the Main Menu, click [Tools] > [System Data Conversion Tool…] in order.
The [System Data Conversion Tool] screen is displayed.

Tips: When you click the [Help] button in the right top of the [System Data Conversion Tool] 
screen, On-line Manual (SV9300 PC Programming Manual) launches. Refer the operation 
procedures and others, if necessary.

[Next >>] button

(1)
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STEP2: Click the [Next >>] button.
The [Step1: Select of Office data] screen is displayed.

No. Item Description

(1) Original Office Data File field Displays an original office data file.
* If you select an original office data file, the following 

path is set to the Converted Script File Output field.
Path: Office data file path + “/Output_” + Office data file 

name (except extensions)

(2) […] button Click to select an original office data file on the [PCPro 
System Data Conversion Tool] dialog box.

(3) Converted Script File Output 
field

Displays the output destination of a converted script file.

(4) […] button Click to change the output destination of a converted script 
file on the [Browse For Folder] dialog box.

(2)(1)

(4)(3)

[Next >>] button
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Tips: Output Folder and File Configuration
• An output folder is generated when clicking the [Conversion] button on the [Step: Confir-

mation of the selected contents] screen.
• An output folder is generated in the directory specified by the maintenance personnel. The

file configurations to be generated are as follows.
- ConvertedSystemData.html: Report of data conversion
- Converted folder: System data after a conversion (Script file for SV9300) 

Scenario.list : Scenario file
* .csv : Script file for each command

- Original folder: System data before a conversion (Script file for SV8300)
* .csv : Script file for each command

STEP3: Click the […] button of the Original Office Data File field.
The [PCPro System Data Conversion Tool] dialog box is displayed.

STEP4: Select the system data file (*.syd), and click the [Open] button.
The screen returns to the [Step1: Select of Office data] screen.

STEP5: To change the output destination of a converted script file, click the […] button of Converted 
Script File Output field.
The [Browse For Folder] dialog box is displayed.

[Open] button
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STEP6: Select the output destination of a converted script file, and click the [OK] button.
The screen returns to the [Step1: Select of Office data] screen.

STEP7: Click the [Next >>] button.
The [Step2: Confirmation of the selected contents] screen is displayed.
* If a script file exists in the selected folder, the following dialog box is displayed. 

To overwrite the file, click the [Yes] button. To specify a script file again, click the [No]
button.

[OK] button
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STEP8: Confirm the selected contents on the [Step1: Select of Office data] screen.
• To change the Office Data File and Script File Output, return to the previous screen using

the [<< Back] button.
• To execute the system data conversion with this settings, go to STEP9.

No. Item Description

(1) Office Data File 
And Script File 
Output Area

Original office 
data file

Displays the file path selected on the [Step1: Select 
of Office data] screen.

Converted script 
file output

Displays the file path selected on the [Step1: Select 
of Office data] screen.

(2) Information Area 
on an Original 
Office Data File

The preservation 
date and time

Displays the preservation date and time set to the 
office data file.

Office name Displays the office name set to the office data file.

(3) [Conversion] button Click to execute a system data conversion.

(3)

(1)

(2)
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STEP9: Click the [Conversion] button.
STEP10: Click the [Yes] button.

The screen switches to the [Step3: Execute Conversion] screen, and PCPro starts the system
data conversion.

* If you click the [Stop] button, the following dialog box is displayed. To stop the process,
click the [Yes] button. To continue the process, click the [No] button.

NOTE: If you stop a system data conversion, a script file after the conversion is outputted until 
interruption. When converting the same system data file again, all script files previously con-
verted are overwritten.

When the process of system data conversion is completed, the screen switches to the [Step4:
Display of Converted Result] screen.

[Yes] button

[Stop] button
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STEP11: Verify the converted result.

No. Item Description

(1) [Launch SV9300 PCPro] button Click to launch SV9300 PCPro.

(2) Output File Display 
Area

Report of the 
system data con-
version

Displays the output destination of report of the 
system data conversion. 
A folder selected on the [Step1: Select of Office
data] screen +“\ConvertedSystemData.html”

Converted scripts 
(including a 
scenario)

Displays the output destination of a script 
(scenario) file after system data conversion.
A folder selected on the [Step1: Select of Office
data] screen +“\Converted”

Original scripts Displays the output destination of a script file 
before system data conversion.
A folder selected on the [Step1: Select of Office
data] screen +“\Original”

Continued on next page

(3)

(1)

(2)
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Tips: Operations after System Data Conversion
After system data conversion, do the following operations in accordance with the procedures
of the [Step 4: Display of Converted Result] screen.
1. Launch SV9300 PCPro by clicking the [Launch SV9300 PCPro] button.

* When SV9300 PCPro has already been lunched, go to the next step.
2. Clear the all system data (CM00>1) of SV9300 by System Data Mode or Command Mode

of PCPro. Page 6-1, Page 7-1
3. Click [Tools] > [Script] in order on the Main menu to lunch the [Script] menu.
4. Click the [Scenario Open] button, and execute the script (scenario) file after system data

conversion.  Page 4-98

System data have now been converted.

No. Item Description

(3) [Return to the Start Page] button Click to return to the [PCPro System Data Conver-
sion Tool] screen.
To return the [PCPro System Data Conversion
Tool] screen, click the [Yes] button of the confir-
mation dialog box.
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Report of System Data Conversion

The following table shows the items to be displayed on the report of system data conversion.

<Display Item List Table for Report of System Data Conversion>

Report Category Item Description

Description of the sys-
tem data conversion

Completed time of 
conversion

Outputs the date and the time when the system data 
conversion is completed.

Original office data 
file

Outputs the file path selected on the [Step1: Select 
of Office data] screen.

The preservation date 
and time

Outputs the date and the time saved in the system 
data file.

Office name Outputs the office name set in the system data file.

The number of con-
verted script files

Displays the number of script files output for 
SV9300.

Converted commands 
List

List of commands 
whose second data 
were changed to rec-
ommended data in a 
SV9300 system

Displays the list of commands whose second data 
were changed to recommended data in a SV9300 
system.
• Original:

CMD, FD, SD before a system data conversion
• Converted:

CMD, FD, SD after a system data conversion
• Description:

Contents of changed settings

List of commands 
whose meaning of 
default data were 
changed in a SV9300 
system

Displays the list of commands whose meaning of 
default data were changed in a SV9300 system.
• Original:

CMD, FD, SD before a system data conversion
• Converted:

CMD, FD, SD after a system data conversion

Continued on next page
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Report Category Item Description

Converted commands 
List

List of commands 
whose meaning of 
setting data were 
changed in a SV9300 
system.

Displays the list of commands whose meaning of 
setting data were changed in a SV9300 system.
• Original:

CMD, FD, SD before a system data conversion
• Converted:

CMD, FD, SD after a system data conversion

List of merged com-
mands due to simplify 
the complicated com-
mands in a SV9300 
system

Displays the list of merged commands due to sim-
plify the complicated commands in a SV9300 sys-
tem.
• Original:

CMD, FD, SD before a system data conversion
• Converted:

CMD, FD, SD after a system data conversion

Converted the com-
mands for the speed 
dialing

Usage of 1000-Slot 
Memory Block/Set-
ting status for Calling 
Name Display for 
incoming calls

Displays the usage of memory for Speed Dialing 
and the setting status of Calling Name Display for 
incoming calls by diagrams of 1000-Slot Memory 
Block unit.

Allocation of a mem-
ory before a conver-
sion

Displays the command list (Original) by the table.
• Original:

CMD, FD, SD before a conversion

Allocation of a mem-
ory after a conversion

Displays the command list (Converted) by the 
table.
• Converted:

CMD, FD, SD after a conversion

The list of the com-
mands which are NOT 
transferred

- Displays the list of commands which are not trans-
ferred.
* These commands are required to register manu-

ally, if necessary.
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NOTE: System Data and Settings Which Are Not Transferred
The following system data for SV8300 are not applicable for system data conversion. Set
those system data manually by the system data of SV9300 after executing the script file to be
outputted for SV9300.

* For details when transferring the system data (CM72 Y=0/1/2/4) for System Speed Dialing (300
memories), refer to the UNIVERGE SV9300 Migration Manual.

System Data for SV8300 
Which Are Not Transferred

System Data for SV9300 
Which Are Manually 

assigned for Transfer

CM03 LOG IN/LOG OUT OF PASSWORD MODE CM03

CME7 PASSWORD LEVEL CME7

CME9 PASSWORD CME9

CM72 Y=0* Called Party Number for System Speed Dialing (300 
memories)

CM74 Y=0

CM72 Y=1* Called Party Number for System Speed Dialing (300 
memories): Called Party Name Character Code

CM74 Y=1

CM72 Y=2* Called Party Number for System Speed Dialing (300 
memories): Called Party Name Character by PCPro

CM74 Y=2

CM72 Y=4* Called Party Number for System Speed Dialing (300 
memories): Called Party Name Character Code (for 
Russian)

CM74 Y=4

CM74 Y=4 Called Party Number for System/Station Speed Dial-
ing: Called Party Name Character Code (for Russian)

CM74 Y=4

CM77 Y=5 Station Name assignment with character code (for 
Russian): Character Code

CM75 Y=5

CM9A Y=18 Setting of Soft Key name for each Pattern Number 
(Pattern Number 0) (for Russian)

CM9A Y=18

CM40 Y=08 Data speed CM40 Y=08

CME6 Y=50 Mobile phone number link up with a Mobility 
Access station number

CME6 Y=50

CMF6 Y=2 MP-FP command output setting (for realtime mode) CMF6 Y=2
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You can configure the maximum number of the displays of System Data, a link to the SV9300, select a
Chinese Character and display or set FTP server information.

• Options
• FTP Server Settings Page 9-43
• HTTP Server Settings Page 9-47

Options

You can set the maximum number of the displays of System Data, monitor the status of an IP connection,
set message display and select a Chinese Character.

• Display
• Connection Page 9-41
• Chinese Character Page 9-42

Display

You can set the maximum number of the displays of System Data when you display multiple System
Data screen with tab.

NOTE 1: The maximum number of the displays of System Data is 10. Default is 1.
NOTE 2: Please restart PCPro to make the change effective.
NOTE 3: When you click on the sub menu or search results of System Data, create a new tab until the 

maximum number of display.

STEP1: On the Main Menu, click [Tools] > [Settings] > [Options...] in this order.
The [Options] dialog box is displayed.
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STEP2: Select the maximum number of the displays of System Data.

STEP3: Click the [OK] button.
STEP4: Restart PCPro to make the change effective.

The display setup has now been completed.

No. Item Description

(1) Submenu Display Select the maximum number of the displays of System Data.

Connection Monitor the status of an IP connection and set message display.

Chinese 
Character

Select the Chinese characters to display when using menus such 
as “Station Copy/Key Copy” and “Speed Dialing”.

(2) The maximum number of 
the displays of System 
Data field

Select the maximum number of the displays of System Data 
from a dropdown list.

(1)
(2)

[OK] button
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Connection

You can monitor the status of an IP connection and set message display.

STEP1: On the Main Menu, click [Tools] > [Settings] > [Options] in this order. 
The [Options] dialog box is displayed.

STEP2: Click submenu [Connection].
STEP3: Set items (1) to item (2) as needed.

STEP4: Click the [OK] button.

The connection setup has now been completed.

No. Item Description

(1) “Watch for time-out of IP 
connection (PCPro sends 
the message to confirm the 
connection periodically)” 
check box

Check to monitor the status of an IP connection (default: 
checked).

(2) “Display the completion of 
the Connection” check box

Check to display a message window when the connection with 
the SV9300 is completed (default: checked).

(1)

(2)

[OK] button
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Chinese Character

You can select the Chinese characters to display when using menus such as “Station Copy/Key Copy”
and “Speed Dialing”.

STEP1: On the Main Menu, click [Tools] > [Settings] > [Options] in this order. 
The [Options] dialog box is displayed.

STEP2: Click submenu [Chinese Character].
STEP3: Set the item (1) or (2), then click the [OK] button.

The Chinese character setting has now been completed.

No. Item Description

(1) “Simplified Chinese” 
check box

Check to use the Simplified Chinese character.

(2) “Traditional Chinese” 
check box

Check to use the Traditional Chinese character.

[OK] button

(1)
(2)
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FTP Server Settings

Use an FTP server to upgrade on the CPU program of SV9300 is on-line or off-line. You can start up and
shut down the FTP server, view its status and configure information about the FTP server, as well as FTP
users.

• Server Setting
• Whole Setting Page 9-45
• User Settings Page 9-46

NOTE: Being a facility developed just for program upgrade purposes, the FTP server facility only sup-
ports the acquisition of transferred files and does not permit transferring (creating) files to a 
sever, and creating and deleting directories.

Server Setting

The Server Setting is start and stop service of FTP Server.

STEP1: On the Main Menu, click [Tools] > [Settings] > [FTP Server Settings] in this order. 
The [FTP Server Settings] screen is displayed.

(7)

(3) (4)

(5)

(6)

(1)

(8)

(2)
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STEP2: Click the [Start] button.
To launch FTP Server.

No. Item Description

(1) Submenu Server Set-
ting

Switches the [FTP Server Settings] screen for Server Set-
ting.

Whole Set-
ting

Switches the [FTP Server Settings] screen for Whole Set-
ting.

User Settings Switches the [FTP Server Settings] screen for User Setting.

(2) FTP Server Status field Displays the FTP sever status.

(3) [Start] button Click to launch the FTP server services.

(4) [Stop] button Click to shut down the FTP server services.

(5) Log Display 
Area

Date/Time Displays the date and time of log occurrence.

Event Displays events (such as server startups, server shutdowns, 
logon requests and logoffs).

User Displays the name of the user who is entitled to log in to 
the FTP server.

IP address Displays the IP address of the FTP user.

Port No. Displays the number of the port used by the FTP user.

(6) [Log] button Click to display the communication log file with the FTP 
server.
NOTE: The communication log file with the FTP server is 

saved as the “FtpServer.log” file.

(7) [Clear] button Click to clear the log.

(8) [Close] button Click to close the [FTP Server Settings] screen.
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Whole Setting

The Whole Setting is register IP address and Control Connection Port of FTP Server.

STEP1: On the Main Menu, click [Tools] > [Settings] > [FTP Server Settings] in this order. 
The [FTP Server Settings] screen is displayed.

STEP2: Click the [Whole Setting] menu.

No. Item Description

(1) IP Address field Enter or select the IP address of the FTP Server. 

(2) Control Connection Port field Enter the Control Connection Port of the FTP Server.
• Input range: 1 to 65534 (default: 21)

(3) [Apply] button Click to save the input value of the command port number.

(4) [Close] button Click the close the [Whole Setting] screen.

(2)

(4)

(3)

(1)
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User Settings

You can confirm/change the FTP user information (user name, password) and the folder in which to
save the FTP user information.

STEP1: On the Main Menu, click [Tools] > [Settings] > [FTP Server Settings] in this order. 
The [FTP Server Settings] screen is displayed.

STEP2: Click the [User Settings] menu.

No. Item Description

(1) FTP User List 
field

User Displays the FTP user name saved. 

Password Displays the password of the FTP user saved.

Folder Displays the name of the folder in which the FTP user 
information is saved. 

(2) [Add...] button Click to add more FTP user information.
• Number of uses that can be registered: Up to 10

(3) [Remove] button Click to delete the FTP user information.

(4) [Properties...] button Click to change the existing FTP user information (user 
name, password) and the folder in which to save the FTP 
user information.

(5) [Close] button Click the close the [User Settings] dialog box.

(2) (4)

(3)

(5)

(1)
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HTTP Server Settings

An HTTP server is required for downloading Terminal Phonebook registered on the Terminal Phonebook
menu to the DT900 Series. This menu provides that starting/stopping the HTTP server, displaying the op-
erating status, configuring the HTTP server information, and managing the server access.

• Start and Stop Page 9-48
• Whole Setting Page 9-50
• Phonebook Page 9-51 

NOTE 1: Only the DT900 Series (except DT920) are available for downloading Terminal Phonebook 
with an HTTP server.

NOTE 2: We do not recommend to download Terminal Phonebook or a Terminal Phonebook list file by 
using the HTTP server of SV9300 PCPro to the DT900 Series accommodated in the SV9500 or 
the Aspire.
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Start and Stop

Starting/stopping the service of the HTTP server, displaying the communication log, and monitoring
the operation are available. 

STEP1: On the Main Menu, click [Tools] > [Settings] > [HTP Server Settings...] in this order. 
The [HTTP Server Settings] screen is displayed.

No. Item Description

(1) Submenu Start and Stop Switches the [HTTP Server Settings] screen for Start and 
Stop.

Whole 
Setting

Switches the [HTTP Server Settings] screen for Whole Set-
ting.

Phonebook Switches the [HTTP Server Settings] screen for Phone-
book.

(2) HTTP Server Status field Displays the HTTP sever status.

(3) [Start] button Click to launch the HTTP server services.

(4) [Stop] button Click to shut down the HTTP server services.

(7)

(3) (4)

(5)

(6)

(1)

(8)

(2)
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STEP2: Click the [Start] button.
To launch the HTTP Server.

(5) Log Display 
Area

Date/Time Displays the date and time of log occurrence.

Event Displays events (such as server startups, server shutdowns, 
logon requests and logoffs).

Server Displays the IP address and the port number of the HTTP 
server.

Client Displays the IP address and the port number of the client 
connecting with the HTTP server.

(6) [Log] button Click to display the communication log file with the HTTP 
server.
NOTE: The communication log file with the HTTP server is 

saved as the “HttpServer.log” file.

(7) [Clear] button Click to clear the log.

(8) [Close] button Click to close the [HTTP Server Settings] screen.

No. Item Description
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Whole Setting

Setting the URL/IP address, the Control connection port, and the Root folder of the HTTP Server are
available. 

STEP1: On the Main Menu, click [Tools] > [Settings] > [HTTP Server Settings] in this order. 
The [HTTP Server Settings] screen is displayed.

STEP2: Click the [Whole Setting] menu.

No. Item Description

(1) URL/IP address field Enter or select the URL/IP address of the HTTP Server. 

(2) Control connection port field Enter the control connection port number of the HTTP 
Server.
• Input range: 0 to 65534 (default: 443)

(3) Root folder field Set the root folder of the HTTP server. 
(default: The “httproot” folder in the PCPro installed 
folder)
The root folder selection screen is displayed by clicking the 
[...] button.

(4) [Apply] button Click to save the input value in the screen.

(5) [Close] button Click the close the [Whole Setting] screen.

(2)

(3)

(4)

(5)

(1)
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Phonebook

You can confirm the terminals for downloading Terminal Phonebook zip by each station number and
the access authority. You can also reload the newest data and can delete the Terminal Phonebook.

STEP1: On the Main Menu, click [Tools] > [Settings] > [HTTP Server Settings] in this order. 
The [HTTP Server Settings] screen is displayed.

STEP2: Click the [Phonebook] menu.

No. Item Description

(1) Zip file of Ter-
minal Phone-
book Data 
(Whole) Area

Station No. Displays the station number of a terminal which is accessi-
ble to the HTTP server. 

Station Name Displays the station name of a terminal which is accessible 
to the HTTP server. 

User Name Displays the user name of a terminal which is accessible to 
the HTTP server. 

Version Displays the version of the Terminal Phonebook zip.

Date/Time Displays the last saved date and time of a terminal which is 
accessible to the HTTP server.

IP Address/
Subnet

Displays the IP address/subnet mask of the terminal.

Access Rights Displays the access authority to the HTTP server. 
• Access Rights: IP address designation/In the identical 

sub-net/Only HTTP Server

(2) (3)

(4)

(1)
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(2) [Delete] button Click to delete the chosen data in the Zip file of Terminal 
Phonebook Data (Whole) area.

(3) [Redisplay] button Click to display the newest information of the Terminal 
Phonebook zip.

(4) [Close] button Click the close the [HTTP Server Settings] dialog box.

No. Item Description
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A

Main Menu and Toolbar Correspondence

The table below summarizes the correspondences between the
Main Menu choice and shortcut icons. Shortcut key correspondenc-
es are also shown in the table below.
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Main Menu Toolbar 
Shortcut Icon

Shortcut Key
Category Menu Choice

File

Exit – Alt + F X

View

Toolbars

Standard Buttons – Alt + V B S

Customize... – Alt + V B C

Sub Menu

Standard – Alt + V M S

Wizard – Alt + V M W

System Data – Alt + V M D

Command – Alt + V M C

Status bar – Alt + V S

Tooltips – Alt + V  T

System

Connect... Alt + S  C

Disconnect... Alt + S  D

System Data Backup Alt + S  B

Copy System Data to Remote Units Alt + S  O

System Data Save/Load/Verify Alt + S  S

Reset Alt + S  R

Software Licence Authentication Alt + S  A

Maintenance

Fault Display Alt + S M  A

System Check and Report Alt + S M  R

Maintenance Report Alt + S M  M

Port Status/Lamp Status Alt + S M  S

Program Upgrade (On-line) Alt + S M  P
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Continued on next page

Main Menu Toolbar 
Shortcut Icon

Shortcut Key
Category Menu Choice

System

Maintenance

Program Upgrade (Off-line) Alt + S M  U

Firmware Upgrade (Line/Trunk 
Blade)

Alt + S M  F

Trace Information... Alt + S M  T

Edit

Standard – Alt + E  S

Wizard – Alt + E  W

System Data – Alt + E  D

Command Alt + E  C

Quick Setup Alt + E  Q

Blade Configuration Alt + E  B

Speed Dialing Alt + E  E

Call Pickup Group Alt + E  P

UCD Group Alt + E  U

Station Hunting Group Alt + E  H

User Web Portal Management Alt + E  R

Terminal Phonebook Alt + E  T

Tools

Connection Accounts... Alt + T  C

PCPro Accounts...

Change Password... Alt + T  A  P

Script Alt + T  I

Station Copy/Key Copy Alt + T K
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NOTE: The Command function on the [Edit] menu is used to show or hide the [Command] mode selec-
tor tab, whereas the Command shortcut icon on the Tools bar is used to display the [Com-
mand] screen in the work window.

Main Menu Toolbar 
Shortcut Icon

Shortcut Key
Category Menu Choice

Tools

Reports

Fault Display... – Alt + T  R  A

System Check and Report... – Alt + T  R  R

System Data... – Alt + T  R  D

Log Viewer... – Alt + T  R  L

Settings

Options Alt + T  S  O

FTP Server Settings... Alt + T  S  F

HTTP Server Settings... Alt + T  S  H

System Data Convertor... – Alt + T  Y

Communication Log... Alt + T  O

Window

Close All – Alt + W  C

Help

Help Alt + H  H

License – Alt + H  E

About SV9300 PCPro... – Alt + H  A
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UNIVERGE SV9300
PC Programming Manual

Appendix

B

List Command

The List Commands is the extended commands that can be used by
a script plug-in. In this List Commands, there are the extended com-
mands for system data lists that read and display the system data as-
signed in SV9300, and the extended commands for functions that
implement such as a system reset, the time correction of the system
and the fault information read.

The list commands are used by the [Script] menu of the [Tools] cat-
egory in Standard Mode.
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List of List Commands

The following list represents the available List Commands.

<List of List Commands (for System Data List)>

* In case of specifying a List Command as LFXXX, the data other than [NONE] is listed.

Continued on next page

Name of Extended 
Commands

Functions
Commands to 

be used
Reference 

Page

L04 (LF04) Setting of System Services CM04 Page B-9

L05 (LF05) Blade Type, Trunk Blade Number, 
Highway Channel for ISDN Data 
Communication

CM05 Page B-10

L08 (LF08) Basic Services CM08 Page B-11

L0B (LF0B) LAN Data Assignment CM0B Page B-12

L0D00 (LF0D00) Routing Table Assignment CM0D Y=00 Page B-14

L0D01 (LF0D01) Routing Table Status Assignment CM0D Y=01 Page B-15

L11 (LF11) Virtual Line Number/Intercom Num-
ber

CM11 Page B-16

L12 (LF12) Station Class-1 CM12 Page B-17

L13 (LF13) Station Class-2 CM13 Page B-18

L15 (LF15) Service Restriction Class CM15 Page B-19

L16 (LF16) Call Pickup Group/Group Diversion 
Group

CM16 Page B-20

L17 (LF17) ACD/UCD Group CM17 Page B-21

L18 (LF18) Station Hunting Group CM18 Page B-22

L19 (LF19) Secretary/Group Diversion Station 
Number

CM19 Page B-24

L1B (LF1B) ISDN Telephone Multipoint Station 
Number

CM1B Page B-25

L1D (LF1D) PS-ID Assignment, PS/Standard SIP 
Station Operation Data Download

CM1D Page B-26
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* In case of specifying a List Command as LFXXX, the data other than [NONE] is listed.

Continued on next page

Name of Extended 
Commands

Functions
Commands to 

be used
Reference 

Page

L20 (LF20) Numbering Plan/Single Digit Feature 
Access Code (Programmable)

CM20 Page B-27

L22 (LF22) Route Advance CM22 Page B-28

L23 (LF23) Tenant Development CM23 Page B-29

L25 (LF25) Kind of Special Terminal Develop-
ment

CM25 Page B-30

L29 (LF29) Numbering Plan Tenant Group CM29 Page B-31

L2A (LF2A) ID Code Assignment with CPU CM2A Page B-32

L2A5 (LF2A5) Development Block Number for Call-
ing Party Number

CM2A Y=5x Page B-33

L2B (LF2B) Authorization Code Per Station/IP 
Station Password/Station Digest 
Authentication Password/Standard 
SIP Station Registration Password/
VoIP Encryption Password Assign-
ment

CM2B Page B-34

L30 (LF30) Trunk Data CM30 Page B-35

L35 (LF35) Trunk Route Data CM35 Page B-36

L36 (LF36) Restriction Data/PAD Data for Tan-
dem Connection

CM36 Page B-37

L40 (LF40) Function of CPU RS-232C Port CM40 Page B-38

L41 (LF41) System Timer Data CM41 Page B-40

L42 (LF42) System Counter Data/PAD Data/
Trunk Restriction Class Conversion/
CODEC List

CM42 Page B-41

L43 (LF43) Periodic Maintenance/IP Station 
Firmware Automatic Update/System 
Data Copy/Automatic Clock Change

CM43 Page B-42

L44 (LF44) External Relay Starting Conditions CM44 Page B-44



Appendix B List Command

B-4 NWA-088656-001 Rev.8.0

* In case of specifying a List Command as LFXXX, the data other than [NONE] is listed.

Continued on next page

Name of Extended 
Commands

Functions
Commands to 

be used
Reference 

Page

L45 (LF45) Make Busy Condition of CFT/DTMF 
Receiver Detect Level

CM45 Page B-46

L48 (LF48) Hold/Wake Up/Timed Reminder/
Automated Attendant Tone

CM48 Page B-48

L4B (LF4B) Room Status Code CM4B Page B-49

L50 (LF50) Common Route Indial CM50 Page B-50

L5737 (LF5737) Group No. for One-Touch Group Mes-
saging

CM57 Y=37 Page B-51

L5738 (LF5738) Group Messaging Pattern by Access 
Code Dialing for One-Touch Group 
Messaging

CM57 Y=38 Page B-52

L5739 (LF5739) Station Assignment for a Representa-
tive Call Group

CM57 Y=39 Page B-53

L61 (LF61) External Key Function CM61 Page B-54

L62 (LF62) Tenants for Each ATT Group CM62 Page B-56

L63 (LF63) Restriction of Inter-Tenant Connection CM63 Page B-57

L64 (LF64) Automated Attendant, Tenant Number 
for Music on Hold, Number of Queue 
Limit, Trunk Access Code for Mobil-
ity Access Mode, ISDN Alternating 
Routing, Ring Frequency Pattern of 
DT500/DT900 and Access Code for 
Answering Representative Call Notifi-
cation

CM64 Page B-59

L65 (LF65) Services on Tenant Basis CM65 Page B-61

L720 (LF720) Calling Party Number CM72 Y=0 Page B-62

L722 (LF722) Calling Party Name CM72 Y=2 Page B-63

L740 (LF740) Stored Number for Speed Dialing 
(Calling Party Number)

CM74 Y=0 Page B-64
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* In case of specifying a List Command as LFXXX, the data other than [NONE] is listed.

Continued on next page

Name of Extended 
Commands

Functions
Commands to 

be used
Reference 

Page

L742 (LF742) Stored Number for Speed Dialing 
(Calling Party Name)

CM74 Y=2 Page B-65

L748 (LF748) Setting of the Illumination Color for 
Station Speed/System Speed Dialing

CM74 Y=8 Page B-66

L74A (LF74A) Setting of the Department No. for Sta-
tion Speed/System Speed Dialing

CM74 Y=A Page B-67

L76 (LF76) Digit Conversion on DID Call CM76 Page B-68

L76B (LF76B) Digit Conversion on DID Call CM76 Page B-69

L77 (LF77) Station Name Assignment with Char-
acter

CM77 Page B-70

L77F (LF77F) Setting of the Department Name CM77 Y=F Page B-71

L7714 (LF7714) Group Name for a Representative Call
Notification

CM77 Y=14 Page B-72

L78 (LF78) Destination of Split Call Forwarding CM78 Page B-73

L81 (LF81) Toll Restriction Pattern on Each Trunk 
Restriction Class

CM81 Y=01-13 Page B-74

L812 (LF812) Scam Call Prevention CM81 Y=20-22, 
29

Page B-75

L85NUM Maximum Number of Sending Digits CM85 Page B-77

L8A0 (LF8A0) LCR/Toll Restriction Development 
Table Route Pattern

CM8A Y=0000-
0255

Page B-78

L8A1 (LF8A1) LCR/Toll Restriction Development 
Table Tenant Pattern

CM8A Y=1000-
1015

Page B-79

L8A2 (LF8A2) LCR/Toll Restriction Development 
Table Time Pattern

CM8A Y=2000-
2007

Page B-80

L8A3 (LF8A3) LCR/Toll Restriction Development 
Table Date Pattern

CM8A Y=3000-
3003

Page B-81

L8A4 (LF8A4) LCR/Toll Restriction Development 
Pattern

CM8A Y=4000-
4007

Page B-82
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* In case of specifying a List Command as LFXXX, the data other than [NONE] is listed.

Continued on next page

Name of Extended 
Commands

Functions
Commands to 

be used
Reference 

Page

L8A5 (LF8A5) LCR/Toll Restriction Development 
Table LCR/TR Pattern

CM8A Y=5000-
5255

Page B-83

L8A9 (LF8A9) LCR/Toll Restriction Development 
Table Digit Addition Pattern

CM8A Y=9000-
9255

Page B-84

L90 (LF90) Multiline Terminal Key Assignment CM90 Page B-85

L9000 (LF9000) Function Settings of Multiline Termi-
nal Keys

CM90 Y=00 Page B-88

L9010 (LF9010) Key Setting of Programmable Pattern 
1

CM90 Y=10 Page B-90

L9B0 (LF9B0) Event Occurrence Notice Button 
Assignment

CM9B Y=0 Page B-90

LA7 (LFA7) CCIS Channel Data 1 CMA7 Page B-92

LB00 (LFB00) PEG Count 1 Data for Trunk Route CMB0 Y=0 Page B-93

LB04 (LFB04) PEG Count 1 Data for ZT CMB0 Y=4 Page B-95

LB11 (LFB11) Incoming Trunk Traffic Data CMB1 Y=1 Page B-98

LB12 (LFB12) Outgoing Trunk Traffic Data CMB1 Y=2 Page B-99

LB13 (LFB13) Incoming Trunk Route Traffic Data CMB1 Y=3 Page B-100

LB14 (LFB14) Outgoing Trunk Route Traffic Data CMB1 Y=4 Page B-101

LB19 (LFB19) Traffic Data of ZT CMB1 Y=9 Page B-102

LB1A (LFB1A) Percentage of ZT B Channel All Busy CMB1 Y=A Page B-103

LB4 (LFB4) PEG COUNT of IP Network CMB4 Page B-104

LBA (LFBA) SIP Profile Data CMBA Page B-105

LD72 (LFD72) OAI Control Data CMD7 Y=2 Page B-106

LE51 (LFE51) Trunk Line Make Busy CME5 Y=1 Page B-107

LE53 (LFE53) ZT Make Busy CME5 Y=3 Page B-108

LE55 (LFE55) Station, Trunk Line Make Busy CME5 Y=5 Page B-109
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Name of Extended 
Commands

Functions
Commands to 

be used
Reference 

Page

LE6  (LFE6) Call Forwarding Set/Reset from 
PCPro/CAT

CME6 Page B-110

LECE (LFECE) Call History of Malicious Call List Set 
by a User Operation

CMEC Y=E Page B-111

LLEN Reading of Terminal (Tenant Group 
Number/Trunk No./ZT No.) Regis-
tered in System

CM05
CM10
CM11

Page B-112

LLIC Software License Data Read CMF8 Y=9 Page B-115

LKEY Software Key Code Read CMF8 Y=A Page B-116

LCARD Firmware Information Read CME8 Y=0 Page B-117

LPICK Listing of Station Numbers for Call 
Pickup Group

CM16 Y=0 Page B-118

LUCD Listing of Station Numbers for UCD 
Group

CMF5 Y=5
CM17 Y=0-2

Page B-120

LHUNT Listing of Station Numbers for Station 
Hunting Group

CMF5 Y=5
CM18 Y=0, 1

Page B-121

LPICK2 The Number of Call Pickup Groups 
and Listing of Station Numbers

CM16 Y=0 Page B-124

LUCD2 The Number of UCD Groups and List-
ing of Station Numbers

CM17 Y=0-2 Page B-127

LHUNT2 The Number of Station Hunting 
Groups and Listing of Station Num-
bers

CM18 Y=0, 1 Page B-131
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<List of List Commands (for Functions)>

Name of extended 
commands

Functions
Reference 

Page

! Reset of System (With F-ROM Backup) Page B-135

!+ Reset of System (Without F-ROM Backup) Page B-135

@WAIT Wait during the Specified Time Page B-136

@TIME Setting of System Date/Time Page B-137

@FAULT Firmware Information Read Page B-138

@SAVE Saving System Data Page B-141

@LOAD Loading System Data Page B-143

@VFY Verifying System Data Page B-144

@B601 Reading the VoIP Packet Statistics between 
locations

Page B-145

@ECE Call History of Malicious Call List Set by a 
User Operation (Optimized to Excel)

Page B-148

@FD Refer to FD of the Script Line Executed Previ-
ously

Page B-149

@SD Refer to SD of the Script Line Executed Previ-
ously

Page B-150

@STN (for CMDYY) Listing of the Station Numbers When Using 
CMDYY

Page B-152

@STN (for FD) Listing of the Station Numbers When Using 
FD

Page B-155

LSTN Reading the Number of Registration for Each 
Kind of Station

Page B-158

MS FD Step Page B-160

MSYY YY Step Page B-161
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Using List Commands (for System Data List)

The followings show how to use the list commands (for system data list) and its usage example.

NOTE: The list commands (for system data list) also output the unused commands which are not 
described in the “Command Manual”.

L04

This list command lists the setting of system services (Command to be used: CM04).

(1) Method
• Input

• Output

* For details of CM04 (such as the setting range and the meaning of Y No. and FD), refer to the
“Command Manual”.

(2) Example
• Input

• Output

CMD FD SD

L04 

CMD FD SD ED

04YY Data 1 Setting data

CMD FD SD

L04 

CMD FD SD ED

0400 00 01

0400 02 NONE

... ... ... ...
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L05

This list command lists the Blade Type, Trunk Blade number and Highway Channel for ISDN data com-
munication (Command to be used: CM05).

(1) Method
• Input

* If the FD field is omitted, all Unit numbers (01-50) are read.

• Output

* The Trunk Blade number (CM05 Y=1) reads the Unit No. and Slot No. to which the Blade Type
(CM05 Y=0) is registered.

CMD FD SD

L05 Unit No. (01-50)

CMD FD SD ED

050 XXZZ
XX: Unit No. (01-50)
ZZ : Slot No. (01-18)

Blade Type

051 XXZZ
XX: Unit No. (01-50)
ZZ : Slot No. (01-18)

Trunk Blade No. 
(000-127)

052 XXZZ
XX: Unit No. (01-50)
ZZ : 2U No. (01-03)

Number of Highway 
Channel for ISDN 
data communication
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(2) Example
• Input

• Output

L08

This list command lists the basic services (Command to be used: CM08).

(1) Method
• Input

* L08 reads all basic services.

• Output

* For details of CM08, refer to the “Command Manual”.

CMD FD SD

L05 

CMD FD SD ED

050 0101 10

050 0102 20

 

050 5018 NONE

051 0101 000

051 0102 001

052 0101 NONE

052 5003 NONE

CMD FD SD

L08 

CMD FD SD ED

L08 Basic Services No. Setting data

... ... ...

... ... ...
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(2) Example
• Input

• Output

L0B

This list command lists the LAN data assignment (Command to be used: CM0B).

(1) Method
• Input

• Output

* For details of CM0B, refer to the “Command Manual”.

CMD FD SD

L08 

CMD FD SD ED

08 011 0

08 012 1

CMD FD SD

L0B 

CMD FD SD ED

0B000 90 Unit No. (01-50)

0B0YY
YY: 01-50 

XX-XXX Maintenance Port

0B1YY
YY: 01-50 

XX-XXX VOIP Port

0B2YY
YY: 01-50 

XX-XXX VOIP Port (RTP)

... ... ...
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(2) Example
• Input

• Output

CMD FD SD

L0B 

CMD FD SD ED

0B000 90 01

0B001 00 192.168.1.2

0B002 00 192.168.1.3

0B050 00 NONE

0B101 00 172.16.1.11

0B150 00 NONE

0B201 00 172.16.1.12

0B250 00 NONE

... ... ...

... ...

... ...

... ...

... ...

... ...

... ...
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L0D00

This list command lists the Routing Table assignment (Command to be used: CM0D Y=00).

(1) Method
• Input

• Output

* For details of CM0D, refer to the “Command Manual”.

(2) Example
• Input

• Output

CMD FD SD

L0D00

CMD FD SD ED

0D00 01XX
XX: Entry No.

(00-19)

Routing table assign-
ment

CMD FD SD

L0D00

CMD FD SD ED

0D00 0100 0/10.41.208.0/255.255.255.0/10.41.207.251/01

0D00 0101 0/10.41.209.0/255.255.255.0/10.41.207.252/01

0D00 0102 0/192.168.2.0/255.255.255.0/192.168.1.251/01

0D00 0103 0/192.168.3.0/255.255.255.0/192.168.1.252/01

0D00 0104 NONE

0D00 0119 NONE

... ... ... ...
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L0D01

This list command lists the Routing table status assignment (Command to be used: CM0D Y=01).

(1) Method
• Input

• Output

* For details of CM0D, refer to the “Command Manual”.

(2) Example
• Input

• Output

CMD FD SD

L0D01

CMD FD SD ED

0D01 01XX
XX: Entry No.

(00-19)

Routing table status 
assignment

Status (A/N)

CMD FD SD

L0D01

CMD FD SD ED

0D01 0100 0/10.41.208.0/255.255.255.0/10.41.207.251/01 A

0D01 0101 0/10.41.209.0/255.255.255.0/10.41.207.252/01 A

0D01 0102 0/192.168.2.0/255.255.255.0/192.168.1.251/01 A

0D01 0103 0/192.168.3.0/255.255.255.0/192.168.1.252/01 N

0D01 0104 NONE

0D01 0119 NONE

... ... ... ...
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L11

This list command lists the Virtual Line number/Intercom number (Command to be used: CM11).

(1) Method
• Input

* If the FD field is omitted, all Virtual Port No. (0000-0999) are read.

• Output

(2) Example
• Input

• Output

CMD FD SD

L11 Virtual Port No. 
(0000-0999)

CMD FD SD ED

11 Virtual Port No. 
(0000-0999)

Virtual Line No./
Intercom No.

CMD FD SD

L11  

CMD FD SD ED

11 0000 5000

11 0001 5002

11 0002 A000

11 0999 NONE

... ... ...
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L12

This list command lists the Station Class-1 (Command to be used: CM12).

(1) Method
• Input

* The FD field cannot be omitted.

• Output

* For details of CM12 (such as the setting range and the meaning of Y No.), refer to the “Com-
mand Manual”.

CMD FD SD

L12 X-XXXXXXXX: 
Station No.

XXXX: 
Automatic/Manual/
Dial Intercom No.

XXXX:
Loop Line No.

XXXX:
ICI/OPR Line No.

CMD FD SD ED

12YY X-XXXXXXXX: 
Station No.

Setting data

XXXX: 
Automatic/Manual/
Dial Intercom No.

XXXX:
Loop Line No.

XXXX:
ICI/OPR Line No.



Appendix B List Command

B-18 NWA-088656-001 Rev.8.0

(2) Example
• Input

• Output

L13

This list command lists the Station Class-2 (Command to be used: CM13).

(1) Method
• Input

* The Station No. cannot be omitted.

• Output

* For details of CM13 (such as the setting range and the meaning of Y No.), refer to the “Com-
mand Manual”.

CMD FD SD

L12 200

CMD FD SD ED

1200 200 3

1201 200 11

 

CMD FD SD

L13 X-XXXXXXXX: 
Station No.

CMD FD SD ED

13YY X-XXXXXXXX: 
Station No.

Setting data (0/1)

... ... ...
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(2) Example
• Input

• Output

L15

This list command lists the Service Restriction Class (Command to be used: CM15).

(1) Method
• Input

* If the FD field is omitted, all Service Restriction Class A/B/C (00-15) and Charging Station
Class (00-15) are read.

• Output

* For details of CM15 (such as the setting range and the meaning of Y No.), refer to the “Com-
mand Manual”.

CMD FD SD

L13 200

CMD FD SD ED

1300 200 1

1301 200 1

CMD FD SD

L15 Service Restriction 
Class A/B/C (00-15) 
and Charging Station 
Class (00-15)

Setting data

CMD FD SD ED

15YYY Service Restriction 
Class A/B/C (00-15) 
and Charging Station 
Class (00-15)

Setting data

... ... ...



Appendix B List Command

B-20 NWA-088656-001 Rev.8.0

(2) Example
• Input

• Output

L16

This list command lists the Call Pickup Group/Group Diversion Group (Command to be used: CM16).

(1) Method
• Input

* The Station No. cannot be omitted.

• Output

* For details of CM16 (such as the setting range and the meaning of Y No.), refer to the “Com-
mand Manual”.

CMD FD SD

L15 

CMD FD SD ED

15000 00 1

15000 01 1

15000 15 NONE

15485 00 1

 

CMD FD SD

L16 X-XXXXXXXX: 
Station No.

CMD FD SD ED

16Y X-XXXXXXXX: 
Station No.

Setting data

... ... ...

... ...

... ...
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(2) Example
• Input

• Output

L17

This list command lists the ACD/UCD Group (Command to be used: CM17).

(1) Method
• Input

* The Station No. cannot be omitted.

• Output

* For details of CM17 (such as the setting range and the meaning of Y No.), refer to the “Com-
mand Manual”.

CMD FD SD

L16 100

CMD FD SD ED

160 100 NONE

162 100 NONE

168 100 1

16A 100 NONE

CMD FD SD

L17 X-XXXXXXXX: 
Station No.

CMD FD SD ED

17Y X-XXXXXXXX: 
Station No.

Setting data
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(2) Example
• Input

• Output

L18

This list command lists the Station Hunting Group (Command to be used: CM18).

(1) Method
• Input

* The Station No. cannot be omitted.

CMD FD SD

L17 100

CMD FD SD ED

170 100 NONE

171 100 0

172 100 NONE

174 100 1

175 100 1

176 100 1

177 100 1

17A 100 1

CMD FD SD

L18 X-XXXXXXXX: 
Station No.

... ... ...
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• Output

* For details of CM18 (such as the setting range and the meaning of Y No.), refer to the “Com-
mand Manual”.

(2) Example
• Input

• Output

CMD FD SD ED

18Y X-XXXXXXXX: 
Station No.

Setting data

CMD FD SD

L18 100

CMD FD SD ED

180 100 NONE

181 100 0

182 100 31

184 100 1

185 100 1

186 100 1

187 100 1
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L19

This list command lists the Secretary Serial number and Group Diversion Station number (Command
to be used: CM19).

(1) Method
• Input

• Output

* For details of CM19, refer to the “Command Manual”.

(2) Example
• Input

CMD FD SD

L19 

CMD FD SD ED

190 Secretary Station 
Serial No. (00-30)

X-XXXXXXXX:
Secretary station 
number

191 Secretary Hunting 
method (0, 5, 7)

192 Secretary Station 
Serial No. (00-31)

196 Group Diversion No. 
(00-30)

X-XXXXXXXX:
Transferred Station 
No.

CMD FD SD

L19 
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• Output

L1B

This list command lists the ISDN Telephone multipoint station number (Command to be used: CM1B).

(1) Method
• Input

* The ISDN Line Station No. cannot be omitted.

CMD FD SD ED

190 00 NONE

190 30 NONE

191 00 0

191 30 0

192 00 31

192 30 31

196 00 NONE

196 30 NONE

CMD FD SD

L1B ISDN Line Station 
No. (1-8 digits)

... ...

... ...

... ...

... ...
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• Output

(2) Example
• Input

• Output

L1D

This list command lists the PS-ID assignment and the PS/Standard SIP station operation data to down-
load (Command to be used: CM1D).

(1) Method
• Input

* The PS/Standard SIP Station No. cannot be omitted.

CMD FD SD ED

1B X-XXXXXXXX, Z
X-XXXXXXXX:
ISDN Line Station 
No. assigned by 
CM10 Y=00
Z: ISDN Multipoint 

No. (0-7)

X-XXXXXXXX:
ISDN Telephone mul-
tipoint station No.

CMD FD SD

L1B 6000

CMD FD SD ED

1B 6000,0 7000

1B 6000,1 7001

1B 6000,7 NONE

CMD FD SD

L1D X-XXXXXXXX:
PS/Standard SIP 
Station No.

... ... ...
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• Output

* For details of CM1D (such as the setting range and the meaning of Y No.), refer to the “Com-
mand Manual”.

(2) Example
• Input

• Output

L20

This list command lists the Numbering Plan (Command to be used: CM20).

(1) Method
• Input

* If the FD field is omitted, all Numbering Plan Groups (0-3) are read.

• Output

* The meaning of setting data set as an Access Code is displayed in the MESSAGE field.

CMD FD SD ED

1DYY X-XXXXXXXX:
PS Station No.

Setting data

CMD FD SD

L1D 100

CMD FD SD ED

1D01 100 100

CMD FD SD

L20 Numbering Plan 
Group (0-3)

CMD FD SD ED

20x Station No./Access 
Code

Setting data

... ... ...
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(2) Example
• Input

• Output

L22

This list command lists the Route Advance (Command to be used: CM22).

(1) Method
• Input

• Output

* For details of CM22, refer to the “Command Manual”.

CMD FD SD

L20 0

CMD FD SD ED MESSAGE

200 0 300 Tenant Block 00

200 1 NONE

200 2 804 4 digits Station

200 3 804 4 digits Station

200 4 804 4 digits Station

200 50 A059 Trunk Answer

200 

CMD FD SD

L22 

CMD FD SD ED

22YY
YY: Route Advance

 Block (00-31)

Priority Order
(0/1/2/3)

Setting data

... ... ... ...
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(2) Example
• Input

• Output

L23

This list command lists the tenant development (Command to be used: CM23).

(1) Method
• Input

* If the FD field is omitted, all Tenant numbers (00-63) are read.

• Output

* For details of CM23, refer to the “Command Manual”.

CMD FD SD

L22 

CMD FD SD ED

2200 0 100

2200 1 101

2200 2 NONE

2200 3 NONE

2201 0 NONE

2231 3 NONE

CMD FD SD

L23 Tenant No. (00-63)

CMD FD SD ED

23YY
YY: Tenant Block 

(00-23) 

Tenant No. (00-63) Setting data

... ...
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(2) Example
• Input

• Output

L25

This list command lists the kind of special terminal development (Command to be used: CM25).

(1) Method
• Input

* If the FD field is omitted, all kind of Special Terminal Block numbers (00-15) are read.

• Output

* For details of CM25, refer to the “Command Manual”.

CMD FD SD

L23 

CMD FD SD ED

2300 00 NONE

2300 01 101

2300 63 NONE

2301 00 NONE

2323 63 NONE

CMD FD SD

L25 Kind of Special Ter-
minal Block (00-15)

CMD FD SD ED

25YY
YY: Kind of Special

Terminal Block
 (00-15)

Kind of Special Ter-
minal (0-4)

Setting data

... ... ...

... ...
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(2) Example
• Input

• Output

L29

This list command lists the Numbering Plan Tenant group (Command to be used: CM29).

(1) Method
• Input

• Output

CMD FD SD

L25 

CMD FD SD ED

2500 0 100

2500 1 NONE

2500 4 NONE

2501 0 NONE

2515 4 NONE

CMD FD SD

L29 

CMD FD SD ED

29 Tenant No. (00-63) Numbering Plan 
Group (710-713)

... ... ...

... ...
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(2) Example
• Input

• Output

L2A

This list command lists the ID Code Pattern number for Remote Access to System (DISA) (Command
to be used: CM2A).

(1) Method
• Input

* If the FD field is omitted, all ID Code Development numbers (00-09) are read.

• Output

CMD FD SD

L29 

CMD FD SD ED

29 00 710

29 01 NONE

29 63 NONE

CMD FD SD

L2A ID Code Develop-
ment No. (00-09)

CMD FD SD ED

2A0x ID Code ID Code Pattern No.

... ... ...
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(2) Example
• Input

• Output

L2A5

This list command lists the Development Block number for Calling Party Number (Command to be
used: CM2A Y=5x).

(1) Method
• Input

* If the FD field is omitted, all Development Pattern numbers (0-2) are read.

• Output

CMD FD SD

L2A 0

CMD FD SD ED

2A00 0 NONE

2A00 1 NONE

2A00 2 NONE

2A00 3 NONE

2A00 4 NONE

2A00 

CMD FD SD

L2A5 Development Pattern 
No. (0-2)

CMD FD SD ED

2A5x Calling Party No. Development Block 
No. assigned by 
CM76

... ... ...
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(2) Example
• Input

• Output

L2B

This list command lists the Authorization Code per station/IP Station password/Station Digests Authen-
tication password/Standard SIP station registration password/VoIP encryption password assignment
(Command to be used: CM2B).

(1) Method
• Input

* The Station No. cannot be omitted.

• Output

* For details of CM2B (such as the setting range and the meaning of Y No.), refer to the “Com-
mand Manual”.

CMD FD SD

L2A5 0

CMD FD SD ED

2A50 0 NONE

2A50 1 000

2A50 2 002

2A50 3 NONE

2A50 4 NONE

2A50 

CMD FD SD

L2B X-XXXXXXXX: 
Station No.

CMD FD SD ED

2BYY X-XXXXXXXX: 
Station No.

Setting data

... ... ...
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(2) Example
• Input

• Output

L30

This list command lists the trunk data (Command to be used: CM30).

(1) Method
• Input

* If the FD field is omitted, all Trunk numbers (000-511) are read.

• Output

*1 For details of CM30 (such as the setting range and the meaning of Y No.), refer to the “Com-
mand Manual”.

*2 If the Trunk No. not assigned to the system is entered, “TRK NOT ASSIGNED” is displayed
in the ED field.

CMD FD SD

L2B 301

CMD FD SD ED

2B00 301 NONE

2B01 301 1

2B02 301 15

2B03 301 15

2B04 301 15

CMD FD SD

L30 Trunk No. (000-511)

CMD FD SD ED

30YY Trunk No. (000-511) Setting data
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(2) Example
• Input

• Output

L35

This list command lists the Trunk Route data (Command to be used: CM35).

(1) Method
• Input

* If the FD field is omitted, all Trunk Route numbers (00-63) are read.

• Output

* For details of CM35 (such as the setting range and the meaning of Y No.), refer to the “Com-
mand Manual”.

CMD FD SD

L30 

CMD FD SD ED

3000 000 01

3000 001 01

3000 511 TRK NOT 
ASSIGNED

CMD FD SD

L35 Trunk Route No. 
(00-63)

CMD FD SD ED

35YYY Trunk Route No. 
(00-63)

Setting data

... ... ...

... ...
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(2) Example
• Input

• Output

L36

This list command lists the restriction data/PAD data for tandem connection (Command to be used:
CM36).

(1) Method
• Input

* If the FD field is omitted, all Outgoing Trunk Routes (00-63) are read.

• Output

* For details of CM36, refer to the “Command Manual”.

CMD FD SD

L35 

CMD FD SD ED

35000 00 15

35000 63 15

CMD FD SD

L36 Outgoing Trunk 
Route (00-63)

CMD FD SD ED

360 XXZZ
XX: Incoming Trunk 

Route (00-63)
ZZ : Outgoing Trunk 

Route (00-63)

Setting data

361

... ... ...

... ... ...
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(2) Example
• Input

• Output

L40

This list command lists the function of CPU RS-232C port (Command to be used: CM40).

(1) Method
• Input

CMD FD SD

L36 

CMD FD SD ED

360 0000 1

360 0063

360 0100 1

360 6363 NONE

361 0000 1

361 0063 NONE

361 0100 NONE

361 6363 NONE

CMD FD SD

L40 

... ... ...

... ... ...

... ... ...

... ... ...
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• Output

* For details of CM40, refer to the “Command Manual”.

(2) Example
• Input

• Output

CMD FD SD ED

40YY
YY: 00-09

Port Location No. 
(0-7/A/B)

CPU RS-232C port 
for PCPro/VoIP Log 
Collection/Built-in 
SMDR/MCI

4010 Port Location No.
(1 fixed)

X-XXXXXXXX:
Built-in Modem No.

4013 Port Location No. 
(0/1)

0: High
1: Low

4030 Port Location No. (0) Connection port

CMD FD SD

L40  

CMD FD SD ED

4000 0 8

4000 7 NONE

4001 0 10

4009 7 NONE

4010 1 3999

4013 1 1

... ... ...

... ... ...

... ... ...
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L41

This list command lists the function of System Timer data (Command to be used: CM41).

(1) Method
• Input

• Output

* For details of CM41, refer to the “Command Manual”.

(2) Example
• Input

• Output

CMD FD SD

L41

CMD FD SD ED

41Y
Y: 0-3

XX-XXX: 
Timer Type

Setting data

CMD FD SD

L41 

CMD FD SD ED

410 00 01 410

410 01 01 410

... ... ...
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L42

This list command lists the System Counter data/PAD data/Trunk Restriction Class conversion/CODEC
list (Command to be used: CM42).

(1) Method
• Input

• Output

* For details of CM42, refer to the “Command Manual”.

(2) Example
• Input

• Output

CMD FD SD

L42 

CMD FD SD ED

42 Data (XX-XXX) Setting data

CMD FD SD

L42 

CMD FD SD ED

42 00 01

42 01 06

... ... ...
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L43

This list command lists the periodic maintenance/IP Station firmware automatic update/system data
copy/automatic clock change (Command to be used: CM43).

(1) Method
• Input

• Output

CMD FD SD

L43

CMD FD SD ED

432 Periodic maintenance 
(00-07)

Setting data

433 Periodic maintenance 
(00-07)

435 Regular backup time 
(00)

436 IP Station firmware 
automatic update time 
(00)

437 System data copy 
(00)

438 Time setting for auto-
matic clock change 
from standard time to 
daylight-saving time 
(00) (for change pat-
tern 0) 

Time setting for auto-
matic clock change 
from daylight-saving 
time to standard time 
(01) (for change pat-
tern 0)

Continued on next page
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CMD FD SD ED

438 Reading of system 
clock changed day 
from standard time to 
daylight-saving time 
(02) 
(for change pattern 0)

Setting data

Reading of system 
clock changed day 
from daylight-saving 
time to standard time 
(03) (for change pat-
tern 0)

Time setting for auto-
matic system clock 
change from standard 
time to daylight-sav-
ing time (04) (for 
change pattern 1)

Time setting for auto-
matic system clock 
change from daylight-
saving time to stan-
dard time (05) (for 
change pattern 1)

Reading of system 
clock changed day 
from standard time to 
daylight-saving time 
(06) (for change pat-
tern 1)

Continued on next page
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* For details of CM43, refer to the “Command Manual”.

(2) Example
• Input

• Output

L44

This list command lists the external relay starting conditions (Command to be used: CM44).

(1) Method
• Input

CMD FD SD ED

438 Reading of system 
clock changed day 
from daylight-saving 
time to standard time 
(07) (for change pat-
tern 1)

Setting data

CMD FD SD

L43 

CMD FD SD ED

432 00 2009030510

432 01 2008120115

 

438 07 NONE

CMD FD SD

L44 

... ... ...
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• Output

* For details of CM44, refer to the “Command Manual”.

(2) Example
• Input

• Output

CMD FD SD ED

4400 XXZ
XX: Relay Group 

Number (00-31)
Z : Circuit Number 

(0-3)
312, 313: 
External Relay Inter-
face of CPU blade

Setting data

4401 XX: Relay Group 
Number (00-31)

CMD FD SD

L44 

CMD FD SD ED

4400 000 0100

4400 003 NONE

4400 010 NONE

4400 313 NONE

4401 00 NONE

4401 31 NONE

... ... ...

... ... ...

... ... ...
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L45

This list command lists the make busy condition of built-in CFT on CPU/DTMF receiver detect level
(Command to be used: CM45).

(1) Method
• Input

• Output

Continued on next page

CMD FD SD

L45 

CMD FD SD ED

456 Built-in CFT circuit 
number (00-15)

Make busy condition 
of built-in CFT (0/1)

45B X 00: Receiver start 
delay time

X: Receiver Type 
(0-2)

Setting data

X 01: DTMF receiver 
detect level

X: Receiver Type
(0-2)

X 02: Forward signal 
receiver mini-
mum detect 
level (For 
Detect Level 0/
1/2/3/4/5/6)

X: Receiver Type
(0-2)
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* For details of CM45, refer to the “Command Manual”.

(2) Example
• Input

CMD FD SD ED

45B X 03: DTMF receiver 
maximum 
detect level 
(For Detect 
Level 0/1/2/3/
4/5/6)

X: Receiver Type 
(0-2)

Setting data

X 04: DTMF receiver 
twist Level 
(Forward)

X: Receiver Type 
(0-2)

X 05: DTMF receiver 
twist Level 
(Backward)

X: Receiver Type 
(0-2)

X 06: DTMF receiver 
ON detect time

X: Receiver Type 
(0-2)

X 07: DTMF receiver 
OFF detect 
time

X: Receiver Type 
(0-2)

CMD FD SD

L45
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• Output

L48

This list command lists the Hold/Wake Up/Timed Reminder/Automated Attendant tone (Command to
be used: CM48).

(1) Method
• Input

• Output

* For details of CM48, refer to the “Command Manual”.

(2) Example
• Input

• Output

CMD FD SD ED

456 00 1

456 01 1

CMD FD SD

L48 

CMD FD SD ED

48X XX-XXXX: 
Sending Pattern

Setting data

CMD FD SD

L48 

CMD FD SD ED

480 00 1400

480 01 1400

488 50 NONE

... ... ...

... ...
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L4B

This list command lists the room status code (Command to be used: CM4B).

(1) Method
• Input

* If the FD field is omitted, all Room status code (1-8) are read.

• Output

(2) Example
• Input

• Output

CMD FD SD

L4B Room status code 
(1-8)

CMD FD SD ED

4B00 Room status code
(1-8)

Setting data

CMD FD SD

L4B

CMD FD SD ED

4B00 100 1

4B00 101 1

4B00 107 4

4B00 201 NONE

4B00 807 3

... ... ...

... ... ...
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L50

This list command lists the common route indial (Command to be used: CM50).

(1) Method
• Input

• Output

* For details of CM50, refer to the “Command Manual”.

(2) Example
• Input

• Output

CMD FD SD

L50 

CMD FD SD ED

50YY
YY: 00-05, 07-16

Kind of data Setting data

CMD FD SD

L50 

CMD FD SD ED

5000 0 99

5000 1 NONE

... ... ...
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L5737

This list command lists member stations of One-Touch Group Messaging Groups (Command to be
used: CM57 Y=37).

(1) Method
• Input

* If the FD field is omitted, all group numbers (Group No. 00 to 63) are read.

• Output

(2) Example
• Input

• Output

CMD FD SD

L5737 Group No. (00-63) 

CMD FD SD ED

5737 Group No. (00-63) + 
Serial No. within the 
group

Setting data

CMD FD SD

L5737 

CMD FD SD ED

5737 0000 2000

5737 0100 NONE

5737 6300 NONE

5737 0001 NONE

5737 0101 NONE

5737 6307 NONE

... ... ...

... ... ...
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L5738

This list command lists the group messaging pattern by access code dialing for One-Touch Group Mes-
saging (Command to be used: CM57 Y=38).

(1) Method
• Input

* If the FD field is omitted, all pattern numbers (Pattern No. 000 to 249) are read.

• Output

(2) Example
• Input

• Output

CMD FD SD

L5738 Pattern No. (000-249)

CMD FD SD ED

5738 Pattern No. XXZZ
XX: Group No. 

(00-63)
ZZ : Message No. 

(00-63)

CMD FD SD

L5738

CMD FD SD ED

5738 000 0000

5738 001 NONE

5738 002 NONE

5738 249 NONE

... ... ...
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L5739

This list command lists the station numbers for serial numbers within the group for each group number
of a representative call group (Command to be used: CM57 Y=39).

(1) Method
• Input

* If the FD field is omitted, all group numbers (Group No. 000 to 127) are read.

• Output

(2) Example
• Input

• Output

CMD FD SD

L5739 Group No. (000-127)

CMD FD SD ED

5739 Group No. (000-127) 
+ Serial No. (00-63) 
within the group

Station No.

CMD FD SD

L5739

CMD FD SD ED

5739 00000 102

5739 00001 NONE

5739 00002 NONE

5739 12763 2000

... ... ...
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L61

This list command lists the external key functions (Command to be used: CM61).

(1) Method
• Input

* If the FD field is omitted, all Key Group numbers (00-63) are read.

• Output

* For details of CM61, refer to the “Command Manual”.
(2) Example

• Input

CMD FD SD

L61 Key Group No.
(00-63)

CMD FD SD ED

61YY
YY: 00, 01, 03, 05, 

06, 08

XXZ
XX: Key Group No. 

(00-63)
Z : Circuit No. (0/1)

Setting data

6130 XXZ
XX: Key Group No. 

(00-63)
Z : Circuit No. (0/1)

CMD FD SD

L61 
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• Output

CMD FD SD ED

6100 000 NONE

6100 001 NONE

6100 010 00

6100 631 NONE

6101 000 NONE

... ... ...

... ... ...
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L62

This list command lists the tenants for each ATT group (Command to be used: CM62).

(1) Method
• Input

* If the FD field is omitted, all Tenant numbers (00-63) are read.

• Output

* For details of CM63, refer to the “Command Manual”.

(2) Example
• Input

• Output

CMD FD SD

L62 Tenant No. (00-63)

CMD FD SD ED

62Y
Y: ATT Group (0-3)

Tenant No. (00-63) Setting data

CMD FD SD

L62 

CMD FD SD ED

620 00 1

620 01 1

620 63 1

621 00 1

623 63 1

... ... ...

... ... ...
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L63

This list command lists the restriction of inter-tenant connection (Command to be used: CM63).

(1) Method
• Input

• Output

* For details of CM63, refer to the “Command Manual”.

CMD FD SD

L63

CMD FD SD ED

630 XXZZ:
XX: Tenant No.of 

TAS (00-63)
ZZ : Tenant No. of 

trunk (00-63)

Setting data

631 XXZZ:
XX: Tenant No. of 

calling station 
(00-63)

ZZ : Tenant No. of 
called station 
(00-63)

632 XXZZ:
XX: Tenant No. of 

called station 
(00-63)

ZZ : Tenant No.of 
trunk (00-63)
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(2) Example
• Input

• Output

CMD FD SD

L63 

CMD FD SD ED

630 0000 1

630 0001 1

630 0063 1

630 0100 1

630 6363 1

631 0000 1

632 6363 1

... ... ...

... ... ...

... ... ...
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L64

This list command lists the Automated Attendant, Tenant number for Music on Hold, number of Queue
Limit, Trunk Access Code for Mobility Access mode, ISDN Alternating Routing, Ring Frequency Pat-
tern of DT500/DT900 and Access Code for Answering Representative Call Notification (Command to
be used: CM64).

(1) Method
• Input

* If the FD field is omitted, all Tenant numbers (00-63) are read.

• Output

* For details of CM64, refer to the “Command Manual”.

(2) Example
• Input

CMD FD SD

L64 Tenant No. (00-63)

CMD FD SD ED

64Y/YY
Y/YY: 0-6, 10-17, 20-

28

Tenant No. (00-63) Setting data

CMD FD SD

L64 
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• Output

CMD FD SD ED

640 00 03

640 01 03

640 63 03

641 00 NONE

6428 63 1234

... ... ...

... ... ...
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L65

This list command lists the services on tenant basis (Command to be used: CM65).

(1) Method
• Input

* If the FD field is omitted, all Tenant numbers (00-63) are read.

• Output

* For details of CM65, refer to the “Command Manual”.

(2) Example
• Input

• Output

CMD FD SD

L65 Tenant No. (00-63)

CMD FD SD ED

65YY
YY: 19-100

Tenant No. (00-63) Setting data

CMD FD SD

L65 

CMD FD SD ED

6519 00 1

6500 01 1

6500 63 1

6523 00 1

... ...

... ...
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L720

This list command lists the stored number for System Speed Dialing (Calling Party number)/(Command
to be used: CM72 Y=0).

(1) Method
• Input

* If the FD field is omitted, all Memory Slot numbers (000-299) are read.

• Output

(2) Example
• Input

• Output

CMD FD SD

L720 First digit of Mem-
ory Slot No. (0-2)

CMD FD SD ED

720 Memory Slot No. 
(000-299)

Calling Party No.

CMD FD SD

L720 0

CMD FD SD ED

720 000 4000

720 001 0,4001

720 002 NONE

 

720 099 NONE

... ...
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L722

This list command lists the stored number for System Speed Dialing (Calling Party Name)/(Command
to be used: CM72 Y=2).

(1) Method
• Input

* If the FD field is omitted, all Memory Slot numbers (000-299) are read.

• Output

(2) Example
• Input

• Output

CMD FD SD

L722 First digit of Mem-
ory Slot No. (0-2)

CMD FD SD ED

722 Memory Slot number 
(000-299)

Calling Party Name

CMD FD SD

L722 0

CMD FD SD ED

722 000 ABC

722 001 123ABC

722 002 NONE

 

722 099 NONE

... ...
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L740

This list command lists the stored number for Station Speed Dialing (Calling Party No.)/(Command to
be used: CM74 Y=0).

(1) Method
• Input

* If the FD field is omitted, all block numbers (00000-99999) are read.

• Output

(2) Example
• Input

• Output

CMD FD SD

L740 1000-Slot Memory 
Block number 
(00-99)

CMD FD SD ED

740 Block number 
(00000-99999)

Calling Party Number

CMD FD SD

L740 00

CMD FD SD ED

740 00000 4000

740 00001 0,4001

740 00002 NONE

740 00999 NONE

... ...
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L742

This list command lists the stored number for Station Speed Dialing (Calling Party Name)/(Command
to be used: CM74 Y=2).

(1) Method
• Input

* If the FD field is omitted, all block numbers (00000-99999) are read.

• Output

(2) Example
• Input

• Output

CMD FD SD

L742 1000-Slot Memory 
Block number 
(00-99)

CMD FD SD ED

742 Block number 
(00000-99999)

Calling Party Name

CMD FD SD

L742 00

CMD FD SD ED

742 00000 ABCDE

742 00001 1234ABC

742 00002 NONE

 

742 00999 NONE

... ...
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L748

This list command lists the Illumination Color for Station Speed/System Speed Dialing (Command to
be used: CM74 Y=8).

(1) Method
• Input

* If the FD field is omitted, all block numbers (00000-99999) are read.

• Output

* For details of CM74 Y=8, refer to the “Command Manual”.

(2) Example
• Input

• Output

CMD FD SD

L748 1000-Slot Memory 
Block (No. 00-99)

CMD FD SD ED

748 Block number
(00000-99999)

Illumination Color
(0-7)

CMD FD SD

L748 00

CMD FD SD ED

748 00000

748 00001

748 00002 NONE

 

748 00999 NONE

... ...
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L74A

This list command lists the Department No. for Station Speed/System Speed Dialing (Command to be
used: CM74 Y=A).

(1) Method
• Input

* If the FD field is omitted, all block numbers (00000-99999) are read.

• Output

* For details of CM74 Y=A, refer to the “Command Manual”.

(2) Example
• Input

• Output

CMD FD SD

L74A 1000-Slot Memory 
Block (No. 00-99)

CMD FD SD ED

74A Block number
(00000-99999)

Department No.
(00-99)

CMD FD SD

L74A 00

CMD FD SD ED

74A 00000 00

74A 00001 01

74A 00002 NONE

 

74A 00999 NONE

... ... ...
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L76

This list command lists the Development Block number for DID Call (Command to be used: CM76).

(1) Method
• Input

* If the FD field is omitted, the Development Table No. 00 and 90 are read.

• Output

(2) Example
• Input

• Output

CMD FD SD

L76 Development Table 
No. (Y No.) (00, 90)

CMD FD SD ED

76xx DID Number Number Conversion 
Block No.

CMD FD SD

L76 00

CMD FD SD ED

7600 7111 000

7600 7112 020

7600 7113 000
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L76B

This list command lists the digit conversion on DID call (Command to be used: CM76).

(1) Method
• Input

* If the FD field is omitted, all Number Conversion Block numbers (000-999) are read.

• Output

* For details of CM76 (such as the setting range and the meaning of Y No.), refer to the “Com-
mand Manual”.

(2) Example
• Input

• Output

CMD FD SD

L76B Number Conversion 
Block No. (000-999)

CMD FD SD ED

76YY Number Conversion 
Block No. (000-999)

Setting data

CMD FD SD

L76B 

CMD FD SD ED

7601 000 100

7601 001 NONE

7601 999 NONE

7602 000 NONE

7641 999 NONE

... ... ...

... ... ...

... ... ...
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L77

This list command lists the Station Name assignment with character (Command to be used: CM77).

(1) Method
• Input

• Output

* For details of CM77, refer to the “Command Manual”.

(2) Example
• Input

• Output

CMD FD SD

L77 X-XXXXXXXX:
Station No.

CMD FD SD ED

771 X-XXXXXXXX:
Station No.

Name Display

CMD FD SD

L77 200

CMD FD SD ED

771 200 ABC
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L77F

This list command lists the Department Name to be used in User Web Portal (Command to be used:
CM77 Y=F).

(1) Method
• Input

• Output

* For details of CM77, refer to the “Command Manual”.

(2) Example
• Input

• Output

CMD FD SD

L77F

CMD FD SD ED

77F Department No.
(00-99)

Department Name

CMD FD SD

L77F

CMD FD SD ED

77F 00 General Affairs 
Department

77F 01 Sales Department

77F 02 NONE

77F 99 NONE

... ... ...
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L7714

This list command lists the Group Name for a Representative Call Notification (Command to be used:
CM77 Y=14).

(1) Method
• Input

• Output

(2) Example
• Input

• Output

CMD FD SD

L7714

CMD FD SD ED

7714 Representative Call 
Group No. (000-127)

Group Name

CMD FD SD

L7714

CMD FD SD ED

7714 000 Public Relations 
Department

7714 001 Contact for mainte-
nance

7714 002 NONE

7714 127 NONE

... ... ...



Appendix B List Command

B-73 NWA-088656-001 Rev.8.0

L78

This list command lists the destination of split call forwarding (Command to be used: CM78).

(1) Method
• Input

* If the FD field is omitted, all Tenant numbers (00-63) are read.

• Output

* For details of CM78, refer to the “Command Manual”.

(2) Example
• Input

• Output

CMD FD SD

L78 Tenant No. (00-63)

CMD FD SD ED

78 XXZ
XX: Tenant No. 

(00-63)
Z : Block No. (0-7)

Setting data

CMD FD SD

L78 

CMD FD SD ED

78 000 100

78 007 NONE

78 010 NONE

78 637 NONE

... ...

... ...
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L81

This list command lists the toll restriction pattern on each trunk restriction class (Command to be used:
CM81 Y=01-13).

(1) Method
• Input

• Output

(2) Example
• Input

• Output

CMD FD SD

L81 

CMD FD SD ED

81YY
YY: Toll Restriction 

Pattern number 
for each class 
(01-13)

X : Trunk restric-
tion class 
(1-8)

Setting data

CMD FD SD

L81 

CMD FD SD ED

8101 1 3

8101 2 3

8101 3 3

8113 1 3

8113 2 0

8113 8 0

... ...

... ...
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L812

This list command lists the scam call detection (Command to be used: CM81 Y=20-22, 29).

(1) Method
• Input

• Output

(2) Example
• Input

• Output

CMD FD SD

L812 

CMD FD SD ED

81YY
YY: Scam Call Pre-

vention 
(20-22, 29)

XX: Toll Restriction 
Pattern No. for 
each class 
(01-13, 15)

ZZ : Outgoing Trunk 
Route 
(00-63)

Setting data

CMD FD SD

L812 

CMD FD SD ED

8120 0100 3

8120 0101 3

8120 1563 3

8121 0100 01

Continued on next page

... ...

... ...
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8121 1563 10

8122 0100 01

CMD FD SD ED

... ...
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L85NUM

This list command lists the maximum number of sending digits (Command to be used: CM85).

(1) Method
• Input

* If the FD field is omitted, all Development Pattern numbers (0-7) are read.

• Output

(2) Example
• Input

• Output

CMD FD SD

L85NUM Development Pattern 
No.(0-7)

CMD FD SD ED

85x Area/Office Code or 
its part

Maximum number of 
sending digits

CMD FD SD

L85NUM 0

CMD FD SD ED

850 0 24

850 1 24

850 2 24

850 ... ... ...
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L8A0

This list command lists the LCR/TOLL Restriction Development Route Pattern (Command to be used:
CM8A Y=0000-0255).

(1) Method
• Input

* If the FD field is omitted, all Route Pattern numbers (000-255) are read.

• Output

* For details of CM8A Y=0000-0255, refer to the “Command Manual”.

(2) Example
• Input

• Output

CMD FD SD

L8A0 Route Pattern No. 
(000-255)

CMD FD SD ED

8A0YYY 
YYY: Route Pattern 

No. (000-255)

Pattern No. (0-4) Setting data

CMD FD SD

L8A0 

CMD FD SD ED

8A0000 0 0000

8A0000 1 NONE

 

8A0000 4 NONE

8A0001 0 NONE

8A0255 4 NONE

... ...

... ...



Appendix B List Command

B-79 NWA-088656-001 Rev.8.0

L8A1

This list command lists the LCR/TOLL Restriction Development Tenant Pattern (Command to be used:
CM8A Y=1000-1015).

(1) Method
• Input

* If the FD field is omitted, all Tenant Pattern numbers (00-15) are read.

• Output

* For details of CM8A Y=1000-1015, refer to the “Command Manual”.

(2) Example
• Input

• Output

CMD FD SD

L8A1 Tenant Pattern No. 
(00-15)

CMD FD SD ED

8A10YY 
YY: Tenant Pattern 

No. (00-15)

Tenant No. (00-63) Setting data

CMD FD SD

L8A1 

CMD FD SD ED

8A1000 00 0000

8A1000 01 NONE

 

8A1000 63 NONE

8A1001 00 NONE

8A1015 63 NONE

... ...

... ...
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L8A2

This list command lists the LCR/TOLL Restriction Development Time Pattern (Command to be used:
CM8A Y=2000-2007).

(1) Method
• Input

* If the FD field is omitted, all Time Pattern numbers (00-07) are read.

• Output

* For details of CM8A Y=2000-2007, refer to the “Command Manual”.

(2) Example
• Input

• Output

CMD FD SD

L8A2 Time Pattern No. 
(00-07)

CMD FD SD ED

8A20YY 
YY: Time Pattern 

No. (00-07)

HHMM
HH : Hours (00-23)
MM: Minutes (00/30)

Setting data

CMD FD SD

L8A2 

CMD FD SD ED

8A2000 0000 0000

8A2000 0030 NONE

 

8A2000 2330 NONE

8A2001 0000 NONE

8A2007 2330 NONE

... ...

... ...
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L8A3

This list command lists the LCR/TOLL Restriction Development Date Pattern (Command to be used:
CM8A Y=3000-3003).

(1) Method
• Input

* If the FD field is omitted, all Date Pattern numbers (00-03) are read.

• Output

* For details of CM8A Y=3000-3003, refer to the “Command Manual”.

(2) Example
• Input

• Output

CMD FD SD

L8A3 Date Pattern No. 
(00-03)

CMD FD SD ED

8A30YY 
YY: Date Pattern 

No. (00-03)

Week (0-6) Setting data

CMD FD SD

L8A3 

CMD FD SD ED

8A3000 0 0000

8A3000 1 NONE

 

8A3000 6 NONE

8A3001 0 NONE

8A3003 6 NONE

... ...

... ...
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L8A4

This list command lists the LCR/TOLL Restriction Development Pattern number (Command to be
used: CM8A).

(1) Method
• Input

* If the FD field is omitted, all Development Pattern numbers (0-7) are read.

• Output

(2) Example
• Input

• Output

CMD FD SD

L8A4 Development Pattern 
No. (0-7)

CMD FD SD ED

8A400x Area Code Pattern No.

CMD FD SD

L8A4 0

CMD FD SD ED

8A4000 0 NONE

8A4000 1 NONE

8A4000 2 NONE

8A4000 ... ... ...
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L8A5

This list command lists the LCR/TOLL Restriction Development LCR/TR Pattern (Command to be
used: CM8A Y=5000-5255).

(1) Method
• Input

* If the FD field is omitted, all LCR/TR Pattern No. (000-255) are read.

• Output

* For details of CM8A Y=5000-5255, refer to the “Command Manual”.

(2) Example
• Input

• Output

CMD FD SD

L8A5 LCR/TR Pattern No. 
(000-255)

CMD FD SD ED

8A5YYY
YYY: LCR/TR 

Pattern No. 
(000-255)

XXX: Pattern No. Setting data

CMD FD SD

L8A5 

CMD FD SD ED

8A5000 000 0000

8A5000 020 NONE

 

8A5001 000 NONE

... ...

... ...
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L8A9

This list command lists the LCR/TOLL Restriction Development Digit Addition Pattern (Command to
be used: CM8A Y=9000-9255).

(1) Method
• Input

* If the FD field is omitted, all Digit Addition Pattern numbers (000-255) are read.

• Output

* For details of CM8A Y=9000-9255, refer to the “Command Manual”.

(2) Example
• Input

CMD FD SD

L8A9 Digit Addition Pat-
tern No. (000-255)

CMD FD SD ED

8A9YYY
YYY: Digit Addition 

Pattern No. 
(000-255)

Entry of digit code to 
be added (0)

Setting data

CMD FD SD

L8A9 
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• Output

L90

This list command lists the multiline terminal key assignment (Command to be used: CM90).

(1) Method
• Input

* The My Line No. cannot be omitted.

• Output

*1 For details of CM90, refer to the “Command Manual”.
*2 The meaning of Multiline Terminal keys (CM90 Y=00) is displayed in the MESSAGE field. 

CMD FD SD ED

8A9000 0 001

8A9000 0 NONE

 

8A9000 0 NONE

8A9001 0 NONE

8A9255 0 NONE

CMD FD SD

L90 X-XXXXXXXX: 
My Line No.

CMD FD SD ED

90YY
YY: 00-05, 14

X-XXXXXXXX, ZZ
X-XXXXXXXX:
My Line No.
ZZ: Key No. (01-24, 

90-99)

Setting data

... ...

... ...
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(2) Example
• Input

• Output

Continued on next page

CMD FD SD

L90 200

CMD FD SD ED MESSAGE

9000 200,00 NONE

9000 200,24 NONE

9000 200,90 F1004 Hooking
(Transfer)

9000 200,99 NONE

9001 200,00 3

9001 200,24 3

9001 200,90 3

9001 200,99 3

9002 200,00 1

9002 200,24 1

9002 200,90 1

9002 200,99 1

9003 200,00 1

9003 200,24 1

9003 200,90 1

... ...

... ...

... ...

... ...

... ...

...

... ...
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CMD FD SD ED MESSAGE

9003 200,99 1

9004 200,00 1

9004 200,24 1

9004 200,90 1

9004 200,99 1

9005 200,00 1

9005 200,24 1

9005 200,90 1

9005 200,99 1

9014 200,00 NONE

9014 200,24 NONE

...

... ...

...

... ...

...

... ...
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L9000

This list command lists the function settings of Multiline Terminal keys. The meaning of functions is
displayed in the MESSAGE field (Command to be used: CM90 Y=00).

(1) Method
• Input

• Output

*1 For details of CM90, refer to the “Command Manual”.
*2 The meaning of Multiline Terminal keys (CM90 Y=00) is displayed in the MESSAGE field.

CMD FD SD

L9000 X-XXXXXXXX: 
My Line No.

CMD FD SD ED MESSAGE

9000 X-XXXXXXXX, ZZ
X-XXXXXXXX:
My Line No.
Z: Key No. (00-24, 

90-99)

Setting of func-
tions

Meaning of 
functions
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(2) Method
• Input

• Output

CMD FD SD

L90 @STN2

CMDYY FD SD ED MESSAGE

9000 3100,00 NONE

9000 3100,24 3100 Station No.3100

9000 3100,90 F1009 Hooking signal 
sent to outside 
(SHF)

9000 3100,99 NONE

9000 3101,00 3101 Station No. 3101

9000 3101,24 NONE

9000 3101,90 F1009 Hooking signal 
sent to outside 
(SHF)

9000 3101,99 NONE

... ...

... ...

... ...

... ...
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L9010

This list command lists the key setting of programmable pattern 1 (Command to be used: CM90 Y=10).

(1) Method
• Input

• Output

* For details of CM90 Y=10, refer to the “Command Manual”.

(2) Example
• Input

• Output

CMD FD SD

L9010 

CMD FD SD ED

9010 Key No. 
(01-24, 90-99)

Key setting of pro-
grammable pattern 1
(same as CM90 
Y=00)

CMD FD SD

L9010 

CMD FD SD ED

9010 00 1

9010 24 24

9010 90 F1004

9010 99 NONE

... ...

... ...
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L9B0

This list command lists the link down notice for CCIS/SIP trunk/Units to the Event Occurrence (Com-
mand to be used: CM9B Y=0).

(1) Method
• Input

• Output

CMD FD SD

L9B0 

CMD FD SD ED

9B0 XXZZ
XX: Event Occur-

rence Notice 
Button No. 
(01-64)

ZZ : link down notice 
for CCIS/SIP 
Trunk/Units 
(00-51)
00: Link down 
notice for CCIS
02-50: Link 
down notice for 
Units (except 
Main Unit)
51: Link down 
notice for SIP

Setting data (0/1)
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(2) Example
• Input

• Output

LA7

This list command lists the CCIS channel data 1 (Command to be used: CMA7).

(1) Method
• Input

* If the FD field is omitted, all CCIS Channel/IP trunk/SIP trunk No. (00-63) are read.

• Output

* For details of CMA7, refer to the “Command Manual”.

CMD FD SD

L9B0  

CMD FD SD ED

9B0 0100 1

9B0 0101 1

9B0 0051 1

9B0 0100 NONE

9B0 6451 NONE

CMD FD SD

LA7 CCIS Channel/IP
trunk/SIP trunk No.
(00-63)

CMD FD SD ED

A7YY CCIS Channel/IP
trunk/SIP trunk No.
(00-63)

Setting data

... ...

... ...
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(2) Example
• Input

• Output

LB00

This list command lists the PEG COUNT 1 data (such as number of outgoing trunk seizure/incoming
call seizure) for Trunk Route (Command to be used: CMB0).

(1) Method
• Input

* If the FD field is omitted, all Trunk Route numbers (00-63) are read.

CMD FD SD

LA7  

CMD FD SD ED

A700 00 001

A700 01 005

A700 63 001

A701 00 NONE

A781 63 7

CMD FD SD

LB00 Trunk Route No. 
(00-63)

... ... ...

... ... ...
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• Output

(2) Example
• Input

CMD FD SD ED

B00 Trunk status data 
(000-063)

Number of outgoing 
trunk seizure-Trunk 
Route

Trunk status data 
(100-163)

Number of incoming 
call seizure-Trunk 
Route

Trunk status data 
(200-263)

Number of times all 
trunks found to be 
busy trunk route

Trunk status data 
(500-563)

Number of incoming 
calls terminated to 
busy tone-Trunk 
Route

Trunk status data 
(600-663)

Number of unan-
swered incoming 
calls-Trunk Route

Trunk status data 
(700-763)

Number of register 
connection on trunk 
call-Trunk Route

CMD FD SD

LB00 
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• Output

LB04

This list command lists PEG COUNT 1 data (such as number of Call Origination/Call Termination) for
ZT (Command to be used: CMB0 Y=4).

(1) Method
• Input

* If the FD field is omitted, all ZT numbers (000-255) are read.

CMD FD SD ED

B00 000 0

B00 001 25

B00 063 1789

B00 100 10

B00 101 495

B00 763 0

CMD FD SD

LB04 ZT No. (000-255)

... ...

... ...
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• Output

CMD FD SD ED

B04 0XXX: Number of 
Call Origination
XXX: ZT No. 

(000-255)

PEG COUNT data 
(0000-4999)

1XXX: Number of 
Call Termination
XXX: ZT No. 

(000-255)

2XXX: Number of 
Location Registration
XXX: ZT No. 

(000-255)

3XXX: Number of 
Handover
XXX: ZT No. 

(000-255)

4XXX: Number of 
out of cell (zone)
XXX: ZT No. 

(000-255)



Appendix B List Command

B-97 NWA-088656-001 Rev.8.0

(2) Example
• Input

• Output

CMD FD SD

LB04 

CMD FD SD ED

B04 0000 00000

B04 0001 00020

B04 0255 49999

B04 1000 00123

B04 4255 49999

... ...

... ...
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LB11

This list command lists the incoming trunk traffic data (Command to be used: CMB1 Y=1).

(1) Method
• Input

* If the FD field is omitted, all Trunk numbers (000-511) are read.

• Output

(2) Example
• Input

• Output

CMD FD SD

LB11 Trunk No. (000-511)

CMD FD SD ED

B11 XXXZ
XXX: Trunk No. 

(000-511)
Z : Record No. 

(0-6)

XXXX: 
Incoming trunk traffic 
data

CMD FD SD

LB11 

CMD FD SD ED

B11 0000 0000

B11 0006 NONE

B11 5110 0000

B11 5116 ****

... ...

... ...

... ...
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LB12

This list command lists the outgoing trunk traffic data (Command to be used: CMB1 Y=2).

(1) Method
• Input

* If the FD field is omitted, all Trunk numbers (000-511) are read.

• Output

(2) Example
• Input

• Output

CMD FD SD

LB12 Trunk No. (000-511)

CMD FD SD ED

B12 XXXZ
XXX: Trunk No. 

(000-511)
Z : Record No. 

(0-6)

XXXX: 
Outgoing trunk traffic 
data

CMD FD SD

LB12 

CMD FD SD ED

B12 0000 0000

B12 0006 NONE

B12 5110 0000

B12 5116 ****

... ...

... ...

... ...
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LB13

This list command lists incoming trunk route traffic data (Command to be used: CMB1 Y=3).

(1) Method
• Input

* If the FD field is omitted, all Trunk Route numbers (00-63) are read.

• Output

(2) Example
• Input

• Output
1

CMD FD SD

LB13 Trunk Route No.
 (00-63)

CMD FD SD ED

B13 XXZ
XX: Trunk Route No. 

(00-63)
Z : Record No. 

(0-6)

XXXXXX:
Incoming trunk route 
traffic data

CMD FD SD

LB13

CMD FD SD ED

B13 000 000000

B13 006 NONE

B13 630 000000

B13 636 999999

... ...

... ...

... ...
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LB14

This list command lists the outgoing trunk route traffic data (Command to be used: CMB1 Y=4).

(1) Method
• Input

* If the FD field is omitted, all Trunk Route numbers (00-63) are read.

• Output

(2) Example
• Input

• Output

CMD FD SD

LB14 Trunk Route No. 
(00-63)

CMD FD SD ED

B14 XXZ
XX: Trunk Route No. 

(00-63)
Z : Record No. 

(0-6)

XXXXXX:
Outgoing trunk route 
traffic data

CMD FD SD

LB14 

CMD FD SD ED

B14 000 000000

B14 006 NONE

B14 630 000000

B14 636 999999

... ...

... ...

... ...
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LB19

This list command lists the traffic data of ZT (Command to be used: CMB1 Y=9).

(1) Method
• Input

* If the FD field is omitted, all ZT numbers (000-255) are read.

• Output

(2) Example
• Input

• Output

CMD FD SD

LB19 ZT No. (000-255)

CMD FD SD ED

B19 XXXZZ
XXX: ZT No. 

(000-255)
ZZ : Time Zone No. 

(00-24)

XXXX: Traffic data

CMD FD SD

LB19 

CMD FD SD ED

B19 00000 0000

B19 00024 NONE

B19 25500 0000

B19 25524 ****

... ...

... ...

... ...
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LB1A

This list command lists the percentage of ZT B channel all busy (Command to be used: CMB1 Y=A).

(1) Method
• Input

* If the FD field is omitted, all ZT numbers (000-255) are read.

• Output

(2) Example
• Input

• Output

CMD FD SD

LB1A ZT No. (000-255)

CMD FD SD ED

B1A XXXZZ
XXX: ZT No. 

(000-255)
ZZ : Time Zone No. 

(00-24)

XXX:
Percentage of B chan-
nel all busy data

CMD FD SD

LB1A 

CMD FD SD ED

B1A 00000 000

B1A 00024 NONE

B1A 25500 000

B1A 25524 ***

... ...

... ...

... ...
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LB4

This list command lists the PEG COUNT of IP network (Command to be used: CMB4).

(1) Method
• Input

* If the FD field is omitted, all location numbers of group to receive side (00-63) are read.

• Output

* For details of CMB4, refer to the “Command Manual”.

(2) Example
• Input

CMD FD SD

LB4 Location No. of 
group to receive side 
(00-63)

CMD FD SD ED

B4YY
YY: 00-03

XXZZ
XX: Location No.of 

group to send 
side (00-63)

ZZ : Location No. of 
group to receive 
side (00-63)

Setting data

CMD FD SD

LB4 
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• Output

LBA

This list command lists the SIP profile data (Command to be used: CMBA).

(1) Method
• Input

* If the FD field is omitted, all Profile numbers for control packet (00-31) are read.

• Output

* For details of CMBA (such as the setting range and the meaning of Y No.), refer to the “Com-
mand Manual”.

CMD FD SD ED

B400 0000 00000

B400 0001 00000

B400 0063 00000

B400 0100 00000

B400 6363 00000

B401 0000 00000

B403 6363 0000000

CMD FD SD

LBA Profile No. for con-
trol packet (00-63)

CMD FD SD ED

BAYY/YYY Profile No.for con-
trol packet (00-63)

SIP profile data

... ...

... ...

... ...
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(2) Example
• Input

• Output

LD72

This list command lists the OAI control data (Command to be used: CMD7 Y=2).

(1) Method
• Input

• Output

(2) Example
• Input

CMD FD SD

LBA 

CMD FD SD ED

BA04 00 15

BA04 01 15

BA04 63 15

BA10 00 NONE

CMD FD SD

LD72

CMD FD SD ED

D72 Message number 
(000-127)

Setting data

CMD FD SD

LD72

... ...

... ...

... ...
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• Output

LE51

This list command lists the trunk line make busy conditions (Command to be used: CME5 Y=1).

(1) Method
• Input

• Output

* If the Trunk No. not assigned to the system is entered, “TRK NOT ASSIGNED” is displayed
in the ED field.

(2) Example
• Input

CMD FD SD ED

D72 000 1000

D72 050 NONE

D72 127 1001

CMD FD SD

LE51 Trunk No. (000-511)

CMD FD SD ED

E51 Trunk No. (000-511) Setting data

CMD FD SD

LE51 

... ... ...

... ... ...
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• Output

LE53

This list command lists the ZT make busy conditions (Command to be used: CME5 Y=3).

(1) Method
• Input

• Output

* If the ZT No. not assigned to the system is entered, “DATA NOT FOUND” is displayed in the
ED field.

(2) Example
• Input

CMD FD SD ED

E51 000 TRK NOT 
ASSIGNED

E51 300 1

E51 511 TRK NOT 
ASSIGNED

CMD FD SD

LE53 ZT No. (000-255)

CMD FD SD ED

E53 ZT No. (000-255) Setting data

CMD FD SD

LE53 

... ... ...

... ... ...
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• Output

LE55

This list command lists the station, trunk line make busy conditions (Command to be used: CME5
Y=5).

(1) Method
• Input

* If the FD field is omitted, all Unit numbers (01-50) are read.

• Output

(2) Example
• Input

CMD FD SD ED

E53 000 DATA NOT FOUND

E53 001 1

E53 255 DATA NOT FOUND

CMD FD SD

LE55 Unit No. (01-50)

CMD FD SD ED

E55 XXZZZ
XX : Unit No. 

(01-50)
ZZZ: VoIPDB chan-

nel (001-128)

0: Make busy (forced)
1: Make idle
2: Make busy (after 

calls finished)

CMD FD SD

LE55 

... ... ...
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• Output

LE6

This list command lists the Call forwarding set/reset from PCPro/CAT (Command to be used: CME6).

(1) Method
• Input

* The Station No. cannot be omitted.

• Output

* For details of CME6 (such as the setting range and the meaning of Y No.), refer to the “Com-
mand Manual”.

(2) Example
• Input

CMD FD SD ED

E55 01001 1

E55 01128 1

E55 02001 1

E55 50128 1

CMD FD SD

LE6 X-XXXXXXXX: 
Station No.

CMD FD SD ED

E6YY X-XXXXXXXX: 
Station No.

Setting data

CMD FD SD

LE6 100

... ...

... ...
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• Output

LECE

This list command lists the Call History of Malicious Call List Set by a User Operation (Command to
be used: CMEC Y=E).

(1) Method
• Input

• Output

* If Operated Station No. or Malicious Call No. is less than the maximum digits, empty digits are
padded with spaces.

CMD FD SD ED

E600 100 4990

E601 100 NONE

CMD FD SD

LECE

CMD FD SD ED

ECE History No. (0000-
1999)

AA/BB/CC/DDD...D
/EEEEE/FF/GGG...G
See below

Call history Indication of Malicious Call List Set:
AA : Year (00-99)
BB : Month (01-12)
CC : Date (01-31)
DDD...D : Operated Station No. (Maximum 8 digits)
EEEEE : Block No. of Malicious Call List (5 digits): 1000-Slot Memory Block No. (00-99) +

10-Slot Memory Block No. (00-99) + Memory Parcel No. (0-9)
FF : Operation (00: Set, 01: Delete)
GGG...G : Malicious Call No. (Maximum 16 digits)

... ... ...
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(2) Example
• Input

• Output

LLEN

This list command lists the reading data of terminal (Tenant Group No., Trunk No., ZT No.)/(Command
to be used: CM05/CM10/CM11).

(1) Method
• Input

CMD FD SD

LECE

CMD FD SD ED

ECE 0000 15/02/16/1000 /18121/00/0399999999

ECE 0001 14/12/07/1200 /19051/01/0377777777

ECE 1999 14/03/25/5140 /18014/00/08011111111

CMD FD SD

LLEN 

... ...
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• Output

* The TDM terminal/Trunk registration (set by CM10 Y=10) reads the Unit No./Slot No. to
which the blade is registered (set by CM05 Y=0).

(2) Example
• Input

CMD FD SD ED

050 XXYY 
XX: Unit No. (01-50)
YY: Slot No. (01-18)

Blade Type

1000 XXYYZZ
XX: Unit No. (01-50)
YY: Slot No. (01-18)
ZZ : Circuit No. 

(01-32)

TDM terminal/Trunk 
No.

1001 Virtual Port No. 
(for IP terminal) 
(0000-1535)

IP terminal No.

1002 Virtual Port number 
(for IPT [P2P CCIS])
(000-511)

Trunk No. (000-511)

1003 Virtual Port No.
(for SIP trunk)
XXYYY
XX : Unit No. 

(01-50)
YYY: Port No. for 

voice channel
(000-127)

Trunk No. (000-511)

1004 Virtual Port No. 
(000-1023)

PHS/Standard SIP 
station No.

11 Virtual Port No. 
(0000-0999)

Virtual Line No./ 
Intercom No.

CMD FD SD

LLEN
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• Output

CMD FD SD ED

050 0101 10

050 0102 30

050 5018 41

1000 010101 F2000

1000 010102 F2001

1000 010201 D000

1000 010202 D001

1000 501832 D399

1001 0000 F3000

1001 0001 F3001

1001 1535 F3500

1002 000 D400

1002 511 D404

1003 01000 D500

1003 01096 D506

1004 000 4000

1004 511 4511

11 0000 5000

11 0999 5999

... ... ... ...

... ... ... ...

... ... ... ...

... ... ... ...

... ... ... ...

... ... ... ...

... ... ... ...
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LLIC

This list command lists the Software License Data registered with system (Command to be used: CMF8
Y=9).

(1) Method
• Input

• Output

(2) Example
• Input

• Output

CMD FD SD

LLIC 

CMD FD SD ED

F89 Consecutive No. of 
License DATA 
Loaded

License Name: 
Authentication Status

CMD FD SD

LLIC 

CMD FD SD ED

F89 001 Capacity/Function/
Terminal License

F89 002 Capacity/Function/
Terminal License

F89 003 Capacity/Function/
Terminal License

...

...

...
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LKEY

This list command lists the Software Key Code registered with system (Command to be used: CMF8
Y=A).

(1) Method
• Input

• Output

* Consecutive No. (000) displays a Hardware Key Code.

(2) Example
• Input

• Output

CMD FD SD

LKEY 

CMD FD SD ED

F8A Consecutive No. of 
License DATA 
Loaded

Hardware/Software 
Key Code

CMD FD SD

LKEY 

CMD FD SD ED

F8B 000 36LYRA

F8B 001 SC18CA7B0500003

F8B 002 SC18CA7B0500003

F8B

...

...

...

... ...
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LCARD

This list command lists the firmware information of the blade registered with system (Command to be
used: CME8 Y=0).

(1) Method
• Input

• Output

* The firmware information reads the Unit No./Slot No. to which the blade is registered (set by
CM05 Y=0).

(2) Example
• Input

CMD FD SD

LCARD 

CMD FD SD ED

E80 XXYY
XX: Unit No. (01-50)
YY: Slot No. (01-18)

XXYYZZ
XX: Firmware type 

(same as second 
data of CM05 
Y=0)

YY: Firmware ver-
sion on the blade

ZZ : Firmware ver-
sion of the blade 
supplied with the 
basic software

CMD FD SD

LCARD 
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• Output

LPICK

This list command lists the station number of the Call Pickup Group to which the specified station num-
ber belongs (Command to be used: CM16 Y=0).

(1) Method
• Input

* The Station No. cannot be omitted.

• Output

CMD FD SD SD

E80 0101 412329

E80 0102 502423

E80 0103 423131

E80 0104 102423

E80 0105 30FF24

E80 0106 WAIT, BUSY NOW

E80 0118 20FF28

E80 5011 ERROR

CMD FD SD

LPICK X-XXXXXXXX:
Station No.

CMD FD SD ED

160 X-XXXXXXXX:
Station No.

Next station number 
in Call Pickup Group

See the table on next 
page.
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* The contents to be displayed in the ED field are as follows.

(2) Example
• Input

• Output

Display Contents Meaning

 “empty” The chain of group is correct.

 [DATA ERROR] The station number in the FD field is not registered.

 [INVALID ERROR] The station number in the FD field cannot be registered to the 
group.

 [NONE] The station number in the FD field is not registered to the group.

 [GROUP BROKEN] The next station number in the SD field is incorrect.

 [OVER LIMIT] The number of stations is over 60.

CMD FD SD

LPICK 4000

CMD FD SD ED

160 4000 4001

160 4001 4002

160 4002 4003

160 4003 4004

160 4004 4005

160 4005 4000
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LUCD

This list command lists the station number of the UCD Group to which the specified station number
belongs, pilot or member station and UCD Group number (Command to be used: CMF5 Y=5/CM17
Y=0-2).

(1) Method
• Input

* The Station No. cannot be omitted.

• Output

* With “170” (CM17 Y=0), the contents to be displayed in the ED field are as follows.

CMD FD SD

LUCD X-XXXXXXXX:
Station No.

CMD FD SD ED

170 X-XXXXXXXX:
Station No.

Next station number 
in UCD Group

See the table below.

171 0: Member station
1: Pilot station
2: OAI member 

station
3: OAI pilot station

172 UCD Group number 
(00-99)

Display Contents Meaning

 “empty” The chain of group is correct.

 [DATA ERROR] The station number in the FD field is not registered.

 [INVALID ERROR] The station number in the FD field cannot be registered to the 
group.

 [NONE] The station number in the FD field is not registered to the group.

 [GROUP BROKEN] The next station number in the SD field is incorrect.

 [OVER LIMIT] The number of stations is over 60.
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(2) Example
• Input

• Output

LHUNT

This list command lists the station number of the Station Hunting Group to which the specified station
number belongs and kind of station numbers included in Station Hunting Group (Command to be used:
CMF5 Y=5/CM18 Y=0, 1).

(1) Method
• Input

* The Station No. cannot be omitted.

CMD FD SD

LUCD 4000

CMD FD SD ED

170 4000 4001

170 4001 4002

170 4002 4000

171 4000 1

171 4001 0

171 4002 0

172 4000 00

172 4001 00

172 4002 00

CMD FD SD

LHUNT X-XXXXXXXX:
Station No.
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• Output

CMD FD SD ED

180 X-XXXXXXXX:
Station No

Next station number 
in UCD Group

See the table on next 
page.

181 Kind of station num-
bers included in Sta-
tion Hunting Group

Station Hunting-Ter-
minal
0: Member station of 

Station Hunting-
Terminal

1: Pilot station of Sta-
tion Hunting-Ter-
minal

Station Hunting-Cir-
cular
0: Not used
1: If station is busy, 

hunt in original 
direction

5: If station is busy, 
hunt in reverse 
direction

Station Hunting-Sec-
retarial
0: Not used
1: Station number 

other than the last 
station number for 
Station Hunting-
Secretarial

5: Last station num-
ber of Station 
Hunting-Secretarial
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* With “180” (CM18 Y=0), the contents to be displayed in the ED field are as follows.

(2) Example
• Input

• Output

Display Contents Meaning

 “empty” The chain of group is correct.

 [DATA ERROR] The station number in the FD field is not registered.

 [INVALID ERROR] The station number in the FD field cannot be registered to 
the group.

 [NONE] The station number in the FD field is not registered to the 
group.

 [GROUP BROKEN] The next station number in the SD field is incorrect.

 [OVER LIMIT] The number of stations is over 60.

CMD FD SD

LHUNT 4000

CMD FD SD ED

180 4000 4001

180 4001 4002

180 4002 4000

181 4000 1

181 4001 0

181 4002 0
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LPICK2

This list command provides overall information about Call Pickup Group assignment, and lists the sta-
tion numbers for each Call Pickup Group and status (Command to be used: CM16 Y=0).

(1) Method
• Input

• Output

Continued on next page

CMD FD SD

LPICK2 

CMD FD SD ED

PICK GRP The number of Call 
Pickup Groups

GRP STN Total number of 
member stations of 
Call Pickup Groups

FREE STN The number of non-
member stations of 
Call Pickup Groups

ERR STN The number of sta-
tions with an incor-
rect “chain” link for 
Call Pickup Group

GRP x
x: Call Pickup Group 
No. (Serial numbers 
starting from 1.)

160 A station number 
assigned to a Call 
Pickup Group

The station number 
being linked with for 
the Call Pickup 
Group

... ... ... ...
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* The LPICK2 command lists all the station numbers being linked together to form each Call
Pickup Group.

* The LPICK2 command lists all the station numbers not being linked together to form a Call
Pickup Group.

* When a chain configuration error is detected in a Call Pickup Group, the station links of the
problematic section are listed under the ERR STN category. If more than one error is present,
the problematic sections are separated by a blank line.

* The LPICK2 command does not provide information about ISDN terminals or modem stations,
which are not supported for Call Pickup Group. The terminals are not listed even under the
FREE STN category.

(2) Example
• Input

CMD FD SD ED

FREE STN

160 A station number not 
assigned to a Call 
Pickup Group

NONE (Result of data 
retrieval with 
CM160>FD)

ERR STN

160 A station number 
with an incorrect 
“chain” link for Call 
Pickup Group

Result of data 
retrieval with 
CM160>FD

Result of data 
retrieval with 
CM160>FD

CMD FD SD

LPICK2 

... ... ... ...

... ... ... ...
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• Output

Continued on next page

CMD FD SD ED

PICK GRP 2

GRP STN 6

FREE STN 8

ERR STN 6

GRP 1 

160 1000 1001

160 1001 1002

160 1002 1003

160 1003 1000

GRP 2

160 1007 1008

160 1008 1007

FREE STN

160 1004 NONE

160 1013 NONE

160 3AAA NONE

160 3000 NONE

160 3001 NONE

160 3 NONE

160 1500 NONE

160 5000 DATA ERROR

ERR STN

160 1006 1005



Appendix B List Command

B-127 NWA-088656-001 Rev.8.0

LUCD2

This list command provides overall information about UCD Group assignment, and lists the station
numbers for each UCD Group and status (Command to be used: CM17 Y=0-2).

(1) Method
• Input

• Output

Continued on next page

CMD FD SD ED

160 1005 1003

160 1009 1010

160 1010 1011

160 1011 NONE

160 1012 1005

CMD FD SD

LUCD2 

CMD FD SD ED

UCD GRP The number of UCD 
Groups, each of 
which consists of 
multiple stations 
linked together by a 
“chain”

GRP STN Total number of 
member stations of 
UCD Groups
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* The LUCD2 command lists all the station numbers being linked together to form each UCD
Group.

CMD FD SD ED

FREE STN The number of non-
member stations of 
UCD Groups

ERR STN The number of sta-
tions with an incor-
rect “chain” link for 
UCD Group

GRP x
x: UCD Group No. 
(Serial numbers start-
ing from 1.)

170 A station number 
assigned to a UCD 
Group

The station number 
being linked with for 
the UCD Group

FREE STN

170 A station number not 
assigned to a UCD 
Group

Result of data 
retrieval with 
CM170>FD

Result of data 
retrieval with 
CM170>FD

ERR STN

170 A station number 
with an incorrect 
“chain” link for UCD 
Group

Result of data 
retrieval with 
CM170>FD

Result of data 
retrieval with 
CM170>FD

... ... ... ...

... ... ... ...

... ... ... ...
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* The LUCD2 command lists all the station numbers not being linked together to form a UCD
Group.

* When a chain configuration error is detected in a UCD Group, the station links of the problem-
atic section are listed under the ERR STN category. If more than one error is present, the prob-
lematic sections are separated by a blank line.

* The LUCD2 command does not provide information about ISDN terminals or modem stations,
which are not supported for UCD Group. The terminals are not listed even under the FREE STN
category.

(2) Example
• Input

• Output

Continued on next page

CMD FD SD

LUCD2 

CMD FD SD ED

UCD GRP 2

GRP STN 6

FREE STN 8

ERR STN 6

GRP 1 

170 1000 1001

170 1001 1002

170 1002 1003

170 1003 1000

GRP 2

170 1007 1008

170 1008 1007
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CMD FD SD ED

FREE STN

170 1004 NONE

170 1013 NONE

170 3AAA NONE

170 3000 NONE

170 3001 NONE

170 3 NONE

170 1500 NONE

170 5000 DATA ERROR

ERR STN

170 1006 1005

170 1005 1003

170 1009 1010

170 1010 1011

170 1011 NONE

170 1012 1005
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LHUNT2

This list command provides overall information about Station Hunting Group assignment, and lists the
station numbers for each Station Hunting Group and status (Command to be used: CM18 Y=0, 1).

(1) Method
• Input

• Output

Continued on next page

CMD FD SD

LHUNT2 

CMD FD SD ED

HUNT GRP The number of Sta-
tion Hunting Groups, 
each of which con-
sists of multiple sta-
tions linked together 
by a “chain”

GRP STN Total number of 
member stations of 
Station Hunting 
Groups

FREE STN The number of non-
member stations of 
Station Hunting 
Groups

ERR STN The number of sta-
tions with an incor-
rect “chain” link for 
Station Hunting 
Group
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* The LHUNT2 command lists all the station numbers being linked together to form each Station
Hunting Group.

* The LHUNT2 command lists all the station numbers not being linked together to form a Station
Hunting Group.

* When a chain configuration error is detected in a Station Hunting Group, the station links of the
problematic section are listed under the ERR STN category. If more than one error is present,
the problematic sections are separated by a blank line.

* The LHUNT2 command does not provide information about modem stations, which are not
supported for Station Hunting Group. The stations are not listed even under the FREE STN cat-
egory.

CMD FD SD ED

GRP x
x: Station Hunting 
Group No. (Serial 
numbers starting from 
1.)

180 A station number 
assigned to a Station 
Hunting Group

The station number 
being linked with for 
the Station Hunting 
Group

FREE STN

180 A station number not 
assigned to a Station 
Hunting Group

Result of data 
retrieval with 
CM180>FD

Result of data 
retrieval with 
CM180>FD

ERR STN

180 A station number 
with an incorrect 
“chain” link for Sta-
tion Hunting Group

Result of data 
retrieval with 
CM180>FD

Result of data 
retrieval with 
CM180>FD

... ... ... ...

... ... ... ...

... ... ... ...
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(2) Example
• Input

• Output

Continued on next page

CMD FD SD

LHUNT2 

CMD FD SD ED

HUNT GRP 2

GRP STN 6

FREE STN 8

ERR STN 6

GRP 1 

180 1000 1001

180 1001 1002

180 1002 1003

180 1003 1000

GRP 2

180 1007 1008

180 1008 1007

FREE STN

180 1004 NONE

180 1013 NONE

180 3AAA NONE

180 3000 NONE

180 3001 NONE

180 3 NONE
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CMD FD SD ED

180 1500 NONE

180 5000 DATA ERROR

ERR STN

180 1006 1005

180 1005 1003

180 1009 1010

180 1010 1011

180 1011 NONE

180 1012 1005
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Using List Commands (for Functions)

The followings show how to use list commands (for functions) and its usage example.

!

This list command resets the system (F-ROM backup is executed before a reset).

(1) Method
• Input

• Output

* If the system is reconnected, “OK” is displayed in the ED field.

!+

This list command resets the system (F-ROM backup is not executed).

(1) Method
• Input

• Output

* If the system is reconnected, “OK” is displayed in the ED field.

CMD FD SD

!

CMD FD SD ED

! FFFFFFFF OK

CMD FD SD

!+

CMD FD SD ED

!+ OK
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@WAIT

This list command is used to wait for the time (second) specified with doing nothing.

(1) Method
• Input

*1 Unable to communicate to the system during waiting time (300 seconds maximum).
*2 “@WAIT” can be used continuously.

• Output

(2) Example
• Input

CMD FD SD

@WAIT Second (1-300)

CMD FD SD ED

@WAIT Second (1-300) OK

CMD FD SD

E80 0101

E80 0101 30

@WAIT 60

E80 0101

E80 0102

E80 0102 40

@WAIT 300

E80 0102
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• Output

@TIME

This list command sets the Date/Time of the system (read the current Data/Time of PC and set them to
the system).

(1) Method
• Input

• Output

CMD FD SD ED

E80 0101 301122

E80 0101 30

@WAIT 60 OK

E80 0101 302222

E80 0102 601823

E80 0102 60

@WAIT 300 OK

80 0102 602323

CMD FD SD

@TIME PC

CMD FD SD ED

02 0 YYYY OK

02 1 MMDDDD OK

02 2 HHMMSS OK
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(2) Example
• Input

• Output

@FAULT

This list command reads fault information stored on the SV9300 and outputs CSV/HTML files.

(1) Method
• Input

*1 If the same file name already exists at the destination, the file will be overwritten.
*2 If a folder does not exist at the destination, the folder for output will be made.
*3 The HTML file is output by changing the extension of the CSV file to “.html”.

• Output

CMD FD SD

@TIME PC

CMD FD SD ED

02 0 2014 OK

02 1 030101 OK

02 2 124530 OK

CMD FD SD

@FAULT CSV file name to out-
put (full path)

CMD FD SD ED

@FAULT CSV file name to out-
put (full path)

See the table on next 
page.
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* The contents to be displayed in the ED field are as follows.

(2) Example
• Input

• Output

*1 The following information is included in the output CSV/HTML file.
- Sequence number (in order of the latest date and time), date and time of fault occurrence,

Fault Kind number, Alarm, Unit/Slot/Circuit number, a detailed level of the fault informa-
tion plugin

*2 The HTML file output in parallel is also output the same format as the CSV file as follows.
- fault_+ date/time (MMDDHHMM).html

Display Contents Meaning

OK Normal termination (there is fault information.)

TIMEOUT Time out

USERCANCEL User cancel

PORTTROUBLES Line disconnection

LACKINPUT Input data error

NG Other error

NONE No fault information

FILE ERROR Input CSV file name error

CMD FD SD

@FAULT C:\Fault\fault.csv

CMD FD SD ED

@FAULT C:\Fault\fault_+ date/
time (MMDDHH
MM).csv

OK
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<An output example of CSV file (C:\Fault\fault.csv)>
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<An output example of HTML file (C:\Fault\fault.html)>

@SAVE

This list command saves the system data (saves the system data registered in the system onto PCPro).

(1) Method
• Input

*1 The extension of the file name is effective only “.lyd”.
*2 Two or more area numbers can be specified by delimiting it by “,” (comma).
*3 If the FD field is omitted, all area numbers are saved (see the table on next page).

CMD FD SD

@SAVE Area No. (1-255) File name to save 
(Path name + File 
name)
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* While saving the system data, do not write and read the system data by using CAT or any other
application.

• Output

(2) Example
• Input

Area No. System Data Area Name Remarks

1 All system data (except Speed 
Dialing)

System data only

2 All service memory Service memory only

3 Call History Data

4 Speed Dial Data CM73, 74

80 Registration data by MAC 
Authentication

81 DBM Data (PHS/OAI)

84 Voice data of VRS (CPU Mem-
ory: Flash-ROM)

83 Voice data of VRS (CF Memory) 
for Migration

– Specifying Area No. Saves system data by specifying 
Area No.

CMD FD SD ED

@SAVE Area No. (1-255) File name to save 
(Path name + File 
name)

Result

CMD FD SD

@SAVE 1 D:\TEMP.lyd
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• Output

@LOAD

This list command loads the system data (loads the system data saved on PCPro into the system).

(1) Method
• Input

*1 For the file to load, specify the system data file saved with SV9300 PCPro.
*2 While loading the system data, do not write and read the system data by using CAT or any 

other application.

• Output

(2) Example
• Input

CMD FD SD ED

@SAVE 1 D:\TEMP_+ date/
time (MMDDHH
MM).lyd

OK

CMD FD SD

@LOAD File name to load 
(Path name + File 
name)

CMD FD SD ED

@LOAD File name to load 
(Path name + File 
name)

Result

CMD FD SD

@LOAD D:\TEMP.lyd
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• Output (OK)

• Output (NG: File format error)

@VFY

This list command verifies the system data (verifies whether there is difference between the system data
registered in the system and the system data saved on PCPro).

(1) Method
• Input

*1 For the file to verify, specify the system data file saved with SV9300 PCPro.
*2 While verifying the system data, do not write and read the system data by using CAT or any

other application.

• Output

* If there is the difference on the verification process, the “<Connection Account>-Verify.log” is
output to the following folder and the result of the verification is written in the output log file.

 -“<Installed Folder>\pbxfiles”

CMD FD SD ED

@LOAD D:\TEMP.lyd OK

CMD FD SD ED

@LOAD D:\TEMP.lyd FILE FORMAT 
ERROR

CMD FD SD

@VFY File name to verify 
(Path name + File 
name)

CMD FD SD ED

@VFY File name to verify 
(Path name + File 
name)

Result
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(2) Example
• Input

• Output (case of no difference)

• Output (case that there are differences [11 differences])

@B601

This list command lists the VoIP Packet Statistics between locations (outputs the listed data with the
format which is easy to browse and edit using Excel). After the list up, it is recommended to save this
listed data in Excel format (xlsx).

(1) Method
• Input

CMD FD SD

@VFY D:\TEMP.lyd

CMD FD SD ED

@VFY D:\TEMP.lyd OK

CMD FD SD ED

@VFY D:\TEMP.lyd ERROR COUNT: 11

CMD FD SD

@B601 Location combi-
nation pattern 
(00-09)
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• Output

*1 The read data of location B is displayed after showing the read data of location A.
*2 For the data (the first line) during collecting the statistics information, * (asterisk) is displayed

at the end of YY/MM/DD HH displayed in the CMD line.

CMD FD SD ED MESSAGE

COMBINATION 
PATTERN NO.

The location 
combination 
number desig-
nated by input. 
(00-09)

LOCATION 
NO. (SEND->
RECEIVE)

Originating loca-
tion No.->
Destination loca-
tion No.

YY/MM/DD HH RTP PACKETS 
(SEND/
RECEIVE)

RTP PACKET 
LOSS

PATH CONNEC-
TIONS

DETECTIONS 
OF SOUND 
DEGRADATION

YY/MM/DD HH:
YY: Year 

(00-99)
MM: Month

(01-12)
DD: Day

(01-31)
HH: Hour

(00-23)

XXX...X:
RTP packets 
(Send)
(Maximum 10 
digits)/RTP
packets 
(Receive)
(Maximum 10 
digits)

XXX...X:
RTP packet loss
 (Maximum 10 
digits)

XXX...X:
path connections
(Maximum 10 
digits)

XXX...X: 
The number of 
detection of 
sound degrada-
tion
 (Maximum 10 
digits)
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(2) Example
• Input

• Output 

CMD FD SD

@B601 00

CMD FD SD ED MESSAGE

COMBINATION 
PATTERN NO.

00

LOCATION NO. 
(SEND->
RECEIVE)

00->01

YY/MM/DD HH RTP PACKETS 
(SEND/
RECEIVE)

RTP PACKET 
LOSS

PATH CONNEC-
TIONS

DETECTIONS 
OF SOUND 
DEGRADATION

15/08/28 13* 300/300 0 0 0

15/08/28 12 1080/1080 2 80 0

COMBINATION 
PATTERN NO.

00

LOCATION NO. 
(SEND->
RECEIVE)

01->00

YY/MM/DD HH RTP PACKETS 
(SEND/
RECEIVE)

RTP PACKET 
LOSS

PATH CONNEC-
TIONS

DETECTIONS 
OF SOUND 
DEGRADATION

15/08/28 13* 421/421 0 0 0

15/08/28 12 510/510 0 15 1
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@ECE

This list command lists the Call History of Malicious Call List Set by a User Operation (Optimized to
Excel). After the list up, it is recommended that you save in Excel format (xlsx).

(1) Method
• Input

• Output

* The first line is the header for editing Excel.

(2) Example
• Input

CMD FD SD

@ECE

CMD FD SD ED MESSAGE

YY/MM/DD STATION NO. BLOCK NO. OPERATION MALICIOUS NO.

YY/MM/DD: 
Year/Month/
Date

X-
XXXXXXXX:
Operated Station 
No. (Maximum 
8 digits)

XXXXX:
Block No. of 
Malicious Call 
List (5 digits):
1000-Slot Mem-
ory Block No. 
(00-99) + 10-
Slot Memory 
Block No. (00-
99) + Memory 
Parcel No. (0-9)

SET
DELETE

XXX...X:
Malicious Call No. 
(Maximum 16
digits)

CMD FD SD

@ECE
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• Output

@FD

This list command refers to the FD of the script line executed previously (executes the command using
the FD data of the script row result executed previously).

(1) Method
• Input (pattern 1)

• Output (pattern 1)

• Input (pattern 2)

• Output (pattern 2)

CMD FD SD ED MESSAGE

YY/MM/DD STATION NO. BLOCK NO. OPERATION MALICIOUS NO.

15/02/16 1000 18112 SET 0399999999

14/12/07 1200 19064 DELETE 0377777777

14/03/25 1400 18031 SET 08011111111

CMD FD SD

Execution command @FD (Setting data)

CMD FD SD ED

Execution command FD data of execution 
result of script line 
executed previously

(Setting data) (Result)

CMD FD SD

Execution command (Setting data) @FD

CMD FD SD ED

Execution command (Setting data) FD data of execution 
result of script line 
executed previously

(Result)

... ... ... ... ...
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(2) Example
• Input

• Output

@SD

This list command refers to the SD of the script line executed previously (executes the command using
the SD data of the script row result executed previously).

(1) Method
• Input (pattern 1)

• Output (pattern 1)

• Input (pattern 2)

CMD FD SD

1200 300

1300 @FD

CMD FD SD ED

1200 300 3

1300 300 1

CMD FD SD

Execution command @SD (Setting data)

CMD FD SD ED

Execution command SD data of execution 
result of script line 
executed previously

(Setting data) (Result)

CMD FD SD

Execution command (Setting data) @SD
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• Output (pattern 2)

(2) Example
• Input

• Output

CMD FD SD ED

Execution command (Setting data) SD data of execution 
result of script line 
executed previously

(Result)

CMD FD SD

1000 010101

L12 @SD

CMD FD SD ED

1000 010101 4000

1200 4000 3

1293 4000 1

... ... ...
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@STN (for CMDYY)

This list command lists the station numbers for the all kinds of stations or the specified kind of station.

(1) Method
• Input

* For @STNx, specify the one from @STN, @STN1 - @STN3, or @STN5 - @STN8.

• Output

CMDYY DESCRIPTION

@STN Lists the all kinds of station numbers.

@STN1 Lists the station numbers of Single Line stations.

@STN2 Lists the station numbers of Multiline Terminals.

@STN3 Lists the station numbers of virtual stations.

@STN5 Lists the station numbers of IP Multiline Terminals.

@STN6 Lists the station numbers of PHS/Standard SIP stations.

@STN7 Lists the station numbers of modem stations.

@STN8 Lists the station numbers of terminals.

CMD FD SD

@STNx (None) (None)

CMD FD SD ED

@STN X-XXXXXXXX:
Station No.

X: Kind No.
1: Single Line 

Station
2: Multiline 

Terminal
3: Virtual Station
5: IP Multiline 

Terminal
6: PHS/Standard 

SIP Station
7: Modem Station
8: ISDN Terminal

SLT: Single Line 
Telephone

MULTI: Multiline 
Terminal

VIRTUAL: Virtual 
Station

PHS/SIP: PHS/
Standard 
SIP Station

MODEM: Modem 
Station

ISDN: ISDN 
Terminal
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* The error information displayed on the ED field is as follows.

(2) Example
• Input (for @STN)

• Output (for normal end)

DISPLAY CONTENTS MEANING

TIMEOUT Time out

USER CANCEL User cancel

PORT TROUBLES Line disconnection

LACKINPUT Input data error

INVALID ERROR Other error

(PBX error message)

CMD FD SD

@STN

CMD FD SD ED

@STN 1000 1 SLT

@STN 1100 2 MULTI

@STN 1101 2 MULTI

@STN 900 3 VIRTUAL

@STN 901 3 VIRTUAL

@STN 2000 5 IP MULTI

@STN 2001 5 IP MULTI

@STN 2002 5 IP MULTI

@STN 3000 6 PHS/SIP

@STN 3001 6 PHS/SIP

@STN 3002 6 PHS/SIP

@STN 3003 6 PHS/SIP

@STN 499 7 MODEM

@STN 5000 8 ISDN
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• Output (when no station is assigned)

• Output (for user cancel)

• Input (for @STN6)

• Output (for normal end)

• Output (when no station is assigned)

• Output (for user cancel)

CMD FD SD ED

@STN NONE

CMD FD SD ED

@STN USER CANCEL

CMD FD SD

@STN6

CMD FD SD ED

@STN 3000 6 PHS/SIP

@STN 3001 6 PHS/SIP

@STN 3002 6 PHS/SIP

@STN 3003 6 PHS/SIP

CMD FD SD ED

@STN NONE

CMD FD SD ED

@STN USER CANCEL
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@STN (for FD)

This list command lists the station numbers for the all kinds of stations, or the specified kind of station,
and executes CMDYY for the listed station numbers as FD.

(1) Method
• Input (for @STN)

• Input (for @STN1)

• Output

CMDYY DESCRIPTION

@STN Lists the all kinds of station numbers.

@STN1 Lists the station numbers of Single Line stations.

@STN2 Lists the station numbers of Multiline Terminals.

@STN3 Lists the station numbers of virtual stations.

@STN5 Lists the station numbers of IP Multiline Terminals.

@STN6 Lists the station numbers of PHS/Standard SIP stations.

@STN7 Lists the station numbers of modem stations.

@STN8 Lists the station numbers of terminals.

CMD FD SD

Execution command @STN (Data)/(None)

CMD FD SD

Execution command @STN1 (Data)/(None)

CMD FD SD ED

Execution command X-XXXXXXXX:
Station No.

Data assigned by 
CMDYY, FD

(The message for 
execution command)
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* The error information displayed on the ED field is as follows.

(2) Example
• Input (when reading the Y numbers of CM12 for all the station numbers)

• Output (for normal end)

DISPLAY CONTENTS MEANING

TIMEOUT Time out

USER CANCEL User cancel

PORT TROUBLES Line disconnection

LACKINPUT Input data error

INVALID ERROR Other error

(PBX error message)

CMD FD SD

L12 @STN

CMD FD SD ED

1200 1000 3

1201 1000 11

1202 1000 1515

1200 1001 3

1201 1001 11

1202 1001 1515

1290 3000 NONE

1296 3000 NONE

...

...
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• Output (when no station is assigned)

• Output (for user cancel)

• Input (for only when the Single Line station is targeted)

• Output (for normal end)

• Output (when no station is assigned)

CMD FD SD ED

L12 @STN NONE

CMD FD SD ED

1200 1000 3

1201 1000 11

1202 1000 USER CANCEL

CMD FD SD

1204 @STN1 00

CMD FD SD ED

1204 1000 00 OK

1204 1001 00 OK

1204 1002 00 OK

1204 1010 00 OK

CMD FD SD ED

1204 @STN1 NONE

...
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• Output (for user cancel)

LSTN 

This list command read the number of registration for each station kind.

(1) Method
• Input

• Output

CMD FD SD ED

1204 1000 00 OK

1204 1001 00 OK

1204 1002 00 USER CANCEL

CMD FD SD

LSTN (None) (None)

CMD FD SD ED

LSTN Kind No. and Name
STN : All kinds 
STN1: Single Line 

Station
STN2: Multiline 

Terminal
STN3: Virtual Sta-

tion
STN5: IP Multiline 

Terminal
STN6: PHS/Stan-

dard SIP 
Station

STN7: Modem 
Station

STN8: ISDN 
Terminal

X-XXXX:
The number of regis-
tration

SLT: Single Line 
Telephone

MULTI: Multiline 
Terminal

VIRTUAL: Virtual 
Station

PHS/SIP: PHS/Stan-
dard SIP 
Station

MODEM: Modem 
Station

ISDN: ISDN 
Terminal
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* The error information displayed on the ED field is as follows.

(2) Example
• Input

• Output (for normal end)

• Output (when no station is assigned)

DISPLAY CONTENTS MEANING

TIMEOUT Time out

USER CANCEL User cancel

PORT TROUBLES Line disconnection

LACKINPUT Input data error

INVALID ERROR Other error

(PBX error message)

CMD FD SD

LSTN

CMD FD SD ED

LSTN STN 13 ALL

LSTN STN1 1 SLT

LSTN STN2 2 MULTI

LSTN STN3 2 VIRTUAL

LSTN STN5 3 IP MULTI

LSTN STN6 4 PHS/SIP

LSTN STN7 1 MODEM

LSTN STN8 1 ISDN

CMD FD SD ED

LSTN NONE
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• Output (for user cancel)

MS

This list command changes (increases) the FD of the command executed at the last minute.

(1) Method
• Input

*1 The FD field can be omitted (if the FD is field is omitted, “1” is added to the FD in decimal
number system). 

*2 The SD field can be omitted (if the FD is field is omitted, the number of repeated time is “1”).
• Output

(2) Example
• Input

CMD FD SD ED

LSTN USER CANCEL

CMD FD SD

MS (The number to be 
added to the FD and 
the type of number 
system of the FD)

(The number of 
repeated times)

CMD FD SD ED

(Command to be exe-
cuted)

(FD to be executed) (Setting data)

CMD FD SD

1000 010101

MS 1,10 5
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• Output (OK)

MSYY

This list command changes (increases) the YY of the command executed at the last minutes.

(1) Method
• Input

*1 The FD field can be omitted (if the FD is field is omitted, the type of number system of the YY
will be decimal number system).

*2 The SD field can be omitted (if the FD is field is omitted, the number of repeated time is “1”).

• Output

(2) Example
• Input

CMD FD SD ED

1000 010101 3000

1000 010102 3001

1000 010103 3002

1000 010104 3003

1000 010105 NONE

1000 010106 NONE

CMD FD SD

MSYY (The type of number 
system of the YY) 

(The number of 
repeated times)

CMD FD SD ED

(Command to be exe-
cuted)

(FD to be executed) (Setting data)

CMD FD SD

1200 3000

MSYY 10 5
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• Output (OK)

CMD FD SD ED

1200 010101 3

1201 010102 11

1202 010103 1515

1203 010104 15

1204 010105 06

1205 010106 1
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UNIVERGE SV9300
PC Programming Manual

Appendix

C

PCPro Maintenance Interface

PCPro Maintenance Interface (referred to as PMI) is the Interface
to access to SV9300 via other applications such as the Windows
Task Scheduler.
By executing PMI using the Windows Task Scheduler, data settings
by specified time and regular maintenance to SV9300 are available.

This appendix explains the PMI features and how to use PMI.

• PMI Features
• Using PMI
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PMI Features

PMI provides the following features.
• Connection/disconnection of SV9300
• Run a script

(By using list commands and a sample file, you can utilize features such as time correction of 
SV9300, fault information read and system data save.)

• Output of execution results

Necessary items for running PMI are as follows.
• <Installation folder for PCPro>\PMI.exe (PMI’s running file supplied with PCPro)
• pmi file

Tips: Using a Sample of pmi File
• Sample File:

The file for running PMI which is pre-installed in <Install folder>\sample\pmi. The following
files are included.

File Types File Names Description

pmi file (.txt) PMI.txt These are the comma-delimited text files 
in which the operations to be run by PMI 
is described.
* Usually, use the PMI.txt which is 

described to read all the script files 
included in a pmi folder.

PMI_faultdisplay.txt
(for fault information read) 

PMI_llen.txt
(for accommodation location informa-
tion read) 

PMI_save.txt
(for system data save) 

PMI_time.txt
(for time correction) 

Script file (.csv) sample_faultdisplay.csv
(for fault information read) 

These are the script files to be specified 
by the pmi file.
* These script files are already specified 

in the PMI.txt. Therefore, the PMI.txt 
can be used as it stands.

sample_llen.csv
(for accommodation location informa-
tion read) 

sample_save.csv
(for system data save) 

sample_time.csv
(for time correction) 
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NOTE 1: Run the PMI by a user who has an Administrator Privilege in Windows (run the PMI from the 
application executed by Administrator Privilege).

NOTE 2: The connection account of the PBX connected from the PMI must be registered by PCPro in 
advance. For instructions on how to create a connection account, see “Connection 
Account”. Page 9-2

NOTE 3: For necessary operating environment of PC to use the PMI, see “Operating Environments and 
Conditions”. Page 1-4
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Using PMI

To run the PMI, do the following steps. This section explains the steps to run the PMI from the Windows
Task Scheduler.

1. Create a Connection 
Account

Create a connection account for communication connection between 
SV9300 and PCPro. For instructions on how to create a connection 
account, see “Connection Account”.  Page 9-2

2. PMI File Preparation
Prepare a pmi file (.txt) and a script file (.csv) based on a sample file 
(PMI.txt).

3. Settings of Windows 
Task Scheduler

Set the PMI to run to the Windows Task Scheduler.
In a Create Basic Task Wizard, mainly set the followings.
Step 1: Specify the running program of the pmi file (.txt) and the 

PMI.txt.
Step 2: Set the running schedule of the PMI.

4. Confirmation of Exe-
cution Results

Verify the execution result of the PMI.
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PMI File Preparation

The following operation contents are described in the sample file (<Install Folder>\sample\pmi\
PMI.txt) pre-installed on PCPro.

<PMI.txt>

Tips: Script files
• You can specify the output destination of the execution result as follows (see the descrip-

tion “(3) Accommodation location information read”).
- “SCRIPT”,“Folder Name + File Name”,“Result Output Folder (omissible)”

*If the folder specification is omitted, the execution result is not output.
• If the output destination of the execution result is specified to the pmi file, “[Script File

Name to be run] -result.csv” is output in the specified folder.

No. Functions Operations to be run

(1) Connection with 
SV9300

Connects with the connection account [IP(LAN, Default)].

(2) Fault information 
read

Runs the script file (C:\pmi\sample_faultdisplay.csv).

(3) Accommodation 
location informa-
tion read

Runs the script file (C:\pmi\sample_llen.csv) and outputs the execution 
result (a log file) to “C:\pmi\LLEN”.

(4) Time correction of 
SV9300

Runs the script file (C:\pmi\sample_time.csv).

(5) System Data Save Runs the script file (C:\pmi\sample_save.csv).

(6) Disconnection with 
SV9300

Disconnects the connection with SV9300.

"CONNECT","IP(LAN, Default)"

"SCRIPT","C:\pmi\sample_faultdisplay.csv"

"SCRIPT","C:\pmi\sample_llen.csv","C:\pmi\LLEN"

"SCRIPT","C:\pmi\sample_time.csv"

"SCRIPT","C:\pmi\sample_save.csv"

"DISCONNECT"

(1)

(2)

(3)

(4)

(5)

(6)
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In reference to a sample file (PMI.txt), change the connection account and the Hard Disk drive specifi-
cation and others depending on the environment you use. For the file name of pmi file, save the file with
a file extension (.txt).

The pmi file has now been prepared.

Settings of Windows Task Scheduler
Add the task to run the PMI by the Windows Task Scheduler. Because of this, the operations described
in the pmi file can be launched from the Windows Task Scheduler. The following steps describe with a
sample file (PMI.txt) as an example.

• When running “C:\pmi\PMI.txt”

STEP1: Copy the pmi folder (<Install Folder>\sample\pmi) pre-installed on PCPro directory below 
“C: drive”.

STEP2: Click [Start] > [Windows System] > [Control Panel] > [System and Security] > [Administra-
tive Tool] in this order in Windows OS to display the [Administrative Tool] screen.

STEP3: Double-click the [Task Scheduler] to display the [Task Scheduler] screen.

pmi folder
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STEP4: Click the [Create Basic Task...] on the right side of the screen to open the [Create Basic Task 
Wizard] screen (Create a Basic Task).

STEP5: Enter a name (“PMI” is used for an example) in the Name field, then click the [Next >] but-
ton.
The screen switches to the [Create Basic Task Wizard] screen (Task Trigger).

[Create Basic 
Task...]

Name field

[Next >] button
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STEP6: Set the Trigger (“Daily” is used for an example) to start the task, then click the [Next >] but-
ton.
The screen switches to the [Create Basic Task Wizard] screen (Daily).

STEP7: Set the start time (“12:00:00 PM” is used for an example) of the task in the Start field, then 
click the [Next >] button.
The screen switches to the [Create Basic Task Wizard] screen (Action).

Daily

[Next >] button

[Next >] button

Start field
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STEP8: Check the “Start a program” check box, then click the [Next >] button.
The screen switches to the [Create Basic Task Wizard] screen (Start a Program).

STEP9: Specify the PMI.exe which is in an installation folder for PCPro to the Program/script field 
and pmi file (full path) to the Add arguments (optional) field, then click the [Next >] button.
The screen switches to the [Create Basic Task Wizard] screen (Summary).

[Next >] button

Start a program

[Next >] button

Program/script 
field

Add arguments 
(optional) field
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STEP10: Confirm the set contents, then click the [Finish] button.
Create Basic Task Wizard will end, the screen switches to the [Windows Task Scheduler] 
screen.

STEP11: Double click the [Task Scheduler Library] located in the upper left portion of the screen.

[Finish] button

Task Scheduler
Library
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STEP12: Double-click the PMI task created in advance in the middle of the screen to display the 
[Properties] screen.

STEP13: Click the [General] tab on the [Properties] screen.
The contents displayed on the [Properties] screen switch for the [General] tab.

STEP14: Check the “Run with highest privileges” check box.

NOTE: When registering two or more tasks using Windows Task Schedulers, set the user account 
having administrator authority in the “When running the task, use the following account:” 
field.

Task for pmi

“Run with highest 
privileges” check box
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STEP15: Click the [Conditions] tab.
The contents displayed on the [Properties] screen switch for the [Conditions] tab.

STEP16: Check the “Wake the computer to run this task” check box.

NOTE: Without this setting, the task set to the Windows Task Scheduler is not run when the PC is in 
“sleep” (non-standby) mode.

STEP17: Click the [OK] button.
The PMI is run on the time and date set to the Windows Task Scheduler.

The PMI has now been configured.

“Wake the computer
to run this task”

check box
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Confirmation of Execution Result

After the PMI set to the Windows Task Scheduler is run, the execution result of the pmi file is output
to the following folder.
• The execution result of the pmi file

- pmi\Time and Date folder\“PMI.log”
• The execution result of the specified script files

- pmi\Time and Date folder\“Script File Name” + “-result.log” 

The execution result of the PMI.txt set by “PMI Settings” is output as follows.

• If “C:\pmi\PMI.txt” is run once a week from 10 March 2014, 23:00:00 

(1) The execution result of the pmi file

<The output destination of a log file>
C:\pmi\20140310-230000\PMI.log

<An output example>

pmi folder

"2014/03/10 Mon 23:00:05","CONNECT","IP (LAN, Default)","","OK"

"2014/03/10 Mon 23:00:36","SCRIPT","C:\pmi\sample_faultdisplay.csv","","OK"

"2014/03/10 Mon 23:00:48","SCRIPT","C:\pmi\sample_llen.csv"

,"C:\pmi\LLEN\sample_llen-result.csv","OK"

"2014/03/10 Mon 23:03:29","SCRIPT","C:\pmi\sample_time.csv","","OK"

"2014/03/10 Mon 23:03:29","SCRIPT","C:\pmi\sample_save.csv","","OK"

"2014/03/10 Mon 23:14:48","DISCONNECT","","","OK"
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(2) The execution result of the script files

<The output destination of log files>
C:\pmi\20140219-230000\sample_faultdisplay-result.log
C:\pmi\20140219-230000\sample_llen-result.log
C:\pmi\20140219-230000\sample_time-result.log
C:\pmi\20140219-230000\sample_save-result.log

<An output example of fault information read (sample_faultdisplay-result.log) >

[Execution Result]
The fault information was output to the specified file.
C:\pmi\fault_report.csv
C:\pmi\fault_report.html

<An output example of accommodation location information read (sample_llen-result.log) >

[Execution Result]
The execution result was output to the file specified by the pmi file.
C:\pmi\LLEN\sample_llen-result.csv

// Read fault information (CSV)

"@FAULT","","C:\pmi\fault_report.csv","OK",""

// List station No./trunk No.

"050","0101","30","",""

"050","0102","30","",""

"1000","010101","D000","",""

"1000","010102","D001","",""

"1000","010103","D002","",""

"1000","010104","D003","",""

"1000","010105","D004","",""
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<An output example of time correction (sample_time-result.log) >

<An output example of system data save (sample_save-result.log) >

[Execution Result]
The system data is output to the specified file.
D:\pmi\IP(LAN, Default).lyd

The execution result has now been verified.

// Set PBX clock (Adjust PBX clock to PC time)

"02","0","2014","OK",""

"02","1","021803","OK",""

"02","2","140829","OK",""

// Save system data

"@SAVE","1,2,4,80,81","C:\pmi\IP(LAN, Default).lyd","OK",""
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UNIVERGE SV9300
PC Programming Manual

Appendix

D

Troubleshooting

This appendix lists the probable reasons for failures as they occur
and the remedial actions.

• The connection between PCPro and the SV9300 fails
• A PCPro error message is displayed
• An error occurs in the FTP Server
• An error occurs in the HTTP Server
• An error occurs on Terminal Phonebook
• An error occurs authenticating license data
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Troubleshooting a Connect Failure

To begin with, check the following items:

If a link still cannot be established after all these checks, proceed to checks of connection method.
• IP Connection Page D-3
• RS-232C Connection (Direct Connection) Page D-4
• Modem/Terminal Adapter Connection Page D-4
• Virtual PBX Connection (Office data file) Page D-5

Point to Check Corrective Action

Is the SV9300 active? If the SV9300 is inactive, turn it on, then back on.
For more details, refer to the “System Hardware Manual”.

Is the cable between PCPro and the 
SV9300 (or modem) connected prop-
erly?

If the cable is not connected properly, reconnect it.
Page 2-7

Has a valid connection account been 
selected?

If a connection account from the connection method has been 
selected, select the connection account associated with the 
connection method in the [Connect] screen. Page 2-16
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IP Connection

Point to Check Corrective Action

Is the PCPro LAN blade (NIC) 
mounted properly?

Check the status of “Local Area Connection” in the Win-
dows [Network Logon] screen. For more details, browse 
through Windows Help.

Is the LAN cable connected properly? If the LAN cable is not connected properly, reconnect it.

Is the IP connection correct? Enter the “Ping” command with the IP address of the 
SV9300 specified to test the communication status. For 
more information about the “Ping” command, browse 
through Windows Help.

Is the destination logon number used 
by another copy of PCPro or an exter-
nal device? 

Check that the destination port number is available. If it is 
used by another device, clear the connection between that 
device and the SV9300 and then retry the connection 
operation. Page 2-16

Is the destination port number or IP 
address wrong?

Display the connection account to verify the setting. If the 
setting is invalid, correct it. Page 9-4

Is any IP address or port number used 
that is unacceptable for network secu-
rity reasons?

Contact with the network administrator.

Is the network running successfully? Reconnect the link after 10 minutes since there is the pos-
sibility that a session of ETHERNET/VOIP port is 
remained by disconnecting of LAN cable and a network 
failure.

Is the maintenance port or VOIP port 
allowed to connect the PCPro?

Confirm whether the maintenance port or the VOIP port 
has been allowed to connect the PCPro by the commend 
(CM0B Y=0XX/1XX>20: 1) or not.
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RS-232C Connection (Direct Connection)

Modem/Terminal Adapter Connection

Point to Check Corrective Action

Is the correct type of cable used? If any type of cable other than the PCPro cable (RS CON-
SOLE CA-A) is used, replace with the correct type of 
cable.

Is the cable loosely connected? A loose cable may result in a failure to establish a link 
between PCPro and the SV9300. Reconnect the cable 
tightly.

Is the cable faulty? If the cable is faulty, replace with new cable.

Is the PC COM port used by another 
application?

If the PC COM port is used by another application, exit 
that application before retrying the connection operation.

Page 2-16

Point to Check Corrective Action

Is the PCPro modem or terminal 
adapter turned on?

Turn on the modem or terminal adapter.

Is the modem or terminal adapter prop-
erly connected to a phone line?

Connect the modem or terminal adapter to a phone line 
properly.
If two modem ports are available, connect the modem or 
terminal adapter to the LINE terminal.

Is the COM port to which the modem 
or terminal adapter is connected the 
same as the COM port in the connec-
tion account?

Display the connection account and verify the settings.
Page 9-6 

Is the dial-up procedure performed 
correctly?

Display the connection account and verify the settings.
Page 9-6 

Isn’t another user accessing the 
SV9300 modem?

Retry the login after a while.
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Virtual PBX Connection (Office data file)

Point to Check Corrective Action

Is there an office data file of Virtual 
PBX?

connection account and verify the settings.
Page 9-6 
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Troubleshooting When an Error Message is Displayed

Connection Failure

Error Message Cause Remedial Action

Cannot connect to the System. Could not log on to the sys-
tem.

See “Troubleshooting a Connect 
Failure”. Page D-2

Unable to Connect
PC network connection is 
unavailable.
Check PC network settings and 
connections.

– Check PC network settings and 
connections.

Unable to Connect
SV9300 system IP address is 
unreachable.
Check system IP address and PC 
network settings.

– Check system IP address and PC 
network settings.

Unable to Connect
System port is closed.
STBY Dual CPU must be off-
line for MAT connection.
Set STBY Dual CPU to off-line 
and retry.

– Set STBY Dual CPU to off-line 
and retry.

Unable to Connect
SV9300 has too many MAT con-
nections.
Only 2 simultaneous connections 
are allowed.
Disconnect one of the current 
connections and try again.

– Disconnect one of the current 
connections and try again.

This system isn’t allowed to con-
nect it.

An attempt was connect to 
SV8300.

Use the SV8300 PCPro, If you 
Install or maintenance the 
SV8300 system.
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Common Error Messages

Continued on next page

Error Message Cause Remedial Action

This application cannot be 
started normally. Do it again.

Although two or more PCPro 
can be lunched simultane-
ously, each PCPro cannot be 
lunched between different 
users (logged in users on 
Windows)
The user who is different 
from a logged in user has 
already lunched the PCPro.

Verify the user who has lunched 
the PCPro by the Windows Task 
Manager.
Take either of the following 
actions as appropriate:
1.Change the user to log in to 

the Windows (log off from the 
Windows once, then log in by 
a user who has already 
lunched the PCPro).

2.Exit the PCPro which has 
been lunched on the PC by the 
different user.

No response from the System.
Confirm the conditions of con-
nection.

– Check the status of communica-
tion with the system.

Errors of communication with 
the System occurred.
Confirm the conditions of con-
nection.

– Check the status of communica-
tion with the system.

Connect to System. There was no connection 
with the system when an 
attempt was made to read or 
write to and from the system.

Check the connection with the 
system.

Cannot start up because that the 
file could not be found or was 
broken.
Reinstall the PCPro.

– Reinstall SV9300 PCPro.

The file could not be found. – Specify a valid folder or browse 
a valid file.
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Error Message Cause Remedial Action

Failed to update the file. – Check to see if the file is not 
read-only or if it is not used by 
another application.

The file cannot be opened. – Check to see if the specified file 
is not broken or if it is not wrong 
file.

Could not create the file. – Check the size of available disk 
drive space and folder attributes 
then retry.

The file cannot be deleted. – Check to see if the file is not 
read-only or if it is not used by 
another application.

Some data is invalid. Some of the input data is 
invalid.

Check the range, value, etc. and 
then enter the data.

This file cannot be opened 
because another application is 
using it.

– Check to see if it is not used by 
another application. 

Some trunk number is same. – There is an entry of the same 
trunk No.
Take either of the following 
actions as appropriate:
1.Modify the trunk No.
2.Delete the data once and then 

register it again.

Failed to copy the system data to 
the remote units.

Failed to copy the system 
data to the remote units for 
some reason.

Retry.
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Menu

Continued on next page

Error Message Cause Remedial Action

Failed to backup the system data. System data backup failed. Retry.

Cannot add more Connection 
Account.

An attempt was made to add 
logon accounts past the max-
imum number of accounts 
that can be registered.

Delete unnecessary logon 
accounts and then add additional 
accounts.

Cannot remove a default 
account.

An attempt was made to 
delete the initial account.

The following initial accounts 
cannot be deleted:
• IP (LAN, Default)
• IP (VoIP, Default)
• RS-232C (9600 bps)

Cannot remove a Connection 
Account that is currently con-
nected.

An attempt was made to 
delete the account that has 
logged currently on to the 
system.

To delete the account in use, log 
off from the system once and 
then delete the account.

Cannot change a Connection 
Account that is currently con-
nected.

An attempt was made to 
change the account that has 
logged currently on to the 
system.

To change the account in use, log 
off from the system once and 
then change the account.

The password you typed does not 
match. Input the same password.

The input password did not 
match.

Enter the same password.

The password setting condition is 
not met.

The input password has an 
invalid length, or includes 
invalid characters.

Enter the password that meets the 
setting conditions.

The system password is wrong. 
Only reading the system data is 
possible.

The input password did not 
match with the registered 
password on password ser-
vice in the system.

If you want to change the system 
data of the system, disconnect 
with the system once and then 
enter the correct password when 
reconnecting with the system.The system is in the password 

service. Only reading the system 
data is possible.

Even though the system is 
during password service, 
there was no password entry.
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FTP Server Functions

Error Message Cause Remedial Action

Failed to copy the system data to 
remote units.

There is possibility that the 
system is during access to 
the flash ROM by the other 
process.

Wait for a while and retry.

Select a System Data file. No System data file is 
selected.

Select the system data file.

"Area number 1: All system data 
(except Speed Dialing)" isn't 
included in a chosen bureau data 
file. 
Please choose a file again.

"Area number 1: All system 
data (except Speed Dial-
ing)" isn't included in a cho-
sen bureau data file. 

Select the bureau data file 
included "Area number 1: All 
system data (except Speed Dial-
ing)".

Error Message Cause Remedial Action

FTP Server cannot be started 
because a specified port is used 
by other services.

The specified port is in use 
by other services (the port 
cannot be used for two or 
more services).

The specified port is in use.
Take either of the following 
actions as appropriate:
1.Stop the service which is 

using the specified port).
2.Change the port number to be 

used.

Cannot add more Connection 
Account.

The number of uses has 
reached the maximum limit.

Delete existing users and then 
add additional users.
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HTTP Server Functions

System Data Conversion Tool

Continued on next page

Error Message Cause Remedial Action

URL/ IP address is wrong. Please 
confirm the setting data. 

Incorrect data has been spec-
ified to the URL/IP address.

Set the URL/IP address or a 
domain name of your PC/server.

Control connection port is 
wrong. Please confirm the setting 
data. 

Incorrect data has been spec-
ified to the Control connec-
tion port.

Set the port number within the 
usable range of HTTPS protocol.

Root folder is wrong. Please con-
firm the setting data. 

Incorrect data has been spec-
ified to the Root folder.

Set the root folder of the HTTP 
server with write permission.

Error Message Cause Remedial Action

Invalid file format selected.
The area number select a file of 
‘All System Data’ (Number of ‘1, 
2, 3, 4, 80, 81’), please.

The system data file that 
Area Number is other than 
‘1, 2, 3, 4, 80, 81’ was 
selected.

Select a file of ‘All System Data’ 
(Number of ‘1, 2, 3, 4, 80, 81’).

Converting the system data.
Please abort the process before 
closing this function.

The [Close] button was 
clicked during converting the 
system data.

Click the [Abort] button first to 
abort the process, then close the 
screen.
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Quick Setup

Error Message Cause Remedial Action

Failed to update the file.
The file name is xx.
please confirm whether it isn’t 
being used by other application 
whether it doesn’t become for 
exclusive use.

There is no authority to open 
the file.

Verify that the file is in read-only 
format or used by other applica-
tions and then retry.

The file could not be found.
The file name is xx.
Reinstall the PCPro Office Data 
Conversion Tool.

The file required for the sys-
tem could not be found.

Reinstall the System Data Con-
version Tool in your PC.

The file or folder cannot be deleted.
The file or folder name is xx.
Please confirm whether it isn’t 
being used by other application 
whether it doesn’t become for 
exclusive use.

The file or folder cannot be 
deleted.

Verify that the file is in read-only 
format or used by other applica-
tions and then retry.

Failed to read the file.
The file name is xx.
Reinstall the PCPro Office Data 
Conversion Tool.

The contents of the file are 
invalid.

Reinstall the System Data Con-
version Tool in your PC.

Error Message Cause Remedial Action

Failed to clear all the system 
data/SRAM. Confirm the 
SENSE SW of CPU blade, and 
do it again.

System data/SRAM all clear 
failed.

Check that the [SENSE] switch 
on the CPU blade is set to E and 
then retry.

Failed to back up the system 
data.

Backup of system data saved 
on the SV9300 failed.

Retry the system data backup.
Page 2-20

Failed to back up the system 
data. Please try again later.

Backup of system data/
SRAM failed following its 
all clear.

Wait for a while before retrying 
the system data backup.
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Software License Authentication

Error Message Cause Remedial Action

Activation Code couldn’t be set. The Activation Code could 
not be registered on the 
SV9300.

Check with the Software License 
Authentication Center to see if 
the Activation Code is valid and 
then retry.

PBX Generator File couldn’t be 
prepared.

A PBX creation file could 
not be created after license 
data had been registered on 
the Main Unit.

Check the size of available hard 
disk drive space on the PC and 
check to see if the folder proper-
ties are not configured to disable 
writing.

Failed to back up the system 
data.
Please try again later.

An Activation Code was reg-
istered on the SV9300 but 
office data backup failed.

Wait for a while and retry the 
office data backup.

Checksum error occurred. A wrong file has been speci-
fied.

Select the right license data file.

File Format is wrong. A wrong file has been speci-
fied.

Select the right license data file.

License data couldn’t be regis-
tered.

License data could not be 
registered on the SV9300.

Retry.

License data couldn’t be deleted. Deletion of license data reg-
istered on the SV9300 was 
attempted but failed.

Retry

The Hardware Key Code of the 
system is different from the 
License files.
Continue to load license data?

You have specified the 
license file in a different sys-
tem.

Return to the [Select of License 
Data File] screen and use the 
license file which corresponds to 
the Hardware Key Code of the 
system.

Failed to License registration.
Please try again later.

The Activation Code could 
not be registered (the flash 
memory was in use).

Wait for a while and then click 
the [Registration] button again.
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Program Upgrade (On-line)

Continued on next page

Error Message Cause Remedial Action

The folder cannot be opened. – Check to see if the folder actually 
exists.

Failed to copy the system data to 
the remote units.

System data could not be 
copied from unit01 to 
another unit (flash memory 
busy).

Allow for a while before clicking 
the [Apply] button once again.

There is no operation unit. No operating unit informa-
tion was available when it 
was read from the scheduling 
window.

Check the system data.

Input information of FTP Server. An attempt was made to set 
the update date and time 
when no FTP server infor-
mation had been entered.

Enter FTP server information.

Change over Date/Time should 
be established later than Upgrade 
Date/Time.

A switching date and time 
earlier than the update date 
and time were appointed.

The program is updated on 
switching after the update pro-
cess. Appoint a switching date 
and time later than the update 
date and time.

Input information of a unit 01 
first.

No information about unit01 
was available at batch setup.

Batch setup executes based on 
the information about unit01. 
Enter main unit information.
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Program Upgrade (Off-line)

Error Message Cause Remedial Action

The following units have contra-
diction in the system data of the 
‘FTP Server Information’.
Unit No.: xx, xx, …

Click the ‘Apply’ button when 
you use the FTP Server of 
PCPro.
or confirm the contents of ‘FTP 
Server Information’ when you 
use the FTP Server except for the 
PCPro’s.

The [Read] button was 
clicked during the following 
states.
• “Use the FTP Server of 

PCPro” check box has 
been checked.

• A directory name has been 
specified by CM0C Y=11>
xx04.

Take either of the following 
actions as appropriate:
1.Check the “Use the FTP 

Server of PCPro” check box 
on the detailed setup screen of 
FTP server Information. The 
click the [OK] button.

2.Click the [Apply] button.

* Click the [Read] button again 
and confirm that the error mes-
sage is not displayed.

Please wait for a while and click 
the ‘Read’ button again.

The following unit(s) is detected 
which is not operating normally 
or starting up.
(Unit XX)

– Wait the completion of Program 
Upgrade (On-line), or try again 
after canceling the operation.

Error Message Cause Remedial Action

Program files are wrong. Click 
the [Next >>] button after con-
firming some files to upgrade.

The program file to be 
upgraded is wrong.

1.Check that all required files 
are available in the specified 
folder.

2.Check that the specified 
folder contains nothing but 
unnecessary files.

Couldn’t confirm the IP Address 
because that LAN cable is 
unplugged or Network Connec-
tion is in an invalid state.

The LAN cable was out of 
position or the network con-
nection was invalid when the 
plug-in launched.

Connect the PC LAN cable and 
check the status of network con-
nectivity.

Continued on next page



Appendix D Troubleshooting

D-16 NWA-088656-001 Rev.8.0

Failed to change the IP Address.
Please change IP Address to 
192.168.1.250 manually.

– Change the IP address manually.

LAN cable is unplugged or Net-
work Connection is in an invalid 
state.

The LAN cable was out of 
position or the network con-
nection was invalid when the 
[Next >>] button was clicked 
in the [Program Upgrade] 
screen.

Connect the PC LAN cable and 
check the status of network con-
nectivity.

PC’s IP Address hasn’t been set 
for 192.168.1.250. Confirm the 
setting.

The PC did not have a speci-
fied IP address when the 
[Next >>] button was clicked 
in the [Program Upgrade] 
screen.

Set 192.168.1.250 as an IP 
address.

A file transfer error occurred. Do 
it again from the beginning.

An error occurred transfer-
ring a file.

Retry from the beginning.

FTP server has a problem.
Confirm the following items, and 
do it again from the beginning.
• If another FTP Server is active

on the PC, stop it.
• Confirm selecting the Menu

item [Tools] > [Configuration]
> [FTP Server].

The FTP server is at fault. Shut down the FTP server once 
and the retry.

Couldn’t return the IP Address to 
default because the LAN cable is 
unplugged or Network Connec-
tion is in an invalid state.

– Connect the PC LAN cable and 
check the status of network con-
nectivity.

Couldn’t return the IP Address to 
previous settings.

– Restore the IP address manually.
The original IP address is stored 
the following file.
<INSTALL folder>\UserDB\
Program Upgradeoffline-IP 
Address. txt

Error Message Cause Remedial Action

Continued on next page
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Firmware Upgrade (Line/Trunk Blade)

Error Message Cause Remedial Action

Program Upgrading.
Please abort the process before 
closing this function.

Program Upgrading.
Please abort the process 
before closing this function.

Wait the completion of the pro-
gram upgrade, or cancel it then 
retry.

Error Message Cause Remedial Action

There are some blades which 
failed to update firmware.

Failed to update firmware. Confirm the following settings 
and then retry.
• The trunk blade No. is assigned 

to the blade that the Firmware 
Upgrade is failed.

• The connection to the system is 
not disconnected.

Please select blades to be 
updated.

The [Apply] button was 
clicked without selecting the 
blades to be updated the 
firmware.

Select the blades to be updated 
the firmware, then click the 
[Apply] button.
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Script

Error Message Cause Remedial Action

Invalid file format selected. Con-
firm the contents of the script file 
(.csv).

The specified script file 
(.csv) has invalid content.

Create a script file (.csv) in a 
valid format and retry.

Invalid file format selected.
Confirm the contents of the 
Scenario file (.list).

The specified Scenario file 
(.list) has invalid content.

Create the Scenario file (.list) in 
a valid format, then retry.

PCPro can save the script only to 
the maximum lines because there 
is too many lines.

The maximum number of lines 
depends on the file type.
- Scripts File: 100,000 lines
- Microsoft Excel Worksheet 

(xlsx): 100,000 lines

The Script is over the maxi-
mum lines.

The Script can only save up to 
the maximum number of lines 
(The maximum number of lines 
depends on the file type).
Click the [Yes] button if you 
want to save up to a maximum 
number of lines. In this case, line 
part that exceeds the maximum 
number of lines will not be 
saved.
Click the [No] button if you want 
to review the contents of the 
script without saving.
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Station Copy/Key Copy

Error Message Cause Remedial Action

Select at least one item of system 
data to be copied.

No system data is selected. Select the system data check box 
from which you want to copy. 

The following system data can-
not be copied in the terminal 
kind of the specified station.
Verify terminal type.

There are unavailable system 
data depending on the termi-
nal type of the station.

Uncheck the check box of the 
system data to which the mes-
sage is displayed.

The specified station cannot be 
copied.

The terminal kind of the 
specified station cannot be 
copied.

Enter an another station number.

Failed to copy some data. – Check the destination system 
data 

Failed to move. – Verify the details of error and 
eliminate the cause of error, then 
retry.

Failed to move. Please refer to 
the log file.

– Check the log file, then change 
the system data of the destination 
station.
Log file name: <installation 
folder for PCPro>\logfiles\
MoveStation_StationNumber.csv

User has canceled the process. 
Move function cannot proceed. 
Please refer to the log file.

– Check the log file, then change 
the system data of the destination 
station.
Log file name: <installation 
folder for PCPro>\logfiles\
MoveStation_StationNumber.csv

Failed to swap. Please refer to 
the log file.

– Check the log file, then change 
the system data of the station.
Log file name: <installation 
folder for PCPro>\logfiles\
MoveStation_StationNumber.csv

Continued on next page
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Speed Dialing

Error Message Cause Remedial Action

User has canceled the process. 
Swap function cannot proceed. 
Please refer to the log file.

– Check the log file, then change 
the system data of the station.
Log file name: <installation 
folder for PCPro>\logfiles\
MoveStation_StationNumber.csv

Name Display (Simplified Chi-
nese) and Name Display (Tradi-
tional Chinese) cannot be set at 
the same time.

– Enter any one of Name Display 
(Simplified Chinese) or Name 
Display (Traditional Chinese) for 
one station.

Error Message Cause Remedial Action

Specify the ‘Number of 10-Slot 
Memory Blocks’.

10-Slot Memory Block num-
ber is not specified on the 
[Memory Allocation] screen.

Specify the 10-Slot Memory 
Block number.

Some stations will not been allo-
cated memory because of mem-
ory area shortage.
(Memory area is shortage for xx 
in xx stations which you speci-
fied.) 

There is not enough memory 
area to allocate memory for 
Memory Allocation.

Delete the unnecessary memory, 
or change the memory area allo-
cation for the station.

Select the only stations which are 
not allocated any memory area.

You are selecting a station of 
the allocated memory area 
when clicking the [Range 
Setting] button.

Release the selection of the allo-
cated station.

The Station No. xx is not regis-
tered or is not available for One-
Touch Dialing.

You are entering a station 
number which is not regis-
tered on the [Memory Area 
Settings] screen, or entering 
a station number other than 
Multiline Terminal for the 
One-Touch dialing registra-
tion.

Enter the registered station num-
ber.
For the One-Touch Dialing regis-
tration, enter the station number 
for Multiline Terminal.

Continued on next page
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Call Pickup Group/UCD Group/Station Hunting Group

Error Message Cause Remedial Action

The Station No. xx has already 
allocated memory area for xx.

You are entering a station 
number that the memory area 
is already allocated on the 
[Memory Area Settings] 
screen.

Enter the station number of the 
un-allocated memory area.

Error Message Cause Remedial Action

Group must contain at least two 
stations.

– Register at least two stations.

Station xx has already been reg-
istered to another group.

An attempt was made to reg-
ister the station to an another 
group that belongs to the 
other group.

Delete the station number once 
from the group that belongs and 
register it to the new group.

The system data for the group is 
incorrect (Chain of group is 
incorrect).
Register the group again after 
deleting the group.

Although the station that 
belongs in the group has 
been read, the system data 
for the group is incorrect 
(such as Chain of group is 
incorrect).

Register the group again after 
deleting the group.

The system data for the group is 
incorrect (The number of stations 
is over 60).
Register the group again after 
deleting the group.

Although the station that 
belongs in the group has 
been read, the system data 
for the group is incorrect 
(The number of station is 
over 60).

Register the group again after 
deleting the group.

The pilot station is not changed. An attempt has been made to 
change the pilot station of 
the UCD Group.
An attempt has been made to 
change the pilot station of a 
Station Hunting-Terminal 
group.

The following pilot stations can-
not be changed:
• Pilot station of a UCD Group
• Pilot station of a Station Hunt-

ing-Terminal group
Register the group again once 
after deleting the group.

Continued on next page
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Error Message Cause Remedial Action

The system data for the group is 
incorrect (No pilot station).
Register the group again after 
deleting the group.

Although the station that 
belongs in the group has 
been read, the system data 
for the group is incorrect (No 
pilot station).

Register the group again after 
deleting the group.
Or confirm the setting of CM17 
Y=1 with Command Mode and 
set CM17 Y=1 again so that the 
Pilot station is only one.
* Readout the data again and 

confirm that the error message 
is not displayed.

The system data for the group is 
incorrect (More than one pilot 
station).
Register the group again after 
deleting the group.

Although the station that 
belongs in the group has 
been read, the system data 
for the group is incorrect 
(More than one pilot station).

Register the group again after 
deleting the group.
Or confirm the setting of CM17 
Y=1 with Command Mode and 
set CM17 Y=1 again so that the 
Pilot station is only one.
* Readout the data again and 

confirm that the error message 
is not displayed.

The system data for the group is 
incorrect (No group number is 
assigned).
Register the group again after 
deleting the group.

Although the station that 
belongs in the group has 
been read, the system data 
for the group is incorrect (No 
group number is assigned).

Register the group again after 
deleting the group.

The system data for the group is 
incorrect (More than one group 
number are assigned).
Register the group again after 
deleting the group.

Although the station that 
belongs in the group has 
been read, the system data 
for the group is incorrect 
(More than one group num-
ber are assigned).

Register the group again after 
deleting the group.
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User Web Portal Management

Error Message Cause Remedial Action

Set at least either port available 
for the Web Server.

An attempt was made to start 
or restart the Web Server 
while the both of VoIP Port 
and Maintenance Port were 
invalid.

At least, make the either one of 
VoIP Port or Maintenance Port 
available as the port used for the 
Web Server.

Can’t download log. Connect the 
system by connection type of IP.

An attempt was made to 
download the log while 
PCPro is directory connected 
to the system or connected to 
the modem.
A log download is available 
only for an IP connection.

Connect PCPro to the system 
with an IP connection. Then, 
download the log file.

The log is not stored. An attempt was made to 
download a log, but the log 
was not stored in the system.

No action is necessary (there is 
no particular problem).
As for the setting of log storage, 
please confirm CMF6.

Failed to download the log.
(Failed to write it to the file.)

– Confirm whether the file to be 
saved is opened by another appli-
cation or not. Close the file if it is 
used by another application and 
try again.

PCPro couldn’t start to down-
load. It would be caused by 
aborting a download last time.
Please wait for a while and 
download it again.

The system is under process-
ing to download the log.

Please wait for a while and 
download it again.

Continued on next page
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Terminal Phonebook

Error Message Cause Remedial Action

Failed to start the Web Server.
Confirm the following items.
* Version license is available.
* VoIPDB is mounted.
* IP address of VoIP Port is set.

The Web Server could not be 
started because the version 
license for 9300V2 or later 
was not registered, or 
VoIPDB was not mounted to 
SV9300, or an IP address of 
VoIP Port was not set.

Confirm the following items, if 
necessary.
* Version license is available.
* VoIPDB is mounted.
* IP address of VoIP Port is set.

Failed to restart the Web Server.
Confirm the following items.
* Version license is available.
* VoIPDB is mounted.
* IP address of VoIP Port is set.

The Web Server could not be 
restarted because the version 
license for 9300V2 or later 
was not registered, or 
VoIPDB was not mounted to 
SV9300, or an IP address of 
VoIP Port was not set.

Confirm the following items, if 
necessary.
* Version license is available.
* VoIPDB is mounted.
* IP address of VoIP Port is set.

Error Message Cause Remedial Action

Microsoft Excel is not installed 
or necessary file is not found.

- Please confirm whether Micro-
soft Excel is installed.
- Please reinstall PCPro.

Microsoft Excel is not 
installed or necessary file 
does not exist.

1. Install Microsoft Excel 2010 
or later if not installed.

2. Re-install the PCPro when the 
trouble is not cleared even if 
Excel 2010 or later is 
installed.

Select the data file. The file for data read is not 
selected. 

Select the correct data file and 
execute the data read.

Couldn't get the data to create the 
head shot.
Retry read the Terminal Phone-
book Data.

Failed to get the data to cre-
ate the head shot.

Execute the data read again.

Read the Terminal Phonebook 
Data.

The Terminal Phonebook 
data read has not been exe-
cuted.

Execute the Terminal Phonebook 
data read again.

Continued on next page
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System Check and Report

Port Status/Lamp Status

Couldn't get the data to create the 
Zip File of Terminal Phonebook 
Data.
Retry read the Terminal Phone-
book Data.

Failed to get the data to cre-
ate the zip file.

Execute the data read again.

The Zip File of Terminal Phone-
book is creating.
Please abort the process before 
closing this function.

The function cannot be 
closed because the zip file of 
Terminal Phonebook is cre-
ating.

Wait for the process to complete, 
or retry after canceling the pro-
cess.

Error Message Cause Remedial Action

HTML file cannot be displayed. Although a HTML file was 
created, the HTML file could 
not be displayed.

Associate the HTML file to the 
application.

Failed to make a HTML file. Failed to create the HTML 
file that you have tried to dis-
play.

Confirm the amount of space in a 
HDD of PC and whether the 
folder properties is set to write 
inhibit or not, then retry.

Error Message Cause Remedial Action

Failed to reset the Blade. – Confirm the blade configuration, 
and do it again.

Error Message Cause Remedial Action
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System Data Save/Load/Verify

Continued on next page

Error Message Cause Remedial Action

Failed to save the system data. 
(Could not create the system data 
file.)

The specified folder is write-
protected or enough hard 
disk drive space is not avail-
able.

Specify a write-enabled folder or 
a folder having enough hard disk 
drive space.

Failed to save the system data. 
(Cannot use the specified system 
data area.)

System data saving was 
attempted with a system data 
area in which no system data 
existed specified.

Specify a valid system data area.

Failed to verify the system data. 
(Could not open the system data 
file.)

The specified file has been 
opened by another applica-
tion.

Close the file.

Failed to verify the system data. 
(Cannot use the specified system 
data area.)

The system data area has 
been specified does not exist.
The version of the system 
may be older than the ver-
sion of the station data file.

Check the subject file or system.

Failed to load the system data. 
(Writing error of the system data 
occurred.)

The SV9300 responded with 
“Write error” while system 
data was loaded.

Retry.

Failed to load the system data.
(System data version error)

The version of files to be 
loaded is not match with the 
system.

The error files cannot be used. 
The files have been already 
saved should be used.

Failed to load the system data. 
(Could not open the system data 
file.)

The specified file has been 
opened by another applica-
tion.

Close the file.

Failed to load the system data. 
(Cannot use the specified system 
data area.)

The system data area has 
been specified does not exist.
The version of the system 
may be older than the ver-
sion of the station data file. 

Check the subject file or system.
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Error Message Cause Remedial Action

Failed to reset the system. – Retry the system reset, or press 
the [Reset] button on the unit.

The file header is wrong. The system data file might 
be broken.

Reselect the system data file.

Loading the system data was 
completed. Database has been 
password protected. Failed to 
load the system data to the flash 
ROM. You must login to the 
SV9300 and manually enter the 
password before the database can 
be loaded to flash ROM.

Backup of loaded system 
data to flash ROM failed.

Retry the backup of the system 
data to flash ROM.

Office data file of the former sys-
tem can’t be loaded.

An attempt was made to load 
the office data file of the for-
mer system.

Please specify the SV9300 sys-
tem data file.
When migrating from the 
SV8300, please use the PCPro 
Office Data Conversion Tool.

Office data file of the former sys-
tem can’t be verified.

An attempt was made to ver-
ify the office data file of the 
former system.

Please specify the SV9300 sys-
tem data file. 

File file name already exists.
When the connection type of the 
connection destination is “vir-
tual PBX (sytem data file)” can't 
overwrite the exist file.
Please change preservation desti-
nation.

– Save as the file name different 
from the file name of the con-
necting destination.
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Reset

Error Message Cause Remedial Action

Failed to reset the blade. Failed to reset the blade. Confirm the blade configuration, 
and do it again.

Failed to reset the system. Failed to reset the system. Confirm the system state, and do 
it again.

Failed to reset the IP Trunk (P2P 
CCIS).

Failed to reset the IPT (P2P 
CCIS). There is possibility 
that the system data is not 
registered properly.

Confirm the system data of the 
IP trunk again.

Failed to reset the IPT (P2P 
CCIS). The [After initial 
construction] is executed 
again after the execution of 
the [After initial construc-
tion].

Execute the [Under operation].
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Maintenance Report

Error Message Cause Remedial Action

System Name not registered. 
Please set system data (CM04, 
Y=70).

The system name is not reg-
istered to SV9300.

Set the CM04 Y=70 by System 
Data Mode.

Invalid date. On the Specified time period 
of the [Make Report (7/8)] 
screen, the date/time older 
than the Start field is set to 
the End field.

Set the date/time of the Start and 
End fields properly again.

File name too long. The file name is too long. Change the length of the file 
name and then retry.

Microsoft Excel is not installed 
or necessary file is not found.

- Please confirm whether 
Microsoft Excel is installed.

- Please reinstall PCPro.

Microsoft Excel is not 
installed or necessary file 
does not exist.

1. Install Microsoft Excel 2010 
or later if not installed.

2. Re-install the PCPro when the 
trouble is not cleared even if 
Excel 2010 or later is 
installed.

Import failed. The specified file is not 
report data.

Specify the report data.

Data already imported. The same report data is 
imported again.

–

Export failed. Failed to export the report 
data.

Specify the row to export on the 
System List area and click the 
[Export] button again.

Unexpected Error Occurred. Invalid data is included in 
the report data.

Delete the appropriate data on 
the [Maintenance Report Data] 
screen of the [Maintenance 
Report] menu.
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Wizard Settings (CCIS)

Error Message Cause Remedial Action

Some voice channels cannot be 
assigned according to the starting 
trunk number.
Please confirm the start trunk 
number and input it again.

Registering the number of 
voice channels from the 
specified starting trunk 
number as trunk numbers 
exceeds the maximum value 
for the trunk numbers.

Confirm the starting trunk 
number again.

Some voice channels and control 
channel cannot be assigned 
according to the starting virtual 
port number.
Please confirm the start virtual 
port number and select it again.

Registering the number of 
voice channels from the 
specified starting trunk 
number as trunk numbers 
exceeds the maximum value 
for the virtual port numbers.

Confirm the starting virtual port 
number again.

The specified virtual port number 
has already assigned.
Please specify the starting virtual 
port number again.

An attempt was made to 
register the data to the virtual 
port for which the data is 
already assigned.

Confirm the starting virtual port 
number again.

The specified port number has 
already assigned.
Please specify the Unit/Slot 
number again.

An attempt was made to 
register the data to the port 
for which the data is already 
assigned.

Confirm the Unit/Slot number 
again.

You specified the assigned trunk 
number.
Please confirm the List of Avail-
able Trunks, and then specify the 
starting trunk number or 
common control channel trunk 
number again.

An attempt was made to 
register the trunk number 
which is already assigned.

Confirm the starting trunk 
number, or common control 
channel trunk number again.

CCH 00 is already assigned to 
TDM CCIS Route xx.
P2P CCIS must use CCH 00.
Please move or delete TDM 
CCIS from CCH 00 before 
assigning P2P CCIS.

Settings for P2P CCIS is not 
available because CCH 00 to 
be used for P2P CCIS is 
already assigned.

Confirm the CCH number for 
TDM CCIS again.
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Wizard Settings (PRI)

Error Message Cause Remedial Action

Some voice channels cannot be 
assigned according to the starting 
trunk number.
Please confirm the start trunk 
number and input it again.

Registering the number of 
voice channels from the 
specified starting trunk 
number as trunk numbers 
exceeds the maximum value 
for the trunk numbers.

Confirm the starting trunk 
number again.

You specified the assigned trunk 
number.
Please confirm the List of Avail-
able Trunks, and then specify the 
starting trunk number again.

An attempt was made to 
register the trunk number 
which is already assigned.

Confirm the starting trunk 
number again.

The specified port number has 
already assigned.
Please specify the Unit/Slot 
number again.

An attempt was made to 
register the data to the port 
for which the data is already 
assigned.

Confirm the Unit/Slot number 
again.
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Troubleshooting on FTP Server

The probable causes of faults that could occur in the FTP server.

(1) Cannot start the FTP server

(2) The FTP service has been performed, but cannot access from a FTP user

(3) Cannot display or disappear the FTP Server Settings screen

No. Cause Remedial Action

1 IP address for PC is not same as the IP 
address for FTP sever.

Set the IP address of PC on the [ Whole Setting] 
menu of [FTP Server Settings]. Page 9-45

2 The command port for the FTP server 
has already been used for other appli-
cations.

Close the application used. Or change the command 
port of FTP server.

No. Cause Remedial Action

1 Windows firewall has been blocked. Unblock the Windows firewall. Page 1-7

2 The port of FTP server has been 
blocked by an anti-virus software.

Unblock the port by using anti-virus software. Please 
refer to setting of anti-virus software for you to know 
a way in detail.

No. Cause Remedial Action

1 Virtual PBX has been connected.

When Virtual PBX is connected, the 
FTP Server Settings screen cannot be 
displayed. The displayed screen disap-
pear, but the starting FTP server does 
not stop.

Disconnect Virtual PBX, and then display the FTP 
Server Settings screen.
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Troubleshooting on HTTP Server

The probable causes of faults that could occur in the HTTP server.

(1) Cannot start the HTTP server

(2) Cannot download the Terminal Phonebook

No. Cause Remedial Action

1 IP address for PC is not same as the IP 
address for HTTP sever.

Set the IP address of PC on the [ Whole Setting] 
menu of [HTTP Server Settings]. Page 9-47

2 The port number for the HTTPS pro-
tocol has already been used for other 
applications (such as IIS or Apache).

Set the port number which does not overlap with 
other applications, and the port number should be in 
the usable range of HTTPS protocol.

3 Windows firewall has been blocked. Unblock the Windows firewall. Page 1-7

4 The port of HTTP server has been 
blocked by an anti-virus software.

Unblock the port by using anti-virus software. Please 
refer to setting of anti-virus software for you to know 
a way in detail.

No. Cause Remedial Action

1 The HTTP server has not been started. Start the HTTP server.

2 The communication 
log cannot be 
recorded. 

The IP address of the HTTP 
server on the client side 
(terminals) and the HTTP 
server’s URL/IP address 
are unmatched. 

Set the matching URL/IP address of 
the HTTP server on the client side 
(terminals).

3 The port number of the 
HTTP server on the client 
side (terminals) and the 
HTTP server’s port num-
ber are unmatched. 

Set the matching port number of the 
HTTP server on the client side (termi-
nals).

Continued on next page
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4 The HTTP server 
response log for the 
client request cannot 
be recorded on the 
communication log.

The protocol other than 
HTTP/HTTPS is used on 
the communication.

Use the HTTPS protocol on the client 
side.

5 “400 Bad Request” is 
recorded on the com-
munication log.

“Receiving data error” or 
“unable to process the 
request” has been caused.

Set the following folder/file name in 
the terminal settings on the client side 
(or URI) correctly.
* folder name: 

“terminal/<station number>”
* file name: 

[Terminal list] “PhoneBookList.csv”
[Terminal Phonebook] “Contact-
List.zip”

6 “404 Not Found” is 
recorded on the com-
munication log.

There is no downloading 
file (a terminal list or a Ter-
minal Phonebook zip). Or, 
the files for downloading 
has not been created. 

Create the necessary files for down-
loading by using Terminal Phonebook.

7 The files for downloading 
(a terminal list or a Termi-
nal Phonebook zip) have 
been deleted.

8 “403 Forbidden” is 
recorded on the com-
munication log.

The access to the file to be 
downloaded has been 
restricted.
To download the Terminal 
Phonebook is not allowed. 

Download the Terminal Phonebook 
with downloading permission.

9 Correct the RIGHTS and ADDRESS 
data in the directory data (Excel). Cre-
ate Terminal Phonebook zip and 
download it.

Continued on next page

No. Cause Remedial Action
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(3) Cannot display or disappear the HTTP Server Settings screen

10 “401 Unauthorized” is 
recorded on the com-
munication log.

“Server authentication fail-
ure” or “encryption error” 
has been caused.

Set “without authentication” in the ter-
minal settings on the client side, and 
then download again. 
Or, download the root certificate of the 
HTTP server to the client (terminals), 
and then download again.
* Root certificate of the HTTP server: 

<PCPro installed folder>\sample\
http\ServerCertificate.der

11 “503 Service Unavail-
able” is recorded on 
the communication 
log.

“Session overflow” has 
been caused.
The HTTP server has 
received multiple down-
loading requests exceeded 
the tolerance level from the 
client (terminals).

Wait for a while and download again.

12 “Request Denied 
(NotSSL)” is recorded 
on the communica-
tion log.

The HTTP server has been 
accessed by unencrypted 
communication.

Use the HTTPS protocol.

No. Cause Remedial Action

1 Virtual PBX has been connected.

When Virtual PBX is connected, the 
HTTP Server Settings screen cannot 
be displayed. The displayed screen 
disappear, but the starting HTTP 
server does not stop.

Disconnect Virtual PBX, and then display the HTTP 
Server Settings screen.

2 Login with the “manager” account To open the HTTP Server Settings screen with the 
“manager” account, use the “HTTP Server Setting”, 
“Check Security”, “Start HTTP Server”, and “Stop 
HTTP Server” button in the Terminal Phonebook 
screen.

No. Cause Remedial Action
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(4) The HTTP server stopped

No. Cause Remedial Action

1 The IP address has been changed due 
to starting Program Upgrade (off-
line).

Close the Program Upgrade (off-line) screen to 
return to the original IP address, and then restart the 
HTTP server.
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Troubleshooting on Terminal Phonebook

The probable causes of faults that could occur in the Terminal Phonebook creating process.

(1) Failed to read the directory data (Excel)

No. Cause Remedial Action

1 The file format of Excel is old (such as 
XLS).

Create the directory data (Excel) by editing a sample 
(sample_phonebook.xlsx).

2 The setting directory data (Excel) is 
incorrect.
For example;
• The required data is missing (such as 

ID or a station number).
• The data are overlapping (such as ID 

or a station number).
• The IP address is incorrect.
• The limit of the number of charac-

ters/digits is exceeded.
• A character is specified in the 

numeric data.
• The data other than the fixed value 

(such as TRUE/FALSE) is specified.
• The required sheet for creating Ter-

minal Phonebook zip is missing 
(M_USER/M_TEL/TERMINAL/
<station number>).

• The number of the station number 
sheets is exceeded 100.

The sheet name and the ID that caused the error are 
recorded in the log. Check and correct the setting 
data in the directory data (Excel).

3 The file of the directory data (Excel) is 
used by other process.

Close the file of the directory data (Excel).



Appendix D Troubleshooting

D-38 NWA-088656-001 Rev.8.0

(2) Failed to create the head shot data of Terminal Phonebook

(3) Failed to create the Terminal Phonebook zip

(4) Consumed the most time for creating Terminal Phonebook

No. Cause Remedial Action

1 Unsupported file extension is used to 
the original photo file.

Check the file extension of the original photo file.

2 The specified photo file is missing. 
Read permission is not set to the spec-
ified photo file.

The telephone number that caused the photo data 
error is recorded in the log. Check that the original 
photo file of the telephone number exists and access 
rights of the file.

No. Cause Remedial Action

1 The required data or a head shot data 
has not been created. 

The station number that caused the error is recorded 
in the log. Check the setting data in the station num-
ber sheet.

2 The required head shot file has been 
deleted.

The station number that caused the error is recorded 
in the log. Check that the head shot file in the station 
number sheet exists.

No. Cause Remedial Action

1 The PC is congested by such as run-
ning Windows Update or a virus scan.

Cancel the process of Terminal Phonebook, resolve 
the congestion, and then try again.

2 The free space in the server for creat-
ing Terminal Phonebook is not 
enough.

Cancel the process of Terminal Phonebook, change 
the root folder to another folder that has enough disk 
space on the HTTP server.
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Troubleshooting on Software License Authentication

The probable causes of errors that could occur in the license data authentication process and the associated
remedial actions are listed below.

(1) Cannot register license data/Cannot create a PBX creation file

(2) Registered license data won’t take effect

No. Cause Remedial Action

1 Unstable communica-
tion between PCPro 
and the SV9300.

The SV9300 was in a con-
gested state, unable to 
receive a maintenance com-
mand.

Wait for a while and retry the commu-
nication session.

Noise present on the com-
munications line.

Connect PCPro and the SV9300 
directly with RS CONSOLE CA-A.

No. Cause Remedial Action

1 No temporary Activation Code or 
Activation Code had been registered 
following the registration of license 
data.

Register a temporary Activation Code or Activation 
Code.

2 Following the registration of an Acti-
vation Code, another Software Key 
Code has been added on the SV9300 
(or the Software Key Code has been 
deleted).

1. Verify the Software Key Code set on the SV9300.
2. Obtain the Activation Code again from the Soft-

ware License Authentication Center, including the 
Software Key Code added, and then register the 
correct Activation Code.

3 The system was reset without backing 
up the system data following the regis-
tration of a temporary Activation 
Code or Activation Code.

Reregister the temporary Activation Code or Activa-
tion Code and then back up the system data.
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(3) Cannot obtain an Activation Code from the Software License Authentication Center

(4) Cannot register a temporary Activation Code or Activation Code

(5) Error type 017 is set to point to an MJ alarm in the PCPro fault display

No. Cause Remedial Action

1 An attempt was made to use license 
data already authenticated to create a 
PBX creation file on another SV9300 
and to register it with the Software 
License Authentication Center 
(illegal copying).

Create a PBX creation file using license data that is 
not yet authenticated and register it with the Soft-
ware License Authentication Center.

No. Cause Remedial Action

1 Invalid temporary 
Activation Code or 
Activation Code.

The Activation Code for 
another SV9300 is used.

Enter a valid Activation Code.

2 Unstable communica-
tion between PCPro 
and the SV9300.

The SV9300 was in a con-
gested state, unable to 
receive a maintenance 
command.

Wait for a while and retry the communi-
cation session.

Noise present on the com-
munications line

Connect PCPro and the SV9300 directly 
with RS CONSOLE CA-A.

No. Cause Remedial Action

1 Invalid Activation 
Code.

The Activation Code for 
another SV9300 is used.

Enter a valid Activation Code.

2 The system was reset after registering new license 
data while a former Activation Code had already 
been registered on it. 

Access the Software License Authen-
tication Center to obtain an Activation 
Code and set it on the SV9300.

3 Five days have passed since you started running the 
system without registering an Activation Code fol-
lowing the registration of a temporary Activation 
Code.

Access the Software License Authen-
tication Center to obtain an Activation 
Code and set it on the SV9300.
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